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Dear Industry 4.0 stakeholders

New competence requirements due to digitalisation and Industry 4.0 (I 4.0) are arising in the
Vietnamese manufacturing industries, which need to be addressed by Technical and Vocational
Education and Training (TVET) institutes in close cooperation with the business sector. TVET plays a
crucial role in the development of a skilled and competent workforce for those advanced industries.

With support of the Vietnamese Directorate of Vocational Education and Training (DVET) under the
Ministry of Labour, Invalids and Social Affairs (MoLISA), the partners Siemens Viet Nam, LILAMA 2
International Technology College (LILAMA 2) and the Deutsche Gesellschaft flir Internationale
Zusammenarbeit (GlIZ), established the development partnership “Vocational Training for Smart
Manufacturing in Machine Tools”. Development partnerships with the private sector promote
activities where entrepreneurial opportunities and development policy potential meet and are
supported by the www.develoPPP.de programme of the German Federal Ministry for Economic
Cooperation and Development (BMZ).

The main achievements of the partners comprised:
« “Digital Technology Education Centre” for smart manufacturing at LILAMA 2 established;

+ Inclusive training modules and teaching and learning materials on higher digitalization and |1 4.0
competencies based on the industry needs developed;

+ Technical and didactical competencies of TVET teachers and in-company trainers for smart
manufacturing for metal processing occupations improved;

« Teachers of LILAMA 2 and other partner TVET institutes of the Vietnamese-German Programme
Reform of TVET in Viet Nam have been trained as master trainers and multipliers for further
dissemination in the TVET system;

« Gender equality promoted and awareness about the employment potential of people of
disadvantaged groups and their career options in industrial occupations and in TVET raised.

National and international smart manufacturing experts and curriculum designers developed the
training module “Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions in
NX”. The newly developed training module provides additional qualification in sophisticated smart
manufacturing application as in high demand of national and international companies in Viet Nam. It
is complying with Circular 03/2017 of the MoLISA and oriented on German standard.

The module can be offered as an elective training module for college level graduates of the three-years
training programme Metal Cutting Technician but also as further training to industry technicians and
engineers in the field of mechanical engineering and machine tools. TVET teachers are recommended to
offer the training module as hybrid learning or blended learning, in which trainees learn via electronic
and online media, as well as traditional face-to-face teaching and training.

Initial and further training programmes, developed in the frame of the Vietnamese-German Programme
Reform of TVET in Viet Nam, are available for free download at www.tvet-vietnam.org.



On behalf of the partners, we would like to express our utmost gratitude to all parties involved in the
development of the training module “Advanced Mold and Die Design with Integrated CAD/CAM/CAE
Solutions in NX". We wish all 1 4.0 and TVET stakeholders a successful application of the module to further
enhance relevant workforce competencies.
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Beate Dippmar Tran The Hien Nguyen Khanh Cuong
GIZ Programme Manager Head of Digital Industries Rector, LILAMA 2 International
Programme Reform of TVET in Viet Nam SIEMENS Viet Nam Technology College, Viet Nam




2D
3D
ABS
ANSI
API
ASC
ASME
BMZ
CAD
CAM
CNC
CSYS
DIN

DPP
DVET
DWG
DXF
ESKD
FCF
FPCD
GB
GD&T
GIZ

1.4.0

IGES

ISO

JIS
LILAMA 2
MolLISA
MRO

NX

PMI
PPO
PS
SCA
TVET
WCs

Two-Dimensional

Three-Dimensional

Absolute Coordinate System

American National Standards Institute

Application Programming Interfaces

Association for Survey Computing

The American Society of Mechanical Engineers

Federal Ministry for Economic Cooperation and Development
Computer-aided Design

Computer-Aided Manufacturing

Computer Numerical Control

Absolute Coordinate System

Deutsches Institut flir Normung e.V. (German Institute for Stan-
dardization)

Development Partnerships with the Private Sector
Directorate of Vocational Education and Training

From drawing (.dwg format file)

Drawing Interchange Format

ESKD Data Standards

Feature Control Frame

Flexible Printed Circuit Design

Guojia Biaozhun (International Standard)

Geometric dimensioning and tolerancing

Deutsche Gesellschaft fiir Internationale Zusammenarbeit
(GIZ) GmbH

Industrial 4.0

Initial Graphics Exchange Specification

International Standardization Organization

Japan Industrial Standard

LILAMA 2 International Technology College

Ministry of Labour, Invalids and Social Affairs

Overhaul processes

Officially NX does not stand for anything but the name came
from the merging of technology from SDRC I-DEAS with UGS
Unigraphics to deliver the "Next Generation" CAD system
Product Manufacturing Information

Proximal Policy Optimization

Sets

Software Composition Analysis

Technical Vocational Education and Training

Workpiece Coordinate System



ABBREVIATIONS 08
A.TRAINING MODULE 12
|. MODULE CLASSIFICATION AND CHARACTERISTICS: . 12
Il. MODULE OBJECTIVES: 12
Ill. MODULE CONTENT: . s T
1. General content and tlme aIIocatron Ty
2. Detailed content - _ v 15
IV. REQUIREMENTS FOR MODULE IMPLEMENTATION . 20
V. ASSESSMENT CONTENTS AND METHODOLOGY ... 20
VI. GUIDELINES FOR MODULE IMPLEMENTATION: 22
’ﬁ B. TRAINING CONTENTS 24
UNIT 1: FUNDAMENTALS OF 2D & 3D DESIGN AND ASSEMBLY ...............24
1.1. NX softwareoverview ... 24
1.1.1 Software overview ... .24
1.1.2 Overview of the interface and functions toolbar software NX 24
1.1:3 Process for areating 3L Pars s wmemmimsisimssimmseimmamsi oD
12 BESIER AR NN 38
1.2.1 Basic commands in 2D part design ......... . . _ ... 38
1.2.2 Correction commands in 2D part design ... SR S .62
1.2.3 Measuring toolsin2Ddesign ... 64
1.3. Design 3D with NX 73
1.3.1 Switching from 2D drawing to 3D ... 74
1.3.2 Basic commands in 3D part design ... s bl
1.3.3 Advanced commands in 3D part des;gn(Surface Modelmg) ... 83
1.4. Export 2D drawings from 3D drawings with NX . 95
1.4.1 International Drawing Standards ................95
1.4.2 Editing information on the drawing frame 103
1.4.2 View Labels ... s 110
1.4.3 Select the projection method for the object ______________________________________________________ 112
1.4.5 Advanced tools in 2D drawing export . . . _ .. 147
1.4.6 Checking drawings and printing drawmgs e 159
1.5. Assembling sub-assemblies ... ... ..........................159
1.5.1 Add Component 159
1.5 2Constram anassembly. coswassmensmmsmsmssasass 11
1:6 APPHEAEION BXOFCISES i 189
UNIT 2: ADVANCED SHEET METAL DESIGN WITH NX: TOOLS AND
TECHNIQUES 204
2.1 Getting started with Sheet Metal with Siemen NX software ... 204
Bl BN o e e 204
2.1.2 Recommended workflow to create a simple part... . 206
2.1.3 Recommended workflow to create enclosures with odd shapes or
ANGIES . 207



10

O

2.2. Sheet metal material standards and sheet metal preferences 208
2.2.1 Sheet metal material standards ... ... 208
2.2.2 Sheet metal preferences....... . 209

2.3 Creating sheet metal parts and features . 2711
2.3.1 Sheet Metal from Solid ... i 211
2.3.2 Basic sheet metal commands... - . 214

2.4. Advanced sheet metal commands and modlfy commands 329
2.4.1 Advanced sheet metal commands and modify commands ... 329
2.4.3 Patterninginsheetmetal ... ... 337
2.4.4 Mirroring in Sheet Metal ... - - . 343
2.4.5 Renew Feature ... - 7. ¥ |
2.4.6 Weld preparations on Sheet Metal parts . _ _ ... 348

2.5. Sheet Metal Drawings 349

2.6 Practical eXerCiSes .. ...y 352
2.6.1 EXamPle . 352
2.6.2 EXOICISES oo 361

UNIT 3: DESIGN OF PLASTIC INJECTION MOLDS WITH NX: FROM CONCEPT

Mold Overview........ . . _ _ . - . . 372
1.Two-platemold. ... .. ... ... 373
2.Three-platemold ... ... .. ... . .. 374

Mold Design with NX Software 376

3.1. Initial stage. (Innitiallize) ... ... 376

3.2. Define ... . 378
3.2.1. Deﬁne mold coordlnate system S . . 378
3.2.2. Definitionofembryo ... 380

3.3. Option. (Optional) ... _ _ _ _ _ 382
3.3.1. Change the shrinkage coefﬁc:ent 382
3.3.2. Arrange the number of cavities and mold cores (Layout) ... 384

3.4. Mold separation process . (PartingProcess) ... 386
3.4.1. Choose the mold withdrawal direction ... . 386
3.4.2. Determine Core and Cavity areas . _ _ .. 388
245 Patelholes ..o . . . . 388
3.4.4. Create parting surface 394
3.4.5. Create Core/Cavity .. R VD

3.5. Insert mold. (Add Mold Base) 403

3.6. System design ... . . . . . _ _ 406
3.6.1. Spray system. (lnjectlon) . 406
3.6.2. Ejection system design ... [ . . A7
3.6.3. Insert some sub detalls(SubInsert) 423

3.7 COMPIete de8IgN ... 424
3.7.1.Create holes (Pockets) S . 424
3.7.2. Create a bill of material (Bill of Materlal) - - 425



UNIT 4: DESIGN OF PRESS DIES WITH NX PROGRESSIVE DIE WIZARD:

STREAMLINING WORKFLOW ... . . . 427
4.1.Overviewof pressdies ... ... 427
4.1.1. Sheet stamping technology e 427
4.1.2. Structure of a progressive stamplng d|e s 2
4.2. Overview of NX PDW (Progressive Die leard) s 438
4.2.1. Introduction 438
4.2.2. The relevant commands 440
4.3. Designing the Progressive Dieusing NX ...........................546
4.3.1. Create intermediatestages ... 546
4.3.2.Create astriplayout ... 583
4.3.3. Create piercing iNSerts ..., D87
4.3.4.Create bending inserts ... . 59T
4.3.5. Design Worlflow of A Progressuve Die Set . . D95
4.4. Application Assignments ... 600
4.4.1. Application ASSIGNTNENT T .. mmmmmsmsssmmasumsmamsaismmssy 000
4.4 Application ASSIONMENE 2 .owsnmsimmmmsnmimmsmssma 00 T

UNIT 5 : INTEGRATED NX EASY FILL: PLASTIC INJECTION MOLD DESIGN

THROUGH SIMULATION .. e . 602
5.1 Overview of nx easyﬁll advanced technology . 602
5.2 Product analysis process with NX Easy Fill ... ... 603
5.2.1 Set Working Folder .. - - - . _ _ .. 603
5.2.25et CaVity . 003
5.2.3 SetRunner ... . 06
5.2.4 Set Parting Direction R
5.2.5 Start Analysis ... - 1L
5.2.6 Start Analysis - Analy5|s Monitor - 616
5.2.7 Show Result 617
5.2 8 Display Besult= CHERIE couwiamammsamsmamiismsmasias O
5.2.9 Display Result - Result Advisor ... 620
5.2.10 Generate RePOIT ..o 623
5.2.11 Export Result to Moldx3D Viewer ... 623
5212 Gate Wizard ... . . 624
52.13RunnerWizard ... 634
5.2.14 Melt Entrance Wizard .. T OB
5.2.15 Cooling Time Indicator 638
5.2.16 Flow Length to Thickness Ratio Indicator ... 640
5.2.18 Sink Mark Indicator 642
5.2.19 Upload to Teamcenter/Download from Teamcenter ... 643
5.2.20 Set Preference ... A3

% APPENDIX 644
Project regions and partnering tvet institutes ... 644

§0,  REFERENCES 645

11



I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

A. TRAINING MODULE

(According to Circular No. 03/2017/TT-BLDTBXH March 1, 2017 of the Ministry of Labour, Invalids
and Social Affairs)

Module name:

Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Module code: MD02

Module duration: 320 hours (Contents: 76h; Practice, experiment, discussion, assignments: 228h;

Examinations / Assessments: 16h)
. Module classification and characteristics:

- Classification:
Training module for AdvaTCed Mold and Die Design with Integrated CAD/CAM/CAE Solutions
qualification — International College Level. Enroliment requirement: National College Diploma in
Metal Cutting.
- Characteristics:
* The module is set to follow the German training and examination standards. It provides
training topics and competencies on Mold and Die Design, as well as advanced training in
Metal cutting. The module is structured into 5 training units which upscale and continue one
another. This can be offered as a supplementary training module for college graduates of
initial training programmes as well as to the industry in hybrid short-term form of training for
technicians, engineers and in-company trainers
* You can design the complete product shape needed with NX
* You can simply import data files from other software without abundant modification, similar to
products designed directly on NX
* You can check the machinability of mold products
* Advanced separating tools specifically designed by NX are available
» Core and cavity generation are fully automatic
» NX can check against new product versions created later automatically
o List of standard parts from mold manufacturers is provided
» Customized tools for push pins, oblique cores, slide cores are available
* You can assign cooling system, pipes and linking valves
» NX can create and extract drawings on demand automatically.
» Learners are aware of and comply to regulations on IT Security, labour safety, as well as
health and environmental protection.
Il. Module objectives:

By the end of this module, the trainees will be able to:

D o i i e e e e e A e e S L e L
m DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Module: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

- Knowledge:

* Understand detailed models, the process of creating 3D drawings

» Understand drawing and modifying commands with NX software to create 3D product
models

» Understand the sheet metal model, the process of creating products from sheet metal

» Understand the material standards applied in sheet metal

» Understand drawing and modifying commands on NX software to create sheet metal product
models

» Understand the overview of mold design and manufacturing technology

» Understand the structure and classification of plastic injection molds

» Understand the process of designing and manufacturing plastic injection molds

» Understand the design standards of plastic injection molds

*» Present the concept of sheet presswork technology and classify the types of this technology

» Analyze the functions of the components that make up a common press die

* Explain the use of support commands of the PDW tool/module

* Read and understand simulation and analysis results

* Analyze the causes and find ways to fix design errors

» Understand the process of simulating plastic flow with NX software.

*  Apply benefits of integrated programme measurement to reduce the time for quality functions

to be establishes and ensured.

- Skills:
 Draw products and 3D models in simple and complex forms with NX software
o Export 2D technical drawings for 3D models with NX software
* Assemble subassembly models
* Draw simple and complex sheet metal products and models with NX software
* Create technical drawing from sheet metal with NX software
o Calculate the technical parameters of plastic injection molds
» Perform automatic mold design steps with NX software
* |mplement the simulation process to analyze and optimize the mold design process with NX
software
* |mplement the management of mold data after design (BOM)
» Export drawings to manufacture mold details
* Use the commands of the PDW tool/module to design a complete set of progressive press
die
» Solve application exercises with the help of the PDW tool/module
 Export the report of simulation results of plastic injection mold with NX software.
* Plan and implement the distribution of complicated industrial tasks
- Autonomy and responsibhility: the trainees are able to work independently and in teams

according to the work assignment, to




I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

» Determine work steps and processes according to functional, organizational and
manufacturing criteria

» Design workflow diagrams for custom tasks according to the order

» Research and evaluate information for order planning in digital networks

* Carry out complex manufacturing processes in compliance with regulations on IT security
and occupational safety as well as environmental protection

» Arrange, monitor and control sub orders

» Develop special task solutions in terms of customer requests

lll. Module contents:

1. General contents and time allocation:

Time allocation (hours)

Practice,

Examination/

No Training module units Total experiment,

Content Evaluation

S

(hours) discussion,

assignment

1. Fundamentals of 2D & 3D Design|
and Assembly

1.1. Overview of NX

1.2. 2D, 3D design with NX

1.3. Exporting 2D drawings with NX 80 24 54 2

1.4. Assembling sub-assemblies

1.5. Practice exercises

2. Advanced Sheet Metal Design
with NX: Tools and Techniques

2.1. General sheet metal design with
NX

2.2. Material standards and features of
sheet metal

2.3. Basic tools for sheet metal design 8 " Zh .
and relevant geometrical elements

2.4. Advanced tools for sheet metal
design and modification tools

2.5. Creating technical drawings of
sheet metal with NX

2.6. Practice exercises

:, MDD | PORGEL ANy ey L e at god M2 Corwava - i b 2 sl 2 b | B P Nt prigtdy i
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I Module: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

3.1
3.:2.
3.3

3.4.
3:5.
3.6.
3.7.
3.8.

3:9.

3. Design Plastic Injection Molds

with NX software: From Concept

to Detailing

Overview of NX mold

Creation of mold design project

Definition of drawing direction of

mold, workpiece, etc.

Definition of core and cavity

Definition of partition face

Flexible Mold Separator
Insert of base mold parts 80 20

Design of plastic channel system,

cooling channel, etc.

Excluding mold parts

details

3.11. Practice exercises

3.10. Creation of 2D drawings for mold

56

4.1.

Progressive Die
Streamlining Workflow

Overview of press die

Die Wizard)

4.5 Practice exercises

4. Design the press Dies with NX

Wizard:

4.2. Overview of NX PDW (Progressive 80 8

4.3. Design of Punch and Die

4.4. Design of the base mold structure

70

5.

Integrated NX Easy Fill

: Plastic

injection mold design through

simulation

Easy Fill

Example exercises.

Total:

2. Deatailed contents:

5.1. Overview of NX Easy Fill

5.2. Product analysis process with NX

30 76

22

228

16
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Training Unit 1: Fundamentals of 2D & 3D Design and Assembly Duration: 40 hours

1. Objective: By the end of this training unit, the trainees will be able to:
- Understand detailed models, the process of creating 3D drawings
- Understand drawing and editing commands with NX software to create 3D product models
- Draw products, 3D models from simple to complex forms with NX software
- Export 2D technical drawings for 3D models with NX software
- Assemble the subassemblies
2. Contents:
2.1. NX software overview
2.1.1.Software overview
2.1.2.0verview of the interface and functions, toolbar software NX
2.1.3.Process for creating 3D parts
2.2. 2D design with NX
2.2.1.Basic commands in 2D part design
2.2.2.Correction commands in 2D part design
2.2.3.Measuring tools in 2D design
2.3. 3D design with NX
2.3.1.Convert 3D drawings from 2D
2.3.2.Basic commands in 3D part design
2.3.3.Advanced commands in 3D part design
2.4. Export 2Ddrawings from 3D drawings with NX
2.4 1.International Drawing Standards
2.4.2.Editing information on the drawing frame
2.4.3.Selection of the projection method for objects
2.4.4 Measurement of parts for required size outputs
2.4.5.Advanced tools in 2D drawing export
2.4.6.Checking drawings and printing drawings

2.5. Practice exercises

Training Unit 2: Advanced Sheet Metal Design with NX: Tools and Techniques Duration: 40 hours

1. Objective: By the end of this training unit, the trainees will be able to:

- Understand the sheet metal model, the process of creating products from sheet metal

- Understand the material standards applied in sheet metal

- Understand drawing and modifying commands with NX software to create sheet metal
product models

- Draw simple and complex sheet metal product models with NX software

- Create technical drawing from sheet metal with NX software

2. Contents:

2.1. Getting started with Sheet Metal with NX software

DPP — Vocational Training for Smart Manufacturing in Machine Tools
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2.1.1.Sheet metal
2.1.2.Recommended workflow to create a simple part
2.1.3.Recommended workflow to create enclosures with odd shapes or angles
2.2. Sheet metal material standards and features
2.2.1.Sheet metal material standards
2.2.2.Sheet metal features
2.3. Designing tools for sheet metal parts and their features
2.3.1.Tools for transforming block metal into sheet metal
2.3.2.Basic tools for designing sheet metal
2.3.3.Tools for fabrication of sheet metal
2.4. Advanced commands for sheet metal and modification commands
2.4.1.Advanced commands for sheet metal
2.4.2 Validating sheet metal parts
2.4.3.Patterning in sheet metal
2.4.4 Mirroring in sheet metal
2.4.5.Updating object features
2.4.6.Weld preparations on sheet metal parts
2.5. Creating technical drawing for sheet metal with NX software

2.6. Practice exercises.

Training Unit 3: Design of Plastic Injection Molds with NX: From Concept to Detailing Duration:
80 hours

1. Objectives: By the end of this training unit, the trainees will be able to:
- Understand the overview of mold design and manufacturing technology
- Understand the structure and classification of plastic injection molds
- Understand the process of designing and manufacturing plastic injection molds
- Understand the design standards of plastic injection molds
- Calculate the technical parameters of plastic injection molds
- Perform automatic mold design steps with NX software
- Implement the simulation process to analyze and optimize the mold design process
with NX software
- Implement the management of mold data after design (BOM)
- Export drawings to manufacture mold details.
2. Contents:
2.1. Overview of NX mold
2.1.1.Two-plate mold
2.1.2.Three-plate mold
2.2. Creating a mold design project
2.2.1.Product Analysis

achine Tools
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2.2.2.Entering shrinkage factor
2.2.3.Setting the order information
2.3. Definition of withdrawal direction.
2.3.1.Definition of coordinate system
2.3.2.Definition of workpiece
2.3.3.Arranging the quantity of products
2.4. Definition of core and cavity
2.4.1.Selecting the withdrawal direction
2.4.2.Defining Core and Cavity areas
2.4.3.Patching holes
2.5. Partition face definition
2.5.1.Partition line setting
2.5.2.Partition face setting
2.5.3.Creating core and cavity
2.6. Flexible Mold Separator
2.6.1.Automatic parting line setting
2.6.2.Automatic parting face setting
2.6.3.Creating core and cavity automatically.
2.7. Inserting base mold parts
2.7.1.Inserting basic mold components
2.7.2.Inserting bushing and nozzle
2.8. System design
2.8.1.Design of plastic channel system
2.8.2.Design of propulsion system
2.8.3.Design of cooling system
2.8.4.Inserting some extra details
2.9. Subtract the parts in the mold
2.9.1.Checking geometrical intersection details
2.9.2.Subtracting blocks to create complete parts
2.10. Material management (BOM)
2.11. Creating 2D drawings for mold details

2.12. Practice exercises.

Training Unit 4: Design of Press Dies with NX Progressive Die Wizard: Streamlining Workflow

Duration: 80 hours

1. Objective: By the end of this training unit, the trainees will be able to
- Present the concept of sheet presswork technology and classify different types of this
technology

- Analyze the functions of the components that make up a common press die

:-: MDD W FIROEL A Ciy B, a i Crvase b antifFart T 1 - e, priwglly Fi
DPP - Vocational Training for Smart Manufacturing in Machine Tools



I Module: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Explain the use of support commands of the PDW tool/module
Use the commands of the PDW tool/module to design a complete set of progressive
press die

Solve application exercises with the help of the PDW tool/module.

2. Contents:

2.1. Overview of press mold

2.1.1.Pressing and Stamping technology

2.1.2.Structure of progressive press die
2.2. Overview of NX PDW

2.2 1.Introduction

2.2.2.Related Commands

2.3. Design of punch and die structure

2.3.1.Design of punch structure

2.3.2.Design of die structure

2.4. Design of base mold structure

2.4.1.Designing the major components

2.4.2.Designing the minor components

2.5. Practice exercises

2.5.1.Practice Exercise No. 1

2.5.2.Practice Exercise No. 2

Training Unit 5: Integrated NX Easy Fill: Plastic Injection Mold Design through Simulation

Duration: 40 hours

1. Objective: By the end of this training unit, the trainees will be able to

Read and understand simulation and analysis results
Analyze the causes and find ways to fix design errors
Understand the process of simulating plastic flow with NX software

Export the report of simulation results of plastic injection mold with NX software.

2. Contents:
2.1. Overview of NX Easy Fill

2.1.1.The influence of materials on the process of forming plastic products

2.1.2.The influence of pressing parameters on the formation of plastic products

2.1.3.The influence from the texture and shape of plastic products on the forming process

2.1.4.NX Easy Fill as a solution to overcome the above factors to make plastic products easier

and more accurate

2.2. Product analysis process with NX Easy Fill

2.2.1.Informing simulation prediction (Set Working, Set Cavity, Set Masterial)

2.2.2.Informing the injection port (Set Runner, Set Melt Entrance)

2.2.3.Informing the withdrawal direction (Set Parting Direction)

achine Tools
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I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

2.2.4 Exporting the analysis command (Start Analysis)
2.2.5.Exporting the analysis result report (Show Result)

2.3 Example exercises.

IV. Requirements for module implementation
1. Specialised classroom, training workshop

a. Specialised classroom: Computer room

2. Equipment and machinery
- Computer
- Projector
- Printer
3. Teaching and learning materials, tools, consumption materials
- Detailed drawings, assemblies and overall drawings
- Assembly instructions, maintenance and reparation plans
- Plan for machining, arrangement and work
- Table of safety data
- Table of characteristic values, measurement checklist, assessment record
- Text books, reference manuals
- Pocket calculator, drawing materials.
- NX software
- Handbooks
- Handouts
- Exercise system.

4. Other requirements and conditions: None

V. Assessment contents and methodology
1. Assessment contents:

- Knowledge:

e Understand drawing and modifying commands with NX software to create 3D product
models

e Understand drawing commands and modifying commands with NX software to create
sheet metal product models

e Understand the overview of mold and die design and manufacturing technology

¢ Understand the structure and classification of plastic injection molds

* Understand the process of designing and manufacturing plastic injection molds

¢ Understand the design standards of plastic injection molds

* Present the concept of pressing technology and classify the types of this technology

¢ Analyze the functions of the components that make up a common press die
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Explain the use of support commands of the PDW tool/module
Read and understand simulation and analysis results
Analyze the causes and find ways to fix design errors

Understand the process of simulating plastic flow with NX software.

- Skills:

Draw products, 3D models in simple and complex forms with NX software

Export 2D technical drawings for 3D models with NX software

Assemble the subassemblies

Draw simple and complex sheet metal product models with NX software

Create technical drawing from sheet metal with NX software

Calculate the technical parameters of plastic injection molds.

Perform automatic mold design steps with NX software

Implement the simulation process to analyze and optimize the mold design process with
NX software.

Implement the management of mold data after design (BOM).

Export drawings to manufacture mold details.

Analyze the functions of the components that make up a common press die

Explain the use of support commands of the PDW tool/module

Use the commands of the PDW tool/module to design a complete set of progressive
press die

Solve application exercises with the help of the PDW tool/module.

Export the report of simulation results of plastic injection mold with NX software.

- Autonomy and responsibility: the trainees are able to work independently and in teams

according to the work assignment, to

Determine work steps and processes according to functional, organizational and
manufacturing criteria

Design workflow diagrams for custom tasks according to the order

Research and evaluate information for order planning in digital networks

Carry out complex manufacturing processes in compliance with regulations on IT security
and occupational safety as well as environmental protection

Arrange, monitor and control sub-orders

Develop customized task solutions required by customers

2. Assessment methods:

The assessment is based on the project work carried out and products manufactured by the

trainee/learner and is carried out in accordance with the provisions on the minimum knowledge, skills,

autonomy and responsibility required for module.
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- Knowledge:

The trainee's/learner's knowledge, skills and attitudes are determined based on oral and written
tests such as quizzes, technical discussions, and multiple-choice questions, as well as through
exercises integrating both theoretical and practical contents or practical exercises during
implementing the teaching units of the module. The evaluations are calculated according to the

valid point rules.

- Skills:
The trainee’s/learner’s practice results are evaluated based on practiceexercises, project work and

actual tasks at workshops via evaluation sheet / scales in accordance with the following criteria:

e Labour safety

* Organization of the workplace

e Technical standards

¢ Planning and implementation

* Target time

e Self — assessment.
- Autonomy and responsibility:
Based on attitudes and characters of the trainees/learners that are determined and evaluated
through observation over the training period: ethics in working, learning and cooperating, regulation
and morale, diligence, conscientiousness, disciplines, teamwaork ability, punctuality, independence,
sense of responsibility, prudence, initiative, activeness, enthusiastic participation in lessons and

supporting/motivating others during the learning process.
VI. Guidelines for module implementation:
1. Scope of application

Training module Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions -

International College Level.

2. Guidelines on module teaching and learning methods
- For teachers, lecturers and in-company trainers: Teachers (in TVET institutes/in-company
trainers) are responsible for compliance with the following guidelines for the professional
implementation of the theoretical and practical training contents of the enire module as well as
each single training unit:

e The trainees/learners must be instructed in details in compliance with regulations on
labour safety, health and environmental protections as well as fire prevention & protection
and security. Such compliance must be continuously monitored by responsible teacher/
in-company trainer. The trainee/learner must be informed with clarity and aware of the
appropriate measures and consequences for not complying with regulations.

* The learning process and progress of trainees/learners shall be regularly monitored and
evaluated, in particular the consistent compliance with labour safety regulations and

environmental protection conditions.
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* Ensure the highest possible quality of teaching and training by providing references to the
corresponding teaching unitsin planning and implementing lessons.

« Within the framework of the practice training units, the necessary working steps shall be
carefully explained to trainees/learners and demonstrated correctly.

¢ Individual knowledge and skill level shall be checked and assessed individually on each
actual teaching unit based on periodical work reports drawn up by the trainee.

 The quality of teaching is enhanced and guaranteed by the increase in using different
teaching and learning methods such as the 4-step method, project method, guiding text,
self-study and group work as well as by the efficient use of teaching and learning
materials and other aids.

e The work results of the trainees/learners must be evaluated and discussed transparently

between trainees/learners, responsible vocational teacher and in-company trainer.

- For trainees/learners: The trainees/learners are instructed to

¢ Follow instructions of vocational teachers or in-company trainers disciplinarily.

« Participate regularly and actively in class and each training lesson of the training module.

 Comply with the regulations regarding labour safety, health, fire prevention & protection,
and environmental protection.

e Contribute actively to environmental protection.

e Comply with teaching and workshop regulations.

o Participate in class attentively, take notes and ask questions in case of uncertainty.

* Raise questions to vocational teachers or in-company trainers or other trainees/learners
to ask for support with difficult tasks and to address problems

e Setup and keep the workplace clean and tidy

e Prepare, handle and maintain equipment properly

 Make daily and weekly reports on theoretical and practical lessons of the training modules

that learners have attended.

3. Focuses

The training focuses of the training module are units: 1, 2, 3, 4, and 5.

4, References

Metal Engineering, Young Publishing House, Vietnam

Mechanical and Metal Trades Handbook (Tabellen Buch Metall), 3rd English Edition, EUROPA —
LEHRMITTEL, Germany

Training materials related to SINUMERIK Operate 840Dsl, Siemens Corp., 2019

NX Documents from Siemens.

5. Further notes and explanations (if any)
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B. TRAINING CONTENTS

UNIT 1: FUNDAMENTALS OF 2D & 3D DESIGN AND ASSEMBLY

Objective: By the end of this training unit, the trainees will be able to:

Understand detailed models, the process of creating 3D drawings

Understand drawing and editing commands with NX software to create 3D product models
Draw products, 3D models from simple to complex ones with NX software

Export 2D technical drawings for 3D models with NX software

Assemble the subassemblies.

Contents:

1.1. NX software overview

1.1.1 Software overview

Figure 1.1 NX overview

1.1.2 Overview of the interface and functions, toolbar software NX
NX interface

The NX Windows interface provides access to frequently used commands with a minimum number of
mouse clicks while maintaining a maximum graphics window area.
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1.1.1.1 NX main frame window
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Figure 1.2 NX Windows interface
# Component Description
1 Quick Access |Contains commonly used commands such as Save and Undo.
toolbar
2 Ribbon bar Organizes commands in each application into tabs and groups.
3 Top Border bar Contains the Menu, Selection Group, View Group, and Utility
Group commands.
4 Resource bar Contains navigators and palettes, including the Part Navigator and
the Roles tab.
5 Graphics window |Allows modeling, visualizing, and analyzing models.
6 Left, Right, and |Displays the additional commands.
Bottom  Border
bars
7 Cue/Status line  |Prompts you for the next action and displays messages.
8 Tab area Displays the name of the part files open in the tabbed window.
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1.1.1.2 NX Ribbon bar

® @ 000

Home | Cove  Sufnce  Analsis  View  Fender  Tool  Application olatgenty 5 B & @9 - 8 X
E: ol !:‘] L—E’ 3 3 PaTam Fetune i i Craweter & @10 Orfael Reg o P ti;;:" T:: &

e - e oy Tries Body o Fenbace Fore 4
SE L AN [ [ AR gy e et @O M M o bumenn  MTE AN o M
(S _--:I:_;f-_ () - é lu:.. . ¥ Sarehe :r»-lu; rYIdsng o C,,-!IJ-.e v '
# Component Description
1 Tab Organizes commands into groups of related functions in each
application.
2 Group Organizes commands by function on each tab. Related commands

appear in lists and galleries.

1 i :
jo) Command Finds commands
Finder

4 o) Maximizes screen space.
= Full Screen

5 Coall th the Ribbon tab.
A Minimize ollapses the groups on the Ribbon ta
Ribbon

6 i = -
) Help Displays on-context Help (F1)

7 [y Allows turning on or turning off commands in each group.
. Ribbon
Options
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1.1.1.3 NX floating frame

Nx widl_query_wlid.prt (Modified) - 0O X
T widi_query_wid.prt & % [ nsmil_bend_taper.prt & mfnl_valve_adapter.prt »4 y
2 ffml_handle_mesh.prt
ﬂ asml_assyl_base.prt

I asml_armature.prt

ﬂ. desb_mach_3_3.prt i3

0

Figure 1.3 Floating frame

# Component Description

1 Tab group Tabbed windows can be arranged into one or more tabbed
groups within the main frame or floating frame.

2 More Appears in the main frame and floating frame when a tabbed group
Windows list contains too many tabs in the tab area. This provides access to the
remaining windows in the tabbed group.

1.1.1.4 Shortcut toolbar
A shortcut toolbar is a toolbar that contains the commands that you are most likely to use for the
selected objects.

If one or more objects are selected of the same type, the shortcut toolbar displays the commands that
are specific to the selected object type. If you select muliiple objects of different types, the shortcut
toolbar displays commands that you can use on all the selected object types.

When no dialog box is open and one or more objects are selected in the graphics window, NX displays
only the shortcut toolbar.
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Figure 1.4 Shortcut toolbar

When no dialog box is open and one or more selected objects are right-clicked in the graphics window,
the Part Navigator, or the Assembly Navigator, NX displays the shortcut toolbar and the shortcut
menu.

bi@ a0 S X E

[1:]
' 4 Select from List...
O, Hide Ctri+B
#, Hide Parents

[if Edit Parameters...
“B  Edit with Rollback...
<p Suppress

&) Assign Feature Color

Ddl Show Dimensions

[g:- Make Current Feature

[b Copy Ctri+C
X Delete Ctri=D
T Browse

¥ Properties

View v

Figure 1.5 Shortcut menu

1.1.1.5 View shortcut toolbar
The View shortcut toolbar is displayed when:

e Clicking in the background of the graphics window.
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= Holding Cirl and clicking an object.

Figure 1.6 Tool bar

Note
If the Drag and Drop between Windows | “| command which enables dragging function is
chosen, NX does not display the shortcut toolbar

1.1.1.6 Radial toolbars and radial shortcuts

Radial toolbar

Radial toolbars are available when Shift+Ctrl is held and a mouse button is clicked. The radial toolbar
has been shown depends on the mouse button is clicked.
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Figure 1.7 Radial toolbar

1.1.2.7 Radial shortcut
Radial shortcuts are available when you click and hold the right mouse button is held and clicked.

A radial shortcut with view commands appears when you the right mouse button is held and clicked
in the background of the graphics window.

D
B <5
Qe

A radial shortcut with object-specific commands appears when the right mouse button is held and
clicked on a selected object.

@
If the Drag and Drop between Windows ! "> command which enables dragging function is
chosen, NX does not display the radial shortcut.
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1.1.2.8 Keyboard accelerators

A keyboard acceleratoris also known as a keyboard shortcut, a shortcut key, or a hot key. A new
keyboard accelerator can be added or an existing one can be modified.

The following table lists a small number of keyboard accelerators in NX.

To do this task Perform this action
Orient geometry in a trimetric view Press Home
Orient geometry in an isometric view Press End
Fit geometry to the graphics window Press Ctrl+F
Switch between standard and full screen display Press Alt+Enter
View Help on context Press F1
View the Information window Press Ctrl+Shift+S

Note When a text box is active, single letter accelerators do not work. The letter is entered in the text
box instead.

Information—Custom Menu Bar—Shortcut Keys

Menu| Note If the Custom Menu Bar submenu cannot be seen, changeRoles to Advanced.

1.1.2.9 Mouse buttons and mouse key combinations
Many tasks can be done with NX by using the mouse or using a combination of a mouse button and a
keyboard key.

To do this task Perform this action

Select commands from menus or options in 8 Click the command or option.

dialog boxes
Select objects in the graphics window 8 Click the object.
Select contiguous items in a list box 8 Hold Shift and click the items.

Select or de-select non-contiguous items in a 8 Hold Ctrl and click the items.
list box

Start the default action for an object @ Double click the object.
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Cycle through all the required steps in a @ Click the middle mouse button.
command prior to clicking
the OK or Apply button

Cancel a dialog box 6 Hold Alt and click the middle mouse button.
Display an object-specific shortcut menu 6 Right-click the object.
Display the View Popup menu Right-click in the background of the graphics

window or hold Ctrl and right-click anywhere
on the graphics window.

1.1.1.10 3D input devices
A 3D input device is also known as a 3D mouse, a 3D motion control device, or a Spaceball. To control
motion, use the puck or ball on a 3D device.

Figure 1.8 3D input devices

Using a 3D input device to:

* Rotate the model at any time without selecting the Rotate command or pressing any mouse
buttons.

» Rotate the model with one hand while using the mouse with the other hand to select objects.
* Rotate, pan, and zoom at the same time in one fluid motion.

* Rotate, pan, and zoom in one direction.

If multiple windows are opened in the current session of the software, the 3D input device performs the
action in the window in which the cursor is placed. If the cursor is not in any graphics window, the 3D
input device performs the action in the work view of the active window.

1.1.1.11 Resource bar
The Resource bar contains tabs for navigators, a browser, and palettes. Each tab displays a page of

information.

The location of the Resource bar, as well as the tabs displayed on the bar, depends on the specific
configuration.

The Resource bar can also be displayed as a Ribbon bar tab.

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

NX D2 H =a-n b i B o Do BT 010 Wodeing - el lkage putint Medtnd . _ 3 X
- " Anshuii  Assambies  Surfacs View  Tooh w0 B A Q. X
| . ™= " + [l @ Omefegan - sy < - 3
W o v-e-eew @O o @ 3 @
Tt ; oo VEML Bl § KT tlm::: PSR :.:‘r e " * ids
. - - £ N LASY  FH0-9-
W Mpene = b Seection FERer + Dty Spsembly - * Ind - L. &= _
WS Q F k] T 8w
L]

4

L.

0
-
0

BmE S & Y B P

2
%
El
*
v
3
i
L
<
Qs =
. 9
= 3
3/

:

Figure 1.9 Resource bar
#  Component Description

Display information such as the features in a part and the components in an

assembly.

o Navigators
Navigators can be used to manage and edit data, view and change creation

order, and select objects such as features, tools, or operations.

° HD3D Tools f’rowdes_ access to HD3D tools that allow displaying and interacting with
information directly on the 3D model.
o Integrated  Web Provides access to the Internet from within the software.
browser

Provide access to standard and frequently used model data.

o Palettes Palettes can be used to access user-defined templates, roles, system

visualization scenes, and system materials.

Provides access to third-party applications and dialog boxes into NX.
o Custom tab
For more information, see Displaying host windows for third-party applications
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1.1.1.12 Open files in native NX
Several methods can be used to open a file in NX.

£ Use this command to open NX files and
files from other compatible CAD/CAM

File—Ofan cominand products as .prt files.

This command is also useful when there is
a desire to change loading options, for
example, to open files with a lightweight
representation.

History palette Use the History palette on the Resource
bar to open a previously opened NX part
T History O file. NX organizes the files into folders

based on when they are last opened.
v ¢ m * Thumbnails make it easy to identify parts.

# « o To open the file as a displayed part,
double-click a thumbnail.

pd

i * To add a part as a component to the
currently displayed part, drag the part

B}_@—) into the graphics window.

w 2-Flowvlend-headboard.prt
from F\workdir\NX

Inferred

test casel.prt from
- F\workdir\NX

Inferred

2 Scooter.prt from
F\workdir\9.0.2\from_fran...

Recently Opened Parts list Use this list on the File tab to open the
most recently opened parts. NX lists the
name and folder path for each part.
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System folders

» To open the file as a displayed part,
double-click the file name.

:'-E::--'- - .- - = e Toadd a part as a component to the
i currently displayed part, drag the part
into the graphics window.

1
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1.1.3 Process for creating 3D parts
NX is a parametric and feature-based system that allows you to create 3D parts, assemblies, and
2D drawings.The design process in NX is shown below.
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‘ Sketch I 3D Part ‘Assemblyl

2D Drawing

Figure 1.10 Process for creating 3D parts

In NX, parameters, dimensions, or relations control everything. For example, if there is a desire to
change the position of the hole shown in figure, it is necessary to change the dimension or constraint
that controls its position.

The parameters and constraints allow having control over the design intent. The design intent
describes the way the 3D model will behave when dimensions and constraints are applied to it. For
example, to position the hole at the center of the block, one way is to add dimensions between the
hole and the adjacent edges. However, when the size of the block is changed, the hole will not be
at the center.
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It is able to make the hole to be at the center, even if the size of the hlock changes. To do this,
it is necessary to delete the dimensions and apply the Midpoint constraint relationships
between the hole point and thehorizontal and vertical edges. Now, even if you change the size
of the block, the hole will always remain at the center.

Midpont

Constrains 4 vertex of pent io be aligned with the
midgeint of 2 ine.

The other big advantage of NX is the associativity between parts, assemblies, and drawings.
When the changes are made to the design of a part, they will take place in any assembly thatitis
a part of. In addition, the 2Ddrawing will update automatically.

7 &
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1.2. Design 2D with NX

This part covers the methods and commands to create sketches used in the part-modeling
environment. The commands and methods are discussed in context to the part-modeling
environment. In NX, you can create sketchesin two environments: Part and Sketch task
environment. Instructions will be given on how to create sketches in both environments.

In NX, create a rough sketch, and then apply dimensions and constraints that define its shape
and size. The dimensions define the length, size, and angle of a sketch element, whereas
constraints define the relations betweensketch elements.

1.2.1 Basic commands in 2D part design

Creating sketches in NX Part environment is very easy. The Sketch command must be activated,
and then definea plane on which you want to create the sketch. To do this, click Home > Direct
Sketch > Sketch on the ribbon. Next, click on any of the Datum Planes located at the center of
the graphics window. On the Create Sketch dialog, click OK to start the sketch. It is now able to
start drawing sketches on the selected plane. After creating the sketch, click Home > Direct
Sketch > Finish Sketch on the ribbon to finish the sketch.
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1.2.1.1 Sketching in the Sketch Task environment
The Sketch Task environment is used to create sketches only to complete a specific task. For
example, to create a sketch to construct an Exfrude feature, activate the Extrude command
(On the ribbon, click Home > Feature > Extrude), and then click on a Datum plane. The Sketch
Task environment will be active. It can be noticedthat the Profile command is also activated,
by default. It is able to start sketching lines or select any other sketching command. After
completing the sketch, click Home > Sketch > Finish on the ribbon to come out of the Sketch

i

5. Applicaton S
’*'-—-._ g .L
L

Datum | Extiude
Hiane v i

Taskenvironment.

1.2.1.2 Drawing Commands
NX providesa set of commands to create sketches. These commands are located on the Direct
Sketchpanel of the Home ribbon.

NX H 2~ G = < 3 switch Window [J] Window = = NX 11 - Modeling -
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6\; Ral | i1 Afternate Selution i Inferrec Constraints and Dimensions
Wl —rr -
| g CAM Eireds | B Display Object Color [I] Convert To/From Reference
|._,] ! {E] Orient to Sketch vfa. Display Dimension-as PMI
|
L) g Role 5 Edit Sketch Parametats -

| \f; Eszentials

1.2.1.3 The Profile command

This is the most commonly used command while creating a sketch. To activate this command, click
Home > Direct Sketch > Profile on the ribbon. As you move the pointer in the graphics window, it
can be noticed that a box is attached to it. It displays the X and Y coordinates of the pointer.
To create a line, click in the graphics window,move the pointer and click again. After clicking
for the second time, it can be seen that an end point is added andanother line segment is
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started. This is a convenient way to create a chain of lines. Continue to click to add more line
segments. To end the chain, right-click in the graphics window and click OK. Notice that the Profile
command is still active. Create another chain of line segments or press Esc to deactivate this
command.
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Tip: To create a horizontal line, specify the start point of the line and move the pointer horizontally: a
dotted horizontal line appears. Click the on the dotted line to create a horizontal line. In addition, the
Horizontal constraint is applied to the line. Constraints will be learned later in this chapter. Likewise, you
can create a vertical line by moving the pointer vertically and clicking.

The Profile command can also be used to draw arcs continuous with lines. Click the Arc icon
on the Profile dialogto draw this type of arc. The figure below shows the procedure to draw
arcs connected to lines. To switch from tangent arc to normal or vice-versa, move the pointer
to the end point of the previous line.

Dbject Type _|1:|.'.'.'.cce
S | (X0
: — 4
A 7
+ L s +
e Fadur | EREE|
Sweep nnglc: 77,5019 Sweep Angle| 190.645
Move the cursor along the direction Move the cursor in the direction
of the line to create a tangent arc normal to the line to create a normal arc

To delete aline, selectit and press the Delete key. To select more than one line, click on multiple
line segments; thelines will be highlighted. Multiple lines can also be selected by dragging a
box from left to right. Press and hold the left mouse button and drag a box from left to right; the
lines inside the box boundary will be selected.
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1.2.1.4 The Arc command

This command creates an arc using two methods: Arc by 3 Points and Arc by Center and
Endpoints.

The Arc by 3 Points method

This method creates an arc by defining its start, end, and radius. Activate the Arc command
(click Home > DirectSketch > Arc on the ribbon). On the Arc dialog, click the Arc by 3 Points
button, and then click to define the startpoint of the arc. Click again to define the end point.
After defining the start and end of the arc, the size and position of the arc need to be specified.
Move the pointer and click to define the radius and position of the arc.

Home  Analysis  Application  Surface

g vwa /o + )
AR Y-

Direct Sketch

&
4 at & 3 S

2y ’:\ XY ﬁ Radius

The Arc by Center and Endpoints method

This method creates an arc by defining its center, start and end. Activate the Arc command and
click Arc by Center and Endpoints. Click to define the center point. Next, move the pointer
and it can be noticed that a dotted line appears between the center and the pointer. This line is
the radius of the arc. Now, click to define the start point of thearc and move the pointer; it can

be noticed that an arc is drawn from the start point. Once the arc appears as desired, click to
define its end point.

Arc e
“In
Arc Method = Input Mode M

= [IRE] | |30V (S

Radius 58,8657
. Sweep Angle| 78.7710¢

1.2.1.5 The Rectangle command

This command creates a rectangle using three different methods: By 2 Points, By 3 Points, and
From Center.
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The 2 Points method

This method creates a rectangle by defining its diagonal corners. Activate the Rectangle command
(On the ribbon, click Home > Direct Sketch > Rectangle). On the Rectangle dialog, click By 2
Points and click to define the first corner. Drag the pointer and click to define the second corner. It
is also possible to type values in the Width and Height boxes attached to the pointer.

I Home  Analysis  Application  Surface

B wasN 0o+

|
;i(r;itscr;'l _\] L\V _\'{', _\]\ ‘@ }%’ J& > \‘j
Direet Sketen £ \Width |
i Height| 37
Rectangle Method | Input Mede

Sty e
The 3 Points method

This method creates an inclined rectangle. The first two points define the width and inclination

(3] |
Rectangle Method | Input Mode éﬂ% _
=Y < (Il = - -'9
\ - Width | B
Height| 42
Angle | 33

1

angle of the rectangle. The third point defines its height.

The other procedure to create a 3 Points rectangle is to specify the first corner. Next, type in a
value in the Angle box. Press the Tab key and type values in the Width and Height boxes.
Click in the graphics window to createthe rectangle.

34z
(:;'J The From Center command

This method creates a rectangle by defining three points: center of the rectangle, and mid
and endpoints of the height. Activate the Rectangle command and select the From Center button
on the Rectangle toolbar. Specify the center point of the rectangle, move the pointer, and click to

define the width and orientation angle of the rectangle. Move the pointer and click to define the
height of the rectangle.
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1.2.1.6 The Circle command

This command creates a circle using two methods: Circle by Center and Diameter and Circle by
3 Points.

©

The Circle by Center and Diameter method

This is the most common way to draw a circle. Activate the Circle command (click Home >
Direct Sketch > Circleon the ribbon) and click Circle by Center and Diameter on the Circle
dialog. Click to define the center point of the circle. Drag the pointer, and then click again to define
the diameter of the circle.

) {,ﬂ%e

Diameter| 61,0261

O | The Circle by 3 Points method
This method creates a circle by using three points. Activate the Circle command and click Circle

by 3 Points Oon the Circle dialog. Select three points from the graphics window. It is also
possible to select existing points from the sketch geometry. The first two points define the
location of the circle and the third point defines its diameter.
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1.2.1.7 The Polygon command

5 Diameter| FEEE

@ :
(2]
This command provides a simple way to create a polygon with any number of sides. Activate
this command (On the ribbon, click Home > Direct Sketch > More Curve > Polygon) and click
in the graphics window to define the center of the polygon. As you move the pointer away from
the center, you will see a preview of the polygon. To change the number of sides of the polygon,
just click in the Number of Sides box on the dialog and enter a new number. Next, press the

ENTER key to update the preview.

Home  Analysis  Application  Surt £ Polygon O X
g e, ‘ Center Poin: A
(r:_,t; | m D / .\ O _I_ * Specify Point d’ }5- *

Edit Curve :
- [ R N l\v l{ ~ £9 Sides A
ng; j@' J@ Q 5 & Number of Sides 6 :|
Me 4 More Curve Size A
B Hist -
£ Mot €3 @ﬁj @ 458 * Specify Point o
Y : ?
;?C _ta E ) d ‘Tj") K J( Size Inscribed Radius -
<al S oteaé b il
3Mo{ EO - [l A Radius 100 mim v_;
Ak [ @ Rotation 0 deg hdl
Close |

Now, The size of the polygon must be defined. On the dialog, the Size menu has three options
to define the sizeof the polygon: Inscribed Radius, Circumscribed Radius, and Side Length. If
you select Inscribed Radius, the pointer will be on one of the flat sides of the polygon. If
Circumscribed Radius is selected, a vertex of the polygonwill be attached to the pointer. Click
in the window to define the size and angle of the polygon. The size and angle of the polygon can
also be defined by entering values in the Radius and Rotation boxes on the dialog.
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Inscribed Radius Circumscribed Radius
h \ I. | .
_f.i}i \ =
W/ \ y
— f ~ : Radius -
Radius B ~ i Ratation| 341 = |

Rotation| 319 |

If you select Side Length, then you have to define the length and angle of one side a polygon.
Type-in values in the Length and Rotation boxes and press Enter to create the polygon.

1.2.1.8 The Ellipse command
This command creates an ellipse using a center point, and major and minor axes. Activate this
command (On the ribbon, click Home > Direct Sketch > More Curve > Ellipse) and click to
define the center of the ellipse. On the Ellipse dialog, type values in the Major Radius and
Minor Radius boxes. The arrows attachedto the ellipse can also be dragged to define the major
and minor radius.

Heome  Analysis  Application Sn.rl‘ O Ellipse (a4
@ - - e Major Radius
e e 2 d . -
llcr;r,; m :l b (_) 1 * Specify Point ;‘::.: 7@’. 1 . - E "
Edit Cor i L
— % i Ao O 2 ¥ g [ N
: ﬁ Se ﬁ< _1 8 Major Radiiss A V’/ I J ._AHEI:._ 7
ey &0 Soecify Poirit [E] 2 = /
s & B Q= : B R _ :
%‘ 4 hora Cus Major Radiis m_ mm | \ 3 - Rotation Angle
e \ ;
 Moc a'} @ \’K:) - -’é Minor Radius A = -
W' [EC R = #
__@ ,CL‘I Jd.. Sl D )E Specify Point Gl A o
S Usel o ) bR g ]
3 Moe 77 - Minor Radius 2 mm =
e = i
Limits A
[ Closed
" A
Angle o deg -

Cancel

On the dialog, type-in a value in the Angle box or drag the angle modifier on the ellipse to define
the rotation angle of the ellipse. On the dialog, click OK to create the ellipse.

1.2.1.9 The Studio Spline command
This command creates a smooth B-spline curve using two different methods: Through Points
and By Poles. B- Splines are non-uniform curves, which are used to create smooth shapes.
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The Through Points method creates a smooth spline passing through the points selected.

€} Siudio Spline O X fj
Type A

|.N Through Points v|

A By Poles ¥

| 4 Show Shortcuts |

Rt T

Caonstraints it ' }
2

® ——e

Inthe By Poles method, various points called as poles will be defined. As the poles are defined,
grey lines are created connecting them. The spline will be drawn tangent to these lines.

€ Studio Spline O X
Type P
iN Through Points =

e

By Poles *
& Show Shortcuts

]

Constraints i

The Close Curve option can be also used to create a closed curve.

Parameterization A

Degree 3 :: l}
d Kot Position

1
'E‘“\)

—_—

On the dialog, click OK to complete the studio spline.

1.2.1.10 The Rapid Dimension command

It is generally considered a good practice to ensure that every sketch created is fully constrained
before creating solid features. The term, ‘fully-constrained’ means that the sketch has a definite
shape and size. A sketch can be fully constrained by using dimensions and constraints. As
sketches are created in NX, some dimensions are added to the sketch elements. These
dimensions are called Driven dimensions and they do not have any control over the sketch
geometry. To allow these dimensions to control the shape and size of the sketch geometry,
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they have to be converted into Driving dimensions. Driving dimensions are so named because
they drive the geometry of the sketch.

Driving dimensions can be added to a sketch by using the Rapid Dimension command. This
command can be used to add all types of dimensions such as length, angle, and diameter and
so on. This command creates a dimension based on the geometry selected. For instance, to
dimension a circle, activate the Rapid Dimension command, and then click on the circle. Next,
move the pointer and click again to position the dimension; a box will pop up. Type a value in
this box, and then press Enter to update the dimension.

If a line is clicked, the Rapid Dimension command automatically creates a linear dimension.
Click once more toposition the dimension, and then type-in a value and press Enter; the

__p0=130.0 | po=180,0
L—

dimension will be updated.

On the Rapid Dimension dialog, click Close to deactivate the Rapid Dimension command.

Linear Dimensions

NX allows you to create various types of linear dimensions. Select a line and click on the
Horizontal Dimension icon on the Contextual toolbar; a horizontal dimension is created.

L 311“" g} iR X s * S Ey T Al |"-i. /
J__ 7 —D}
v le pl=A9.6

| Honzental Dimenzion

Creates a horizontal distance constraint between two
points.

T
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Select aline and click the Vertical Dimension icon on the Contextual toolbar; a vertical dimension
will be created.

BN EH® X = § £ g 3
1
~ \.le.r;i{.al.Dirnen:ion

Creates a vertical distance constraint between two points

To know the true length of the line, select the line and click the Parallel Dimension icon on the

Contextual Toolbar. Next, double-click on the dimension, type a value in the box, and press
Enter; the dimension is updated.

& j I OB ox - | Lo L
14
| Parzllel Dimension

| Creates a parallel distance constraint between twe paints
| (shortest distance between the points).

b o i 4
* e
s
-

Angular Dimension

The procedure to create an angle dimension is similar to that of linear dimensions. Select two
lines that are positioned at an angle to each other. Click the Angular Dimension icon on the
Contextual Toolbar. Double-click on the angular dimension, type-in a value, and press Enter.

/l

%

: Ve
F— j:'|“§) B % 4 L= 1 = L .._‘.)é
1 & e8] A

T -
o W . |
TR 3
il % LE\\_
: Angular Dimension : ;
— 3 Crestes an 2ngular constraint between bwo non-parallzl : (2
lines. -
. .

Qver-constrained Sketch

When creating sketches for a solid or surface feature, NX will not allow over-constraining the
geometry. The term ‘over-constrain’ means adding more dimensions than required. The
following figure shows a fully constrained sketch. If another dimension is added to this sketch
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(e.g. diagonal dimension), the Update Sketch message pops up. It shows that the dimension
over constrains the sketch. when clicking OK, all the dimensions in the sketch will become red.

p4=620,0
&

Update Sketch ,
o The sketch geametry is overconstenined affer the intest edir.

The constiaints and dimensions that am reiated to the problerm s highlighted in the Red color
The curves that se nat positioned cormectly are shown in the Sitver Gray color.

[”] Dant displey this message agan

o

Now, one of the dimensions has to be made as a Reference dimension. Click on the diagonal
dimension and select Convert to Reference on the contextual toolbar. The Convert Dimension
to Reference message appears. Click OK to convert the dimension to reference. The reference
dimensions will be in brown. Now, if the value of the width is changed, the reference dimension
along the diagonal updates automatically. Also, note that the dimensions which are initially

created will be driving dimensions, whereas the dimensions created after fully defining the
sketch are driven dimensions.

p1=175,0 p1=175,0
& g = I
| B ® X °
L L 3
= = 8
¥ B
2. a
Bz ¢
E- e ! L — ll

Continuous Auto Dimensioning

NX creates dimensions automatically while a sketch is being drawn. However, if you do not
want dimensions to be created automatically, then deactivate the Continuous Auto

Dimensioning command (on the ribbon, click Home > Direct Sketch > More > Continuous
Auto Dimensioning)

>,
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It is also possible to hide the already created continuous auto dimensions by deactivating
the Display Sketch AutoDimensions button (Click Home > Direct Sketch > More >
Sketch Constraints > Display Sketch Auto Dimensions). This button can be activated
to display the auto dimensions.

5 [ [0 &
Mare Datum Extrude Hole
X Flane = bl
| Recently Uzed

E £ Continuous Auto Dimensioning

| sketch Constraints

#y Geometric Constraints
(fT Perimeter Dimension
&l Display Sketch Auto Dimensions

Sketch Feature

i Reattach

Sketch Tools

« Pattern Feature
B Unite ~
& Shell

|:'_'i B¢ Chamfer < &a

Blend ~

s

5 Trim Body i

Edge More  Mow
4 Drait -

Fac

[ Make Symmetric

+4 Display Sketch Constraints

s

' Display Sketch Auto Dimensions

sketch.

Displays all auto dimensions of the active

1.2.1.11 Geometric Constraints

Geometric Constraints are used to control the shape of a drawing by establishing relationships
between the sketch elements. These geometric constraints can be applied using the Geometric
Constraints command (On the ribbon, click Home > Direct Sketch > Geometric Constraints) or
with the help of Contextual Toolbar.

Coincident

This constraint connects one point with another point. Select the points to be made coincident and
click the Coincident icon on the Contextual Toolbar. The selected points will be connected.
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T EY=EIEy

] Comncident

Constrains two or more vertices or points to be
coincident,

Point on Curve

This constraint makes a vertex or a point to be on a line, curve, arc, or circle. Select a curve
and point, and click Point on Curve on the Contextual Toolbar. The point will lie on the curve or
the curve extension.

9‘ U&-+_ 13| w

Peint On Curve

Constrains a vertex or point to beon 2 curve.

Tangent

This constraint makes an arc, circle, or line tangent to another arc or circle. Select a circle, arc, or
line. Select another circle, arc, or line. On the Contextual Toolbar, click the Tangent button; both
the elements become tangent to each other.

N\ = .
\\ |FH&P X5 L1e
b 3 T
\‘ \\M Tangent
\ g
\\ Constrains two curves to be tangent.
N,
\\

N,
N
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Parallel
This constraint makes two lines parallel to each other. Select two lines from the sketch and click
Parallel on the Contextual Toolbar. The under constrained line is made parallel to the constrained
line. For example, if a line is selected with vertical constraint and a free to move line, the free-to-

move line becomes parallel to the vertical line.

= A o+

ko= ¥\

! v £ Parallel
Constrains two er mare curves to be parallel.

e

Concentric
This constraint makes the center points of arcs, circles or ellipses coincident. Select a circle or
arc from the sketch.Select another circle or arc, and then click Concentric on the Contextual

Toolbar. The first circle/arc will be concentric with the second circle/arc.

EHH®X S L@= 1 ¢

MR
* Concentnz
ins twn ar more cunves to be cancentic

Horizontal
This constraint makes a line horizontal. Select a free-to-move line, and then click Horizontal

on the Contextual toolbar; the line is made horizontal.

:.]H‘QH‘:} > x ‘S-+ P {-’!-lﬂ

I| Ay
Horzontal
Constrains one or moie lines to be horizontal,

100IS
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Vertical

This constraint makes a line vertical. Select an under-constrained line, and then click Vertical
on the Contextual toolbar.

r
'

BLPHES DX = ‘f};d 1 £

12 |

Constrains one or more lines to be vertical,

Vertical

z/.

Equal Length

This constraint makes two lines equal in length.

Equal Radius

This constraint makes circles or arcs equal in radius.
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| Equal Raclius |

| Constreins two or more arcs to have egual radius.
L

Perpendicular

This constraint makes two lines perpendicular to each other. Select two lines from the
sketch, and click the Perpendicular icon on the Contextual Toolbar. The two lines will be
made perpendicular to each other.
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- Perpendicular

Constrains two curves to be perpendicular.

Collinear

This constraint forces a line to be collinear to another line. The lines are not required to touch each

other.
T P
,EI IEIR % X /. + \\ = A 1
{{l - I s |
‘ | | = -—IE——o

Midpoint

This constraint forces a point or vertex to be aligned with the midpoint of a line. Click on a point
or vertex, and thenclick on a line. Select Midpoint from the Contextual Toolbar.

il R
1 ‘__[}' 5 = -

Midpoint

Constrains 3 verter or point to be aligned with the
midpoint of a line.

Horizontal Alignment

The Horizontal Alignment constraint aligns the two selected points horizontally. Select
the points to align horizontally, and then click the Horizontal Alignment button on the
Contextual Toolbar.
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paints to be honzontally ahgned.
.l == b1 I

Vertical Alignment

The Vertical Alignment constraint aligns the two selected points vertically. Select the points to align
vertically, andthen click the Vertical Alignment button on the Contextual Toolbar.

H L ] [

& ®

Points to align

Bl sy T e
i L _]_| < %
L |
.
Vertical Alignment
Constrains two or more selected vertices or

points to be vertically aligned.

Constant Length

This constraint fixes the length of a selected line. Select a line and click the Constant
Length button on the Contextual Toolbar.

Click and drag the sketch elements connected to the line; the size of the connected elements
changes but thelength of the line remains constant.

&
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Constant Angle
This constraint fixes the angle of a selected line. Select a line and click the Constant

Angle button on the Contextual Toolbar.

BN T B XK= | @l VA
il.___“‘ ¥ :‘/\. % h
e Constant Angle
& Constrains one or more selected lines to be

|

at & constant angle.

Click and drag the sketch elements connected to the line; the size of the sketch elements changes

but the angle ofthe line remains constant.

Non-uniform scale
This constraint scales a spline in horizontal or vertical direction. Select a spline and click Non-

uniform scale onthe Contextual toolbar.

EECE 2y | EEN

Non-uniform Scale
! . Constrains a selected spline to scale defining
~ points proportionally along the spline length,

/

Activate the Rapid Dimension command, and then select the two end points of the spline.
Change the dimensionvalue; the spline is scaled along the direction of the dimension.
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Uniform scale

This constraint scales a spline in both horizontal and vertical direction. Select a spline and click
Uniform scale onthe Contextual toolbar.

RPN X ~Be G
L ’ o

/ \ Uniform Scale

/ \l\\ Constrains a selected spline to scale defining
/ ™~ points in two directions to maintain the

H\"“\_\_H____’_/ spline shape.

Activate the Rapid Dimension command, and then select the two end points of the spline.
Change the dimensionvalue; the spline is scaled uniformly in both horizontal and vertical

directions.
-
A .
E— . L{ \\\_1____ ' Second Object
FirstObject| e
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p7=300,0

Make Symmetric
This command makes two objects symmetric about a line. The objects will have same size, position
and orientation about a line. Activate this command (On the ribbon, click Home > Direct Sketch >
More > Make Symmetric) and click on the first object. Click on the second object, and then define
a symmetrical centerline. The two objects will be made symmetric about the centerline. The Make
Reference option on the Make Symmetric dialog converts the centerline into a reference object.

PR T R Lt
Rapid Mere Datum Extrude Hole ot Edge @ Trim Bady More | Mowe Primary Objed_ A
Dimengen* = Planar = 9 Sael Bleng» P Draft T Fa # Select Dbject (0) :)f'_
Recently Used 4 o
Bl = & Relations Browser ¥l Display Sketch Auto Dimensions Secondary Object A
+ Geometric Constraints ﬂ Confinucus Ata Dimensaning * Select Dbject (0) -
Sketch Constraints
#_ Geometric Constrainis [ Wik Symmetric Symmetry Centerling A
(7 Perimeter Dimersion V4 Display Sketch Canstraints # Selec Caniine ) &

¥ Display Sketch Auto Dimensions
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It is possible to continue selecting the objects to be made symmetric object the previously selected
centerline. Close the dialog after applying the symmetric constraint.
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Create Inferred Constraints

Constraints can also be applied automatically by activating the Create Inferred Constraints
command. Activate ordeactivate Create Inferred Constraints by clicking Direct Sketch > More
> Create Inferred Constraints on the

ribbon. With this command turned on, constraints are applied automatically when the sketch
elements are created. It is possible to define which constraints to apply automatically by using the
Inferred Constraints and Dimensions dialog. On the ribbon, click Home > Direct Sketch >
More > Inferred Constraints and Dimensions. On the Inferred Constraints and
Dimensions dialog, select the constraints to be created while sketching elements.
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Under the Dimensions Inferred while Sketching section, define the order in which the automatic
dimensions are applied. Check the Create Dimensions for Type Values to create driving
dimensions when creating sketchesby typing exact values. Click OK to close the dialog.

Display Sketch Constraints

As constraints are created, they can be viewed using the Display Sketch Constraints button
(On the ribbon, clickHome > Direct Sketch > More > Display Sketch Constraints). When dealing
with complicated sketches involving numerous constraints, you can deactivate this button to turn
off the display of all constraints.
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Sketch Relations Browser

The Sketch Relations Browser dialog helps to view all the constraints in the sketch, their
status, and elements associated with them. Activate the Sketch Relations Browser (On the
ribbon, click Home > Direct Sketch > More > Relations Browser). On the Sketch Relations
Browser dialog, select Scope > All in Active Sketch to view all the constraints and dimensions
in the active sketch. Next, select Top-level Node Objects > Curves to display all the curves
available in the sketch in the form of nodes. Next, expand each curve node to view all the
constraints related to it. The Status column displays the status of each curve: Fully

()
Constrained ® ,Partially Constrained © , or Over Constrained. Right click on the curve node
and select Fit View to Selection; the select curve is zoomed in the graphics window.
!

Okject to Browse A

o
i . 1 - I -
| - &
T o
L i A
4 2! Cioject Status  DewedFro Extemal Reternce
— + A1 L
y. g ™, N hrce L]
a \ { = Line1 L]
L4 < | —-—— * Line2 .
\ \ / - Lined .
g N " Lined [
=4 Lingt L]
Lined e
Lined L]
b1 ¥ L]

Setting W

Cioge

Select Top-level Node Objects > Constraints to display all the constraints available in the
sketch in the form of nodes. Next, expand each constraint node to view the curves related to
it. Right click on a constraint and notice ashortcut menu with different options. These options
are self-explanatory.
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Close the Sketch Relations Browser dialog.

Alternative Solution

This command gives alternate solutions for different dimensions and constraints applied between
sketch elements. For example, to change the side of the linear dimension shown in figure, activate
the Alternate Solution command (On the ribbon, click Home > Direct Sketch > More > Alternate

Solution). Click on the linear dimensionto see the alternate solution. Likewise, alternate solutions
for geometric constraints can be seen.
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Convert to Reference
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This command converts a sketch element into a reference element. Reference elements
support you to create a sketch of desired shape and size. To convert a sketch element to the
reference element, click on it and select Convert to Reference on the contextual toolbar. It can
also be converted back to a sketch element by clicking on it and selecting Convert to active.
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1.2.2 Correction commands in 2D part design
Only one sketch can be active at a time. While a sketch is active, NX adds any geometry created to that
sketch. How to activate a sketch depends on whether the sketch is internal or external.

Internal Sketches

« |n the Part Navigator, right-click the owning feature and choose Edit Sketch.

* |n the Part Navigator or the graphics window, double-click the owning feature. On the feature
dialog box, click the Sketch Section step to activate the Sketch task environment.

External Sketches

From Modeling, external sketches can be opened in a number of ways, depending on the work
preference:

* Double-click a sketch curve in the graphics window.
* From the Part Navigator:

o Double-click a sketch feature.

o Right-click a sketch and choose Edit.
Edit Multiple Sketches

Multiple sketches can bhe edited when just one model update is required. To edit multiple sketches, it is
required to:

Cl
- Open a sketch in the Sketch task environment oed,

- Select a sketch name from the Home tab—Sketch group—Sketch Name Drop-down list.

To edit subsequent sketches, double-click a sketch in the Part Navigator or select another sketch
name from the Sketch Name list.

1.2.2.1 The Chamfer command N
This command replaces a sharp corner with an angled line. Activate this command (On the
ribbon, click Home > Direct Sketch > Chamfer) and select the elements’ ends to be
chamfered. Type the chamfer angle inthe Distance box and press Enter.
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Distarce ﬁ_ﬂ

1.2.2.2 The Quick Extend command AV
This command extends elements such as lines, arcs, and curves until they intersect another
element called the boundary edge. Activate this command (On the ribbon, click Home > Direct

Sketch > Quick Extend) and click onthe element to extend. It will extend up to the next
element.

P

1.2.2.3 The Quick Trim command ~ %~

This command trims the end of an element back to the intersection of another element. Activate
this command (Onthe ribbon, click Home > Direct Sketch > Quick Trim) and click on the
element or elements to trim. It is also possible to drag the pointer across the elements to trim.

Q i (”.)_

1.2.2.4 The Make Corner command AT‘

This command trims and extends elements to form a corner. Activate this command (On the ribbon,
click Home > Direct Sketch > Make Corner) and select two intersecting elements. The elements
will be trimmed and extended to form a closed corner.

‘g. e [

&
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1.2.2.5 The Offset Curve command

This command creates a parallel copy of a selected element or chain of elements. Activate this
command (On the ribbon click Home > Direct Sketch > Offset Curve) and select an element or
chain of elements to offset. After selecting the element(s), type a value in the Distance box. On the
Offset Curve dialog, click the Reverse Direction button to reverse the side of the offset. Check
the Symmetric Offset option to create a parallel copy onboth sides. Set the Cap Options to
Arc Cap to create arcs at the corners. On the dialog, click OK. The parallel copyof the elements
will be created.
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1.2.3 Measuring tools in 2D design

1.2.3.1 Driving dimensions

p5=50,0

A
¥

—?

Driving dimensions control the design intent in the sketch. These dimensions drive the
position, shape, and size of the sketch.

Each dimension creates an expression that can be edited.

1.2.3.2 Automatic dimensions

=~y
~atf |

i 1

Automatic dimensions show where design intent has not been added. NX creates automatic
dimensions by default as you sketch.

These dimensions can be converted to driving dimensions. As The design intent is added, NX
automatically deletes redundant auto dimensions.
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1.2.3.3 Reference dimensions

| 50
S

; :

Reference dimensions display information only. They do not constrain the sketch.

It is possible to create reference dimensions or convert driving dimensions to reference
dimensions. There are no specific commands to create reference dimensions. To create
them, use the Reference option in any dimension command.

1.2.3.4 Dimensional constraint terminology
To correctly add the design intent to a sketch, the terminology and the process of creating dimensional
constraints must be understood.

These terms apply to all NX sketch dimension types.

1.2.3.5 Measurement Method
The measurement method controls the design intent of a dimensional constraint. The design intent may
not be apparent until the geometry of the sketch is changed. For example, the linear dimension shown
could be created using one of three different measurement methods.

p18=75,0

a This linear dimension is created using one of three
measurement methods shown below. When the
] geometry is changed, the dimension appears as
] one of the three conditions shown, depending on
the measurement method used.
e - 2]

Perpendicular

Create a perpendicular dimension by selecting a
line and a point as reference objects.
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Point-to-Point

Create a point to point dimension between any
two points or line end points. When you select a
line, NX initially infers the two end points of the line
as reference objects.

Horizontal

A horizontal or vertical dimension uses two points
as reference objects, but measures the distance
vertically or horizontally relative to the sketch
coordinate system. NX infers horizontal or vertical
by where the place of the dimension text is clicked.

It is possible to explicitly choose a measurement method when creating the dimension, NX can infer a
measurement method itself. NX infers a measurement method based on what is selected for the
reference objects, and where the origin is located.

1.2.3.6 Reference Objects
Sketch dimensions create a constraint between reference objects in the sketch. Reference objects can
be curves or points.

» p18=716 ‘|
/'/‘-‘ \'\
;// !
//,. N &
- N\ ; ; ; ;

’.// \\ Point-to-point, horizontal, vertical, and
‘Hﬂ \ perpendicular dimensions require two reference
\ % objects. These can be two points, or a line and a
H point.
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Angular dimensions require two lines as reference
objects.

Radial and diametral dimensions use only one
reference object.

1.2.3.7 Inferred reference objects
When the first reference object is selected, NX may initially infer the second reference object, depending

on the measurement method and the object selected. For example, if a line is selected, NX may infer
that a dimension between the two end points of the line need to be created.

1.2.3.8 Inferred selection gesture

When a second reference object that is different from what NX infers needs to be selected, an inferred
selection gesture can be used.

1. When a line is selected as the first reference object, NX may infer that the two reference objects
for the dimension are the two end points.

The References group of the dialog box indicates that two reference objects are selected, and the
graphics window previews the dimension between the two inferred reference objects.

:ﬁ:_iﬁég I

¢ _¢_ | S—
8
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2. Toinfer a different type of dimension, hover the cursor over the object you would like to select for
the second reference object.

The References group of the dialog box highlights the second reference object selection line.
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1.2.3.9 Reselecting reference objects

The first and second reference objects can be explicitly selected in order by clicking the selection line
in the dialog box.

Selected reference objects can be changed at any time until the dimension is created by locating the
text.

When a dimension is edited, the two reference objects can be reselected to reattach the dimension to
different reference objects.

_ Al
« ¥
«

1.2.3.10 Origin

The origin of a dimension is the location of the dimension text. To change this location, drag the
dimension text.

Driving dimensions

Most sketch dimensions in NX Modeling are added for the purpose of controlling the shape of the
sketch. Reference dimensions may also be created to measure distance without driving the geometry.
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1.2.3.11 Dimension commands
There are five dimension commands. Each command supports a related family of measurement
methods. When a dimension is edited, the measurement method can be changed between the family
of measurement methods.

Dimension
Command

s
2 Rapid

Dimension

I X
Linear
Dimension

*)\ Radial

Dimension

&
= Angular
Dimension

Rapid Dimension

Description

Creates a dimensional constraint between one or
two objects selected. This command will infer one of
these measurement types based on the objects
selected, or one of these dimension measurement
methods can be selected explicitly.

A linear, radial, or angular dimension is created.

Creates a dimensional constraint between the
objects selected using one of these dimension
measurement methods.

When a dimension is edited using one of these
measurement methods, the measurement method
can be changed between the methods listed.

Creates a radial or diametral dimensional constraint
on an arc or circle selected.

When a radial or diametral dimension is edited, the
measurement method can be changed between the
methods listed.

Creates an angular dimensional constraint between
two lines you select.

Measurement Methods

» Horizontal

» Vertical

e Point to Point
» Perpendicular

e Cylindrical
* Angular
+ Radial

e Diametral

» Horizontal

e Vertical

* Point to Point
» Perpendicular
e Cylindrical

¢ Radial
« Diametral

This measurement method
cannot be changed to
another type.

Use the Rapid Dimension command to create a dimensional constraint. NX infers the dimension type
based on the objects you select and the location of the cursor.

Command Finder %

Rapid Dimension

Linear Dimension
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Use the Linear Dimension command to create a dimensional constraint. NX infers the dimension
type based on the objects selected and the location of the cursor.

O R

Command Finder x
Linear Dimension|—

Radial Dimension
Use the Radial Dimension command to create a radial or diametral dimensional constraint. NX infers
the dimension type based on the object selected.

Rp22=1010

Command Finder R
Radial Dimension :{

Angular Dimension
Use the Angular Dimension command to create an angular dimensional constraint between two
lines.

p20=112,2
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Command Finder

Angular Dimension /—ﬁ

Perimeter Dimension
Use the Perimeter command to constrain the total lengths of selected lines and arcs in an open or

closed profile. Ellipses, conics or splines cannot be selected.

Command Finder | ﬁo

Perimeter Dimension .|

Edit dimension associativity
A dimension can be edited to reattach the dimension leader lines to different reference objects using

the same dialog box used to create the dimension. When reattaching a dimension, it is possible to:

* Retain the expression value and resize the target geometry to match it.

» Change the expression value to match the target geometry.

Animate Dimension
Use the Animate Dimension command to dynamically display the effect of varying a given dimension

over a specified range. Any geometry affected by the selected dimension is also animated.
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.
i

Animate does not change the sketch dimensions. When the animation is finished, the sketch returns
to its original state.

Tip You can also use the Edit Sketch Parameters command to dynamically animate dimensions
using a slider bar.

Command Finder|,_*,
— 1l Animate Dimension

Auto Dimension

Use the Auto Dimension command to create dimensions on selected curves and points according to
a set of rules.

The following rules can be applied in any order.

e Create Horizontal and Vertical Dimensions on Lines
e Create Dimensions to Reference Axes
o Create Symmetric Dimensions
» Create Length Dimensions
» Create Adjacent Angles
Driving and Automatic Dimensions
Driving

Creates a dimension based on an expression. Modify the dimension expression value to size
the geometry.

Automatic

Automatic dimensions show where design intent to a sketch has not been entered.

» When dragging sketch curves, automatic dimensions are relaxed, allowing the sketch to
be shaped. After the drag, the new shape will be constrained by the automatic
dimensions again.

+ [f a constraint that conflicts with an automatic dimension is added, the automatic
dimension will be deleted.

» Automatic dimensions can be converted into driving or reference dimensions.

All dimensions are displayed in the Part Navigator when Timestamp Order is turned off in
the Unused Items—Sketch—Curves and Dimensions—Dimensions folder.
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In Modeling, use this command to assist in creating a fully constrained sketch by removing all degrees
of freedom from the selected curves.

In Drafting, use this command to fully dimension selected sketch curves in a drawing.

Command Finder ﬂ[
Auto Dimension

1.3. Design 3D with NX
The modeling process to design a part is the same whether it is the design of stand-alone parts or
parts within an assembly. The decisions made at each step depend on the design goals.
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These are some of the main steps in the process of designing parts with NX.

Start with a new file.

1. Create an empty file for the part
model.

2. Add the empty file to the assembly
as a new component to design the
part within an assembly context.

Design parts within an assembly to
create proper fit and alignment to other
parts, and to avoid unintentional
interferences.

Define the modeling strategy. Decide if the final part will be a solid
body or a sheet body. This will impact
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the modeling strategy of which features
to build first.

e Solid bodies are preferred for most
models because they provide an
unambiguous definition of the
volume and mass.

¢ Sheet bodies are sometimes used
for manufacturing or simulation.
They may also be used as trimming
tools for solid body models

Create datums.

Create datum coordinate systems and
datum planes to position modeling
features.

These datums form the beginning of a
chain of associativity for the features
added next.

Create features.

Create features according to the
modeling strategy.

@ 1. Start with design features such as
extrude, revolve, or sweep to define
basic shapes. These features
typically use sketches to define
sections.

Continue adding other features to
design the model.

Finish with detailed features such as
edge blends, chamfers, and draft to
add the final details.

1.3.1 Switching from 2D drawing to 3D

Extrude and revolve features are used to create basic and simple parts. Most of the time, they
form the base for complex parts as well. These features are easy to create and require a single
sketch. Now, let's find out the commands to create these features.

The topics covered in this part are:

» Constructing Extrude and Revolve features in the Modeling template
* Creating Reference Planes
* Additional Options in the Extrude and Revolve commands
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1.2.1.1 Extrude Features
Extrude is the process of taking a two-dimensional profile and converting it into 3D by giving it
some thickness. Asimple example of this would be taking a circle and converting it into a
cylinder. Once a sketch profile or profiles wanted to Extrude have been created, activate the
Extrude command (On the ribbon click Home > Feature > Extrude). Click on the sketch profile
to add thickness to the sketch. Type-in a value in the End box and press Enter to create the
Extrude feature.

Extrude //\

coo
b :
Use the Symmetric Value option on the dialog to add equal thickness on both sides of the sketch.

Tviits M

End — ) Symmetric Valus =

Distance | 25 mm -

_| Cp=n Profile Smart Volume !

On the dialog, click OK to complete the Extrude feature.

1.3.1.2 Revolve Features

Revolve is the process of taking a two-dimensional profile and revolving it about a centerline to
create a 3D geometry (shapes that are axially symmetric). While creating a sketch for the
Revolve feature, it is important to think aboutthe cross-sectional shape that will define the 3D
geometry once it is revolved about an axis. For instance, the following geometry has a hole in
the center. This could be created with a separate Cutf or Hole feature. But in orderto make that
hole part of the Revolve feature, it is necessary to sketch the axis of revolution so that it leaves
a space between the profile and the axis.
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After completing the sketch, activate the Revolve command (On the ribbon, click Home > Feature
> Design Feature Drop-down > Revolve). Click on the sketch to define the section of the
Revolve feature. On the dialog, click SpecifyVector under the Axis section. Click on a line to
define the axis of revolution. The sketch will be revolved at a full turn of 360. To enter an angle
of revolution, type a value inthe End box attached to the preview andpress Enter. On the dialog,
click OK to complete the Revolve feature.
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1.3.2 Basic commands in 3D part design

1.3.1.1 Block
Use this command to create basic block solid bodies. Blocks are associated with their positioning
objects.

It is possible to use one of three methods (types) to create a block.

Create a block using a point and edge lengths

Choose Home tab—Feature group—Block ‘E
In the Type group, select Origin and Edge Lengths from the Type list.

Select an object to infer an origin point or specify a point using the Specify Point options in
the Origin group. Snap Point options are available.

ZC

YC
i

XC
Type the block's measurement values in the Dimensions group. All values must be positive.

5. (Optional) If the block intersects another solid, you can choose a Boolean option from the Boolean
list.

|
Select Body l@' becomes available to specify a target for the Boolean operation.
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6. Click OK or Apply to create the block.
The block is created from the origin point, with edges parallel to the axes of the WCS.

1.3.1.2 Cylinder
Use this command to create basic cylindrical solid bodies. Cylinders are associated to their
positioning objects.

It is possible to use one of two methods (types) to create a cylinder.

Available with the Advanced with full menus and Essentials with full
Prerequisite menus roles.
Command ‘ﬁ‘
Finder Cylinder =

Create a cylinder using an axis, a diameter, and a height
Choose Home tab—Feature group—Cylinder E‘
2. From the Cylinder Type list, select Axis, Diameter, and Height.

Note A vector, direction, and origin point for the cone's axis are specified by default. If you want
to change the defaults, see steps 3, 4, and 5.

3. Select an object to infer a vector, or specify a vector using the Specify Vector options in
the Axis group.
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X

e |

5. Click Specify Point and select an object to infer a point, or use the Specify Point options to
specify one. Snap Point options are available.

4. (Optional) Create a cylinder in the opposite direction by clicking Reverse Direction

In the Dimensions group, type values for the diameter and height of the cylinder.

(Optional) Choose a Boolean option from the Boolean list if the cylinder intersects another solid.

Select Body @ allows selecting a body for the Unite, Subtract, or Intersect Boolean
operation.

8. Click OK or Apply to create the cylinder.

1.3.1.4 Cone
Use this command to create basic conical solid bodies. Cones are associative to their positioning
objects.
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o Top diameter o
e Base diameter

o Origin point
o Height

It is possible to use one of five methods (types) to create a cone.

Available with the Advanced with full menus and Essentials with full
Prerequisite menus roles.
Command /
Finder Cone d

Create a cone using arc diameters and height

2. Inthe Type group, select Diameters and Height from the Type list.

Choose Home tab—Feature group—Cone

Note A vector, direction, and origin point for the cone's axis are specified by default. To change
the defaults, see steps 3, 4, and 5.

3. Select an object to infer a vector, or specify a vector using the Axis group Specify
Vector options.

N

Click Specify Point and select an object to infer a point, or use the Specify Point options to
specify one. Snap Point options are available.

(Optional) Create a cone in the opposite direction by clicking Reverse Direction

For this example, the default WCS origin point and the Z-axis direction are used.

6. Inthe Dimensions group, type values for the following dimensions:
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o Base Diameter
o Top Diameter

o Height
For this example, the Base Diameter is 50, the Top Diameter is 20 and the Height is 25.

7. (Optional) If the cone intersects another solid, it is possible to select a Boolean option from the
Boolean list.

Select Body @ becomes available to specify a target for the Boolean operation.
8. Click OK or Apply to create the cone.

1.3.1.5 Sphere
Create a sphere using a center point and a diameter

Q)

1. Choose Home tab—Feature group—Sphere '~ .
In the Type group, select Center Point and Diameter from the Type list.

3. Select an object to infer a center point for the sphere or create a center point using the Specify
Point options in the Center Point group.
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In the Dimension group, in the Diameter box, type a value for the diameter of the sphere.
5. (Optional) If the sphere intersects another solid, select a Boolean option from the Boolean list.

Select Body @ becomes available to specify a target for the Boolean operation.
6. Click OK or Apply to create the sphere.

Sphere created using the Subtract Boolean

1.3.1.6 Hole
Use the Hole command to add the following types of hole features in a part or assembly:

e General holes (simple, counterbored, countersunk, or tapered form)
e Dirill Size holes

s Screw Clearance holes (simple, counterbored, or countersunk form)
e Threaded holes

¢ Holes on non-planar faces

¢ Holes through muliiple solids as a single feature

¢ Multiple holes as a single feature
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Application Modeling

©

Command Finder|Hole

1.3.3 Advanced commands in 3D part design (Surface Modeling)

1.3.3.1 X-Form
Use the X-Form command to edit surfaces or spline curves by dynamically manipulating the pole
locations.

It is possible to do the following:
e Select any type of face (B-surface or non-B-surface).

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

s Select individual or multiple poles using standard NX selection methods such as selecting inside
a rectangle.

e Select rows of poles by selecting the polyline that connects pole handles.

The X-Form command also includes advanced options to edit a B-surface.
It is possible to do the following:

s |ncrease or decrease the number of poles and patches.

e Insert knot points.

¢ Proportionally move adjacent poles.

o Maintain continuity at surface edges when editing a surface.

e Lock regions of a surface to remain constant when editing the surface.

s |dentify faces with symmetry and offset conditions. The modifications made to the selected face
will automatically be applied to the faces that meet these conditions.

The X-Form command creates an X-Form feature in the Part Navigator when the Associative
Freeform Editing is enabled in Modeling Preferences.

Application Modeling, and Shape Studio

I'E'

Command Finder|X-Form | ™

1.3.3.2 I-Form

Use the I-Form command to dynamically modify a face by adding isoparametric curves to it and by
editing their direction.

It is possible to select and modify the control poles or polygons of any type of face (B-surface and
non-B-surface) without having to extract, untrim, refit, replace, or otherwise convert them.
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Changes made to a face are cumulative as its shape is altered. For example, a face can be modified
by first changing its shape along its U-direction isoparametric curves, and then modified further by
changing its V-direction isoparametric curves.

Note The I-Form command creates an |-Form feature in the Part Navigator when the Associative
Freeform Editing preference is enabled in the Modeling Preferences dialog box on
the Freeform tab.

Application Shape Studio, Modeling

Command Finder|l-Form|_

1.3.3.3 Match Edge

Use the Match Edge command to modify a face so it is geometrically continuous with one or more
reference objects.

It is possible to:

e Match the edge of a face to the edge of another face, the interior of another face, or a curve.
When the Associative Freeform Editing preference is enabled, the relationship with the parent
object is maintained when the parent object is repositioned.

e Maintain or edit the surface degrees and patches.

e Edit the surface poles while maintaining matching continuity.

s Use Shape Control to influence the magnitude of change in the Matched surface.

This example shows two input surfaces during a Match Edge operation, and the matched surfaces.

The Match Edge command creates a Match Edge feature in the Part Navigator when
the Associative Freeform Editing preference is enabled.

Application Modeling and Shape Studio

Command Finder

Match Edge ‘ z |

1.3.3.4 Edge Symmetry
Use the Edge Symmetry command to match a surface edge to a centerline plane so that the surface
will be symmetrical and continuous to its mirror image across the centerline plane.
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Application Modeling and Shape Studio

Command Finder|Edge Symmetry @

1.3.3.5 Deform Surface
Use the Deform Surface command to dynamically modify a surface using stretch, bend, skew, twist
and shift operations.

This example shows how a surface is deformed using Stretch and Bend pivot controls.

Pivot Control = Horizontal — Stretch

50.0
i N

Pivot Control = V-Low — Bend

The command creates a Deform feature in the Part Navigator when the Associative Edit
Freeform preference in the Modeling Preferences dialog box is enabled.
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Application Modeling, Shape Studio

Command Finder m
Deform Surface

1.3.3.6 Transform Surface
Use the Transform Surface command to dynamically scale, rotate, and translate individual B-

surfaces.

o Original sheet body

9 Copy of the original sheet body scaled along XC axis and translated along YC axis

Note If the original sheet is chosen to edit, and the selection is parametric, a warning is displayed
informing that transforming the surface will result in it becoming unparameterized.

Application|Modeling, Shape Studio

Menu
Transform Surface m

1.3.3.7 Flattening and Forming

You can unwrap and flatten 3D faces and related curves and points from one or more bodies to a 2D
plane, where it may be easier to define and create new curve and point structures. It is possible to
then form the new curves and points back onto the original 3D faces.

e 3D objects can
be flattened to
a 2D plane.
Object types
that can be
flattened are:

o Faces

o Curves
and Points
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New sketch
curves can be
added to the
flattened faces.

e The Flattened
faces, curves,
and points,
along with any
new curves
and points
specified, can
be formed
back onto the
original 3D
faces.

e [nthis
example,
openings are
trimmed in the
faces using the
sketch curves.

Application Modeling and Shape Studio

Command Finder|Flattening and Forming $

1.3.3.8 Snip Surface
Use the Snip Surface command to divide a surface, or to snip off portions of a surface, at specified
boundary geometry. Snip Surface modifies the underlying pole structure of the target surface.

This example shows a surface snhipped along a curve, and the pole structure of both the input surface
and the Snip Surface feature.
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Application

Modeling and Shape Studio

Command Finder

qb
Snip Surface ‘b

1.3.3.9 Editing the U and V Directions
Use the Edit UV Direction command to modify the U and V directions of B-surfaces that are not part

of a feature.

Any combination of the following options can be used:

e ReverselU
¢ ReverseV
e SwapUandV

With Reverse U selected

——

With Reverse V selected

v

‘—-_

Start

'With both Reverse U and Reverse V selected

\E1

With Swap U and V selected

Application

Modeling and Shape Studio
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Command Finder|Edit U/V Direction |

1.3.3.10 Enlarge
Use the Enlarge command to create a 4—sided surface feature that is associative to a selected
trimmed or untrimmed sheet or face. The size of the feature can be changed by dragging handles or
typing U and V percentage values for the four edges.

When creating models using sheets it is good practice to overbuild them, to eliminate downstream
solid modeling issues. The Enlarge command can be used to do this while retaining the sheet's
current parameters. It is also possible to use it to reduce the size of a sheet, to remove degenerate
edges, for example.

Enlarge may not always follow the complete
outline shape of the original surface or its
number of sides, because its resize parameters
affect only the 4—sided form of

the Enlarge feature.

o Enlarge feature

o Originally selected face

Application Modeling and Shape Studio

@

Command Finder|Enlarge

1.3.3.11 Refit Face
Use the Refit Face command to modify an existing surface by changing degree, patch count, or
tolerance. A face can also be fitted to target geometry.
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Use Refit Face to modify existing geometry when the geometry:

e Has a heavy pole structure as a result of previous operations.
e |sreverse-engineered data to be used for detail work.

e |s data translated from other CAD software.

» |s aesthetically unacceptable.

Application Modeling

Command Finder|Refit Face &‘

1.3.3.12 Smooth Poles
Use the Smooth Poles command to modify pole distribution by calculating the proper distribution of
selected poles in relation to surrounding surfaces.

This command can be used to finalize Class A production surfaces. After creating a surface that is in
compliance with the specification data (such as a scanned image), it is possible do some minor
editing to achieve a clean pole distribution and finalize the selected surface.

Removing minor imperfections in a slab surface can help later when trying to build secondary
surfaces that are both in compliance with the specification data and that achieve the proper highlight
flow.

Note The Smooth Poles command removes parameters from associative surface features.

The following graphics show an example of surface pole smoothing.

wC

o Original surface

0 Selected poles to move
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o Resulting smoothed surface

Application Modeling, Shape Studio

Command Finder|Smooth Poles g

1.3.3.13 Global Shaping
Use the Global Shaping command to deform a surface region using a combination of geometry and
values, the relationship of two curves, or the relationship of two surfaces. Combinations of geometry
and values are provided by Types of Global Shaping.

Global Shaping allows deforming a surface in a predictable manner, with full associativity. It can be
used to alter existing surfaces while preserving their aesthetic properties. It is also possible to modify
surfaces to account for the effects of springback during metal forming.

Using a shaded preview to gauge Global Shaping results

A shaded result will only be as true as the facets of the sheet body will allow, which is why a preview
is not a full proof method to validate the result of a Global Shaping action. If the surface is planar in
most of the areas, the face resolution tolerances may occasionally have to be tweaked to increase the
number of facets to get the correct shaded display.

To change the Resolution Tolerances for Face in either the Facet Settings or Visualization
Preferences dialog boxes. You could also use a Section Analysis grid to view the correct result.

Application Modeling

Command Finder

-

2]
Global Shaping " |
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Global Deformation

Use the Global Deformation ﬁ command to modify an existing product design to accommodate
changes from downstream design or production process constraints, such as CAE analysis or

physical tryout.

The command can also be used for maintenance, repair, and overhaul processes (MRO). For
example, Global Deformation could be used for MRO in jet engines, to adapt an as designed engine
fan blade in it's hot state to the unwound cold state when the engine is not operating. This
representation of the form may be important if it is the state in which the part is manufactured or

repaired.

® o Original shape of a jet engine fan blade

® ° Globally deformed shape (shown in blue)
Inputs for global deformation can include:

e The formed shape of the sheet body.

s A set of points representing the non-deformed shape.

e Another set of points corresponding one-to-one to the previous set of points, and representing
the deformed shape.

Application

Modeling

Command Finder

Global Deformation ﬁ |

1.3.3.14 Replace Edge
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Use the Replace Edge command to modify or replace an existing boundary of a sheet body.
It possible to:

o Extend the boundaries of a sheet body if it consists of a single face.
e Edit the original or a copy of a sheet body.

The Replace Edge command trims a sheet body and removes the sheet body parameters. If you
want to retain the sheet body parameters, use the Trimmed Sheet or Trim Body command.

Application Modeling

Command Finder|Replace Edge ! §|
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1.4. Export 2D drawings from 3D drawings with NX

The Drafting application is designed to produce and maintain engineering drawings which comply with
major national and international drafting standards. Drawings can be created in NX using the following
processes.

The model- Drawings are created directly from 3D models or assemblies and are fully
based associated to the model. Any changes made to the model are automatically
process reflected in the drawing.

The stand- Drawings are created using 2D geometry and dedicated Drafting tools to

alone process create the drawing details. Additional tools are available that allows
converting the 2D content into 3D models.

1.4.1 International Drawing Standards
An intuitive, easy to use, graphical user interface with automated tools that help to

create drawings quickly and easily. Immediate, on-screen feedback throughout the drafting
process helps to reduce rework and editing.

e Support for major national and international drafting standards, including ASME, 1SO, DIN, JIS,
GB and ESKD.

e Fully associative drafting annotations that update when the model updates.

o A comprehensive set of view creation tools that support advanced display, placement,
associative, and update requirements for all view types.

e Support for 2D to 3D workflows in the stand-alone process. The 2D curve data created in the
drawing can be used to derive a 3D model.

s Controls for managing drawing updates and large assembly drawings which enhance user
productivity.

o NX Open Application Programming Interfaces (APIs) to the Drafting functionality that enable the
development of customer and third party custom applications.

o Data migration for I-deas drawings (ASC/DWG), DXF/DWG data, and IGES data.
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e The following illustrates the general process for creating a drawing from an existing 3D model
This overview is not intended to give a detailed description of specific functions or operations.
Details are addressed in later sections of this document.

o Set the drafting standard and drawing preferences

o Before creating a drawing, it is recommended that the drafting standard, drafting view
preferences, and annotation preferences for the new drawing should be set. Once set, all views
and annotations will be consistently created with appropriate visual characteristics and
symbology.

1.4.1.1Create a new drawing
o The first step in creating a drawing is to make a new drawing sheet either directly within the
current work part, or by creating a non-master drawing part that contains the model geometry
as a component.

e See Creating a new drawing for more information.
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1.4.1.1 Add views
o NXenables to you create a single view or multiple views at the same time. All views are derived
directly from the model, and can be used to create other views, such as section and detail
views. The base view determines the orthographic space and view alignment for projected
views.
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e See Drafting views for more information.
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1.4.1.3 Add dimensions and annotations

e Once the views on the drawing have been place, dimensions and annotations are ready to be
added.

LS e R T
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e Dimensions and annotations are associated with the geometry in the views. If a view is moved
the associated dimensions and annotations move with the view. If the model is edited, the
dimensions and annotations update to reflect the change.

e You may also choose to add notes, labels, and in the case of assembly drawings, parts lists to

the drawing
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o A completed drawing can be plotted directly from NX, or the part containing the drawing can be
used directly by manufacturing to fabricate the part

1.4.1.4 The stand-alone drawing process in NX
The following illustrates the general process for creating stand-alone 2D drawings. NX provides support
for two basic standalone approaches:

e Non-view based approach — Applying 2D geometry directly to the drawing sheet.
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e Drawing-view based approach — Using Drawing views to manage 2D curves and the resultant
3D model.

1.4.1.5 Set drafting standard and drawing preferences

Before creating a drawing, it is recommended that the drafting standard, drafting view preferences, and
annotation preferences for the new drawing are set. After having set them, all views and annotations
will be created consistently with appropriate visual characteristics and symbology.

See Setting your Drafting standard and Drafting Preferences for more information.

1.4.1.6 Create a new stand-alone 2D drawing

The first step in creating a stand-alone 2D drawing is to create a new part file. This drawing part file
does not need to reference 3D model geometry. It is possible to use the drawing templates that do not
require the reference of model geometry. See 2D: Create a stand-alone drawing for more information.

| o 0 1 5 7 0 Y O [ ™4 _“;"

1.4.1.7 Add views

When using the drawing-view based approach, it is possible to create a single empty drawing view or
multiple empty drawing views at the same time. The drawing view determines the orthographic space
and view alignment for all projected views, and can be used to create detail views. See Drafting
views and Drawing View for more information.

1.4.1.8 Create curves
In NX curves can be created directly on the drawing sheet or in the Drawing view. See Methods for
creating 2D curves in Drafting for more information.
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In the drawing-view based approach, the Project to View command simplifies 2D design by projecting
curves from one view onto other views with appropriate orientations.
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In the non-view based approach, NX enables the infinite use of lines to help to create and align 2D
geometry in a drawing. See Infinite sketch lines overview for more information.

1.4.1.9 Add dimensions and annotations
After having placed the views on the drawing, dimensions and annotations are ready to be added.

Dimensions and annotations such are associated with the geometry in the views. If a view is moved the
dimensions and annotations move with the view. If the model is edited, the dimensions and annotations
are updated to reflect the change.

i

Notes and labels can also be added to the drawing.

A completed drawing can be plotted directly from NX, or the part containing the drawing can be used
directly by manufacturing to fabricate the part.

1.4.1.10 Convert 2D designs to 3D models

In the drawing-view based approach, NX provides a streamlined path to convert 2D designs to 3D
models without recreating the whole geometry. Use the Copy to 3D command to project sketch and
view curves from drafting views to the 3D model space as a starting point for the construction of the
model geometry.
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1.4.1.11 Drafting support for convergent bodies

Convergent bodies are faceted geometry that are imported to NX and optimized so it is possible to
apply NX features directly to the faceted data. Because convergent bodies are modeling data from
multiple sources, they can be used to accelerate the concept-to-production workflows.

Convergent bodies are approximations of a true analytic surface, so support for convergent bodies in
drawings is limited to documenting key characteristics of the part, such as overall dimensions,
annotations that point out key design features, and important design decision and manufacturing notes.

For more information about the use of convergent bodies in modeling, see What is Convergent
Modeling? in the Modeling help.

. s =

1.4.1.12 Limitations to using convergent bodies in a drawing

e Exact (Pre-NX8.5) drafting views and legacy lightweight views are not supported. If convergent
bodies are detected in the master model, a warning is presented indicating that the bodies will
not be displayed.
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Note In pre-NX 12 drafting views, you must first version up and then update the views for

convergent bodies to be visible in the view.

The following Hidden Lines preferences and settings are not supported for convergent bodies in
a view:

> Process Interfering Solids

Display Interference Curves

(o]

> Any Display Mode setting for Small Features

It is only possible to dimension convergent bodies using the Linear Dimension and the Rapid
Dimension commands. Only Horizontal, Vertical, and Point to Point linear dimensions and
dimension sets are supported.

When applying annotations, dimensions, and centerlines on convergent bodies, only specific
snap point options can be used:

o For annotations, only End Point / , Control Point 1 (limited to end points only),

7

and Point on Curve can be used.

o For dimensions, only End Point / and Control Point 1 (limited to end points only)
can be used.

For centerlines, only Control Point 1 (limited to end points only) can be used.

(o]

Note It is possible to create all types of centerlines, except 3D centerlines and automatic

centerlines.

For Smart Lightweight drafting views, hidden line rendering may display lines for geometry that
should be hidden.

The following limits apply for Smart Lightweight section views created from convergent bodies:
o Automatic centerlines are not applied to convergent edges created in the section view.

o Automatic anchor points are not created for section views. Neither can anchor points be
manually added to the section view. If converting a section view from Exact to Smart
Lightweight, or vise versa, the view position on the drawing may change.

o Itis impossible to apply dimensions to section curves created from convergent bodies in the
section view.

You cannot apply Flag, Datum, or Dot Terminated leader types because convergent bodies do
not contain true linear edges.

When using convergent bodies in the definition of a custom symbol, NX extracts edge geometry
from the body and saves it in the custom symbol.

It is impossible to create crosshatch, area fill, or solid fill patterns on convergent bodies.

It is impossible to create hole tables from convergent bodies.

Hybrid bodies (convergent bodies to which NX features are added) are not supported in Drafting.

1.4.1.13 3D Create a new drawing of a master model
This example shows how to create a non-master drawing from a master part.
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102

J—

Choose File tab—Open, and select the master model part or assembly.
For native NX only: Choose File tab—New.

For Teamcenter Integration only: Choose File tab—New—Item.

Click the Drawing tab.

For native NX only: In the Templates group, from the Relationship list, make
sure Reference Existing Part is selected.

From the Templates list, select an appropriate drawing template.

e Tip o Although not mandatory, typically a drawing will be in the same units as the
model. By default, the units will be set to the same units as the model.

(Optional) In the Name box, accept the default name or type a name.

(Optional) Choose a new folder location by clicking Browse -j next to the Folder box.
Click OK to create the new drawing part.

(Optional) Use the Populate Title Block dialog box to automatically add content to individual
unlocked title block cells in the drawing.

(Optional) Use the View Creation Wizard or the Base command to add views to the drawing.

In this example, an E sized template was created and added views.
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| Note When creating a drawing this way, by default the template will set all of the drafting
preferences to those contained in the template. If there is a desire to use a Drafting
Standard to set the Drafting preferences, it is required either to select the Drafting
Standard after the template part is created, or to set the Use Settings from
Standard customer default on the Drawing—General tab of
the File tab—Utilities—Customer Defaults—Drafting dialog box.

o
e Click the Assembly Navigator Fo tab in the Resource bar.

Note that the working section is now in an assembily file and the original part file has been added
as a component.

o & Sections
e -E_Lf; block_dwg1
~M P plock

Although this is an assembly of the original part, all Drafting commands and operations perform in
the same way as they do in the original part.

Note See the Assemblies Help for additional information about working with assemblies.

1.4.2 Editing information on the drawing frame

1.4.1.1 Add a custom drawing sheet

» |In the Drafting application, use one of the following methods to open the Sheet dialog box.

o Choose Home tab—New Sheet [ ;
o Choose Menu—lnsert—Sheet.
o In the Part Navigator, right-click the Drawing node and choose Insert Sheet.

In the Sheet dialog box, click Custom Size.

Set the Height to 8.5 and the Length to 14.

From the Scale list, select Custom Scale.

Set the scale to 1:3.

(Optional) Expand the Name group, and type a new:

o Drawing Sheet Name

o Sheet Number
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o Revision

o (Optional) Expand the Settings group and change the drawing units and projection angle.
e Click OK to create the custom drawing sheet.
e The drawing sheet displays with a dashed border.

e (Optional) Use the Borders and Zones command to add custom borders and zones to the
drawing sheet.

1.4.1.2 Creating a new drawing
Drawings can be created using either a stand-alone workflow method or a model-based workflow
method.

Stand-alone drawing workflow

The stand-alone drawing workflow is used to place the drawing data in a single part file. This is
recommended for a 2D drafting process where only 2D geometry is used to create the drawing. The 2D
curves can be placed directly on the drawing sheet, or can be placed in drawing views, and used to
generate 3D model geometry.

Model-based drawing workflow

The model-based drawing workflow uses the existing 3D geometry to generate the 2D drafting data. In
this workflow, it is possible to:

e Place a drawing directly in the file that contains the 3D model geometry. The drawing data is
associated to the 3D geometry and will update when the model geometry updates.

e Use the master model architecture, in which the drawing data is placed in a file which is separate
from the file that contains the model geometry. This workflow is recommended for a 3D drafting
process. The drawing data is directly associated to the 3D model geometry and updates when
the geometry updates, but different users can work concurrently with the same model data.

[

Location in dialog|Drawing tab—Relationship list—»Stand-alone Part—select a template
box from the list

Command Finder [New

Model-based drawing workflow — drawing contained in the master part

Application |Drafting

Choose File tab—Start—Drafting or press Cirl+Shift+D to start the Drafting
Prerequisite |application.
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New Sheet =

Note: |[f the Always Start Insert Sheet Commandis selected in
the General/Setup node—Workflow node—Model-Based group of the Drawing
Command |Preferences dialog box, then a sheet will automatically be prompted to be added
Finder when entering the Drafting application for the first time.

Model-based drawing workflow — drawing contained in a separate, non-master part

0

Location in dialog|Drawing tab—Relationship list—Reference Existing Part—select a
box template from the list

Command Finder |New

It is @ must to provide the name of the 3D model to be referenced before the
Prerequisite drawing part is created.

1.4.1.3 Populate Title Block

Use the Populate Title Block command and the Populate command to edit the contents of unlocked
title block cells. The Populate Title Block command allows globally editing all unlocked cells in all the
title blocks in the drawing. The Populate command allows editing only the unlocked cells of the
currently highlighted title block.
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Tlp To automatically edit the contents of a title block when creating a drawing from a template,

Display Populate Title Block Dialog on Template Instantiation . check box must be
selected in the Customer Defaults dialog box.

The Populate Title Block command is not available from the shortcut menu when creating a new
drawing template or editing an existing drawing template.

Note A drawing template is created by using the Mark as Template command.

To use the Populate Title Block command to edit the contents of a title block in a drawing template,
it is a must to specifically choose Drafting Tools tab—Drawing Format—Populate Title

Block E Or it is possible to double-click the title block to open the Edit Definition dialog box, and

!
then click the Edit Table IE button to edit the contents of the title block.
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Application Drafting

Command Finder|Populate Title Block E
Edit the unlocked cells of a specific title block

Application Drafting

Graphics window|Right-click the title block—Populate

Edit all title blocks in the drawing
Use this procedure to make changes to all of the title blocks in your drawing at the same time.
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1. Choose Drafting Tools tab—Drawing Format—Populate Title Block E i

In the Populate Title Block dialog box, all unlocked cells from all title blocks in the drawing
appear in the list.

2. Select a row from the list.
In this example, the First Issued row is selected.
3. Inthe First Issued text box at the top of the dialog box, type 2-28-2016.

Note

For additional characters and symbols, click and use the Text dialog box to edit the
cell's value.

4. Press Enter to add the value to the cell, and then repeat the step to add information to other
empty cells.
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0
FIRST ISSUED 2.28-2016 TITLE
DRAWN BY D. Fisher
CHECKED BY J. Lee
APPROVED BY f. Darrow SIZE
REVISION DATE A3

SCA

5 6

5. Click Close when finishing adding content to the empty cells, and then review all title blocks in the
drawing to validate the changes.

Note If the same title block is used on other sheets in the drawing, the edits will also appear in
those title blocks.

1.4.1.4 Edit a specific title block

Use this procedure to make changes to a specific title block in the drawing. In this example, a revision
date is added to only the title block on the second sheet of a drawing.

1. In the Part Navigator, double-click the “Sheet 2” node to display the drawing sheet.

2. Right-click the title block and select Populate.

E If the title block does not highlight, make sure the layer the title block resides on is
selectable.

o

i i i I | ¥ ‘
B e e ke e = e e

4. Inthe Populate Title Block dialog box, select the Revision Date row from the list.
5. In the Revision Date box at the top of the dialog box, type 4-28-2017, and then hit Enter.

FIRST ISSUED 2-29-2017 T
DEAWN BY D. Fisher

CHECKED BY J. Lee

APPROVED BY M. Darrow

REVISICN DATE 4-28-17 @
—

17 [

6. Close the Populate Title Block dialog box, and then verify that the other title blocks in the
drawing do not include the revision date.
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FIRST ISSUED 2-28-2017

DRAWN BY D. Fisher

CHECKED BY J. Lee

APPROVED BY M. Darrow

REVISION DATE -

5 6
FIRET ISSUED 2-29-2017
DRAWN BY D. Fisher
CHECKED BY J. Lee
APPROVED BY M. Darrow
REVISION DATE 4-28-17

17

FIRST ISSUED 2-29-2017

DRAWN BY D. Fisher

CHECKED BY J. Lea

APPROVED BY M. Darrow

REVISION DATE *——-
25 26

1.4.1.5 Reuse a title block
Open the drawing that contains the title block that wanted to reuse.

S SR S— | O, W 5, s N Ay
& =

& &l
L 8
. —

Right-click the title block and choose Copy.
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Do one of the following:
o Open another drawing sheet in the current part.

o Open another drawing part and display a drawing sheet.

P

|

[

|

| |4

Wi

[

[

| K

| oo |
In the graphics window, right-click and select Paste

|l e e —————— . ]

Reposition the title block if necessary.
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1.4.1.6 Workflow for drawing templates

Start with an
existing NX
template?

y Y
Create a blank file Open an existing drawing template
Use the File—New command. Update template content as needed.

;

Add sheets and borders

Use the Borders and Zones
command to create borders and
zones on your sheets,

: v

Create a title block Add reusable content
Use the Define Title Block = Add systemn and part attributes, add template
command. regions, and apply automation rules as needed.

IT Identify the file as a drawing templat
Use the Mark as Template command,

'

Make the template reusable

Add the templale to the File—New dialog box
or save the template to a custom PAX file.

1.4.2 View Labels

It is possible to automatically generate associative labels for any drafting view. When the view is
either moved or deleted, the labels are likewise moved or deleted.

L

A view label consists of a prefix and a label letter. A scale label consists of a prefix and scale value.
The scale value is associated with the actual scale of the view and updates when the view scale

changes.

Setting view label options helps to:

e Control the visibility of the view label and scale |abel

e Set the view label's prefix name, letter, letter format, and letter size.

e Set the view scale label's text position, prefix name, prefix text size, letter format, and letter size.
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LA LTS

SECT 10N A - /ﬁ\

Lepaie 52

Section View with view label and view scale
label

NX uses the same dialog box to both set view label preferences and edit existing view labels. Use
the Drafting Preferences dialog box to set preferences for new view labels, or use

the Settings dialog box to edit the settings of existing view labels. Different options are available in
the dialog box depending on whether setting preferences or editing an existing view label are on

progress.
Application Drafting

. . 3

Command Finder Drafting Preferences N

Set the format of view labels:

View node—Common node—View Label node

Display and set view label properties for new views:
View node—Base/Drawing node—Label node
View node—Projected node—Label node

View node—Section node—Label node

Location in dialog box|View node—Detail node—Label node

Display and set view label properties for an existing view

Application Drafting

Double-click a view boundary
Right-click a view node in the Part Navigator—Settings

Graphics window Double-click an existing view label

Set the format of the view label

Location in dialog box
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Common node—View Label node

Display and set view label properties for view
Base/Drawing node—Label node
Projected node—Label node

Section node—Label node

Detail node—Label node

1.4.3 Select the projection method for the object

1.4.3.1 View Creation Wizard
The View Creation Wizard streamlines the process of adding one or more drafting views to a
drawing sheet.

1
}

» -

»l.
|

!
:

S LS - [N T
=1 r T =1 1T 1=

1 = 1 = | a | »

N

F:fn'ﬂ
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] T +# T = T 5T 71T 7T « v_|||||-]mJ_-:;

=1

The wizard guides the process of:

e Selecting a currently loaded, recently loaded, or unloaded part or assembly to be included in the
views.

e Specifying the preview style and view settings.

e Optimizing view settings for large assembly views.

e Inheriting PMI data from the model.

e Selecting assembly arrangements.

e Specifying a custom view orientation for the parent view.
e  Generating a multi-view layout.

e Placing the view layout on the drawing sheet.

From the parent view, it is possible to select up to five standard orthographic view projections. The
projection angle of the views is derived from the orientation of the parent view and the drawing’s
projection angle.

112
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It is also feasible to include an isometric or trimetric view in the layout.

Application Drafting

Command Finder|View Creation Wizard :

1.4.3.2 Base views

Use the Base command to add any standard modeling or custom view saved in a part to a drawing
sheet. A single drawing sheet may contain one or more base views. From base views, you can create
associated child views such as Projected, Section, and Detail views.

The Base command provides options that help to:

e Add any view from the master model part, the current part, or another loaded part.
e Specify the position and orientation of a view on the drawing.

e Define the view scale and settings.

e Control the appearance of components in views on assembly drawings.

Note Exploded views can only be added as base views if the exploded view resides in the part that
contains the drawing. See Exploded Views in Drafting for additional information.

Application Drafting

T

Command Finder|Base View

Shortcut menu  |Right-click a drawing sheet border— Add Base View g

Part Navigator |Right-click a sheet node—Add Base View !

1.4.3.3 Projected views

You can project views from an existing base, drawing, orthographic, or auxiliary view. NX automatically
infers orthographic and auxiliary alignment as the cursor is moved in a circular motion about the parent
view's center.

NX automatically infers:

e A hingeline.

e A vector direction perpendicular to the hinge line. The vector arrow indicates the projection
direction from the parent view.

It is possible to dynamically orient the hinge line and also reverse the projection direction before placing
the view.
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Application Drafting

Command Finder|Projected View @‘

Shortcut menu  |Right-click a view border—Add Projected View fal

Part Navigator |Right-click a view node— Add Projected View ‘%]

1.4.3.4 Create an orthographic view

When the Always Start Projected View Command option is selected in the Settings dialog box, NX
places in projected view mode immediately after placing a base view on the drawing sheet. The
following example shows how to create an orthographic view from an existing view.

Right-click an existing view's border and choose Add Projected View.
The hinge line and arrow vector symbol appear in the view.

(Optional) Choose any of the Projected view options or right-click and choose shortcut options as
desired.

Move the cursor to the right or left of the parent view to let NX snap the view into position.

_"_“_"1-’

-

Optional: move the cursor above or below the parent view:

114 DPP — Vocational Training for Smart Manufacturing in Machine Tools



Module: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Click to place the view.

It is feasible to continue to project views from the same parent view by positioning the cursor as
needed.

If necessary to project from the previously placed view or from an entirely different view, in

the Parent View group, click Select Parent ‘ @‘ and then select a different view.

LS
i

Now the hinge line and arrow vector appear in the new view selected.
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Click to place the view.

Fain
S

1.4.3.5 Create an automatic auxiliary view
To create an auxiliary view:

Right—click an existing view's border and choose Add Projected View.
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In the Hinge Line group, from the Vector Option list, make sure Inferred is selected.

Rotate the hinge line to an oblique angle about the center of the parent view.

Click to place the view on the drawing sheet.
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1.4.3.6 Create an associative auxiliary view
Inferred

You can use the Inferred method to automatically specify an associative hinge line for auxiliary views.
When rotating the hinge line so that it becomes parallel to a planar face on the part, that face
becomes the defining feature for the hinge line.

Right-click an existing view's border and choose Add Projected View.

In the Hinge Line group, from the Vector Option list, select Inferred.

Select the Associative check box.
Rotate the hinge line about the center of the parent view.
When the hinge line becomes parallel to a planar face on the part, the face highlights.

_J

Click to place the view on the drawing sheet.
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The face becomes the defining geometry for the hinge line. Were the angle of this face to change,
the hinge line and auxiliary view would update accordingly.

Defined
Use the Defined method to manually select planar faces, linear edges or other types of model
geometry to define an associative hinge line for the auxiliary view.

Right-click an existing view's border and choose Add Projected View.
In the Hinge Line group, from the Vector Option list, select Defined.

From the Vector Constructor list, select Two Points _'/'. L
Select the two holes in the part.

-

From the View Origin group, under Placement, select Perpendicular to Line from
the Method list.

|
L%

If necessary, select the Reverse Projected Direction check box.

Click to place the view on the drawing sheet.

The hinge line becomes associated with the two hole centers. Were either hole to move in the
part, the hinge line and auxiliary view would update accordingly.
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120

1.4.3.7 Display projected views with viewing direction reference arrows
By default, viewing direction reference arrows are only displayed with parent views for non-
orthographic projections, such as auxiliary views. To create an auxiliary view with a viewing direction
reference arrow:

Right-click the border of the parent view and choose Add Projected View.

2 —4.**:“5@

Drag the projected view to the desired alignment position with its parent view.

Click to place the view on the drawing sheet.
Click Close.
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A

The viewing direction reference arrow and corresponding label automatically appear on the drawing
sheet.

It is also possible to apply viewing direction reference arrows to any projected view as desired by
using the shortcut menu command Display Viewing Direction Arrow. To create an orthogonal view
with a viewing direction reference arrow and label:

Right-click the border of the parent view and choose Add Projected View.

—__[r

Drag the projected view to the desired orthographic position with its parent view.

1
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Right-click and choose Display Viewing Direction Arrow
Click to place the view on the drawing sheet.
Click Close.

B

B -

The direction arrow and label appear in the views.
To change the viewing direction reference arrow letter:
Right-click the border of the projected view and choose Settings.
B
S|

A

a

—
)
u

Under the Common node, select the View Label node.
In the Letter box, type a valid character.
Click OK.

C

C -

To remove the arrow letter and view label:

Right-click the border of the projected view and choose Settings.
Under the Projected node, select the Label node.

Clear the Show View Label |j check box.

122 DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Under the Projected node, select the Arrow node.

Clear the Display with Reference Arrow D check box.
Click OK.

) i

To edit the viewing direction reference arrow style:

Right-click the border of the projected view and choose Settings.
Under the Projected node, select the Arrow node.
In the Arrowhead group, set the following:

Style = Open
Length = 10
Angle = 45
Click OK.
=
I

To omit the arrow altogether:

Right-click the border of the projected view and choose Settings.
Under the Projected node, select the Settings node.

From the Display Arrow on Parent View list, select No.

Click OK.
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The reference arrow is removed.

1.4.3.8 Locate a projected view and its parent view
You can locate a parent view from a projected view in the Part Navigator. You can also locate a
projected view from its parent view, and vice versa, in the graphics window.

Locate a project view’s parent view in the Part Navigator

In the Part Navigator, expand the Shee‘c-[E node that contains the projected view.

Right-click the Projected % node and choose Navigate to Parent.
The parent view is maximized in the graphics window.

1.4.3.9 Locate a projected view or its parent view in the graphics window
To locate a projected view's parent view:

On the drawing sheet, right-click the boundary of the projected view and choose Navigate to
Parent.

To locate a projected view from its parent view:

On the drawing sheet, right-click the viewing direction reference arrow and choose Navigate to
Projected View.

For more information on viewing direction arrows, see Display projected views with viewing
direction reference arrows.

1.4.3.10 Drawing View
Use the Drawing View command to create a drawing view, which is an empty drafting view that does
not reference any model geometry. Although a drawing view is not associated to model geometry, it
can be identified as a standard view orientation (TOP, LEFT, and so on) or defined its orientation
relative to the model's absolute CSYS.

A drawing can be placed view using one of two options:

Center

Allows creating and adjusting the position of the drawing view on the sheet by specifying a
center point. The resulting boundary is an Automatic Rectangle.

Corners

Allows controlling the size of the drawing view and its position on the sheet by specifying two
diagonal points. The resulting view boundary is a Manual Rectangle.

To create view-dependent geometry in the drawing view:

e Make the drawing view the Active Sketch View Eﬂ and create sketch curves in it.

e Expand the drawing view and use the curve tools to construct 2D geometry inside the view.

124

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Application Drafting

[
Command Finder|Drawing View —

Shortcut menu  |Right-click a drawing sheet boundary— Add Drawing View

Part Navigator |Right-click a sheet node— Add Drawing View

1.4.4 Measure the part to output the required size

1.4.4.1 Interactive on-screen controls for dimensions
It is possible to set and change the associativity and appearance of dimensions, dimension lines, and
extension lines using interactive, on-screen controls in NX These controls include:

e The ability to let NX automatically position and place a dimension. This allows creating a
dimension with the fewest number of mouse button clicks.

e Interactive, on-screen controls for setting and changing the associativity and appearance of
dimensions, dimension lines, and extension lines.

These controls include:

o Access handles that, when selected, display a scene dialog for modifying frequently used
options and settings for the annotation object.

Note Only one access handle can be active at a time.

Tip = The Pause delay for on-screen dialog Drafting preference and customer default
allows adjusting the amount of time, in seconds, that are required to pause the
cursor before scene dialogs appear.

= Press F3 to suppress the display of all scene dialogs.

o Drag handles for repositioning dimension and extension lines.
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o Settings buttons‘ A| for access to additional options associated with the annotation object.

1]
ra—

e
&

106

106

) IR

ERC

Graphics
window

When creating a dimension:

o Pause the cursor until the scene dialog appears. Use the scene dialog

to immediately start editing the textual content of a dimension.

Note

i
Click the Edit "EJ;Q‘ button to enter the edit mode and access
additional scene dialogs.

To edit an existing dimension:

o Double-click the dimension to enter the edit mode, or right-click the

dimension and choose Edit.
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1.4.4.2 Jogs on extension lines
Extension lines connect the dimension to the object being dimensioned and can be straight or have a
jog. It is possible to add or remove jogs while creating or editing linear and ordinate dimensions.
Interactive on-screen handles and controls help to add, place, and size the jog for one extension line
or for both extension lines.

By 4 o -m
2X @6 0.2
2X R5
' !
—{+ — — -+ 40
oo~ 30 |

For ordinate dimensions, jogs are inferred by default. NX determines when a jog is added to the
extension line. For linear dimensions, jogs are not inferred and it is a must to manually add them to
the extensions lines of a linear dimension either while creating it or after it is created.

=t

/ o A
L
~
7,

[}

o 31,8

—] O

1. Ordinate extension line with a jog

™
T

2. Ordinate extension line without a jog

Interactively add or remove jogs

Application

Drafting and PMI

Graphics
window

Double-click an existing dimension, or while creating a dimension, click

%
the Edit ™ on-screen button to enter the dimension edit mode, and then click
the Extension Line access handle to display the on-screen controls.

Set the jog parameters
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1.4.4.3 Inferring rapid and linear dimensions from a selection
The selection process for creating dimensions using the Rapid or Linear commands is unique in that,
for some measurement types supported by these commands, NX can infer the dimension from a
single selection.

For example, if the vertical edge of a part is selected (and not a point on the edge), NX will infer a
vertical dimension. In this instance, Specify Location in the Origin group becomes the current
option, and it is feasible to immediately click to place the dimension.

£} Rapid Dimension O X
References A

* Select First Object

* Select Second Object

Origin A
Specify Location @ (|2

[T] Place Automatically

Alignment v

Measurement
Driving
Settings

Sometimes NX may infer a dimension from a single mouse click unintentionally. In this case, the
creation of a different dimension can be forced by moving the cursor over another valid drafting
object. When placing the cursor over another object, Select Second Object in the References group
becomes the current option, and the second object for the dimension can be selected. Once the
second object is selected, the Specify Location option in the Origin group becomes active again,
and then it is possible to click to place the dimension.

1.4.4 .4 Single-sided dimensions
The Display as Single Sided Dimension option helps to create and edit linear and angular
dimensions with only a single leader line. Use single-sided linear or angular dimensions for geometry
that is larger than the size of the drawing view or sheet, or where the measurement origin is
associated to geometry that is not visible. While creating or editing a single-sided dimension, you can

use the Flip Dimension Side X button to switch between dimension lines.

Note Chain dimension sets and narrow dimensions are not supported. Also, it is impossible to create
single-sided dimensions using the Rapid dimension command.

When in edit mode, access handles are available to indicate which extension line and arrow to retain.
The access handle can also be used to set the length of the remaining, stunted arrow line. Alternately,
it is also possible to set the length of the remaining line using the Length option in the Settings dialog
box.
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Example of an angular single-sided
Example of a linear single—sided dimension dimension

Set the single sided option

Application

Drafting and PMI

Graphics window

Right-click while creating a dimension—Settings

Double-click an existing dimension— Settings

Location in dialog box|Single Sided node—Display as Single Sided Dimension

1.4.4.5 Flip Dimension Side button

Application Drafting, PMI
While in edit mode, click the Arrow Line access handle, and then turn the Flip
Dimension Side  *~ | on-screen button on or off.

. Right-click while creating a dimension— Settings

Graphics

window Double-click an existing dimension— Settings

Location in 2o

dialog box Single Sided node—Flip Dimension Side

Set the length of the remaining arrow line

Application

Drafting, PMI

Graphics window

While in the edit mode, click and drag the Arrow Line access handle
Right-click while creating a dimension—Settings

Double-click an existing dimension—Settings

Location in dialog box|Single Sided node—Length

1.4.4.6 Auto-centering dimensions
When using Manual Placement options, dimension text automatically snaps to the center of the
dimension line when it crosses within the range of an invisible snap corridor.
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Invisible snap corridor shown here in green dashed lines
This behavior is useful when you want to center your dimension but do not want to use the Automatic
Placement option.

1.4.4.7 Appending text to dimensions
It is possible to add text before, after, above, or below the dimension while creating a dimension, or

whenever editing a dimension.

—~B8X 23,0 10,10 THRU
s
THIS SIDE ONLY

- 122,0

1.4.4.8 Scene dialog
When placing or editing a dimension, a scene dialog appears in the graphics window. It can be used

to interactively add, modify, or delete appended text.
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A scene dialog can contain different options depending on the dimension type, and is available in
Drafting and PMI, and in the Sketch task environment.

While creating a dimension

Application Drafting

Pause before placing a new dimension, and then click inside the scene dialog
wherever you need to apply appended text.

Graphics Right-click and choose Edit Appended Text to open the Appended
window Text dialog box.

For an existing dimension

Application Drafting

Right-click the dimension and choose Edit Appended Text .

Graphics Double-click the dimension and, in the scene dialog, type the appended text in
window the appropriate box.

Add appended text to a new dimension

1. Choose Home tab—Dimension group—Radial :T :
2. In the Measurement group, from the Method list, select Diametral.
3. In the graphics window, select the hole.

?11.9

4. Pause the cursor in a temporary location until the on-screen Text dialog appears.
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5. In the Before appended text box, type 8X.
_‘;.i. 100 w [[EE| _,74-"2' -
X [xxx|v

i1.00) Ad

@11.9

E Use Alt + any arrow key to quickly move to the associated appended text box.

6. Click to place the dimension.

8X 4

?11.9

Add appended text to an existing dimension
Double-click an existing hole dimension to place it in edit mode.

If there is a simple text to append to the dimension, add the text directly in the appended text
boxes. This procedure demonstrates how to add more complicated text to a dimension.

2. If necessary, click the Text access handle.

A

3. In the scene dialog, click Edit Appended Text .
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—8X 4

o §* | B v M

Tip To access more quickly the Appended Text dialog box, right-click any dimension and
choose Edit Appended Text. It is not required to first place the dimension in an edit mode.

in the Controls group, from the Text Location list, select Below.

5. In the Text Input group, expand Symbols.

E When not seeing the Symbols group, right-click the top border of the dialog box and
select Appended Text (More).

6. Inthe Symbols group, from the Category list, select Drafting.
7. Click Insert Counterbore.

vu'lil:T_—B»:b.:[]
—~£]x ]|~ [ )]®
@ o sp X ¢t Q~
Ol<]x]<«>

Note that a counterbore symbol appears below the hole dimension.
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8. In the Symbols group, click Insert Diameter ¢ I
9. In the Text Input window, after the diameter characters, type 19.0.

IR

| <#B><0>19.0

10. Press Enter and then click Insert Depth
11. After the depth characters, type 5.0.

[<#B8><0>19.0
=#0D=5.0

12. Click Close twice to create the appended text.

Add appended text to multiple dimensions
This example shows how to simultaneously add appended text to three different dimensions

1. Select the "120° 0" dimension.

Right-click and choose Edit Appended Text.
Select the diameter and radius dimensions.

In the Appended Text dialog box, in the Controls group, from the Text Location list,
select Before.

5. Inthe Text Input window, type 3X.

6. Click Close to save the changes.
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Add appended text to a basic dimension
This procedure demonstrates how to add appended text inside the box of a basic dimension.

1. Right-click the basic dimension and select Edit.

2. Inthe scene dialog, in the Before box, type <#Anum=>, where num is equal to the number of
additional objects.

In this example, <#A8> is used.

3. Click Close in the Angular Dimension dialog box.

Add existing appended text to other dimensions
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This example shows how to copy appended text from one dimension and apply it to other dimensions.

1. Place the cursor over the "3X" appended text of the .750 diameter dimension.

] ¢ 750 THRU
S [#F1 P 00]A8 B

Right-click and choose Edit Appended Text.

In the Appended Text dialog box, in the Controls group, from the Text Location list,
select Before.

In the Dimension group, click Select Dimension | .
Select the .500 diameter dimension and the .250 dimension.
Click Close.

X ¢ 500 THRU
[@| @ .co5|A@ (B

X @ 250 THRU
&[¢.czolA@[E

71

1.4.4.9 Replace a dimension's value with manual text

Note Sometimes, it is a must to replace associative dimension text with manual text, such as when
you illustrate a tabular note with a dimension view. In such cases, manual dimension text does

not update when the model objects associated with it change.

To create manual dimension text:

1. Right-click an existing dimension and choose Settings.
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2. Expand the Text—Format node.

3. Select the Override Dimension Text check box.

4. For simple text, type a new value or text string in the text box, or click Edit Text z_5 to access all
of the text editor options.

Note A message appears whenever you manually edit the value of an associated dimension.
Click OK to proceed.

5. In the Settings dialog box, type a new value and click Close to save it.

——— 14 .95 to 22.95—

1.4.4.10 Revert manual dimension text to an associative value
1. In the graphics window, right-click the manual dimension and choose Settings.
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Width

2. Inthe Settings dialog box, expand the Text node, and then select the Format node.

3. Inthe Format group, clear the Override Dimension Text check box.
4. Click Close.

29

The manual text is replaced with an associative value.

Tip To quickly identify any dimensions on the current drawing sheet with manual text in them,
choose Menu—Information—Other—Object-specific—Dimensions with Manual Text. The
dimensions will highlight on the drawing.

1.4.4.12 Rapid dimension

Rapid Dimension '~ helps quickly create different dimensions from a group of general, well-used
dimension types using a single command and a basic set of selection options.

The following dimension types are supported for creation.

® Inferred — determines the type of dimension to create based on the selected objects and the
cursor location.
| o

e |~ Horizontal

x
|

Vertical

Point—to—Point

21

e | Perpendicular
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e

Cylindrical

° /—_ﬁ_. Angular

° l Radial

° 3 Diametral

You can use the Rapid Dimension command to create the dimension from one of the supported
dimension types. In edit mode, the selected dimension will invoke the dialog box associated with its
dimension type.

Application Drafting and Layout
—
&7 |

Command Finder|Rapid Dimension
Linear Dimension

x

The Linear Dimension ' command help to create one of six different types of linear dimensions
as standalone dimensions or as a set of chain or baseline dimensions. It is possible to create the
following dimension types:

e Horizontal

o Vertical

¢ Point-to-Point
e Perpendicular
e Cylindrical

o Hole Callout (in linear format, with or without secondary depth dimensions).

Note It is possible to create a set of chain or baseline dimensions using horizontal, vertical, point-to-
point, or perpendicular dimension types.

M10 x 1.5 THRU
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Using the Linear Dimension command, to:

Let NX infer the type of linear dimension to create based on the selected objects.
Dynamically change the type of linear dimension while creating or editing the dimension.

When dimensioning sketch curves on the drawing, determine whether or not the dimension will
affect the sketch curves if it is changed. This is referred to as a driving dimension. This option is
only visible for appropriate dimension types.

Manually position the dimension, or let NX automatically place the dimension.

Convert a baseline dimension set to a chain dimension set, and a chain dimension set to a
baseline dimension set.

Manually override the computed value of a dimension while creating or editing the dimension
using the Override Dimension Text option in the Settings dialog box. This override option is
available for all dimensions except driving dimensions and PMI dimensions.

Set the measurement type to Directed or Feature of Size, which enables capture of additional
design information. This information is especially useful in downstream applications such as
tolerance analysis and inspection applications. The option to set the measurement type is
available if the Enable Directed Dimensions Drafting preference is enabled. You cannot apply
a measurement type to cylindrical, hole callout, chain, or baseline dimensions.

Application Drafting and Layout

x

|
Command Finder|Linear Dimension —

Radial Dimension

The Radial Dimension

:T ' command lets you create one of five types of radial dimensions.
Radial, with Radius to Center and Folded Radius variations
Diametral

Hole Callout (in radial format, with or without secondary depth dimensions).

2% R 20 @ 17 THRU

M10x 1.5

@ 32 R 25

Using the Radial Dimension command to:

140

Let NX infer the type of radial dimension to create based on the selected objects.
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Dynamically change the type of radial dimension while creating or editing the dimension.

When dimensioning sketch curves on the drawing, determine whether or not the dimension value
will affect the sketch curves if it is changed. This is referred to as a driving dimension. This option
is only visible for appropriate dimension types.

Manually position the dimension, or let NX automatically place the dimension.

Manually override the computed value of a dimension while creating or editing the dimension
using the Override Dimension Text option in the Settings dialog box. This override option is
available for all dimensions except driving dimensions and PMI dimensions.

Application Drafting and Layout

Command Finder|Radial Dimension :T

R

Angular Dimension

Use the Angular Dimension /—ﬁ command to measure the angle between two objects in a view.
The objects selected can be any combination of:

Lines

Model edges

Cylindrical and planar faces
Dimension extension lines
Centerline symbol components

User-defined vectors

When selecting two objects in a view, any one of the angles depicted below can be dimesioned:

Minor angle Opposite angle

2 .

A3

O /O,

i

OO O O
O O & )
ﬁ\%/ K}"y |

Angular dimension units

Angular dimension units can be displayed in either:

DPP — Vacational Training for Smart Manufacturing in Machine Tools 141



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

o Whole degrees
e Fractional degrees (in decimal or fractional format)
e Degrees and minutes

e Degrees, minutes, and seconds

It is possible to specify an angular dimension as a fractional division of an arc by setting the Display
as a Fraction preference.

O AL O

360s

o}?.; o/ (OF O

Display as a Fraction

D Display as a Fraction

Application Drafting and Layout

Command Finder|Angular Dimension Lﬁ.

Display as a Fraction

Preferences—Drafting—Dimension node—Text node—Units page—Display as a
Menu|Fraction

Chamfer Dimension
It is possible to apply the Chamfer Dimension to edges chamfered at 45 degrees.

Ga.50 x 45° —

—C ©.30

When dimensioning a chamfered edge that is angled 45 degrees from an adjacent linear edge, no
further selections are required. If an adjacent linear edge cannot be detected, then it is a must to
either select an adjacent linear edge or manually create the chamfer dimension.

Note For any chamfer that varies from 45 degrees, it is required to use other dimensioning
techniques to dimension it.
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Application Drafting and Layout

c

&
Command Finder|Chamfer Dimension _\

Thickness Dimension

The Thickness Dimension command helps to create a dimension between two curves (including
splines). The thickness dimension measures the distance between a point on the first curve and the
intersection point on the second curve. It measures in the normal direction from the point specified on
the first curve.

XXX

o

o Object selection (point on curve used for dimension)

o Object selection

If the two curves are arc-like objects (arc, splines shaped like arcs, cylindrical faces, or circular
centerlines), NX creates a concentric circle dimension, which measures the difference in radii
between two concentric arcs. It then computes the numerical difference between the two radii.
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«250

Concentric circle dimension

Note Non-concentric curves, while selectable, are not supported by the thickness command and
erroneous results will be displayed. Use a different dimension command if you need a
dimension between two non-concentric curves.

Application Drafting and Layout

Command Finder| Thickness Dimension 2=

Arc Length Dimension
Use the Arc Length Dimension command to dimension the distance along the perimeter of a circular
segment.

Arc length dimension

Typically, an arc length dimension is used to measure the travel distance around a camera or to
measure the length of a tube or cable. It is recognizable by its two radial arrow segments and by the
arc symbol that appears above the dimension text. The dimension’s linear extension lines are
oriented perpendicular to the chord of the arc segment being dimensioned.
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Application Drafting and Layout

X

Command Finder|Arc Length Dimension R
Ordinate dimensions

=
Use the Ordinate Dimension **  command to measure the linear distance from a common origin
point to an object in the view. An ordinate dimension generally consists of dimension text and a single
extension line, and can be displayed either with or without a dimension line.

«©

SO

i e 0
=5 o D
el

il Y
L

A

L ]

9,6

N —413

‘ L 1L 413
N .
—D)— N A L @ \\ 31,8

o1 NEE
S
| | v | |

9.5 9,5

With dimension lines Without dimension lines

In the figure below, all of the elements that typically comprise an array of ordinate dimensions are

shown. The ordinate origin, name, baselines, margins, and associated dimensions are collectively
referred to as an ordinate dimension set.
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Ordinate dimension set

120.3
154 &

1. Ordinate origin

The common start point for all of the ordinate
dimensions.

2. Ordinate set name
Identifies the ordinate set on the drawing sheet.

3. Baseline
Points in the X direction of measurement from the
origin.

4. Perpendicular Baseline
Points in the Y direction of measurement from the
origin.

5. Margins
Align the dimensions with each other.

6. Ordinate Dimension (with jog)

Measures the distance from the ordinate origin to
objects in the view.

Multiple ordinate dimension sets can be placed on a single drawing sheet or even within a single
view. It is also possible to select an existing ordinate origin in one view to dimension an object in
another view. The ordinate origin can be in any view on any drawing sheet.

Note When an ordinate dimension is associated with an origin in a different view, it is not copied
when the view it appears in is copied

When you create an ordinate dimension set, it is recommended to confine all of its defining elements
to a single view. Placing an ordinate origin in one view and its margins in another view can lead to
undesirable results.

As a rule, you create ordinate dimension sets on the drawing sheet just like any other dimension. You
can, however, create them in an expanded drawing view. If you do that, you must also perform any
subsequent edits to the ordinate set within the expanded view.

Application Drafting

H=
Command Finder|Ordinate Dimension EL
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1.4.5 Advanced tools in 2D drawing export

1.4.5 1 Feature Control Frame

Use the Feature Control Frame command to specify the geometric tolerances applied to the features
of a model.

4 72030 A B CM[Z6.4]

You can create and edit the following, with or without leaders:
e Single line feature control frames.
e  Multi-line tolerance frames.

o Composite feature control frames.

o Composite feature control frames with one or more additional tolerance frames underneath.

You can also attach any of the above feature control frames to an existing dimension.

Application Drafting and Layout

Command Finder|Feature Control Frame ‘E‘
Create a feature control frame

+].0
2l 55

& [20.4@[ATBIC
go.2%@ [4[B)
1 [eaae

Creating a composite feature control frame

Note The following example creates a feature control frame from the Drafting application. You can
also create the same feature control frame from PMI.

Create a composite Feature Control Frame (FCF)
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N =

o s

6
s
8
9

Choose Home tab—Annotation group—Feature Control Frame =

In the Alignment group, select Stack Annotation and Align Horizontal or Vertical.

In the Frame group, set Characteristic to Position & , and Frame Style to Composite
Frame GE !
Make sure Frame 1 is highlighted in the List box.

Set the Tolerance options:

a. Setthe tolerance shape to Diameter @ 1.

b. Type 0.4 in the Tolerance Value box.

c. Set the Tolerance Material Modifier to Maximum Material Condition ® !
Set the Primary Datum Reference to A.

Set the Secondary Datum Reference to B.

Set the Tertiary Datum Reference to C.

Select Frame 2 from the List box.

10. Set the tolerance and datum references as desired.

In this example, the tolerance is set to 0.2, the Primary Datum Reference is A, and
the Secondary Datum Reference is B.

11. To position the composite FCF, do one of the following:

148

o Position the FCF so that it is stacked below the hole dimension.

r———————

¢ .0
. 3rd| -0.5 I

| |
1P ¢0.4$ABCI

o Inthe Leader group, click Select Terminating Object, then click the hole edge to attach the
leader.

Note Make sure the Point on Curve option in the Selection bar is available before selecting

the hole edge.
U

1.0
g2l 4.5

& g0.4@][A]B
F0.26 A

o Inthe Leader group, set the leader Type to Datum, then click the hole dimension stub and
drag to position the FCF.

B

o
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——

«] .0
221 9.5
& 0.4 |A|B|C
B0.200 |A|B

Note

+
To add a third row to the composite frame, you would click Add New Frame | .¢- :

12. Click to place the FCF.

\— gz1 L0

-0.5
Bo.4@|[a[B]|C]|
Fo.20 |A|B

&

1.4.5.2 Add a single FCF
1. With the Feature Control Frame dialog box still open, in the Frame group set

the Characteristic to Perpendicularity | 1 | and the Frame Style to Single Frame E

2. Set the Tolerance and Primary Datum options to produce an FCF as shown below.

[ L[&o0.1]B]

3. Drag the new FCF until it stacks below the composite FCF.

o S i i it
P21 g5 |
|¢. ﬁg*‘ A:CJl
| ce2l Bl
Lilgo-118]

4. Click to place the symbol, then click Close to close the dialog box.

5. Datum Feature Symbol
6. Use the Datum Feature Symbol command to create a GD&T datum feature symbol (with or
without a leader) to indicate a datum feature on your drawing.
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Datum Feature Symbol (A)

Application Drafting and Layout

Command Finder|Datum Feature Symbol %‘

1.4.5.3 Create or Edit a Datum Feature Symbol
Create a Datum Feature Symbol

Choose Home tab—Datum Feature Symbol %I .
[Optional] In the Leader group, select the leader Type you want.
[Optional) Set the Style options for the leader type.

For example, to create a filled datum triangle feature, set the leader Type to Datum. then set
the Arrowhead style to Filled Datum.

In the Datum Identifier group, verify the correct datum letter is displayed in the Letter box.

Highlight an edge with your cursor.

— © e

Highlight an edge.

6. Click and drag to create the datum feature symbol and extension line.

7. Click once to place the symbol.
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Place the symbol.

Note Use the Shift key to position both the datum leader line and the datum extension line while
placing a datum with a Datum leader type.

1.4.5.4 Edit a Datum Feature Symbol
1. Double-click a datum feature symbol.
| | —Y]
On the Datum Feature Symbol dialog box, from the Settings group, click Setting =
In the Settings dialog box, modify your settings.
Click OK.

1.4.5.5 Create a composite Feature Control Frame
This example shows how to create a three-row composite feature control frame.

o= +
0.0
| UV )

1. Open a part and start the Drafting application.

/_,—4X ¢ 6.00 +0.250
31000 ¥ &

SETTIoN A A

2. Choose Home tab—Annotation group—Feature Control Frame =,
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3. In the Frame group, set the following:

o Characteristic = Position ¢‘

o Frame Style = Composite Frame BeE

4. Inthe Tolerance subgroup, set the following:

o Shape = Diameter ¢
o Value=0.5

o Modifier = Maximum Material Condition ®

¢ |05 ® v
5. In the Primary Datum Reference subgroup, set the reference letter to A.
6. In the Secondary Datum Reference subgroup, set the following:
o Reference letter = B
o Modifier = Maximum Material Condition ®
7.

In the Tertiary Datum Reference subgroup, set the following:
o Reference letter=C

o Modifier = Maximum Material Condition ®

& 20.50) |A|BM | CW) |
0.0]

8. Inthe List subgroup, select Frame 2.

In the Tolerance subgroup, set the following:

o Shape = Diameter @
o Value=0.12

o Modifier = Maximum Material Condition ®

10. In the Primary Datum Reference subgroup, set the reference letter to A.

7050 [A[B0) [c) ]
20.120 [A]

.‘I ¥

%
11. Click Add New Frame .

12. In the Tolerance group, set the following:

o Shape = Diameter L
o Value = 0.007

o Modifier = Maximum Material Condition ®
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Fosm[A[B@][cW®]
¢ MH&I
#0.007(M)

13. In the Alignment group, select Stack Annotation.

14. Drag the feature control frame so that it stacks beneath the counterbore hole annotation, and click
to place it.

- W - O O O . -
axX & 6,00 20.250 a3

10.00 + 5
]
10.500 JA|BOLJCOU
12(M BA

A
. -

1.4.5.6 Add text to your feature control frame
You can add text before, after, above, and below a Feature Control Frame (FCF) while you are
creating it.

1. Create the feature control frame but do not place it on the drawing.

. |08 |A|BM |CM

.-.1_.\_ :/“l:r‘:':' ] A

2. Expand the Text group of the Feature Control Frame dialog box.
Note that control code for the FCF, <My Feature Control Frame>, already exists in the input box
3. Inthe Text group, use one of the following methods to add text to the feature control frame:

o Place your cursor in front of the<My Feature Control Frame> control code and then type your
text to add it to the beginning of the FCF.

WATAVE Ay ofi A - ™ ~
AAA x‘:\ h U '.’_'.I-' | u'j\ b iy L I /
\

o Place your cursor at the end of the <My Feature Control Frame> control code and type your
text to add it to the end of the FCF.

20.8M) A BM) | C(M) | XXXX

"M DR\ /\
\J.Z20 / A

o Place your cursor before the <My Feature Control Frame> control code, hit Enter to add a
blank line, then place your cursor on the blank line and type your text to add it to the top of
the FCF
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XXXX

. |20.8M) |A]|BM |CM)
v | 20.25(M) | A

o Place your cursor at the end of the <My Feature Control Frame> control code, hit Enter to
add a blank line, and then type your text to add it to the bottom of the FCF

20.8(M) |A|BM) | C(M)

" 1 D0.25(M) | A

=

XXXX
4. (Optional) You can underline the text by doing the following:
a. Right-click in the graphics window and choose Settings.

b. Select the GDT node.

c. Inthe Feature Control Frame group, select an option from the Underline Additional
Text list.

In this example, All is selected.
d. Click Close to exit the Settings dialog box.
5. Click to place the FCF, or select a point and then click and drag to place the FCF with a leader

| {b.;aaa() A|BM | CM
?0.2504) | A
XXXX

1.4.5.7 Weld Symbol

7
Use the Weld Symbol _Jﬁ. command to create various weld symbols in both Metric and English
parts and drawings. Weld symbols are associative and relocate when the geometry they are
associated to changes or is flagged as out of date. You can edit weld symbol properties such as text
size, font, scale and arrow dimensions.

Weld Symbol Standards
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You can create ASME, ISO, DIN, JIS, ESKD and GB standards compliant weld symbols.

Following are examples of symbols available above and below the continuous reference line.

Mone MNone

Mone

y
J

MNone
AR VIS | Pl
L I I I\
||

[ N
[ N

FTX/ 0=
C N
N\ <

im 1|1y |1O ||O
O ||V ||[&|&
Ve | e[|\ ||
LI 7N | e (N[N
w K [N (==
Oll=|IM|l= =
S| (=M NN
ClIN| X || ||@
N | |2 | [*||® |®
@@me
oo —— 4 i -

ASME ISO&DIN JIS ESKD GB

Weld symbol types are initially controlled by the drafting standard set in your part. You can change
the available weld symbol types by changing the weld standard setting in the Drafting
Preferences dialog box.

Application Drafting and Layout

yi
Command Finder|Weld Symbol Lr:
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Set or change the weld standard setting

Application Drafting

Command Finder Drafting Preferences

Location in dialog box|General/Setup—General node— Standard group—Weld

Crosshatch

v
Use the Crosshatch /; command to fill a specified area with a pattern. A crosshatch object
includes the hatch pattern and defining boundary entities.

You can define a crosshatch boundary area with a single selection inside a face or a closed loop of
supported curve types such as solid edges, section edges, silhouettes, and basic curves.

Note You can not add crosshatch objects to perspective views. Perspective views are views which
have Use Perspective set in the Settings dialog box for the view.

You can also define the boundary by selecting objects. To define a boundary, you can select curves,
solid silhouettes, solid edges, and section edges. Text islands are created when you also select
notes, PMI annotations, and GD&T symbols. Make sure that you select the boundary objects in
consecutive (connected) order to keep the shape of the crosshatch predictable.

When adding crosshatches to a non-master drawing part, or to a drawing contained within an
assembly, you cannot select a mix of part objects and component objects to define the boundary.
However, you can define a boundary made up entirely of part objects (such as silhouette curves) or
component objects (such as component edges). If you want to define a crosshatch boundary using a
mixture of part objects and component objects, you must first display the view with extracted edges.

R 2
'y -;y

ahd

Note If you change your view Representation setting from Exact to Smart Lightweight, or if you
change the Resolution setting of your Smart Lightweight view, existing crosshatch patterns
may become retained.

Where do | find it?

Application Drafting and Layout

%,

Command Finder |Crosshatch

Double-click a crosshatch pattern

Graphics Window|Right-click a crosshatch pattern —Edit
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Area Fill

Use the Area Fill i command to create an area fill object which consists of a specified pattern of
complex lines enclosed by a set of boundary curves. Area Fill also includes solid fill which fills the
inside of the boundary with color or gray scale.

Note You can not add area fill objects to perspective views. Perspective views are views which
have Use Perspective set in the Settings dialog box for the view.

You use the Area Fill dialog box to both create and edit attributes of an area fill object, including
boundary curves, pattern type, and color, width, angle and tolerance of the pattern lines.

Ten ANSI Y14.2M fill pattern styles are available representing ten common patterns.

[y
T
i

o

o
D
b

Note If you change your view Representation setting from Exact to Smart Lightweight, or if you
change the Resolution setting of your Smart Lightweight view, existing area fill patterns may
become retained.

Where do | find it?

Application Drafting and Layout

Command Finder |Area Fill i

Double-click an area fill pattern

Graphics Window|Right-click an area fill pattern —Edit

Assembly drawings

Like single part files, you can create your drawing directly in your assembly file, or add the assembly
as a master part to a non-master drawing file. Once the drawing is created, you can use the drafting
tools to create and annotate views on separate drawing sheets.

Parts lists are derived directly from the components in the assembly, regardless of how the drawing is
created (in the master part or in a non-master part). Dimensions, labels, symbols, and other drafting
aids are fully associative with the geometry in the component to which they are attached. Therefore,
the assembly drawing updates whenever the referenced components are modified. Similarly, view-
dependent modifications made at the drawing level are retained when the component geometry is
edited.
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Note All view dependent edits are made in the top-level work part. This is the non-master drawing file
if you are using the master model strategy. Likewise, any 2D geometry added to a drawing
sheet or drawing view is created in the top-level work part.

Dimensions, drafting notes, and drafting labels that are present in a component part are not visible in
the assembly where the component part is used. If you wish to display component-level annotation in
the assembly, consider using PML.

Effects of assembly load options on drawings

When you open an assembly part, NX uses assembly load options to determine how to find and load
component parts that are referenced by that assembly. The amount of data loaded into your computer's
working memory is determined by your Assembly Load Options.

When you create a drawing view, only the currently loaded geometry is displayed in the view. However,
if you fully load the part, the additional geometry is added to the drawing view once you update it.

Loading structure only

When you select Structure Only, only the assembly structure is opened and no components are
loaded. Any existing silhouettes, extracted edges, or faceted representations remain in your drafting
views until you update the drawing sheet.

When you are ready to work in a view, you can load only the components or subassemblies required
for your work. If you hover over the node of an unloaded component in the Assembly Navigator, a
geometry box appears in the view indicating the component’s location. To load a component, right-click
the node of an unloaded component node and choose one of the following:

Note Annotations and dimensions associated to unloaded data, such as attributes, will appear retained
until you load the data, and a question mark ?is displayed next to drawing view nodes in the di.

¢ Open—Component
¢ Open—Assembly

You may find it easier to load components in a model view instead of a drafting view because a
geometry box appears in the location of the component whose node you hover over in the Assembly
Navigator.
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Note If you set the Load Structure Only check box in the Open dialog box, the Load option in
the Assembly Load Options dialog box is automatically set to Structure Only in the same NX
session.

Partially loaded

When you partially load a part or an assembly, only the geometry from the active reference set is loaded.
You may want to use partial loading when you need to display certain components to complete your
task, but your assembly is large enough to reduce your computer's performance when all the data is
loaded in the memory. You can save 20 to 30 percent of your computer's memory when you partially
load components.

When you partially load a part or an assembly, you can still annotate geometry in the drafting view, but
you must fully load the assembly before you can completely update the view.

1.4.6 Checking drawings and printing drawings

1.5. Assembling sub-assemblies

NX W

WA W e v sy Tioh dpplasun Deshge e TDCSE A Ea F_8

1.5.1 Add Component
Use the Add Component command to add one or more component parts to the work part.

If you add a part family template part, the Select Family Member dialog box appears.
You can:
e Add one or more instances of selected components in a single operation.

Note When you add multiple components at the same time, you may want to use the Scatter
Components option to prevent the components from being positioned in the same
location.

e Select multiple parts to add in a single operation.

e Add the same component with different settings by selecting Keep Selected @ from the Part To
Place group to keep selected parts selected.
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You can also add a component by dragging it to the XC-YC plane. To do this, enable the Position on
XC-YC Plane customer default.

Tip Tofind a customer default, choose File tab— Utilities—Customer Defaults, and click Find

3.
4.

o

8.

0?

Default I

Application Assemblies

g+
Command Finder|Add Component ’

1.5.1.1 Add components to an assembly
g+
Choose Assemblies tab—Component group—Add - |
Select one or more parts to add to the assembly from any of the following:
The graphics window

(w]

o The Assembly Navigator

o Inthe Part To Place group, from the Loaded Parts list box or the Recent Parts list box
3
J

Q

The Part Name dialog box that opens when you click Open

Note If you type the name in the File Name box, instead of selecting it from the list box, you
must include the part name and its extension, such as .prt.

The components to be added are displayed in the graphics window.
In the Part To Place group, do the following:

(w]

(Optional) To keep the selected parts selected after selecting Apply, select the Keep
Selected check box.

In the Count box, type the number of instances to be added.

Q

In the Location group, from the Assembly Location list, select a positioning option.
If you selected Snap, specify a location.

From the Placement group, click one of the following:

o Move to place the component using movement functionalty

o Constrain to place the component with assembly constraints

In the Settings group, do the following:

o (Optional) select the Enable Preview Window check box.

o (Optional) In the Settings group, from the Reference Set list, select the reference set to use
for the added components.

o From the Layer Option list, select an option to define where components should be located.
Click OK or Apply.

1.5.1.2 Create a custom anchor point

This example shows how to create a custom anchor point for a component, so you can more easily
place the component in situations where the absolute origin of the component is not an acceptable
anchor point.

1.

160

Open the component.
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Z

e
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e

In this example, the part was created in an assembly context by WAVE-linking a face and
extruding it. As a result, the absolute origin of the part is at the absolute origin of the assembly it
was created in, which is not an acceptable anchor point for placing the part in a different
assembly. We need to create a new anchor point.

2. Choose Home tab—Feature group—Datum Plane Drop-down list—Datum CSYS | ™= |
You will use a datum CSYS and use it to define the anchor location and orientation.

3. Create a datum CSYS at the new anchor location.

Z

4. To define the CSYS as an anchor, select Assemblies tab—General group—Product

=

Interface | ;‘:a i

From the Interface Objects group, from the Object Type list, choose E‘? Datum.
Select the datum CSYS you created.
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10.
11.

12.
13.

14.

15.

¥ Product Interface

Interface Objects

Object Type

‘Select Datum (0)
‘Name "Type ‘Status 'Referenced
‘Coordinate Sys... 'Datum 'Active

The datum CSYS is added to the list in the dialog box. However, in the Add Component dialog
box, the name of this anchor is Coordinate System, which does not provide useful information
about the anchor point. You need to rename the anchor point.

Right-click the datum CSYS and choose Properties.
On the General tab, in the Name box, type a new name for the coordinate system.
Click OK twice.

The new anchor point is defined. You will add the component into an assembily to finish the
process.

Save the component.
Open the assembly.

@+
Choose Home tab—Assemblies group— Add e dl|

In the Part To Place group, from the Loaded Parts list box, select the component you want to
add to the assembly.

In the Location group, from the Component Anchor list, select the anchor you created earlier.

Location A

Component Anchor Absolute =i
Assembly Location Absolute |

¥ ‘Select Object (0) ' bi'. I -
Cycle Orientation s EIL? &

Place the component in your assembly.
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The new anchor point is saved with the component, so you and downstream users can easily locate
this component to move or apply constraints to.

1.5.1.3 Add a part family member to an assembly
This example shows how to add a single instance of a part family member to an assembly, and
position the component at a selected origin.

g+
1. Choose Assemblies tab—Component group—Add -
>
2. Inthe Part To Place group, click Open "~ and select a part family template part.

3. Inthe Choose Family Member dialog box, from the Matching Members list, select a member
part.
E Even if you know the part name, you may want to set Criteria so you can use the reporting
and update mechanisms at a later time. This can help capture your design intent.

4. If you want to set Criteria to filter for and select the member of the part family, do the following:
a. Select an attribute in the Family Attributes list box.

The attribute name appears in the Criteria box, and the possible values appear in the Valid
Values list box.

b. (Optional) Type an expression or modify the expression in the Criteria box.

Tip You can click Clear All Criteria any time you want to remove and redefine all the
criteria.

c. From the Valid Values list box, select a value that meets the requirements for the assembly.
The Valid Values list includes all values for the selected family attribute.

Example If “length” has valid values of 8 and 12, you can select 8. Now, 12 moves to
the Not Valid Values list box. The Matching Members now lists only family
members whose length attribute is 8.

d. Repeat this step until you define all necessary selection criteria.

In the Matching Members list box, select one of the remaining parts, and then click OK.
6. In the Placement group, click Move or Constrain.
7. In the Settings group, do the following:

o From the Reference Set list, select a reference set type.

o From the Layer Option list, select Work.

8. Click OK to place the part family member.
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1.5.1.4 Create New Component
Use the Create New Component command to create a new component in the assembly by selecting

geometry and saving it as a component.
You can use Create New Component to create an assembly using a top-down design method.
With the top-down method, you can:

o Copy or move existing geometry into a new component.

s Create an empty component file and add geometry to it later.

NX creates a new component file that contains the selected geometry and also creates a component
in the assembily file.

Note You must save the new component. It is not saved automatically.

Application Assemblies

ot
Command Finder|Create New Component | ™"

1.5.1.5 Reflect Component
When you want both left-hand and right-hand versions of a component, you can add the component
to the assembly and then reflect the component to create the other version. The reflected component
is a new instance of the original component; a new part file is not created. You can also reflect
subassemblies or multiple components.

Editing a reflected component

The reflected and non-reflected component instances are referencing the same part file, so the
geometry in both is always the same. Because the reflected instance has a reflection transform
applied to it, all the geometry in it appears reflected. Editing the geometry in the original component
results in the edits appearing in both the reflected and non-reflected component instances.

Because you cannot make a reflected component instance the work part, you cannot directly edit the
geometry in the reflected component instance.

Note Use the Mirror Assembly command instead of the Reflect Component command if you need
left-hand and right-hand versions that don't match. Mirroring a component produces a new part
file that you can edit during or after creation.

Preparing reflected components for downstream processes

Because a reflected component is an instance of an existing component, you must ensure that
downstream processes, including manufacturing, recognize which instances are reflected and which
instances are not reflected. For example, you can assign a unique component name to a reflected
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component in the Assembly Navigator properties, if your company's processes are capable of
distinguishing between reflected and nonreflected instances based on component names.

Application Assemblies

Command Finder|Reflect Component ﬁ&

1.5.1.6 Create New Parent
Use the Create New Parent command to create a new parent part for your current active part. During

the operation, an empty assembly is created, and the current active part is added to it as a child.
When the operation is complete, the new parent assembly becomes the active and work part.

Descriptive Part Name
= Sections
5 M -a— e, _parent_assm
B-M%  assm_base
B3R Constraints
M pase
g lug
~M O pin

Application Assemblies

Command Finder|Create New Parent | T

1.5.1.7 Create a new parent assembly
This example shows how to create a new parent part file for a selected component.

1. (Optional) In the Assembly Navigator, ensure that the current active part is the part for which
you want to create a new parent part file.

2. Choose Assemblies tab—Component group—Create New Parent T‘f- ;s
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3. Inthe Create New Parent dialog box, from the Templates list, select a template.

In the New File Name group, in the Name box, specify a unique name.

Tip 3
Click “~ | to select a part that has a similar name and modify the name for a new parent
part.

5. In the Folder box, specify the directory for the parent part file.

Tip £
Click “ | to navigate to the directory for the new parent part file.
6. Click OK.
The Assembly Navigator lists the parent part file. The new parent part file becomes the work
part.
Component

Use the Replace Component command to remove an existing component and replace it with another
component that is a *.prt file type.

Note You will be alerted that the component to be replaced is not a revision of the replacement part,
if the new component is:

* Not created from the same template part as the original.

* Not a descendent of the same original blank part if no template was used.

Application Assemblies

|
Command Finder|Replace Component %(

1.5.1.8 Make Unique
Use the Make Unique command to create a new pairt file for one or more selected occurrences of the

same part.

For example, the following figure shows four selected occurrences of a part named GKballjoint. You
can use the Make Unique command to convert the two occurrences near the tires to reference a new
unique part file named GKballjoint_tire. The other two occurrences, which are attached to the
steering column subassembly, continue to reference the GKballjoint part file.

When you create a unique part file, you can modify the occurrences that reference the new part
without affecting occurrences that still reference the original part. For example, you can modify
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the GKballjoint_tire part file so its occurrences fit larger tire subassemblies without affecting
the GKballjoint ball joints that are attached to the steering column subassembly.

Application Assemblies

Command Finder|Make Unique [V 5

1.5.1.9 Mirror Assembly
Use the Mirror Assembly command to:

e Create associative or nonassociative mirrored components in an assembly.

e Position new instances of the same parts at mirror locations.

e Create new parts that contain linked mirror geometry.

Many assemblies represent one side of a fairly symmetric larger assembly. You can create one side of
your assembly and create a mirrored version to form the other side of your assembly.

=l

You can mirror an entire assembly, or you can select individual components to be mirrored. You can
also specify components to be excluded from the mirrored assembly. Each mirrored body is added to
the reference set of its source body.

You can create a mirrored component in one of the following ways:

e Create mirror geometry. NX creates a new part file that contains the linked mirror body features
for all the solid geometry in the original component. It also adds the new mirror part to the
assembly as a component.

e Create a new instance of the selected part or subassembly, and reposition it across the mirror
plane.

You can specify the plane of symmetry that is used to mirror the component, using one of six Reuse
and Reposition options to define the plane of symmetry. Each positioning option is based on one of
the following:

e The inertial axes of the geometry in the part or subassembly.

e The WCS of the part or subassembly.

e A user defined plane of symmetry, which is useful when the part is not truly symmetric. For more
information, see User defined plane of symmetry for mitrored assemblies.

Before you create the mirrored assembly, you can preview it and make corrections using the Mirror

Review step.
Application Assemblies
Prerequisite An assembly must be the work part.
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Command Finder{Mirror Assembly E’

Mirror an Assembly

1.

Choose Assemblies tab—Component group—Mirror Assembly | E‘J L
The Mirror Assemblies Wizard welcome page opens.

Click Next.

The Select Components page is displayed.

Select the components to mirror and click Next.

The components must be children of the work assembily.

The Select Plane page is displayed.

4. Select an existing plane or click Create Datum Plane EI , and create a datum plane.

Click Next.

The Naming Policy page is displayed. If no component uses the Mirror Geometry type, you can
click Finish. Otherwise, proceed to the next step.

Specify the Naming Rule that you want to use for these opposite-side parts, and specify
a Directory Rule for the parts.

You can add a prefix or suffix to the source part names, or replace the string in the original name.
Click Next.
The Mirror Setup page is displayed. Selected components are listed in the right-hand panel.

(Optional) Select a different mirror type for each component. Select a component from the list of
components in the right panel and click any of the following:

o Click Associative Mirror E to create an associative opposite-side version of a
component and create new parts.
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10.

11.

o Click Non Associative Mirror EEI’ to create an nonassociative opposite-side version of a
component and create new parts.

o Click Exclude x to exclude the selected component.

Reuse and Reposition is the default mirror type.

Click Next.

The mirrored components appear in the graphics window. The Mirror Review page is displayed.

(Optional) Make corrections before finishing the operation. You can do any of the following:

1
o Click Cycle Reposition Solutions | 2+ | to cycle through the options for reuse and
reposition.

o Change a component's mirror type from Reuse and Reposition to Associative
Mirror or Non Associative Mirror.

x|

o Select components and click Exclude
Click Next or Finish.
The Name New Part Files page is displayed.

To change the name, folder, or attributes of the new mirrored parts, do the following:

o Click Use the button to name the mirrored parts and set attributes 4 to open the Name
Parts and review the names that the wizard applied to your new opposite-side parts in
the Parts to Rename list.

o Select a name in the Name column to change it.

o Inthe Name and Location group, in the Name box, specify a new unique name.

Note In a Teamcenter environment, double-click the object in the Object Name column, and
change the name in the Edit dialog box.

o In the Folder box, specify a new folder.
o Click OK.

Note In a Teamcenter environment, you can also assign the following values:

=, 21

o Secondary Attributes

@ Alternate Ids
é Projects
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| Folder
12. Click Finish.

Note In a Teamcenter environment, the attributes must be fully specified, as indicated in
the Fully Specified column V.

1.5.1.10 Deformable parts

You can define a part as capable of assuming more than one shape when it is added to an assembly.
This is especially useful for parts such as springs or hoses, which often have different shapes in the
same assembly. Deformable components are also known as flexible components.

To use a deformable component in an assembly, you must:

s Define the deformable component. You can do this either before or after you add it to the
assembly.

e Add the deformable component to the assembly.
e Edit the deformable component in the assembly to the desired shape.
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Add a deformable part to an assembly
1. Make sure your assembly is the work part.

ro
2. Choose Assemblies tab—Component group—Add | & .

3. Select a deformable part and position it somewhere close to the assembly.
In this example, the spring is a deformable component.

The deformation dialog box appears. The name of this dialog box is the name of the deformation.
4. In the deformation dialog box, modify the deformation input parameters, and click OK.

If you do not want to deform the part at this time, click Cancel.
5. Constrain the deformable component to the assembly as shown.
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OO

6. Save the assembly.

Create an Assembly Arrangement
Use this procedure to create assembly arrangements.

1. In the Assembly Navigator, select an assembly or subassembly.

2. Choose Assemblies tab—General group— Arrangements v

. - B
3. From the list box, select an arrangement and click Copy |
Rename the copied arrangement.
You can accept the new default name, rename it immediately, or rename it at a later time with

=

5. Move the components to the new positions within the assembly and save your parts.

the Rename option |

Check for arrangement-specific options in either the Move or Suppression dialog boxes.

If you have two or more arrangements, you can switch arrangements by selecting the one that
you want from the Assembly Navigator—Arrangements shortcut menu.
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g

gy

If you want to change your arrangement to the one you created, right-click the assembly or
subassembly where you created it and choose the new arrangement.

Note The arrangement is saved when you save your parts.

'™
If you want to make the new Arrangement the default, click Set as Default E:Eﬂ :

1.5.1.11 Move Component
Use the Move Component command to move and optionally copy one or more components in an
assembly. You can move components dynamically, or you can create temporary constraints to move
the components into position.

When you move components, the Modified column in the Assembly Navigator displays
a Modified icon Ef in the rows of the parts that are affected.

Note Your assembly may have some constraints that were created by NX as needed to complete
earlier operations. This can cause parts that you thought were not affected by the move to be
marked as modified. For example, NX may create hidden constraints when you add routing
geometry to the assembly. These constraints do not appear in the graphics window,
the Assembly Navigator, or the Constraint Navigator.

Moving components that are not immediate children

By default, you can only move components that are immediate children of the work part.

However, you can set a customer default to let you move components anywhere in your assembly
when you are in the Move Component dialog box, regardless of what your work part is. In
the Customer Defaults dialog box, under Move Component, set Scope to Anywhere in Assembly.

E To find a customer default, choose File tab—Utilities—Customer Defaults, and click Find

W

Default !

This is useful, for example, if you want to simultaneously move a collection of components that do not
share the same assembly parent.

Caution The use of the Anywhere in Assembly customer default can significantly reduce the
performance of the Move Component command when the assembly structure of the
displayed part has a large number of assembly constraints.

Application Assemblies

[
Command Finder|Move Component %
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1.5.1.12 Move a component
Move a component dynamically

This example shows how to move a component dynamically using handles and without collision
detection.

5
1. Choose Assemblies tab—Component Position group—Move Component | ﬂ
2. In the Move Component dialog box, in the Components to Move group, ensure that Select

Components @ |is active.
3. Select one or more components to move.

In the Transform group, from the Motion list, select Dynamic.
In the Copy group, from the Mode list, ensure that No Copy is selected.
In the Collision Detection group, from the Collision Action list, select None.

In the Transform group, ensure Specify Orientation is active.

© N o o s

Drag the handles to move the components to a new location.
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1.5.2 Constrain an assembly

1.5.1.1 Assembly constraint types

Assembly Description
constraint type
!EI; Aligns two axes in different objects, while simultaneously preventing any
rotation about the common axis.

Align/Lock It is commonly used as one of the constraints when you want to fully
constrain a bolt in a hole.

| 44 Specifies an angle between two objects, optionally around a specified axis.
Angle
DB Constrains objects together so they move as a rigid body.
~— Bond

Note Bond constraints can only be applied to components, or to
components and assembly-level geometry. Other objects are not
selectable.

‘ Centers one or two objects between a pair of objects, or centers a pair of
Center objects along another object.

@ Constrains two circular or elliptical edges so the centers are coincident and
Concentric the planes of the edges are coplanar.

MM Specifies the 3D distance between two objects.
i+ | Distance

Note If a distance constraint is created between two edges, or two points,

~ oran edge and a point, positive and negative values are treated as
identical. NX does not recognize negative signs for these cases
because it can move these geometries continuously from one side to
the other while solving the constraint. For these cases, values are
sign-independent in limits on driven distance constraints as well as
in distance constraint values. For other types of geometry such as
faces, negative values are recognized.

- Constrains two objects with equal radii, such as circular or elliptical edges,
or cylindrical or spherical faces.

i
-

The linear tolerance is 0.1 mm for cylindrical faces, and the angular
tolerance is 1 degree for conical faces.

If the radii later become non-equal, the constraint is invalid.

A fit constraint is useful for locating pins or bolts in holes.

Note Fit constraints created during the releases between NX 5.0 and NX
6.0.1 are listed as Legacy Fit constraints. Fit constraints created in
NX 6.0.2 or later releases are listed as Fit constraints.

Legacy fit and fit constraints differ only in their behavior with cones
or tori. A legacy fit constraint makes the axes of two cones or tori
coincident. A fit constraint makes two cones or tori fully coincident.
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= Fixes an object at its current position.
| Eix

Note A fix constraint is useful when you need an implied stationary object.
With no fixed node, the entire assembly has freedom to move.

% Defines the direction vectors of two objects as parallel to each other.

Parallel

’|:|_ Defines the direction vectors of two objects as perpendicular to each other.
Perpendicular

Constrains two components so they touch or align with each other.

M
=| Touch Align
Note Touch Align is the most commonly-used constraint.

You can specify whether you want a touch constraint or an align constraint,
or you can use the Prefer Touch orientation to let NX calculate the
constraint type.

This example shows how to create and constrain an assembly by using the following components to
assemble a food chopper.

chopper._blade chopper_bo chopper_bowl_co chopper_case_b chopper_case_t
= wi

Geb Gk op chopper_gear1
=
e -

chopper_gear2 chopper_motor chopper_rotor chopper_spindle chopper_support_plate

As you add each component to an assembly, consider which constraints it needs in order to be
positioned correctly in the assembly. Not all components should be fully constrained. For example,
some components such as gears need to rotate, and other components may need to slide in one or
more directions.

Note In the example, the assembly is created by adding existing components and constraining each
component when it is added. Another common workflow is to create each component in context
of the assembly and to constrain it at that time.

1. Create an assembly part file for the chopper.
a. Choose File tab—New.

b. In the New dialog box, on the Model tab, in the Templates group, select the Assembly row.

176

DPP - Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

c. Inthe New File Name group, define the following.
= Name = a name for your assembly. In this example, Name = chopper_assy.
= Folder = the directory where your parts for the assembly are located.

d. Click OK.

The Add Component dialog box is displayed, and the assembly is displayed as the top-level
node of the assembly structure in the Assembly Navigator.

For more information, see Add Component.
2. Add the first component.
a. Inthe Part group, select or open the first component.

Note You can assemble components in any order that is convenient during the design
phase, and create alternate orders later. For more information, see Ordering
components in the Assembly Navigator.

b. The first component is displayed in the Component Preview window if your Preview check

box is selected.

C.

d. Inthe Assembly Navigator, the first component is displayed as a component node under the
assembly node, and the current order is displayed at the end of the assembly node.

=M% chopper_assy (Order: Chronological)
M chopper_case_base
e. Inthe Placement group, from the Positioning list, select Absolute Origin.
f. Click OK.
3. Constrain the first component in one of the following ways.
o Constrain the component with a fix constraint.
o Fully constrain the component to assembly-level geometry, such as a datum CSYS.
In this example, the first component is constrained by a fix constraint.
b4
c. Choose Assemblies tab—Component Position group—Assembly Constraints O |
d. Inthe Assembly Constraints dialog box, from the Type list, select Fix.

e. In the Settings group, ensure that the Associative check box is selected.

f. In the graphics window, select the first component.

The fix constraint is displayed in the graphics window.

N D
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You can use the Constraint Navigator to help you analyze, organize, and work on assembly
constraints. You can specify a Constraint Navigator grouping mode to specify how the
information is organized in the navigator. This example uses the Group by

Constraints mode, which lists constraints under the top-level Work Part node. You can
expand a constraint to get more information about the components that are involved in the
constraint.

= :':js Work Part
= M2 Fix (CHOPPER_CASE_BASE)
M (P chopper_case_base

You can also see some information about constraints in the Assembly Navigator, although
the Assembly Navigator is designed primarily to help you explore components and the
assembly structure. In the Assembly Navigator, a Constraints node is displayed under the
assembly node. You can expand the Constraints node to see the fix constraint.
= M chopper_assy (Order: Chronological)
=2 Constraints
M+ Fix (CHOPPER_CASE_BASE)
~MACe chopper_case_base
g. Click OK.
4. Add and constrain a second component.
g+
Choose Assemblies tab—Component group—Add w |
a. Inthe Add Component dialog box, in the Part group, select or open a component.

b. In the Placement group, from the Positioning list, select By Constraints.
c. Click Apply.
The Assembly Constraints dialog box is displayed.

E In the Preview group, you can select the Preview Component in Main Window check

box to preview how your current constraints position the component in your
assembly.

d. Constrain the second component according to your design intent.

In the example, the chopper_case_top is constrained to the chopper_case_base by two touch
constraints. For both constraints:

=  Type = Touch Align
= Orientation = Prefer Touch

Each constraint is created after you select one object in the base and one object in the top.
You do not need to click OK or Apply until you finish creating both constraints.

Note A lightning bolt symbol may be temporarily displayed beside the constraint in the
graphics window while NX calculates whether the constraint type is touch or align.
See Assembly constraint notes for more information.

Select geometry in the base Select geometry in the top
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First touch constraint

Second touch constraint

e. Click OK.
NX adds the second component to the assembly and positions the components according to
the constraints.

o
In the Constraint Navigator, the new constraints are displayed under the Work Part node.
e l:'l::. Work Part
= M ¥+ Fix (CHOPPER_CASE_BASE)

| M chopper_case_base
& [ "M Touch (CHOPPER_CASE_BASE, CHOPPER_CASE_TOP)

[ Touch (CHOPPER_CASE_BASE, CHOPPER_CASE_TOP)
In the Assembly Navigator, the new constraints are displayed under the Constraints node.

2 Efﬁ chopper_assy (Order: Chronological)
‘:‘51 Constraints
M Fix (CHOPPER_CASE_BASE)
M ™ Touch (CHOPPER_CASE_BASE, CHOPPER_CASE_TOP)
M ™ Touch (CHOPPER_CASE_BASE, CHOPPER_CASE_TOP)
e chopper_case_base
M chopper_case_top
5. Continue adding and constraining components until the assembly is complete.

In the example, the chopper_support_plate component is constrained with one touch
constraint and one align/lock constraint.

For the touch constraint:

=  Type = Touch Align
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Orientation = Prefer Touch

Select geometry in the base Select geometry in the support plate

Touch constraint

For the align/lock constraint:
=  Type = Align/Lock

Select geometry in the base Select geometry in the support plate

Align/lock constraint

a. Inthe assembly, the chopper_gear1 component is constrained to the chopper_support_plate
component using a touch constraint and an align constraint.

For the touch constraint:
=  Type = Touch Align

Orientation = Prefer Touch

Select geometry in gear1 Select geometry in the support plate

Touch constraint ( s

For the align constraint:
=  Type = Touch Align

Orientation = Infer Center/Axis
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Note When you use the Infer Center/Axis orientation, you can select the cylindrical
face or edge whose axis you want to align.

Select geometry in gear1 Select geometry in the support plate
Align
constraint
Tip You can show and hide components as necessary to help you add and constrain new

components.

The following figure shows the completed food chopper.

1.5.1.2 Assembly Constraints dialog box
Constraint Type

These options also appear in the Transform group of the Move Component dialog box
when Motion is set to By Constraints.

Fidt Lets you specify the type of assembly constraint by selecting its icon. For more
information, see Assembly constraint types.

These options also appear in the Constraints section of the Move Component dialog box.

Appears only when Type is Touch Align.

Qrentation Lets you influence possible solutions for a Touch Align constraint as follows:
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Subtype

Port

Axial Geometry

» Prefer Touch — Presents a touch constraint when touch and align solutions
are both possible. (Touch constraints are more common than align
constraints in most models.)

Prefer Touch presents an align constraint when a touch constraint would
over-constrain the assembly.

® Touch — Constrains objects so their surface normals are in opposite
directions.

» Align — Constrains objects so their surface normals are in the same
direction.

s Infer Center/Axis — Specifies that when you select a cylindrical, conical, or
spherical face, or a circular edge, NX uses the object's center or axis itself
for the constraint.

Note When more than one solution is possible, you can flip through the
solutions.
Appears only when Type is Angle or Center.
(Angle only) Specifies whether the angle constraint is:

» 3D Angle — Measured between two objects without requiring a defined axis
of rotation.

Note The value of a 3D angle constraint is 180 degrees or less. Because a
3D angle constraint defines the angle in space between two objects
without using a defined axis, the minimum angle between the objects
is used to solve the constraint.

o Orient Angle — Measures the angle constraint between two objects, using a
selected axis of rotation. It can support up to 360 degrees of rotation.
(Center only) Specifies whether the center constraint is:

» 1 to 2 — Centers one object between a pair of objects.
s 2to1— Centers a pair of objects along another object.

o 2to 2 — Centers two objects between a pair of objects.

Appears when you open a Routing assembly and when the Type list is set
to Angle.

This option specifies the constraints with respect to the connection ports.

® cg\ Align specifies a parallel constraint between the alignment vectors of
the two ports.

® $‘ Rotate specifies a parallel constraint between the rotation vectors of
the two ports.

Appears only when Type is Center and Subtypeis1to2or2to 1.

Specifies what NX uses for the center constraint when you select a face
(cylindrical, conical, or spherical), or a circular edge:
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» Use Geometry — Uses the face (cylindrical, conical, or spherical) or edge
for the constraint.

» Infer Center/Axis — Uses the center or axis of the object.

Lets you select the objects for the constraint.

This option's name may vary slightly to tell you how many objects to select. For
example, this option is sometimes named Select Two Objects, depending on the
settings of other options in the Assembly Constraints dialog box.

Appears only when Type is Center, Fit, Touch Align, or Distance.

Opens the Point Constructor to let you define a point for the constraint.

Appears only when Type is Bond.

Constrains selected objects together so they must move as a rigid body.
Available only when there are two solutions to a constraint.

Shows you the other solution to the constraint.

Appears only for distance constraints when there are more than two solutions.

Lets you cycle through the possible solutions for the distance constraint.

Appears after you select objects when Constraint Type is set to Angle.

Angle

Angle Limits

Displays the angle value between the selected objects and lets you specify the
behavior of the angle when the components are moved.

If you want the angle you specify to:

» Remain constant - Select the Angle IE check box to define the constraint as
driving. Other constraints will adjust as necessary.

e Clear the Angle D check box to define the constraint as a driven constraint.

Appears after you select objects when Constraint Type is set to Angle.

Angle Limits

Distance

Lets you specify a range of motion for the components by defining an upper limit,
a lower limit, or both for the angle constraint.

Appears after you select objects when Constraint Type is set to Distance.

Distance

Displays the distance value between the selected objects and lets you specify the
behavior of the distance when the components are moved..

If you want the distance value you specify to:

» Remain constant - Select the Distance check box to define the
constraint as driving. Other constraints will adjust as necessary.
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e Clear the Distance El check box to define the constraint as a driven
constraint.

Appears after you select objects when Constraint Type is set to Distance.

Distance Limits

Settings

Arrangements

Dynamic
Positioning

Associative

Move Curves
and Routing
Objects

Dynamic
Update of
Routing Solids

Lets you specify a range of motion for the components by defining an upper limit,
a lower limit, or both for the distance constraint.

Specifies how the constraints affect component positioning in other
arrangements:

e Use Component Properties — Specifies that the setting
of Arrangements on the Parameters tab of the Component
Properties dialog box determines the positions. The Arrangements setting
can be either Individually Positioned or Same Position in All.

e Apply to Used — Specifies that the constraint is applied to currently used
arrangement.

Specifies that NX solves constraints and moves components as you create the
constraints.

If the Dynamic Positioning check box is not selected, NX does not solve
constraints or move objects until you click OK or Apply in the Assembly
Constraints dialog box.

Specifies that constraints are added to the assembly when you close
the Assembly Constraints dialog box. The constraints are saved when you save
the component.

Constraints created when the Associative check box is cleared are transient.
They are deleted when you click OK to exit the dialog box or when you

click Apply.

Note When you define an assembly constraint, the state of
the Associative check box determines whether or not the constraint is
associative. You can define multiple associative and nonassociative
assembly constraints before clicking OK or Apply.

Moves routing objects and related curves when they are used in a constraint.

Dynamically updates the routing objects when you move connected components.

Example In this assembly, when you move the compartment (1) and substations
(2) and (3) along the X-axis, NX automatically updates the routing
stock to accommodate the change.
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Lets you simplify the Constraint Type group to include only the types you use.

lcE:nabIed_ Select or clear the check box beside a constraint type to display or remove it from
onstraints the group

Limits on distance and angle constraints

If you want to limit the range of motion for a component positioned by a distance or angle constraint,
you can define an upper or lower limit, or both, for the constraint value. Limiting the range of motion is
useful, for example, when you want to prevent collisions between components.

You can define limits in any of the following situations:
s When you create a distance or angle constraint using the Assembly Constraints command.

¢ When you edit a distance or angle constraint, for example, when you right-click the constraint in
the Assembly Navigator or Constraint Navigator and choose Edit.

¢ \When you move a component by constraints, for example, when you open the Move
Component dialog box and choose By Constraints from the Motion list.

* When you edit the constraint in arrangements, for example, by right-clicking the constraint and
choosing Edit in Arrangements.

Driving constraints and driven constraints

Distance constraints and angle constraints are either driving constraints or driven constraints.
e For a driving constraint, you define a value for the angle or distance. If the constraint has defined

limits, you should make sure that the value you specify is between the limits. Otherwise, as
designed, the constraint fails.
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Note Distance and angle constraints created in previous versions are driving constraints.

e For adriven constraint, the angle or distance varies within defined limits for movement that is
driven by other constraints or directly by moving the component using the Move
Component command.

You can define a distance or angle constraint as driving or driven using either of the following
methods:

e Inthe Assembly Constraints dialog box, in the Distance group or Angle group, you can select
or clear the checkbox. The constraint is a driving constraint if the check box is selected . If the
checkbox is not selected D the constraint is a driven constraint.

Note The options also appear in the Move Component dialog box when you move components
by constraints.

¢ Inthe Assembly Navigator, you can right-click a distance or angle constraint. If the constraint is
a driving constraint, the Make Driven command is available. If the constraint is a driven
constraint, the Make Driving command is available.

If you want to see which constraints in your assembly are driven constraints, you can open
the Constraint Navigator and scroll to the Driven column. A driven distance constraint has

an ‘?‘h icon, and a driven angle constraint has an V icon. Distance and angle constraints that do not
have an icon are driving constraints.

Differences between Align and Align/Lock constraints
Align/Lock constraints

Use an Align/Lock constraint type to:

e Align two axes in different components while preventing any rotation about the common axis.
The Align/Lock constraint behaves like an Align constraint except for this lack of rotation.

e Align two circular arcs in different components while preventing the components from rotating
relative to each other. The Align/Lock constraint behaves like a Concentric constraint except for
this lack of rotation.

In the following figure, the bolts have the same constraints, except the bolt on the left has

an Align constraint between the centerlines of the bolt and hole. The bolt on the right has

an Align/Lock constraint between the same centerlines. The bolt on the left has one rotation degree
of freedom, which means that the bolt can spin around its centerline. The bolt on the right is locked in
place, and therefore has no degrees of freedom.

1 ? 9

Note If you create an Align/Lock constraint when the geometry of both components are already
aligned, as in the previous figure where the centerlines of the bolt and the hole are already
aligned, neither component is rotated when the constraint is applied.

An Align/Lock constraint is useful in situations such as the following:

e You want to position and fully constrain rotationally-symmetric components.
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 You have a component that you want to constrain using an axis, and you want to simultaneously
prevent rotation about that axis. For example, you often use an Align/Lock constraint to position

and lock a bolt in a hole.
Align constraints
An Align constraint is more versatile than an Align/Lock constraint because you can align other
objects besides axes.

An Align constraint may be more useful in situations such as the following:

o When you need components to have the ability to rotate. For example, the blade subassemblies
in this toy helicopter need to be constrained to the propeller shaft so their axes are aligned, but
the blade subassemblies must rotate around the common axis.

e In simple situations, such as when you want to constrain two planar faces.

¢ In situations where some other constraint determines the orientation. For example, if you have a
triangle formed by three struts with holes near their ends and bolts going through the holes. You
would use Align constraints instead of Align/Lock constraints because the length of the struts

determines the angle between them.

1.5.1.3 Assembly constraint notes
Tips for selecting geometry objects

While creating constraints, you can select geometry in a component and drag the component to
another location. If you hold down the Alt key while dragging, the component rotates. This is a fast
way to reposition components, for example, to help you select the geometry you want for the

constraint.

Note Because Fix and Bond constraints are designed to hold components in place, the ability to drag
components is disabled when you create or edit Fix or Bond constraints in order to prevent

accidental movement of the components.
Geometry that is not available for assembly constraints includes the following:

o Faceted geometry

e Geometry that is not a product interface object when the component has a product interface that
restricts geometry selection for assembly constraints. For more information, see Product Interface
dialog box.

e Convergent modeling geometry is often not available because the geometry may be faceted or
have other characteristics that make it not selectable for assembly constraints.

When you constrain to cylinders, cones, or tori, you can select either the axis or face of the object for

the constraint.
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Variable positioning behavior with assembly constraints

You can override a component position so it has a different position in higher-level assemblies than in
its parent subassembly. For more information, see Position override.

Note When you use variable positioning on a component that includes Fix assembly constraints, the
inherited version of each Fix constraint is a Bond constraint. NX converts inherited Fix
constraints to Bond constraints because higher-level Fix constraints could cause undesirable
behavior, such as preventing movement of the parents of the fixed component in higher-level
assemblies. Inheriting to a Bond constraint allows the parent and fixed component to move
together, but restricts independent movement of the fixed component.

Bond constraints that are converted from inherited Fix constraints are identified in
the Info column of the Assembly Navigator and in reports run from the Information menu.

When you open an assembly that includes Fix constraints inherited by variable positioning applied in
an earlier release of NX, the higher-level inherited Fix constraints are converted to Bond constraints.

1.5.1.4 Import a part file with assembly constraints
When you import a part file that has assembly constraints, the constraints are included.

However, when you import a part file that has a constraint with arrangement-specific suppression
states, the imported part uses the suppression state of that constraint in its active arrangement.
Arrangements are not imported with part files, because the assembly that contains the original
component may have different arrangements than the assembly to where the component is imported.

Constraint-related symbols in the graphics window

Image Description

When an assembly constraint is surrounded by { and } brackets in the
graphics window, the constraint is non-associative and will be deleted
when you exit the dialog box where you created the constraint.

Situations where the brackets may appear include the following:

o When the assembly constraint is created in the Move
Components dialog box.

o When the assembly constraint is created in the Assembly
Constraints dialog box while the Associative check box is not
selected.

The brackets only appear in the graphics window. Because the
constraint is temporary, the Assembly Navigator and Constraint
Navigator have no corresponding symbol.

When you select the Prefer Touch option while creating a Touch Align
constraint, a lightning bolt symbol may be temporarily displayed.

The symbol indicates that NX has not yet determined whether the
constraint is a Touch constraint or an Align constraint. NX switches
between the types as needed to make the constraint solve. The
lightning bolt symbol disappears when NX makes its decision, or when
you exit the dialog box, whichever is sooner.

1.5.1.5 Constraints in arrangements

When you make a change that requires NX to solve constraints, in order to speed up the solving time,
NX makes the updates only in arrangements that are in use. Arrangements that are in use include the
following:

e Any arrangement that is the active arrangement of the displayed part.

e Any arrangement that is used in a component of the displayed part, including the work part in
design-in-context cases.
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e Any arrangement that is used for the definition of a WAVE-linked feature or geometric
expression.

e Any arrangement used in an exploded view of the displayed part or a sequence of the displayed
part.

e Any arrangement used in a drafting view that belongs to the displayed part.

For each unused arrangement, NX postpones solving the constraints until one of the following occurs.
e The unused arrangement is put into use.

e The assembly is saved.

Constraints in all arrangements must be solved when an assembly is saved to prevent potential
problems with Teamcenter Integration with NX or with programs such as NX/Open.

Use the Show and Hide Constraints command to control the visibility of:

¢ Selected constraints
e All the constraints associated with selected components
e Only the constraints between selected components

You can also control the visibility of components whose constraints are hidden after a show and hide
constraints operation.

Application Assemblies

L
Command Finder|Show and Hide Constraints ""’
Show only selected assembly constraints

L
1. Choose Assemblies tab—Component Position group—Show and Hide Constraints “’/ !

The Show and Hide Constraints dialog box opens.

.$_

2. While Select Component or Constraints is active, select one or more of the following in

the graphics window:

o Components whose constraints you want to show or hide

o Constraints you want to show besides the constraints affected by selected components
3. Inthe Settings group, set Visible Constraints to one of the following:

o Choose Between Components if you want only constraints between your selected
component, plus any constraints you select directly in step 2, to be visible.

o Choose Connected to Components if you want all constraints that belong to your selected
components, plus any constraints you select directly in step 2, to be visible.

4. Select the Change Component Visibility check box if you want the components that are not a
part of the results to be hidden.

5. Select the Filter Navigator check box if you want components that are not a part of the results to
be placed under a More node in the Assembly Navigator.

6. Choose OK or Apply.

1.6 Application exercises
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LESSON 2: ADVANCED SHEET METAL DESIGN WITH NX: TOOLS AND
TECHNIQUES

Objective: By the end of this training unit, the trainees will be able to:

- Understand the sheet metal model, the process of creating products from sheet metal
- Understand the material standards applied in sheet metal
- Understand drawing commands and modifying commands with NX software to create sheet
metal product models
- Draw simple and complex sheet metal product models with NX software
- Create technical drawing from sheet metal with NX software
Contents:
2. 1 Getting started with Sheet Metal with Siemen NX software

2.1.1 Sheet Metal

The Sheet Metal application provides an environment for the design of sheet metal parts used
in machinery, enclosures, brackets, and other parts normally manufactured with a brake press.

Figure 2.1: Product design sheet metal

You can:

- Create uniform thickness sheet metal parts using basic features such as flanges, tabs, and jogs.
You can also close corners, and create cutouts and stiffening features.

- Create complex sheet metal parts by designing the solid model in the Modeling environment and
then converting it to a sheet metal part.

- Some Modeling commands are also available in the Sheet Metal application that can be used to
create holes and slots, as well as copy, paste, pattern, and mirror sheet metal features.

- Import, clean up, and convert a non-sheet metal part to a valid sheet metal part.

- Export flat pattern data of sheet metal parts to other applications.

Starting a Sheet Metal part To start a new sheet metal part, click Home > Standard > New

on the ribbon, and choose Sheet metal template on the New dialog/OK

204
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Figure 2.2: Create design a Sheet metal interface
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21.2 Recommended workflow to create a simple part

7~ =

*_ || Sketch the shape

"|_| — \ Sketch the shape of the base feature, or use an existing sketch
L — || orsection.

Construct the base feature

& | Construct the base feature to define the part's shape.

\"V‘/ This base feature is normally a Tab, but you can also create a
Contour Flange or a Lofted Flange.

Add features

/| Add features such as Flanges, Jogs, or Bends, to further define
_ | the shape of the formed sheet metal part.
.
i >

|

i Unbend and add punch features or cutouts

Unbend the bend areas where needed, and place Holes,
: Cutouts, Beads, Dimples, or Louver features on the part.

l

i Create a Flat Pattern
Create a Flat Pattern of the part for drafting and later
- manufacturing.

Chart 2.1: Recommended workflow to create a simple part
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2.1.3 Recommended workflow to create enclosures with odd shapes or angles
g~ - 5

- | Create a solid body

l Create a solid body that encompasses the interior volume of the
final enclosure shape, using tools in the Modeling application.

!

| Wrap the solid body with sheet metal

Use the Sheet Metal from Solid command to wrap the
' solid body with sheet metal.

Add features

_ | Add features such as Flanges, Jogs, or Bends, to further define
 the basic shape of the formed sheet metal part.

r

Unbend to add more features

Unbend the bend areas where needed, and place Holes,
| Cutouts, Beads, Dimples, or Louver features on the part.

h 4

i Rebend the unbent areas

Rebend the flattened bend areas to complete the part.

!

i Create a Flat Pattern

- [@fj . Create a Flat Pattern of the part for drafting and later
S==S | manufacturing.

s ' ..|

Chart 2.2: Recommended workflow to create enclosures with odd shapes or angles
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2.2. Sheet metal material standards and sheet metal preferences
2.21 Sheet metal material standards

Safely withstanding the expected maximum load without permanent deformation (or to stay
within the specified deflection) is a basic requirement for any product. The “resistance” against the load
is a function of the cross-section and the mechanical properties (or in loose terms the “strength”) of the
material. The most important mechanical properties are the yield strength, tensile strength, and
elongation.
The most common Sheet Metal Part Properties are type of material and bend allowances.

You can define these properties by clicking File > Preferences > Sheet Metal. On the Sheet
Metal Preferences dialog, select Parameter Entry > Value Entry and type-in values in the Material
thickness, Bend radius, Relief depth, and Relief width boxes. These parameters are illustrated in
the following figure.

,_'—'—""_“—’—’—,\"\
,_,af"""‘rf \\‘.
s )
_,...-—"'"_F'_F—F.-FFF ‘\‘\
r/) Relief width
W k
N\ - — N[ —
N\ T ‘
N R
N = -
- - b T Bend radius
Material thickness e hY

_ m(R + KT)A

k4 180

BA = Bend Allowance

R = Bend Radius

K = Neutral Factor = t/T

T = Material Thickness

t= Distance from inside face to the neutral sheet
A =Bend Ang

T

Figure 2.3: These parameters are illustrated in the following figure

You can also define the bend allowance by using a bend table or your own bend allowance
formula. To enter a bend allowance formula, select the Bend Allowance Formula option and type-in a
value in the box. Click OK after specifying values on the Sheet Metal Preferences dialog.

Next, type-in a value in Neutral Factor Value box. The Neutral Factor is the ratio that
represents the location of neutral sheet measured from the inside face with respect to the thickness of

208 |8
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the sheet metal part. The Neutral Factor defines the bend allowance of the sheet metal part. The
standard formula that calculates the bend allowance is given below.

2.2.2 Sheet metal preferences
Bend parameters for sheet metal features

Bend parameter Description
Bend Radius Sets the inside radius of a bend.

Bend Angle Sets the bend angle for the feature. The value must be greater than zero
and less than 180 degrees.

Bend Relief Square

Round

None

Extend Relief [¥] check|[SPecifies whether to extend the bend relief to the edge of the part.
box
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I —

Extend Relief = Extend Relief = D

Depth, Width of the bend||Sets the depth (D) and width (W) of the reliefs.
relief

D

Neutral Factor Sets a value for the neutral factor.

The neutral factor depends on the properties of the material that is being
bent. While bending, the outer surface of the bend is under tension and
the inner surface is under compression. There is a layer in between that
is neither in compression nor tension. The ratio of the distance of thi
surface from the inner bend to the thickness is the neutral factor. The
default value is 0.33 and the value typically ranges from 0 to 1.

Corner Relief Specifies that you want to apply corner relief to features that are adjacent|
to the feature that you are constructing.

Bend Only

Applies corner relief only to the bend portion of the adjacent
features.

Bend/Face

Applies corner relief to both the bend and face portions of the
adjacent features.
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Bend/Face Chain

Applies corner relief to the entire chain of bends and web faces
of the adjacent features.

None

Applies no corner relief.

Table 2.1: Bend parameters for sheet metal features

2.3 Creating sheet metal parts and features

2.3.1 Sheet Metal from Solid

Use the Sheet Metal from Solid command to create a sheet metal body using a solid body to
model it. The solid represents the inner void of an enclosure. You select the faces from the solid to be
panel (web) faces, and edges between the faces to be bend regions. You specify bend properties, or
use the ones you established in the Sheet Metal Preferences dialog box. NX creates the model based
on your inputs. You can then treat this body as you would any other sheet metal body.

Resulting sheet metal body

Steps to do
1. Create a solid body in Modeling.
2. Start Sheet Metal.
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3. Choose Home tab— Convert group— Sheet Metal from Solid é .
4. Select the web faces that you want to include in your sheet metal body.

As you select the web faces, NX performs the following actions:

Infers the bend edge and adds it to the List group.

Shows a preview of the result (if there is only one logical bend option).

Displays a message informing you that the sheet metal from solid preview may not
exactly match the resultant feature.

0 0 0

In this example, two faces are selected and only one bend edge is shared between them. NX
displays a preview.

5. Click OK in the message box.
6. In the List group, under the ID column, select the newly added bend edge (Bend1) and specify
the values for bend parameters and bend relief.

In the Bend Parameters subgroup:
o Bend Radius =5
In the Relief subgroup:
o Bend Relief = Square
o Depth=5
o Width=5

The selected bend edge and the Bend Radius, Bend Relief, Width, and Depth columns under
the List group reflect the changed values.

7. Select more web faces that you want to include in your sheet metal body.
As you select web faces, NX infers the bend edge and adds it to the List group.
If you select faces where there might be more than one bend edge, you must select one of the
bend edges.

8. Select the bend edge.

212
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If you select an appropriate combination of faces and edges (creating a body that can be
flattened), the preview reappears.

NX creates a clean open corner at the three bends.

9. Select more web faces that you want to include in your sheet metal body.

10. In the List group, under the ID column, individually select the bend edges (Bend2, Bend3,
and Bend4), and specify the values for bend parameters and bend relief.

For this example:

)

' Bend Radius | Bend Relief . Width | Depth
‘-Bend2 ‘ 5 [ Square ‘ 5 _ [ 5
Bend3 | 5 | Round | 5 | 5
|Bend4 ‘ 5 | Square ‘ 4 | 4

11. (Optional) In the Thickness group, click Reverse Direction X to thicken the sheet metal body
in the opposite direction.

Note:

By default, the sheet metal body is thickened on the outside of the solid model.
12. In the Settings group, select the Hide Original check box.

NX hides the parent body and you can view the resultant sheet metal body clearly.
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13. Click OK to create the sheet metal body.

14. (Optional) Create a flat solid view of the sheet metal body.

2.3.2 Basic sheet metal commands
2.3.2.1. Tabs and flanges
2321.1Tab

Use the Tab command to create a base feature or a tab by extruding a sketch along a vector
by a specified thickness value. You can also use this command to create a secondary tab if the work
part includes existing sheet metal features. You can do this by adding material to existing faces and
bend regions of an existing sheet metal part.

Tab with multiple cutouts
You can create a tab with multiple cutouts by selecting multiple inner closed profiles.

. N

Base tab ‘ Secondary tab
Tab with multiple bends
You can create a tab with multiple bends, such as a mating bracket in an assembly, using the assembly
references.
214
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Adding material to an existing sheet metal body
You can add material to a specified sheet metal body when multiple bodies are present in a part file.

a. Create a base tab with cutouts

This example shows how to create a tab using a section.

Choose Home tab— Base group— Tab: I
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Create the sketch shown.

Finish the sketch.

In the Thickness group, set the Thickness value to 4.

6.

5

Middle-click to create the tab.
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b. Create a multi-bend tab

This example shows how to create a mating bracket with multiple bends.

<

Choose Home tab— Base group— Tab .

In the Multi-Bend References group, click Specify Plane.

If the plane direction is not as shown, double-click the arrow to reverse it.
Select the face shown to specify the first reference plane.

4.

From the Inset list, select Material Outside :9
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From the Parent list, select Plane1.

In the List box for the New plane, the Parent changes from Sketch Plane to Plane1.

Select the face shown to specify the second reference plane.

8.

From the Inset list, select Material Inside 5

In the Section group, click Sketch Section @’
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10.
Note:

Make sure that the sketch plane normal direction and the bend direction are the same. In this example,
both the sketch plane and the Z-axis of the CSYS (which indicates the bend direction) are pointing
downwards.

'EH'"“‘x‘H i

Select the XY plane of the datum coordinate system and click OK in the Create Sketch dialog box.

The sketch plane reorients and NX displays the bend center and bend tangent curves in infinite lines.

11.
Tip:

The selected curves are highlighted in the following graphic.
Choose Home tab— Include group— Project Curve and select the curves as shown to project onto
the sketch plane.

Click OK in the Project Curve dialog box.
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13.
Note:

Make sure that you close the open ends of the sketch and create a closed loop.
Choose Home tab— Curve group— Line and create two lines to complete the sketch as shown.

Right-click and choose Finish Sketch E 2

15.

In the Thickness group, click Reverse Direction x !

16.
Click OK to create the multi-bend bracket.

c. Create a secondary tab across a bend

To create a secondary tab across a bend region, you need to flatten the bend area, create the
tab, then rebend the unbent region. This example uses a part from a computer video card.
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1. Choose Home tab— Bend group— Unbend % :
2. Select the flat face of the tab as the stationary face, then select the bend.

3. Click OK.

<

4. Choose Home tab— Base group— Tab :

In the Type group, the Secondary type is selected by default.

5. Click Sketch Section @ and sketch the profile of the tab you want to add.

)\

6. Select the sketch.

7. Click OK.

8. Use the Rebend % command to return the part to its original shape.
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2.3.2.1.2 Flange
Use the Flange command to create a single flange instance or multiple instances by selecting

a single or multiple base edges.

NX creates multiple flange instances in a single flange feature.

Note:

- NX successfully creates the flange feature, even if some of the flange instances in a set fail.
- A flange consists of a bend region (1) and a web (2). You can add a web at an angle to a planar face
and add a bend between the two.

a. Create a flange
This example shows how to create a flange.

1. Choose Home tab— Base group— Flange §>
2. Select the edge to which you want to add a flange.
\

g

-_
At

—

A preview of the flange appears.

n

=
Tip:

If required, click Reverse Direction X to reverse the direction of the flange.
3. In the Width group, from the Width Option list, select At Center.
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4. In the Flange Properties group, set the flange properties.
For this example:

Width =15
Length = 20
Angle =90
Length Reference = Inside
o Inset = Material Inside
5. Inthe Bend Parameters group, specify values for the bend radius and the neutral factor.
6. In the Relief group, set the following.

O 000

For this example:

Bend Relief = Square
Depth =3

Width =3

Corner Relief = Bend Only
Extend Relief =

o Include Relief In Width = D
7. (Optional) In the Geometry Properties group, select the Use Geometry Mirror and

Pattern check box.
8. Click OK or Apply.

O OO0 0O

NX creates the flange.

|
= .

b. Create a flange matched to a face
This example shows how to create a flange by matching it to the planar face of either the same
part or from other part in design context.

1. Choose Home tab— Base group— Flange §>
2. Select the edge to which you want to add a flange.
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3. In the Width group, from the Width Option list, select Full.
4. Inthe Flange Properties group, set the flange properties.

For this example:

o Length =20
o Match Face = Until Selected
o Length Reference = Inside
o Inset = Material Outside
5. Click on the planar face of the other part.

If the face you select is from another component in an assembly, and you want the flange to

&
update associatively, on the Top Border bar, turn on Create Interpart Link & before selecting
the face.

6. Click OK to create the flange.

The flange is associative to the planar face. If the face changes, the flange changes with it.

c. Create a flange on the edge of a deformed face

This example shows how to create a flange on the edge of a deformed face of a dimple feature.
The dimple feature is of the closed section type and the cutout is created on the face parallel to the
planar face on which the dimple feature is created.

Choose Home tab— Base group— Flange Q
Select the edge to which you want to add a flange.

M =
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3. In the Width group, from the Width Option list, select Full.
4. Inthe Flange Properties group, set the flange properties.

For this example:

o Flange direction = +ZC

o Length =20
o Match Face = None
o Angle =90

o Length Reference = Inside
o Inset = Material Inside
5. In the Offset group, enter an offset value of 10.

6. Click OK to create the flange.

d. Create multiple flange instances
You can create multiple flange instances by selecting multiple base edges. The flange instances

are created within a single flange feature.

Choose Home tabh— Base group— Flange @
Select the edge to which you want to add a flange.
In the Flange Properties group, set the flange properties.

DI

For this example:

o Width Option = Full

225
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Note:

You can create multiple flange instances only when you set the width option to Full or At
Center.
o Length=20
o Angle=90
o Length Reference = Inside
o Inset = Bend Outside
4. Select one or more edges.

As you select edges, you can preview the flange instances.

5. Change the flange properties.
For this example:

o Length =40
o Angle=70

The flange instances, as well as the Length and Angle columns under the List group, reflect the
changed values.

e

6. Click Add New Set ® .

You can add a new set of edges with unique feature parameters to create another set of flange
instances.

7. Select one or more edges.
As you select edges, you can preview the flange instances.
8. In the Flange Properties group, set the flange properties.
For this example:
Width Option = Full
Length = 16
Angle =90

Length Reference = Inside
Inset = Material Inside

O 00O O0O0
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10.

Note:

The values of the first set remain unchanged. Each set of edges has unique feature parameters.
Change the flange properties for the second set of flange instances.

For this example:

o Length=35
o Angle=75

The flange instances, as well as the Length and Angle columns under the List group, reflect the
changed values.

Note:
If there is an interference between flanges on adjacent edges within a set, you can avoid the
interference by applying a miter.

In the Geometry Properties group, select the Miter | | check box.

NX applies the miter and removes the interference.
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11. Click OK to create the flange instances.

NX creates the flange instances in a single flange feature under the Model History node.

2.3.2.1.2.1 Contour Flange
a. Create a base contour flange

1
2.

4.

Choose Home tab— Base group— Contour Flange m :

In the Section group, click Sketch Section 2 , and specify the plane on which you want to
sketch the section geometry.
Sketch the open section.

In the Width group, from the Width Option list, select Symmetric.

In the Thickness group, specify the thickness value.
For this example, the default thickness of 3 is used.

You can modify the options available in the Bend Parameters, Relief, Miter, and Corner groups.
For this example, the default values are used.

Click OK.

b. Create a secondary contour flange

This example shows how to create a chained secondary contour flange. You will close and miter corners
where the two adjacent bends meet. You will also create a gap equal to the sheet metal thickness.

You will start with a base sheet metal tab.

228
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g .

p—

Choose Home tab— Base group— Contour Flange [ﬂ

In the Section group, click Sketch Section' P to create the contour flange section.

w

Select the edge of the tab as the sketch path and then middle-click.

i

T

Create the sketch shown.

The start point of the sketch must be on the selected edge.

DPP — Vocational Training for Smart Manufacturing in Machine Tools 229



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Finish the sketch.

In the Width group, do the following:
e Width Option = Chain

<
e Click Select Edge
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Do the following:

Corner group:

Close Comer =
Treatment = Circular Cutout

¢ Miter Comer =

Corner Setting group:
Gap = Sheet_Metal _Material_Thickness

9.

v

Middle-click to create the contour flange.

c. Create wrapped features
This procedure shows how to use the Contour Flange command to construct features that are

wrapped around a cylinder. For example, you can use this procedure to create parts that are made by
rolling perforated material.

1. Choose Home tab— Base group— Contour Flange m ;
2. Inthe Type group, select Base.
3. Sketch an arc that has an included angle of slightly less than 360 degrees.

Lc G
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When you create the arc:

o There must be a slight gap where the ends of the rolled material meet, else the part will
not unbend.
o The material side and the material thickness of the contour flange must be defined such
that it does not close the gap.
4. In the Width group, set the width of the contour flange.

For this example:

o Width Option = Finite
o Width = 60

5. Click OK.

After you have constructed the contour flange, you can unroll it using the Unbend command.

6. Choose Home tab— Bend group— Unbend %
7. Select an edge of the part, as the stationary edge.

.

8. Select the bend as shown in the following graphic.
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If the Preview check box is selected, the unrolled state of the part appears as shown below.

9. Click OK to unbend the part.

You can add features, such as a pattern of holes, to the flattened part, and then use
the Rebend command to re-roll the part. You can fill the gap by adding an extrude.

2.3.2.1.2.2 Lofted Flange
Use the Lofted Flange command to create a base or secondary feature between two sections

where the lofted shape is a linear transition between the sections. The two sections must be open and
on parallel reference planes.

You can:

e Create conical bend regions.

o Create transition regions between two different sections.

The following example shows a round to square transition that is used in HVAC technology.
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You can create a lofted flange by using bend segments to generate a flange surface that has a constant
bend radius. This flange is developable.

You can use different bending methods to create the following:

* Non-planar, non-cylindrical, and non-conical faces.

e Planar, cylindrical, and conical faces.

e Planar faces and cylindrical bends.

When you create a lofted flange that has a conical region or a cylindrical region, NX triangulates
that region to planar faces and cylindrical bends.

When you create this type of a flange, you can:

o Create a relief on the bend segments. When you use a relief, NX trims the interfering
bends and helps to easily flatten the resulting model. You can specify a linear or a
spherical relief.

o Specify how each bend can be divided using the following parameters.

= Bend segments
= Chord height

= Segment length
= Segment angle

Create a lofted flange
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This example shows how to create a transition from a square section to a round section by creating a
lofted flange between two sections.

NS

e

Note:
If there are no sheet metal features in the part, a base lofted flange is created by default.

Choose Home tab—Base group—Lofted Flange a

In the Start Section group, select the start curve of the flange that you want to create.

In the End Section group, click Select Curve, and then select the end curve of the flange that you want
to create.
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In the Bend Segments group, set the following.

Bending Method = Bends
Divide Parameter = Bend Segments
Number of Bend Segments =10

In the Bend Parameters group, accept the default values of the Bend Radius and Neutral Factor.

— L

In the Relief group, set the following.

For this example:

« Auto Relief = Linear >~
e Trim End Plates =

236
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Click OK.

2.3.2.1.2.3 Hem Flange
Use the Hem Flange command to modify an edge of a sheet metal part by folding it onto itself
for safe handling or to increase the stiffness of the edge.

The hem flange is always created as a secondary feature on a base part.
You can create hem flanges on:

e Linear edges and curved edges of a part.

o Connected curves that include a curved edge. You can also create a flange on the linear
edge of such hem flanges.

In the following example, a flange is created on the linear edge of a hem flange, and then both
the flanges are flattened.

Create a hem flange
This example shows how to create an S-type hem flange on a tab .

1. Choose Home tab— Bend group— Hem Flange Q.
2. In the Type group, from the list, select S-Type @-‘J !
In the Edge to Hem group, the Select Edge option is active.

3. Select the edge of the tab on which you want to create the S-type hem flange .

237
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4. In the Inset Options group, from the Inset list, select Bend Outside iH \
5. In the Bend Parameters group, set the following:

Equal Radii =
1. Bend Radius =1
2. Flange Length = 20
4. Flange Length = 20
6. In the Relief group, set the following.

o Bend Relief = Round
o Depth = 3.0000
o Width = 3.0000
7. Click OK to create the S-type hem flange .

2.3.21.24 Jog

Use the Jog command to create an offset or a step in a tab. You can use small jogs to provide
clearance or rigidity to a part. The section for the jog must consist of a single profile that is linear or
oblique across a planar face. NX creates the jog at any angle between 0 and 180° by lifting material on
one side of the jog line and adding a flange between the two sides.

If the part has multiple sheet metal bodies, you can specify the target face on which you want to create

‘ = &S

Create a Jog on a tab

1. Choose Home tab— Bend group— Jog §> ;
2. Select the top face of the tab to create a section for the jog.
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a. Sketch a line for the jog section as shown.

3. Inthe Jog Properties group, set the following:

a. Height=20
b. Angle =45
Note:

You can specify an angle between 0 and 180°. Ensure that the angle you specify supports
the creation of an offset web.

c. Height Reference = Outside

d. Inset = Material Inside

e. Extend Section = D
4. In the Bend Parameters group, accept the default values for Bend Radius and Neutral Factor.
5. In the Relief group, set the following:

a. Bend Relief = Square

b. Depth = 3.0000

c. Width = 3.0000

d. Corner Relief = Bend Only
6. Click OK to create the jog.

2.3.2.2. Corners
2.3.2.2.1 Closed Corner

Use the Closed Corner command to modify two flanges in one operation and to close the
corner where the two flanges meet. During flattening, the comer and relief geometry are made
appropriate for a flat pattern.

When you use the Closed Corner command, you can create:

o Mitered closed corners using the finite cutting methods for the U Cutout and V Cutout type of
corner treatment options.
o Cutting by limiting the cut up to the bend area. This method is intended for laser
cutouts.
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“F

(1) depicts a cut that stops at the boundary of the bend.
o Cutting by controlling the length of the cutout. This method is intended for punching

l\“

(1) depicts a cut limited by the specified length.
o Mitered closed corners on bends that have unequal bend radii or bend angles.

o Overlapping webs with mitered corners. This is applicable for the Close and Relief type of
Closed Corner feature.

o Corners between flanges that bend in opposite directions.
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o Corners between a wide range of corner angles.

The example shows closed corners where all the corner angles have different values.

Pip!

o Mitered closed corners with a smooth transition from the miter to the cutout edges for
the Circular Cutout, U Cutout, V Cutout, or Rectangular Cutout type of corner treatment

options.

This smooth transition ensures that any jerks or jitters while tracing the tool path are avoided.

o Reliefs without creating a corner.

a. Close a corner across two adjacent bends

This example shows how to close a corner between two bends. The closed corner has a circular
cutout type of corner relief treatment.
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Choose Home tab— Corner group— Closed Corner @ :
From the Type list, select Corner and Relief.

Select the bends adjacent to the corner you want to close.

In the Corner Properties group, specify the corner parameters.

PONS

For this example:

Treatment = Circular Cutout
Overlap = Closed

Gap=0

Miter Corner =

o Blend Miter =
5. In the Relief Properties group, specify the relief parameters.
o Origin = Bend Center
o Diameter=5
o Offset=2.5
6. Click OK to close the corner.

O 0O 00

b. Close a corner across two adjacent bends using a finite cutting method

This example shows how to close a corner between two bends using a finite cutting method.

The closed corner has a V cutout type of corner relief treatment.

Choose Home tab— Corner group— Closed Corner @ !

From the Type list, select Corner and Relief.

Select the bends adjacent to the corner that you want to close.

In the Corner Properties group, specify the parameters for the corner.

PON=

For this example:

Treatment = V Cutout
Overlap = Closed
Gap=1

Miter Corner =

Blend Miter =
o Blend Miter Radius =5

5. In the Relief Properties group, specify the parameters for creating the relief.
o Cut Method = By Path

Origin = Corner Point

Diameter = 15

Offset =0

Angle1=25
o Angle2=20

6. Click OK to close the corner.

O 0O 0 0O0

O 0 0 O
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c. Close a corner by limiting miter propagation
This example shows how to close a corner by limiting miter propagation.

-

1. Choose Home tab— Corner group— Closed Corner @
2. From the type list, select Corner and Relief.
3. Select the bends adjacent to the corner that you want to close.

4. Inthe Corner Properties group, specify the parameters for the corner.
For this example:

Treatment = Circular Cutout
Overlap = Side 1
Gap=1
Miter Corner =
Blend Miter =
o Blend Miter Radius = 0.5
5. In the Miter Limits subgroup, select the first edge to limit the miter.

c 0 000

NX creates the miter and stops at the first selected edge.

e

6. (Optional): In the Miter Limits subgroup, select the second edge to limit the miter.
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NX creates the miter and stops at the second selected edge.

7. In the Relief Properties group, specify the parameters for creating the relief.
o Origin = Corner Point
o Diameter =5
o Offset=0

8. Click OK.

The corner is closed and the miter is applied at both the sides.

2.3.2.2.2 Three Bend Corner
Use the Three Bend Corner command to close corners where three adjacent bends with equal
or unequal bend radii or bend angles meet. The corner is closed by extending the bends and flanges.

In the example, the three adjacent bends have unequal bend radii and bend angles.

You can:

o Create mitered three bend corners using the finite cutting methods for the U Cutout and V
Cutout type of corner treatment options.
o Cutting by limiting the cut up to the bend area. This method is intended for laser
cutouts.

>
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(1) depicts a cut that stops at the boundary of the bend.
o Cutting by controlling the length of the cutout. This method is intended for punching

operations.
. ‘

(1) depicts a cut that stops at the boundary of the bend.
e Create a mitered three bend corner to avoid intersecting flanges.

g M

e Blend the mitered edges and create a smooth transition from the mitered edge to the cutout
edge to avoid jerks or jitters while tracing the tool path.

& A8

o Add offsets to the cutouts that are created at the corner where three adjacent bends meet.
You can create the offset from the center of the bend or from the corner point of the bend.

Offset = 0 mm Offset (1) =6 mm
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o Specify the width of the gap between overlapping flanges in the flattened state by setting
a Flange Clearance value.

Flange Clearance = 0 mm Flange Clearance = 3 mm

a. Close a corner where three adjacent bends meet
This example shows how to close a corner where three adjacent bends that have equal bend
radii meet. You will close the corner using the Circular Cutout corner treatment option.

|
1. Choose Home tab— Corner group— Three Bend Corner @ |
2. Select the bend faces adjacent to the corner.

3. Inthe Corner Properties group, from the Treatment list, select Circular Cutout E
4. In the Relief Properties group, specify the diameter of the circular cutout.

For this example, Diameter = 8.
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5. Click OK to create the Three Bend Corner feature.

B. Close a three bend corner with mitered edges using a finite cutting method

This example shows how to close a corner where three adjacent bends with unequal bend radii
meet. You will create a mitered three bend corner and blend the mitered edges using a finite cutting
method to create a smooth transition from the mitered edge to the cutout edge.

£

1. Choose Home tab— Corner group— Three Bend Corner @
2. Select the bend faces that are adjacent to the corner.

3. In the Corner Properties group, specify the parameters for the corner.
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For this example:

Treatment = U Cutout
Miter Comner =

Blend Miter =
o Blend Miter Radius = 2.5
4. In the Relief Properties group, specify the parameters for creating the relief.

O 0 O

For this example:

Diameter = 15
Cut Method = By Tool
Origin = Corner Point
Offset=0
o Length =20
5. In the Settings group, in the Flange Clearance box, enter 2.5.

O 00O

6. Click OK.

2.3.2.2.3 Break Corner
Use the Break Corner command to round or chamfer sharp corners of a tab or flange.

248 DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

When you create blends on thick edges, to save design time, you can filter out invalid edges.
Round a sharp corner on a tab

This example shows how to round the sharp corners of a tab.

1. Choose Home tab— Corner group— Break Corner S :
In the Edge to Break group, the Select Face or Edge option is active.
2. Select the face of the tab.

4

3. In the Break Properties group, for this example, set the following:
Method = Blend
Radius =10

(

4. Click OK to round the sharp corners.

(

2.3.2.3. Bend, unbend, and rebend
2.3.2.3.1 Bend

Use the Bend command to modify the model by bending material on one side of a sketch line,
adding a bend between the two sides.

You can create a bend on a planar face of a sheet metal body.

If the part has multiple sheet metal bodies, you can specify the target face on which you want to create
the bend.
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You can create a bend across existing Bead, Dimple, or Drawn Cutout features. When you create such
bends, the bend line must pass completely through the deform features.

In the example, a bend is created across an existing Bead feature.

Note To create a cutout on a bend that you want to joggle, you must first joggle the bend before you
create the cutout.

a. Create a bend on a tab

1. Choose Home tab— Bend group— Bend @ )

2. Click Sketch Section @ to specify the plane on which you want to sketch the section
geometry.

For this example, the planar face of the Tab feature is selected.

3. Create the sketch to define the bend center line.
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5. In the Bend Properties group, set the following:
a. Angle =60

b. Click Reverse Direction X to reverse the bend direction.

c. Click Reverse Side x to change the side of the part to move. The direction arrow
points towards the portion that will move.

6. Click OK to create the bend.

b. Create cuts in bend regions

This example shows the typical workflow for making holes or similar cuts in Sheet Metal. You unbend
any bend regions that the cuts will intersect, make the cuts, and then rebend the bend areas.

You will use the Unbend, Hole, and Rebend commands.

1.

v

p—

Click Unbend % :
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Select the stationary face.

Select the bend region that you want to unbend.

NX unbends the bend and opens the Hole dialog box.

Select the flattened bend region as the sketch placement plane.
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In the Sketch, create a circle as shown, and then click Finish ‘F ‘

In the Hole dialog box, set the following:

* Type = General Hole

* Form and Dimensions group
Form = Simple

* Dimensions subgroup
Depth Limit = Through Body

8.

¢ I

e

Click Rebend %

NX creates the hole and opens the Rebend dialog box.

-
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Select the bend region that you want to rebend.

10.

Click OK to rebend the part and close the Rebend dialog box

2.3.2.3.2 Unbend
Use the Unbend command to unbend a portion of the part to construct cutout features, hole
features, or deform features across a bend. You can later reform the bend to represent the true formed

state of the model.
&- x

1. Choose Home tab— Bend group— Unbend %
2. Select a planar face that remains stationary during the unbending operation.

a. Unbend a part

3. Select the bends you want to unbend.

4. Click OK to unbend the part.
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Note:

If you create a part that intersects itself at any point during its development, either when creating
it or when unbending or rebending, any further unbend or rebend operations may result in an error. If
this happens, roll the part back to the step before the self-intersection and try to correct the self-
intersecting condition.

2.3.2.3.3 Rebend
Use the Rebend command to return an unbend feature to its previous bent state. Any features
added after the unbend operation are properly repositioned during the rebend operation.

a. Rebend a part
This example shows how to rebend and unbend feature using a stationary face for reference.

1. Choose Home tab— Bend group— Rebend % )
In the Rebend dialog box, in the Stationary Face or Edge group, click Select Face or

@
Edge | !

3. In the graphics window, select the face to be retained as the stationary face during the rebend
operation.

4. Select the unbend feature that you want to rebend.

A preview of the rebend operation appears.

5. Click OK to rebend the selected bend.
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Note:

If you create a part that intersects itself at any point during its development, either when creating
it or when unbending or rebending, any further unbend or rebend operations may result in an error. If
this happens, use the Edit with Rollback command to roll the part back to the step before the self-
intersection, and try to correct the self-intersecting condition.

2.3.2.4. Bend Taper

Use the Bend Taper command to taper one or both sides of the bend or web by adding or
removing material.

Taper from Bend Taper from Web
(1) Stationary face
(2) Start point of the taper
You can create tapers on:

* Flanges, contour flanges, jogs, or any other bend or web.

In the example, the top face is stationary, and a taper is created symmetrically on both sides of
the bend.

o Partial width flange.

You can create tapers that extend up to the end of the base flange or the tab.
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In the example, a taper that extends up to the end of the stationary face is created.

1 Stationary face

—3

2 Start point of the taper

Note:
You cannot use this command to create tapers on non-cylindrical bends.
a. Create a symmetric taper on a bend and the web

This example shows how to create a symmetric taper on both sides of a selected bend and the
web.

1. Choose Home tab— Corner group— Bend Taper §> .
2. Select a face that remains stationary during the taper operation.

You can select a face or an edge. NX uses the selected face or edge to infer the side that remains
fixed during the taper operation.

3. Select the bend that you want to taper.

Tip:

The arrows indicate the direction in which the edges of the bend and web are tapered. To create
a taper on the other side of the bend, you must change your selection of the stationary face.
4. In the Taper Properties group, from the Taper Sides list, select Symmetric.
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5. In the Bend subgroup, click Taper from Bend @
NX will create a taper that starts at the bend.
6. Set the following parameters:
o In the Bend subgroup:
Taper = Linear
Input Method = Angle
Taper Angle =10
o Inthe Web subgroup:
Taper = Face
Taper Angle =10
7. NXdisplays a preview of the bend taper feature.

b. Create an asymmetric taper on a bend and the web
This example shows how to create an asymmetric taper on either side of a selected bend and

the web.

1. Choose Home tab— Corner group— Bend Taper §> .
2. Select a face that remains stationary during the taper operation.

You can select a face or an edge. NX uses the selected face or edge to infer the side that remains
fixed during the taper operation.
3. Select the bend that you want to taper.
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Note:
The arrows indicate the direction in which the edges of the bend and web are tapered. To create
a taper on the opposite side of the bend, you must change your selection of the stationary face.
4. In the Taper Properties group, from the Taper Sides list, select Both.
5. In the Taper Definition Side 1 group, set the taper parameters for side 1.
For this example:
o Bend subgroup:

Taper from Bend =
Taper = Tangent
Taper Distance =5

Infer Radius =
o Web subgroup:
Taper = Face
Taper Angle =10
NX displays a preview of the taper created on side 1.

e -~

6. In the Taper Definition Side 2 group, set the taper parameters for side 2.
For this example:

o Taper from Bend = @

o Bend subgroup:
Taper = Square
Taper Distance =5

o Web subgroup:
Taper = Face
Taper Angle =5

NX displays a preview of the tqp\sr created on side 1.

7. Click OK to create the taper.

259
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2.3.2.5. Bend Bulge Relief
Use the Bend Bulge Relief command to create bend reliefs that let you avoid bulging,
deformation, and excessive material collection at specified bends.

:_Circular relief __U-sha__ped relief E_V-shaped relief
You can create bend bulge reliefs only for:

e Cylindrical bends that are not deformed.
o Bend edges that are not connected to other bend edges.

Create a bend bulge relief

This example shows how to create a relief at the ends of selected bends to avoid the bulging
of bends.

Choose Home tab— Bend group— Bend Bulge Relief ?

In the Bend Edge group, click Select Edge @‘_

Select the end edge where you want to create the relief.
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In the Relief Properties group, set the -followi-ng.

Relief Type = Circular [m]
Width =6

Depth =3

Click OK.

2.3.2.6. Bridge Bend
Use the Bridge Bend command to create transition geometry by joining two edges on different

sheet metal bodies and then uniting the bodies. You can join two unconnected sheet metal bodies by
creating a Z-shaped, U-shaped, or fold type transition between them.

i \.’ 1Start Edge

U-shaped

2End edge

Z-shaped
If the two sheet metal bodies intersect or overlap, you can create fold transitions to join them.
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Fold transition
(1) Start edge

(2) End edge

If one of the sheet metal bodies has a chained advanced or chained contour flange, you can
select a linear edge as the start edge from the planar web face of the flange and create a fold transition
to join the two sheet metal bodies.

Fold transition defined by bend
(1) Start edge
(2) End edge

This command works the same as the Bridge Transition command in the
a. Create a bridge bend

This example shows how to join two unconnected sheet metal bodies by creating a Z-shaped bridge
bend between them.

1. Choose Home tab— Bend group— Bridge Bend 3 :

2. In the Bridge Bend dialog box, from the Type list, select Z or U Transition ‘\-..
3. Specify the start edge for the transition.

00

4. Specify the end edge for the transition.

00
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5. In the Width group, from the Width Option list, select Full Both Edges E I

i

_

‘

6. In the Bend Properties group, select the Start and End Parameters Equal check box.
7. Inthe Start Edge subgroup, under Bend Parameters, in the Bend Radius row, click Launch

the formula editor ! i ,, and select Use Local Value.

This option overrides the sheet metal preferences and uses the bend radius value that you enter
in the dialog box.

8. In the Bend Radius box, specify the radius of the bend and press Enter.

9. Click OK.

b. Create transitions between intersecting sheet metal bodies
This example shows how to create a fold transition between two intersecting sheet metal
bodies.

Choose Home tab— Bend group— Bridge Bend ? I

2. In the Bridge Bend dialog box, from the Type list, select Fold Transition =
3. Specify the start edge for the transition bend.

4. Specify the end edge for the transition bend.
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5. To trim the bodies and join them with a bend, do the following:
o Inthe Bend Properties group, from the Define By list, select Bend.

o In the Width group, select the Trim or Extend to Bend Tangent check box.
6. Click OK.

NX trims the bodies and creates a bend between the two intersecting bodies.

c. Create a fold transition between planar webs of chained bends
This example shows how to create a fold transition between the planar web faces of chained
bends by selecting a linear edge as the start edge from the planar web face of a chained contour flange.

1. Choose Home tab— Bend group— Bridge Bend @ .

2. In the Bridge Bend dialog box, from the type list, select Fold Transition
3. Specify the start edge for the transition.

-

Note:

Make sure that you select the start edge from the planar web face of the chained contour flange.

4. Specify the end edge for the transition.

Note:
Make sure that you select the end edge from a body that does not contain a complex feature such
as a chained advanced or a chained contour flange, or a lightening cutout, or a joggle.

5. In the Width group, from the Width Option list, select Full Both Edges =18
6. Inthe Bend Properties group, from the Define By list, select Bend.
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7. Click OK.

NX creates a bend between the two planar web faces.

2.3.2.7. Punch
2.3.2.7. 1 Dimple

Use the Dimple command to lift an area of the model inside a sketch that simulates a stamping
tool. You can create an indentation in a sheet metal part using a sketched section as the dimple outline.

Like the Drawn Cutout command, the Dimple command makes an indentation in the sheet
metal part, using a sketched section as its outline. The difference between the two is that a Dimple
feature has a bottom face whereas a Drawn Cutout feature does not.

-

B

You can create dimples on bends in the folded or flattened state. A dimple created on a bend
in the folded state does not wrap around the bend. You can also create dimples on deform features in
sheet metal parts.

Ditiples o fiatiened eylindical berd Dimple on a flattened non-cylindrical bend

Dimple on a formed non-cylindrical bend

Dimple on a formed cylindrical bend

Dimple across deform features
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a. Create a dimple

1. Choose Home tab— Punch group— Dimple Q

2. In the Section group, click Sketch Section '@ to create a sketch that defines the section
geometry.

For this example, a sketch is created on the top face of the tab.
Note:

You can also create a sketch on the bottom face of the tab. In any case, NX creates the dimple
with consistent depth irrespective of the sketch position.

(-

X

A closed section must not touch any part edges.

If you want to use an open section, the open ends must intersect the part edges. If you create an
open section where the curves do not intersect the outer edges of the part, NX extends the ends
of the section curves tangentially until they either intersect one another or intersect the edges of
the part.

3. Inthe Dimple Properties group, specify the depth parameters for the dimple.
For this example:

o Depth=15
o Side Angle = 20

o Side Walls = Material Outside
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4. In the Settings group, specify the parameters to blend the edges of the dimple.

For this example:

Blend Dimple Edges =
Punch Radius = 0.5
Die Radius =1

Blend Section Corners =
Corner Radius = 0.5

o
o
o
o
o

5. Click OK to create the dimple.

N

b. Create dimples across bends in the formed state
When you create dimples on bends without first flattening the bend, the dimple does not wrap around

‘
é

1. Choose Home tab— Punch group— Dimple

2. Inthe Section group, click Sketch Section @ :
3. Select a face to specify the sketch plane and click OK.

Z
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4. Sketch a rectangle.

i

|

|

5. Finish the sketch.

6. Inthe Dimple Properties group, set the following properties:

o Depth

o Side Angle

o Side Walls
7. In the Settings group, ensure that the Blend Dimple Edges check box is selected.
8. Click OK.

2.3.2.7. 2 Louver
Use this command to create a customized vent by piercing the model along a single sketch
line.

Louver features cannot be flattened.
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Create a louver
This procedure shows how to create a formed louver feature.

1. Choose Home tab— Punch group— Louver_:‘:$>,

2. In the Cut Line group, click Sketch Section @ and select the sketch placement face as
shown in the following graphic.

3. Sketch a line as shown in the following graphic and click Finish IE to exit the Sketch.

4. In the Louver Properties group, set the following:
o Depth=8
o Width=15
o Louver Shape = Formed

5. Click OK to create the louver.

2.3.2.7. 3 Solid Punch
Use the Solid Punch command to add a sheet metal feature that inherits its shape from the

tool body.
Example: Type = Punch
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T

(1) Target face

(2) Tool body
(3) Resulting solid punch feature

Example: Type = Die

NG NG o

(1) Target face
(2) Tool body
(3) Resulting solid punch feature

You can create other sheet metal features such as a flange, beads, or dimples, on the face of
a solid punch feature which is parallel to the target face.

=t

(1) Target face
(2) Tool body
(3) Resulting solid punch feature

Create a solid punch feature

-

=]
1. Choose Home tab— Punch group— Solid Punch |<ﬁ’|
2. Inthe Type group, from the list, select Punch |i L
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3. Select the target face that you want to punch.

4. Select the tool body.

5. In the Settings group, set the following.
Blend Edges =h
Constant Thickness =
Centroid Point =

Hide Tool Body =
6. Click OK.

2.3.2.7. 4 Drawn Cutout
Use this command to cut an area of the model inside a sketch that simulates a stamping tool.

Similar to the Dimple command, the Drawn Cutout command makes an indentation in the sheet metal
part, using a sketched section as its outline. The difference between the two is that a Dimple feature
has a bottom face whereas the Drawn Cutout feature does not.

You can also create a Drawn Cutout feature across cylindrical bends in the unbent state. The Drawn
Cutout feature can have an open or a closed section.

el
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Create a drawn cutout
1. Choose Home tab— Punch group— Drawn Cutout @
2. In the Section group, click Sketch Section @ to create a sketch that defines the section
geometry.
For this example, a sketch is created on the top face of the tab.

Note:

You can also create a sketch on the bottom face of the tab. In any case, NX creates the drawn
cutout with consistent depth irrespective of the sketch position.

A closed section must not touch any part edges.
If you want to use an open section, the open ends of the section must intersect the part edges.
3. In the Cutout Properties group, specify the following parameters:
o Depth=15
o Side Angle = 25

| Sidednglel2s  +

o Side Walls = Material Outside =
4. In the Settings group, specify the parameters to blend the edges of the drawn cutout.

For this example:

Blend Drawn Cutout Edges =
Die Radius = 2

Blend Section Corners =
Corner Radius =2

o
o
o
o

5. Click OK to finish the feature.
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2.3.2.7. 5 Normal Cutout

Use the Normal Cutout command to cut material by projecting a sketch onto the model and
then cutting perpendicular to the faces intersected by the projection.

You can use planar sketches or 3D curves to specify the section for the normal cutout.

If the sheet metal part has multiple bodies, you can specify the target body on which you want to create
the normal cutout.

You can design the sheet metal part within the context of an assembly and create cutouts while the

model is in the formed state.

In the example, the intersection curves of the two bodies are used as input to create a normal cutout.
The cutout creates a void in the pipe hanger that allows the pipe to pass through it.

a. Create a normal cutout using a sketch

This example shows how to create a normal cutout using an open sketch section.
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3 .

e

‘. -
Choose Home tab— Base group— Normal Cutout IQ|

In the Normal Cutout dialog box, set the following:

o Type = Sketch -
¢ In the Section group, click Sketch Section ‘Eﬁj

X
Select a plane for the sketch and then middle-click.

o

—

Sketch an open profile for the normal cutout.
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Finish the sketch.

In the Cutout Properties group, set the following:

e Cut Method = Thickness R"
« Limits = Through All =8

Double-click the section arrow to reverse the direction of the normal cutout.

8.
Middle-click to create the normal cutout.

/\\H

i

B. Create a Normal Cutout using a 3D curve

1. Choose Home tab— Base group— Normal Cutout @ I
2. From the Type list, select 3D Curves.
3. Select the 3D curve that defines the cutout shape, as shown in the following figure.
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4. Click OK to create the Normal Cutout feature.

2.3.2.8. Convert to sheet metal
2.3.2.8.1 Convert to Sheet Metal Wizard

Use the Convert to Sheet Metal Wizard to convert a non-sheet metal part to a valid sheet
metal part by ripping edges and cleaning up geometry.

The wizard streamlines the workflow by performing the cleanup and conversion tasks in the correct
sequence and ensures a workable sheet metal model.

The example shows a typical workflow to convert a non-sheet metal part to a sheet metal part.

/\/

0 N Rip along the corner edges. This step is optional, but if you
do not rip edges that need to be ripped, they are defined as
non-sheet metal areas that cannot be bent or unbent.

2 _
i _

Clean up imported parts so that the cleaned up part meets
the requirements of the Convert to Sheet Metal step. This
is an optional step.

Convert the non-sheet metal part to a valid sheet metal part
on which you can perform operations like bending,
unbending, flattening, and so on.

Convert a model to a Sheet Metal part
Note: You must be in the Sheet Metal application.

This example shows how to convert a non-sheet metal part to a valid sheet metal part with a
thickness value of 3.

Choose Home tab— Convert group— Convert to Sheet Metal Wizard @ !

1. Select the corner edges to rip.
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2. Click Next to advance to the Cleanup Utility step.
3. Select the base face to perform the cleanup operation.

Because NX uses the thickness of the base face to infer the thickness of the resulting cleaned up
part, select a base face that has uniform thickness.

4. Inthe Thickness group, clear the Infer Thickness ‘:l check box as you want to enter a
thickness value.

5. Inthe Thickness box, type 3.

6. Click Next to advance to the Convert to Sheet Metal step.

You must perform this step to create a Convert to Sheet Metal feature. If you skip this step, the
wizard will perform the cleanup operation, but it will not create a Convert to Sheet Metal feature
to perform sheet metal operations like bending, unbending, flattening and so on.

7. Click Finish to create the Convert to Sheet Metal feature and exit the wizard.

You can later perform sheet metal operations like bending, unbending, flattening and so on.

The following graphic shows the unbent sheet metal part. The converted body is unbent using
the Unbend command.

2.3.2.8.2 Rip
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Use the Rip command to define cuts in sheet metal parts or rip corner edges when converting
a solid model to a sheet metal part.

You can:

* Rip along corner edges.

e Rip along a curve.

You can use the following types of curves to generate the rip:

..

Linear Non-linear Tangential

Non-tangential Intersecting

When you use a curve to generate the rip, you can:

o Define the width and the shape of the end cap of the rip.
o Blend sharp corners by applying fillets.
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Note:

NX applies fillets only at the corners of a profile.

a. Rip along corner edges
This example shows how to rip the edges on a body.

1. Choose Home tab— Convert group— Rip @
2. Select the edges that you want to rip.

3. Click OK to rip the body along the selected edges.

B. Rip along a curve

Use any of the following methods to rip the faces of a body along sketched curves.

Rip along non-linear curves

This example shows how to rip the face of the body along non-linear curves.

1. Choose Home tab— Convert group— Rip @

2. In the Rip References group, click Sketch Section @ to create a non-linear curve along
which you want to create a rip.
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For this example, a sketch is created on the face of the body as shown.

3. In the Rip Parameters group, set the parameters for the rip.

For this example:

Use Minimal Relief = I:l
Symmetric Offset =
Rip Width =5

End Cap Shape = Round

Blend Sharp Corner = D
4. Click OK to rip along the sketch.

0 000 O

c. Rip along intersecting curves
This example shows how to rip the face of the body along the intersecting curves.
1. Choose Home tab— Convert group— Rip @'

2. In the Rip References group, click Sketch Section H§| to create an intersecting curve
sketch that defines the rip.

For this example, the sketch is created on the face of the body as shown.

Note:

You cannot create bends at sharp corner points at which the curves intersect.
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3. In the Rip Parameters group, set the parameters for the rip.

For this example:

Use Minimal Relief = I:l
Symmetric Offset =
Rip Width =5

End Cap Shape = Square
Blend Sharp Corner =
Fillet Radius = 10

00 000 O

NX applies fillets to blend the sharp corner only at the corners of the profile. In this example, NX blends
the rightmost sharp corner by applying the specified curve radius.

4. Click OK to rip along the curve.

2.3.2.8.3 Cleanup Utility

Use the Cleanup Utility command to identify areas of a model that do not meet the
requirements of the Convert to sheet metal command. If your part has sharp corners, you must rip the
edges of the part to fix the sharp corners before you use the Cleanup Utility command.

You can clean up imported parts and make the conversion of non-sheet metal parts to sheet metal parts
successful.

NX cleans up the sharp edges using a bend radius value of 0.02 mm. The model can have an inner
sharp edge with an outer bend face, an outer sharp edge with an inner bend face, or both sharp edges.
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For example, if a model has an inner sharp edge, the inner sharp edge is replaced with a bend face of
radius 0.02 mm. The corresponding outer bend radius is equal to the sum of the inner bend radius and

the input thickness.

You can use customer defaults to change the value of tolerance.

Note:

e Use the Cleanup Utility command only if the model is not successfully converted using
the Convert to sheet metal command.

e You can also use the Optimize Face command for additional cleanup.

Clean up a part before converting it to a Sheet Metal part

This example shows how to clean up a non-Sheet Metal part before converting it to a Sheet
Metal part.

Non-Sheet etal part Cleaned up part

1. Choose Home tab— Convert group— Cleanup Utility J :
2. Select the base face of the part.

3. Inthe Thickness group, specify the thickness of the sheet metal part.
For this example, Thickness = 1.2.
4. In the Sliver group, specify the value of tolerance for identifying sliver faces.

For this example, Sliver Tolerance = 0.01.
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5. In the Settings group, select the Hide Original check box, to hide the original body after the
cleanup.
6. Click OK.

The part is now ready to be converted to a Sheet Metal part.

2.3.2.8.4 Optimize Face

Use the Optimize Face command to simplify surface types, merge faces, improve edge
accuracy, and recognize blends.

Use this command to convert B-surface faces to analytic faces on models that

Optimize faces

This example shows how to convert spline and tolerant edges
to more accurate geometric edges and convert B-surfaces with
analytic surfaces of an imported solid.

1. Choose Home tab— Convert group— Optimize Face @ :

.

fa—g

2. Select the faces that you want to optimize.

For this example, all faces are selected.

3. In the Settings group, select the options that you want.

In this example, Clean Body before Optimize and Report are selected.
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4. Click OK.

y

The Information window displays the optimize face report.

2.3.2.8.5 Convert to Sheet Metal

You can use the Convert to Sheet Metal command to:

e Convert a non-sheet metal part to a valid sheet metal part so that you can perform sheet
metal operations like bending, unbending, flattening, and so on. You can convert solid models
and imported sheet metal-like parts to sheet metal parts.

o Remove corners of an imported or non-sheet metal geometry while converting the geometry
to sheet metal.

e Convert a non-sheet metal part to a valid sheet metal part using global conversion, local
conversion, or both. Using global conversion, you can convert an entire non-sheet metal part
to sheet metal, whereas using local conversion, you can convert a local region such as a
single face or a group of connected faces to sheet metal.

Thus, to fully convert a non-sheet metal part to sheet metal, first you use global conversion,
and later use local conversion to convert small, local areas of the part that are not converted
by the global conversion.

Note:

o There can only be one local conversion per feature.
o A convert feature can have a local conversion without a global conversion.

Converting solid models

The solid models must have a constant thickness. You cannot convert a sheet body to a sheet
metal part. In the example, the solid model is created in the Modeling application, its edges are ripped
using the Rip command, and then it is converted to a valid sheet metal part using the Convert to Sheet
Metal command.

Converting non-sheet metal parts

When you convert a non-sheet metal part to a valid sheet metal part, you can also specify
additional geometry for conversion.

In the example, an imported part containing non-cylindrical bends are selected as additional geometry
for conversion. After conversion, you can use the Unbend command to flatten them.
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Note:

You cannot use the Convert to Sheet Metal command to rebend the areas that were previously unbent
in the original non-sheet metal part.

a. Convert a solid model to a sheet metal part
This example shows how to convert a solid model that is created in the Modeling application, to a valid
sheet metal part. The solid model is of uniform thickness.

Note:
You must rip the edges of the solid model before converting it to a valid sheet metal part. Use
the Rip command for this operation.

1. Choose Home tab— Convert group— Convert to Sheet Metal ﬁ@ :
2. Select the base face.

You must select a face that has tangent continuity with the other faces in the model.

3. Click OK to complete the conversion.

NX creates corners wherever required.

You can now perform sheet metal operations such as bending and flattening on the part.
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b. Convert a solid model to a sheet metal part using global and local conversions

1. Choose Home tab— Convert group— Convert to Sheet Metal @
2. Inthe Global Conversion group, select the base face.

3. In the Preview group, select the Preview check box.

In this example, the deform faces are identified and highlighted in a color specified for an alert,
indicating that those faces cannot be bent or unbent.

In this case, if you try to perform flattening or unbending operations, the result may not be
successful. Therefore, you need to convert the deform faces locally.

4. Inthe Local Conversion group, select the base face.

286
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6. Click OK in the dialog box.

A message appears, informing you that the body is converted successfully. However, faces that
are identified and highlighted as deform faces cannot be bent or unbent.

7. Click OK in the message box.
In this case, if you try to perform flattening or unbending operations, the result may not be
successful, as the corner faces are intersecting. Therefore, you need to handle the corner faces.
6:;: e\
8. (Optional) On the Resource bar, select HD3D Tools tab— Visual Reporting ' to view

the conversion result.

Using the Visual Reporting, you can check the conversion result. Also, you can see that the part
under conversion is color coded with specific colors for deform faces, non-sheet metal features,
or sheet metal features. This gives you clear visual feedback, highlighting the deform faces or
faces that are not yet converted to sheet metal.

9. (Optional) In the Report group, from the list, select Sheet Metal Face Type.

10. (Optional) In the Controls group, click Activate Report :

The part is color coded, highlighting specific colors for deform faces or the faces that are not yet
converted to sheet metal. Also, the color legend is displayed in the Results: Sheet Metal Face

Type group.

In this case, if you try to perform flattening or unbending operations, the result may not be
successful, as the corner faces are intersecting.

Therefore, you need to handle the corner faces.

X

11. (Optional) In the Controls group, click Deactivate Report
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12. On the Resource bar, select the Part Navigator tab, and from the Model History node, double-
click the Convert to Sheet Metal feature.

13. Choose Corner Removal group— Select Adjacent Bend Faces hl’
14. Select the adjacent bend faces to remove the corner.

Note:

You can select the adjacent bend faces of multiple bend corners to open up the corners. To do
this, you can click Add New Set to add a new set of faces in the List box. However, note that you
can add only the adjacent bend faces in the same set.

15. Click OK.

The corners are removed and the part is fully converted to sheet metal.

You can now add new corner treatments on the cleaned-up corners and perform sheet metal
operations on the part, such as unbending or flattening.

2.3.2.9. Flat Solid And Flat Pattern
2.3.2.9.1 Flat Solid

You can use the Flat Solid command to:
o Create a flat representation of the formed sheet metal part. The flattened version of the part is
associative to the formed version.
e Create an associative flat solid fixed at the current timestamp. This helps you to create a flat
solid at an intermediate stage of the part design, rather than at the end.
o Control the orientation of the flat solid, using one of the following orientation methods:
o Default: You can create a flat solid using the default orientation method, so the body will
be flattened in place.
o Select Edge: If you specify a linear edge from the selected stationary face, NX creates the
flat solid by moving the selected edge to align with the X-axis of the absolute CSYS.
o Specify CSYS: If you specify the CSYS, NX creates the flat solid by matching the
specified CSYS with the absolute CSYS.
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When you flatten a sheet metal part, the flat solid feature is added in the model history in
the Part Navigator. If the part contains deformation features, they are retained in their formed condition.
If you change the sheet metal model, the flat pattern automatically updates to include the new feature.

However, it is recommended not to build the bend creation (for example, Flange, Bend, Jog)
or bend modifying (for example, resize operations) or Convert to Sheet Metal features on flat solid
output.

Note:
The mass properties of the flat solid are not exactly the same as the mass properties of the formed
body.

a. Create a flat solid for manufacturing

This example shows how to create a solid representation of the flat
stock to which you can make dimensional changes without changing
the definition of the original sheet metal part.

This example supposes that during prototyping, you found that the
indicated tab is 1 mm too short after forming.

5.

Choose Home tab— Flat Pattern group— Flat Solid T I

Select the base tab as the stationary face.
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3.
Click OK.

NX creates two solid bodies, one formed and one flattened.

Right-click the formed solid body and choose Hide.

Switch to the Modeling application and use the Synchronous Modeling command Offset
Region %] to offset the tab by 1 mm.

- 5 Model History

@Q-. {

@ T 5B Flat Solid (50)
@9 Offset Region (51)
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In the Part Navigator, notice that the flat solid feature follows all the sheet metal definition
features, and is followed by the offset region feature. This means that if there is a change to the original
sheet metal definition, NX will update the flat solid feature and then update the offset region feature.

b. Create an oriented flat solid

You can create a flat solid by selecting a planar reference face and the Orientation Method.
These options allow you to position the flat solid body for export to a machining tool.

Create a flat solid by specifying a linear edge

You can create a flat solid by specifying a linear edge from the selected stationary face.

Choose Home tab— Flat Pattern group— Flat Solid T i
2. Select a base face to create the flat solid.

—_

3. From the Orientation Method list, choose Select Edge.
You can also select Default to create the flat solid using the default orientation method.

4. Select a linear edge from the selected base face for X-axis orientation.
The curve of the selected edge is aligned with the X-axis of the absolute CSYS and the view is
oriented accordingly.

5. In the Preview group, click Show Result.

6. Click OK in the Flat Solid dialog box to create the feature.

Create a flat solid by specifying CSYS
You can create and orient a flat solid by specifying a CSYS.

Choose Home tab— Flat Pattern group— Flat Solid T i
Select a base face to create the flat solid.

From the Orientation Method list, choose Specify CSYS.
Specify the CSYS along which you want to align the flat solid.

hPON=

Note:
For consistent results, select the Z-axis of the CSYS as the normal of the base face, and the
CSYS origin as a point on the base face.
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5. In the Preview group, click Show Result.
The flat solid is oriented per the specified CSYS.

6. Click OK in the Flat Solid dialog box to create the feature.

Insert a bend table in a flat solid view
This example shows how to create a bend table using the bend information that NX displays in
the flat solid view.

Before you begin, you must create a flat solid.

1. Choose PMI tab— Rule group— Insert Instance Gy |

2. Inthe Insert Instance dialog box, in the Folder View group, expand the MBD Logical
Rules node and select Table.

3. Inthe Member Select panel, select the Create Bend Table rule and click OK.

Tip:

Select the Create Bend Table command that creates a table from the sheet metal bends in the
part.
4. In the graphics window, select the flat solid.

5. Click OK.

NX inserts the bend table in the flat solid view.
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When you select a row in the bend table that represents a bend, NX highlights the corresponding
bend in the flat solid.

.....

Insert a bend table in a body
This example shows how to create a bend table using the bend information that NX displays in

a body.

Choose PMI tab— Rule group— Insert Instance | Gy .

2. Inthe Insert Instance dialog box, in the Folder View group, expand the MBD Logical
Rules node and select Table.

3. In the Member Select panel, select the Create Bend Table rule and click OK.

—_—

Tip:

Select the Create Bend Table command that creates a table from the sheet metal bends in the

part.
4. In the graphics window, select the body.

5. Click OK.

NX inserts the bend table and displays in the graphics window.

————
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When you select a row in the bend table that represents a bend, NX highlights the corresponding
bend in the body.

Generate the blank shape

8
Use Flat Pattern when you are making drawings of the flattened blank shape created by your
sheet metal part.

Any changes made to the 3D formed model are automatically reflected in the Flat Solid, and also in
the Flat Pattern.

However, it is recommended not to build the bend creation (for example, Flange, Bend, Jog)
or bend modifying (for example, resize operations) or Convert to Sheet Metal features on Flat Solid
output.

To create a Flat Pattern feature:

8
1. Choose Home tab— Flat Pattern group— Flat Pattern “=1

2. Select a planar face from the formed model to use as a basis for the flat pattern.
3. Click OK to create the Flat Pattern.

The Flat Pattern feature is created in a special FLAT-PATTERN view that you can add to a drawing.
To see the FLAT-PATTERN, in the Part Navigator, click to expand Model Views, then double-click
the FLAT-PATTERN view.

2.3.2.9.2 Flat Pattern

Use the Flat Pattern command to create a 2D representation of the flattened 3D sheet metal
part.

Creating a flat pattern

You can:
e Create a flat pattern from a formed sheet metal body or from flat solids.
o Create an associative flat pattern fixed at the current timestamp. This helps you create a flat
pattern view at the intermediate stage of the part design.
o Control orientation of the Flat Pattern view for the upward face having non-linear edges. To
do this, you need to specify a CSYS while defining the orientation.

Viewing hole details in a flat pattern
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You can:

o Visually identify the types of holes and their parameters, such as the drill size, the screw
clearance, and if it is threaded.

B30 X 20 THiy [ £25 THRU TAPER 10

O O
] OO [
-O O

- J125 THRU CSUNK 30X90"

K30 x 25 THRUS

11042 THRU

Setting Sheet Metal preferences for a flat pattern

You can specify the flat pattern treatments and the default display of curves and callouts in the
flat pattern view for each part individually in the Sheet Metal Preferences dialog box.

Create a flat pattern view by specifying a linear edge
This example shows how to create a flat pattern by specifying a linear edge from the selected upward
face.

1. Choose Home tab— Flat Pattern group— Flat Pattern “-1

2. Select an upward face to create the flat pattern view.

This face can either be on a formed sheet metal body, or on a flat solid body. The normal direction
associated with this face is used to specify the upward direction for bend regions. For this
example, select the upper tab face.

3. From the Orientation Method list, choose Select Edge.
You can also select Default to create the flat pattern view using the default orientation method.
4. Select a linear edge from the selected upward face for X-axis orientation.
The curve of the selected edge is aligned with the datum CSYS and the view is oriented
accordingly.
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5. In the Preview group, click Show Resulit.
A message appears, informing you that the flat pattern feature is created in the separate Flat

Pattern view.
6. Click OK in the message box and in the Flat Pattern dialog box to create the feature.

NX creates the following in the Part Navigator.

o Aflat pattern feature in the Model History node.
o Aflat pattern view FLAT-PATTERN#nnn in the Model Views node.

Where nnn corresponds to the number that is incremented each time when you create a
flat pattern view.

7. In the Part Navigator, expand the Model Views node, and double-click FLAT-PATTERN#nnn.

NX displays flat pattern information as PMI objects in the flat pattern view.

e
e sl
¥ire .
[
[
r

You can resize and reposition the generated PMI labels.

8. Choose PMI tab— Display group— Resize & :
9. Click Position %

Bendd Sequanca 1D 4
Boend Name Sena 4

Intenor Cutout - Court 7 Bend Direction duwn

Exterior Cul Length 521.20 Beng Racius 500 Bend Sequence IDE
lntenor Col Length 321,74 Bend Angla 4500 7 Bend Namo Bana 5
Bnmum X "86.43 Moutral Factor 0. ‘-}{ Beang Lwrection up
Mvmum Y 130 329 i Berg Radus 0,40

Total Cot Langih 922 95 Bend Angie 9000

Neutral Factor 0.33

o~ Jougle Rurout 27 .00
v Joagle Depih 2.0
Tael 10 Dimpie — Rt '

== Hoke Diameter 40.00

Bend Sequance 1D 2 Cautout Diamwior 26,54

Bana Nora Bana 2

Bend Dirscion v \
Bena Racus 0 40 / \_ Band Seauence ID 1
Bend Angle 540,00 { — BanG sequencs |U

2 sy i Sand Nave Bonad 1
Neutral Facloe 0.33 <1

e > / Zendd Direclor down

Band Hadiys 040
Band Arngle 9000
Neutral Factor 0.33

Hole Detals 10 THRY —~

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Module: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

10. View the flat pattern labels that NX creates.

a. On the Resource bar, click the MBD Navigator tab.
b. Inthe MBD Navigator, expand the PMI— Annotation node to view the flat pattern
labels.

Create a flat pattern view by specifying a CSYS

You can create a flat pattern view by specifying a linear edge from the selected upward face.

However, this method of orientation is not useful for upward faces that have non-linear edges. In such
cases, you can specify a CSYS and create a flat pattern view that is oriented per the specified CSYS.

PN

=
Choose Home tab— Flat Pattern gallery— Flat Pattern ;
Select an upward face to create the flat pattern view.
From the Orientation Method list, choose Specify CSYS.
Specify the CSYS along which you want to align the flat pattern view.

Note:

For consistent results, select the Z-axis of the CSYS as the normal of the base face, and CSYS
origin as a point on the base face.

The flat pattern view is oriented per the specified CSYS.
In the Preview group, click Show Resuilit.

A message appears, informing you that the flat pattern feature is created in the separate flat
pattern view.

Click OK in the message box and in the Flat Pattern dialog box to create the feature.
To see the flat pattern view, in the Part Navigator, expand the Model Views node, and double-
click FLAT-PATTERN.

ntenos Cutout
Exterior Cul
mterior Cut Length 41,39
Minimum X 74,39
Ainimum ¥ 63.19
lotal Cut Length 29523

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Editing a flat pattern feature

The flat pattern view consists of a set of curves and associated annotations. You can edit curves
in the flat pattern. However, when you update the model, the curves associated with the flat pattern are
regenerated and the changes are overwritten. To avoid this, you can create a non-associative flat
pattern view.

Displaying PMI in a flat pattern

When you create a flat pattern, NX displays flat pattern information as PMI objects in the flat
pattern view.

Bend Sequene 1D 4
Bond Name Sanda 4
Sendd Direction duan
Bend Racius 500
Band Argle 4500 [

Imenor Cotout - Coumt 7
Exterior Oul L wth 521 .20
Intesior Cut Length 321,79
Mwvmum X *8E.43

- Bend Sequance 1D 5

Bend Name Band 5

Nautral Faclor L‘l.i-;

!

Barnd Cirection up

Mvrrum Y 136 249 { Berre! Ractos 0140
Tetal Cat Langih 942 .95 { Bend Angle 5000
/ Keutral Factor .32

o~ Jooale Rurout 27 .00
sl Bapth 2 00

-
Tool 1D Dimple — @---H_‘ 3

Bend Sequence 1D 2 m
Bang Noma Bana 2 ?

Hode Diameter 40.00
Cutout Diamelor 26.54

= '—LH‘-L l\‘
Bemd Dirsction up ] \
Bena Rads D a0 ] - = gt
Bend Ancle 94 00 i — Band Saquence 1D
TR AANCRE SR R F; Band N o
e ; Hond Name Bend 1

Neutral Facior 0.33 T

i ! / Bend Dlrecbor down

Hole Detads 210 THRU —~ Sand Radius 040

Sand Angle 90.00

Neutral Factor 0.33

You can view the following PMI objects in the flat pattern view.

o Flat pattern attributes such as interior cutout count, minimum X, and minimum Y.

NX also displays the total cut length including the exterior boundary (1) and interior cutouts (2)
of a flat pattern.

Interior Cutout - Count 7
Exterior Cul Length 621.20
Interior Cut Length 321.79
Minimum X 186.43
() Minimum Y 136.29

- - Total Cut Length 94299

You can view this information in the Flat Pattern Properties dialog box.
e Information about a bend such as bend sequence ID, bend direction, and bend angle.

{ Bend Sequence 1D 1
Bend Name Bend 1
Bend Direction down
Bend Radius 0.40
Bend Angle 90.00
Neutral Factor 0.33

298 DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

¢ Other information such as hole diameter, tool ID, and cutout diameter.

- Hole Dsarmiter 40.00
Cutput Dismwtar 26 54
|~ Joggie Runcat 27.00
Jogge Dapth 2.00

Insert a bend table in a flat pattern view

This example shows how to create a bend table using the bend information that NX displays in
the flat pattern view.

1. In the Part Navigator, expand the Model Views node, and double-click the flat pattern view
in which you want to create a bend table.

Intes n.ut—a - Count ( Bend Dineetion doen
Extesior Cul Leagth £ HBend Hacis 5 L'| - Bend Sequence 10 S
Irtenoe: Cut Length 321 ?'1 Bend Angle 45 00 '; Brnd Kame Sanc &
MMnmum X 128643 MNoutrad Factor O, 3,{’ Bard Dire
Marruh Y 136 29 Beoo Radus 0140
Total Gt Langll 52 45 _./ Bona Angie 2000

."” Newtral Factor 0,33

fl o Jougle Rurout 27 00
¥V Jangie Depth 200

Tood 10 Dimpie —,
"*=sse Hinke Diamester 4000
Cutout Diareter 26 54

Band Saguencs 1D 1
f Sand Name Band 1
_:f Sand Dirmclon down
Hole Coteds (10 THRY =/ Baned Radius 0 40
Band fangla 90 00
eutral Faotor 0.33

&
Choose PMI tab— Rule group— Insert Instance -

2.

3. In the Insert Instance dialog box, in the Folder View group, expand the MBD Logical
Rules node and select Table.

4. In the Member Select panel, select the Create Bend Table rule and click OK.

5. In the Part Navigator, expand the Model Views node and select the flat pattern view.

6. Click OK.

Cownt
Bngin 621 2L Bemi Sequence I3 5
ngth 321,79 Bend Angle 45,00 s Nama Band §
Mlriesonn X 18843 Meylral Factor 0.3
Mo ¥ 136,29 /
Total Gid Length 942 8 /

/
3 M . 4
Jf’
I T |r
é/ Jr¢ ||s|\P| th

N v [iastretesr 300 (02
] ?...-.-__ t Dismeter 26 54
] N
/
Neutrof Fi /
i
Hale Detalls 710 THRU =/
£ = T T T = - 7
E + t t 1 t t 1
E T . ¥ 1 = ¥ 1
1 T T T T T T 1
| 1 b - » - o i ) — J

Now, when you create a drawing of the flat pattern, you can include this bend table in the drawing.
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2.3.2.9.3 Bend List

The Bend List command is available only after you create a flat pattern and replace the modeling view
with the flat pattern view.

After creating a flat pattern, each bend in the part is assigned a unique Bend Sequence ID and Bend
Name. Using the Bend List command, you can edit these default bend sequence IDs and bend names
per your requirement.

You can select a bend and move it up or down and change its sequence. After you move the bend, itis
assigned with the new Bend Sequence ID. After the bend is moved to the required position, you can
change its name if required.

The Bend List command is available for both associative and non-associative flat pattern views.

Edit bend properties

You can edit bend properties such as bend sequence ID and bend name using the Bend
List command.

The Bend List command is available only after you create a flat pattern and replace the modeling view
with the flat pattern view.

1.Use the Flat Pattern command to create a flat representation of the part.
2.To see the flat pattern view, in the Part Navigator, expand the Model Views node, and double-
click FLAT-PATTERN.

3.Choose Home tab— Flat Pattern group— Bend List

4.Under the Existing Bend ID column, select the bend and click Move Up ﬁ or Move Down @

The existing bend ID is changed.

5.Click Apply.

The bend sequence ID is changed and updated in the Flat Pattern view.

6.(Optional) In the Existing Bend ID column, select a bend ID, and in the Bend Name box, type a
different name.
7.Click OK.

The bend properties are edited.

Export a Flat Pattern feature
This example shows how to export Flat Pattern feature in the DXF format using the 2D
Exchange translator.
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Note:

Exporting a Flat Pattern feature through a translator requires a proper translator license. This license is
not included as part of Sheet Metal license.

Choose Menu—File—Export—2D Exchange.

In the 2D Exchange dialog box, select the Files tab.

On the Files page, in the Export to group, select DXF from the Output As list.

Specify where you want to save the new file.

Click the Data to Export tab.

In the first Export list, choose Selected Objects.

ok wWN =

In the Model Data group, click Select Object _q} , then in the graphics window select the part.
In the second Export list, choose Selected View, select FLAT-PATTERN from the view list.
Click OK to export.

©omN

Showing both formed and flattened views on a drawing

With Sheet Metal, you can show views of your solid part in both the formed and unformed
states:

1. Create a Flat Pattern feature.
2. Enter the Drafting application and create views of the formed solid part.

T = =t N

3. Click Base View and choose FLAT-PATTERN from the list of available views.
4. Add the flat pattern view just as you would any other part view.

301
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Note that for the flat pattern view to be visible, the layer that the flat pattern curves were placed on
(according to your Customer Defaults) must be a visible layer. If you are placing the flat pattern view

and do not see any resulting geometry, check your layer settings.

2.3.2.9.4 Bend Table

Use the Bend Table command to insert a bend table in a drawing that you create using the
Flat Pattern view of a Sheet Metal or FPCD part. The tabular format makes the bend information easy
to read in downstream applications.

rﬁcnc Radius = 3.00
— Band Angle = 90.00

|

!

r [" — Bend Sequenca ID = 3
| J‘r
' |l f

— Bend Direction = up

i
i
{

!

Py
O/
T )]

1=

Bend Sequence |D = 2 —- —t+— Bend Radius = 3.00

Bend Angle = 33.00

Bend Direction = up
Bend Angle = 33.00 ——t — Bend Direction = up

Bend Radius = 3.00 — - Bend Sequence ID = 1

Bend Sequence ID = 4 —

Bend Direction = up ~

Bend Angle = 90,00~

Band Radius = 3.00 —

4 Band 4 3.00 40,00 up 00,00

3 Beng 3 3,00 40,00 up 090,00

2 Bend 2 3.00 33.00 up 147,00

i Bangd 1 3,00 33,00 up 147,00

([} Nameg Radius Argle Ditaction Includad Angle

To display the bend parameters that you want in the bend table, you must set preferences in
the Drafting Preferences dialog box. You can display any or all of the following bend parameters:

Bend ID

Bend Name
Bend Radius
Bend Angle
Bend Direction
Included Angle

NX derives the values of the bend parameters from the Flat Pattern view. If you delete the reference
Flat Pattern view, NX deletes the bend table.
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Insert a bend table in a drawing of a flat pattern view

This example shows how to create a flat pattern view of the part shown, how to place it in a
drawing, and how to insert the bend data in a table in the drafting view. For this example you will display
only the ID, Name, Radius, and Angle columns in the bend table.

B N
—— \\

™,
N

\

1. In the Sheet Metal or FPCD application, use the Flat Pattern command to create a flat
representation of the part.

Tip:

To display the flat pattern view, in the Part Navigator, under the Model Views node, double-click
FLAT_PATTERN.

Barnd Rodius

— Bend Ary =

—Bend rection = -
q

Berd Se

jance | d

O
=1

2. Switch to the Drafting application.
The Sheet dialog box is displayed.

3. Inthe Settings group, make sure View Creation Wizard is selected.
4. Select your sheet size and click OK.

The View Creation Wizard dialog box is displayed.

5. Inthe left pane, select the Orientation step.
6. In the Orientation group, in the Model Views list box, select the required flat pattern view.
7. Click Finish to add the flat pattern view to the sheet.
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8. (Optional) To make your view smaller, do the following:
a. Double-click your view border.
b. Inthe Settings dialog box, in the left pane, choose Common— General.
c. Inthe Settings group, set your scale and click OK.

10. In the Settings group, click Settings 1“% ;
The Settings dialog box is displayed.

11. In the Columns group, clear the check boxes next to the Bend Direction and Included
Angle options so that these columns are not displayed in the bend table.

12. Click Close to return to the Bend Table dialog box.

13. Select the flat pattern view and then click in the sheet to place the bend table at the required
location.

14. Click Close.

| EC) |
f == :
1 I
=l |
9 :
| { ; |
z N d Berd 2 3,00
—
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2.3.2.9.5 Sheet Metal Label

Use this command to display Product and Manufacturing Information (PMI) for a sheet metal
body and a bend.

Add sheet metal labels and view them

This example shows how to add PMI labels to a sheet metal body and a bend face on it.

Add a sheet metal |abel to a bend face

1. Choose Home tab— Flat Pattern group— Sheet Metal Label g :
2. From the type list, select Bend.
3. Select the bend face that you want to label.

NX displays a preview of the label with the plane on which the label will appear.

4. In the Leader group, from the Type list, select All Around.

5. In the Settings group, click Settings & L

6. Inthe Sheet Metal Label Settings dialog box, set the following parameters.

7. Click Close.

8. In the graphics window, click the location at which you want to place the sheet metal label.
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Add a sheet metal label to a body

1. Choose Home tab— Flat Pattern group— Sheet Metal Label g
2. From the type list, select Body.
3. Select the body that you want to label.

NX displays a preview of the label with the plane on which the label will appear.

4. In the Leader group, click Select Terminating Object.
5. Point to the label.

NX displays handles to adjust the stub and the Leader scene list.

Leader 1|« ~
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6. Drag the handle to adjust the stub length.

—————e—

142137000

Leaderl|—

v - -

7. (Optional) From the Leader scene list, choose a style for the display of the arrowhead.

8. Click Close.

9. In the Origin group, click Specify Location! i .|, and then click in the graphics window to
place the sheet metal label.

Material Thickness=3.00
Physical Material Aluminum_ 6061
Sheet Metal Material Aluminum_606

2
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2.3.2.10. Resize

2.3.2.10.1 Resize Bend Radius
Use the Resize Bend Radius command to change the radius of a cylindrical bend connected

to planar faces, by overriding the feature that created the bend.
You can modify the radius of individual bends to illustrate over-bending and spring back effects.
You can change the radius of the following:

o Existing bends to create bends that have zero bend radii.

e

o Bends in partial flanges.

If you resize the bends in flanges that are created with no relief, NX creates the reliefs wherever
required.

If you resize the bends in flanges that are created with a relief, the existing reliefs on the bend are
maintained.

s Two adjacent bends.

Individually change the radius of the adjacent bends. If you change the radius of one of the bends,
the end caps of one bend or both bends are adjusted to keep the corner intact.
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You can also individually change the bend radius of adjacent bends that are not connected, but
their bends caps are, and do not form a corner. The bend end caps remain connected after you

change the bend radius.
ﬁ

e Three adjacent bends that are connected to form a corner and which do not have any corner
treatment.

You can individually change the radius of the adjacent bends. If you change the radius of one of
the bends, the end caps are adjusted to keep the corner intact.

o Bend end caps created by the Bend Taper command.

The example shows a linear bend taper with a square relief. When you increase the bend radius,
both the relief and the end caps are adjusted accordingly.

=

¢ Bends that have deform features and cutouts created across cylindrical bends.

The feature across the bend region is adjusted accordingly.

The example shows a Dimple feature created across the bend region perpendicular to the bend
centerline. When you increase the bend radius, the Dimple feature is adjusted accordingly.
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» Non-uniform thickness bends created by chamfers, blends, counterbored holes, countersunk
holes, tapered holes and so on.

The example shows a countersunk hole created across the bend region. When you decrease the
bend radius, the hole is adjusted accordingly.

The modifications appear as a separate Resize Bend Radius feature in the Main panel of the Part
Navigator.

Y& Model History

M Datum Coordinate System (0)

M0 SB Tab (1)

- '\'\ SB Flange (2)
-3 5B Resize Bend Radius (3)

As these features are in timestamp order, you can hide, show, or edit them to display the model in
various states of forming.

Depending on the type of Resize Bend Radius feature you create, the overall length, or the length of
the unfolded part, remains fixed, or is changed.
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Resize Bend Radius — supported geometrical conditions

Input Result
Bends on adjacent flanges Fixed Tab/ Flange Position  Fixed Unfolded Length

Three adjacent bends Fixed Tab/ Flange Position Fixed Unfolded Length

1 — Stationary edge
Zero bend radius support Fixed Tab/ Flange Position Fixed Unfolded Length

Partial flanges If you resize the bends in flanges that are created with a relief, the
existing relief on the bend is maintained.
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Partial flanges, with bend| |f you resize the bends in flanges that have no relief, NX creates
outside the reliefs wherever required.

Bend Tapers Fixed Tab/ Flange Position — Fixed Unfolded Length —
bend radius increased bend radius increased

Fixed Tab/ Flange Position — Fixed Unfolded Length — bend
bend radius decreased radius decreased

312
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rr

Dimple feature Fixed Tab/ Flange Position Fixed Unfolded Length

i 8

Bead feature Fixed Tab/ Flange Position  Fixed Unfolded Length

o e

Drawn cutout Fixed Tab/ Flange Position Fixed Unfolded Length
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Non uniform thickness features || Bend radius increased Bend radius decreased

Table 2.2: Resize Bend Radius

Resize the bend radius of a flange
This example shows how to change the size of the bend radius of a flange while keeping the

overall length of the unfolded part unchanged.

=>

1. Choose Home tab— Resize group— Resize Bend Radius %
2. In the Resize Bend Radius dialog box, from the Type list, select Fixed Unfolded Length.
3. In the graphics window, select the stationary face.
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4. Select the bend whose radius you want to modify.

In the Bend Parameters group, specify a value in the Bend Radius box.

For this example, Bend Radius = 5.

Click OK to resize the radius of the selected bend.

Dimensions of the formed part change but the dimensions of the unfolded part remain unchanged.

2.3.2.10.2 Resize Bend Angle

Use this command to change the angle of a bend by overriding the feature that created the

bend.

You can do the following:

Depict a bend in various intermediate stages.
Study over-bending and spring back effects of selected bends.
Perform forming studies on an already-designed Sheet Metal part.

You can use the Part Families command to create a family of similar parts showing each of the
interim forming states of bend regions in Sheet Metal parts.

-

The Resize Bend Angle feature is listed in the Part Navigator as shown in the following graphic.

= Model History

Eﬂf Datum Coordinate System
Tl SB Tab (1)
il Extrude (2)
& sB Bend (3)
b SB Bend 4)
1<) Resize Bend Angle (5)

Note NX doesn’t update the neutral factor value when you update the bend angle.
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Resize the bend angle to show interim forming states of a bend region
The following example shows how to create Resize Bend Angle features for bend angle values
of 90, 120, 150, and 180 degrees.

1. Open the Sheet Metal part for which you want to show multiple stages of the bending operation.

=

2. Choose Home tab— Resize group— Resize Bend Angle @
3. Select a non-thickness face to remain stationary when you modify the bend angle.

4. Select the bend you want to modify.

6. Click Apply

The bend is modified according to the new value of the bend angle.

316
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7. Repeat steps 3 to 6 to create Resize Bend Angle features using bend angle values of 120, 150,
and 180 degrees.

Bend angle =120 Bend angle = 150 Bend angle = 180
8. Click Cancel to close the Resize Bend Angle dialog box.

The Resize Bend Angle features are listed in the Part Navigator as shown.

= Model History
: ‘@ Datum Coordinate System
@< B Tab (1)
®@ Extrude 2
®%F S8 Bend (3
®%  SB Bend (4
@@ Resize Bend Angle (5)
®@ Resize Bend Angle (6)
@@ Resize Bend Angle (7)

@'@ Resize Bend Angle (8)

You can then use the Part Families command to create a family of similar parts showing each
of the interim forming states of bend regions in Sheet Metal parts.

2.3.2.11. Stiffening features
2.3.2.11.1 Bead

Use the Bead command to lift material along the contour of a sketch that simulates a stamping
tool. Beads can also be created to stiffen sheet metal parts.

You can create beads on bends in the folded or flattened state. A bead created on a bend in the folded
state does not traverse the bend.

You can also create beads on deform features in sheet metal parts.

Bead on 2 faticned eyindicd end Bead on a flattened non-cylindrical bend

¥

N
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Bead on a formed non-cylindrical bend

Bead on a formed cylindrical bend

3
§,‘,ﬁ LA

Beads across deform features

Create a bead

This example shows how to create a bead on a sheet metal part. The bead is created from a
sketch. You can either create the sketch first and then select the Bead command, or you can select
the Bead command and then create the bead.

Choose Home tab— Punch group— Bead 0
2. In the Section group, click Sketch Section )@
3. Select a planar face.

-

4. Sketch the contour of the bead.
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5. Specify the bead parameters.
In the Bead Properties group, set the following:

o Cross Section = Circular
o Depth=3

o Radius=3

o End Condition = Formed

In the Rounding group, set the following:

o Round Bead Edges =
o Die Radius =2
6. Click OK to create the bead.

.
/,)r""
”/

Create beads across bends
This example shows how to create a bead across a bend in a flattened state. You will flatten
the bend, create the bead, and then rebend the part to its original state.

1. Flatten the sheet metal part.

a. Choose Home tab— Bend group— Unbend % :
b. Specify the face that remains fixed during the unbend operation.

c. Select the bend that you want to flatten.

DPP — Vocational Training for Smart Manufacturing in Machine Tools 319



I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

2. Create the bead.
a. Choose Home tab— Punch group— Bead :
Note:

If the command dialog box contains an <OK> button, you can select the next command
without clicking OK. NX automatically completes the current command.

b. Inthe Section group, click Sketch Section @'.
c. Sketch a single curve in the middle of the face as shown.

e. Set the bead parameters.

This example uses the following parameters:

= Cross Section = Circular

= Depth=2

= Radius=6

= End Condition = Formed
f. Click OK.

3. Rebend the sheet metal part.

a. Choose Home tab— Bend group— Rebend %
b. Select the bend that you want to restore to its original state.

c. Click OK.
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Create a bead across bends in the formed state
This example shows how to create a bead across a bend in the formed state. When the bends
are not flattened, the bead washes out at the bend and does not wrap around the bend.

1. Choose Home tab— Punch group— Bead 0

2. Inthe Bead dialog box, in the Section group, click Sketch Section @
3. To specify the sketch plane, select the face on which you want to create the bead.

4. Sketch a single curve across the bends.

6. Click OK.
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2.3.2.11.2 Gusset
Use the Gusset command to create a stiffening feature on a part.

You can:
e Create strengthening features where extra strength is required in the bend region.
e Create punched or embossed shapes in bend regions of sheet metal parts.
o Specify default dimensions for the Gusset feature using customer defaults.
o Create gussets on cylindrical blends that are created by deform features such as a dimple, a

drawn cutout, a solid punch, and so on.

o Create gussets on cylindrical or non-cylindrical bends that are created by different flanges.

Gussets on cylindrical segments of chained p gusset on a non-cylindrical bend segment
bends

Gusset feature representation in the flat pattern view

Gusset features on cylindrical or non-cylindrical bends are represented as centerline curves in
the flat pattern view.

Gusset on a cylindrical bend Gusset on a non-cylindrical bend
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Gusset on a cylindrical bend Gusset on a non-cylindrical bend

—Bend Seguence 10 = |
| —Band Direction = up
— _|—Bond Angle : 20.00
Bend Rodive © 3.00

Gusset features on cylindrical blends of deform features are represented as interior feature curves in
the flat pattern view.

Gussets on cylindrical blends of deform features

Gusset interoperability

You can view the boundary edges of the gusset as curves on both layers when you flatten the
bend using the Unbend command.

gyt
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a. Create a round gusset
This example shows how to create a round gusset using the automatic profile.

1.

v

pa—4

Choose Home tab— Punch group— Gusset @

Select the bend face.

4

5

Middle-click to advance to the next step.

To locate the gusset, specify the reference datum plane. You can select a datum plane, or create one
using the Specify Plane options.

NX displays a preview of the gusset.
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Note:
The datum plane must be perpendicular to the axis of the bend.

6.
In the Shape group, set the gusset parameters.

For this example:

e Depth=25

e Form = Round

* Dimensions subgroup:
o Width =20
o Side Angle =10
o Die Radius =3

Click OK to create the gusset.

b. Create a round gusset with a user defined profile

Choose Home tab— Punch group— Gusset @ ;
From the Type list, select User Defined Profile.

In the Section group, click Sketch Section ' and sketch the gusset profile.

In the Create Sketch dialog box, specify the tangent path along which you want to define the
section curve for the gusset.

PO N2

5. In the Plane Location group, from the Location list, select % Arc Length.
6. Inthe % Arc Length box, type 50 and click OK.
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7. Sketch the profile for the gusset.

Note:

The sketch dimensions shown here are approximate.

8. Right-click in the graphics window, and choose Finish lﬁ' to exit the Sketch.

9. In the Section group, from the Width Side list, select Symmetric.
10. In the Shape group, set the gusset parameters.

For this example:

o Form = Round

o Dimensions subgroup:
=  Width=10
= Side Angle=0
= Die Radius=3

Note:

If the user defined profile has more than one curve, the side angle must be 0.
11. Click OK to create the gusset.
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c. Create gussets on cylindrical blends
This example shows how to create gussets on cylindrical blends that are created by deform features
such as a dimple, a drawn cutout, or a solid punch, and so on.

1. Choose Home tab— Punch group— Gusset @ :
2. From the Type list, select Automatic Profile.
3. Inthe Bend group, select the blend face.

\
The gusset is created symmetrically on both sides of this plane.

Note:

The plane must be perpendicular to the selected bend segment.
5. In the Shape group, set the gusset parameters.

For this example:

o Form = Square
o Dimensions subgroup:
= Width=10
= Side Angle =30
= Punch Radius =3
= Die Radius=3
6. Click OK to create the gusset.
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d. Create gussets on non-cylindrical bends
This example shows how to create gussets on non-cylindrical bends that are created by an
advanced flange, a chained contour flange, or a joggle.

1. Choose Home tab— Punch group— Gusset @ :
2. From the Type list, select Automatic Profile.
3. Inthe Bend group, select the bend face.

For this example, we select a bend face created by an advanced flange.

4. In the Location group, select the plane which you want to use to locate the gusset.

The gusset is created symmetrically on both sides of this plane.

5. Inthe Shape group, set the gusset parameters.
For this example:

o Form = Square
o Dimensions subgroup:
= Width=10
= Side Angle = 30
= Punch Radius =3
= Die Radius=3
6. Click OK to create the gusset.
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2.4. Advanced sheet metal commands and modify commands

2.4.1 Advanced sheet metal commands and modify commands
2.4.1.1 Advanced Flange

Use this command to add a flange along an edge using a bend angle or a reference face. The
edge and reference face can be curved.

You can select a single edge or a chain of tangent edges.

When you create a flange, you can:

e Specify that the flange body is on the inside of the bend and indicate that the material is from
the edge opposite the selected reference edge using the Material Inside OML option.

1 Selected reference edge
Material inside opposite the selected reference
edge

Inset = Material Inside OML
o Define the developed flange length according to the DIN6935 standard using
the Tangent option.

Flange using a reference face that does not intersect the body

1 Reference face

2 Sheet Metal body

This command is useful when you want to create non-linear flanges, or when you work with
sheet metal support structures in complex assemblies.

Note:
- The advanced flanges that you create on linear edges of a body work like regular flanges.
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- To create more accurate flat representations, apply compensation for material deformation to the start
and end of the advanced flange edge chain.

Create an Advanced Flange feature

This example shows how to create an Advanced Flange feature along a non-linear edge. The
direction of the flange is along the -ZC axis.

Choose Home tab— Bend group— Advanced Flange @ .
In the Advanced Flange dialog box, from the Type list, select By Value.
In the graphics window, select the base edge for the flange.

W=

4. In the End Limits group, set the following:

a. Click Specify Plane 1 - and select a plane to specify the start limit of the flange.
b. Click Specify Plane 2 . and select a plane to define the end limit of the flange.

(1) End plane
(2) Start plane

5. In the Relief group, specify the bend relief parameters.
a. Bend Relief = Square
b. Depth=3
c. Width=3
d. Corner Relief = None
6. In the Flange Properties group, set the following:

a. Click Reverse Direction X to specify the flange direction along the -ZC axis.
b. Specify the flange properties.

= Length =20

=  Angle =90

= Inset = Material Inside

7. Click OK or Apply to create the Advanced Flange feature.
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2.4.1.2 Joggle

Use this command to offset a portion of a flange or a tab defined by one or two datum planes.
You can create a single joggle or twin joggles. You can also apply partial or full compensation to the
edges of a joggle to create more accurate flat representations.

Joggle on a tab face

Joggle on a web face

You can select multiple adjacent or non-adjacent web faces simultaneously to create the joggle.
You can also specify a different depth value and direction for each web face.

1, 2 Intermediate web Faces

3 End web face

Note:

Make sure the joggle transition does not overlap when you create nested joggles.
Joggle across a datum plane that does not intersect adjacent bend faces

Flattening a complex joggle

To flatten a joggle created on intermediate or multiple adjacent web faces, use the Flattening
and Forming command in the Modeling application.

Complex joggle One layer selected Flattened output
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Create a joggle on the web face of a flange

1. Choose Home tab— Bend group— Joggle @ :
2. Select the face of a flange on which you want to create a joggle.

3. In the Face group, specify the offset value for the joggle.
For this example:
Value =8
4. In the Limits group, specify the joggle type and the start plane.
For this example:
Limit Type = Single

Specify Start Plane = XC-ZC Plane H

5. In the Transition group, in the Side 1 subgroup, set the joggle properties.
For this example:

o Runout=25
o Clearance =0
o Stationary Radius = 5
o Offset Radius =5

6. Click OK to create the joggle.

2.4.1.3 Lightening Cutout

Use the Lightening Cutout command to cut an area of the model inside a sketch that
simulates a stamping tool.
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You can create flanged cutouts. You need to define a cutout diameter or create a sketch of a cutout.

You can also create lightening holes in standard sizes. To specify the standard sizes, use the Sheet
Metal Materials Standards File customer default.

Create a lightening cutout

This example shows how to create a lightening cutout on a tab using a sketch.

v I

p -

Choose Home tab— Bend group— Lightening Cutout < i

NX creates a preview as soon as you finish the sketch. If you set the properties first, and then sketch,
NX creates the lightening cutout to your specified values.

In the Type group, set the following:

Type = User Defined >
Cutout Properties group:

Length=8

Angle = 60

Clearance =5

Section Comer Radius =10

Position group:

Click Sketch Section 'Z
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Sketch the cutout section as shown using the Rectangle “:l command.

Click Finish ‘E‘

5.

.

Examine the preview and then middle-click to create the lightening cutout.

2.4.1.4 Meta Form

Use this command to unform complex geometry into an alternate shape. This command also works
with non-Sheet Metal features and takes material characteristics into account.

Unform complex geometry

Choose Home tab— Bend group— Meta Form Q

In the graphics window, select the region to unform.
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=
In the End Region group, click Select Face Q and select the target faces to unform.

Al

In the Transform Geometry group, select the edges from the unform region.

A

Specify the layer where you want to place the resulting Meta Form feature.

For this example, Layer = 161.
Specify the boundary conditions.
In the Boundary Conditions group, from the Constraint Type list, select Curve-to-Curve.

In the graphics window, select a curve in the target region to specify the start region curves to be used
for mapping.

e

+
In the Boundary Conditions group, click Add Boundary Condition + I
From the Constraint Type list, select Curve-along-Curve.

Select a curve in the target region to specify the start region curves to be used for mapping.

e

In the Thickness group, select the Infer Thickness check box.
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In the Settings group, accept the default values for the Material Properties, Remove Holes,
and Tolerances options.

Click OK or Apply to create the Meta Form feature.

Validate sheet metal parts
Run validation checks on Sheet Metal parts
This procedure shows how to run the minimum web length validation check on a Sheet Metal part.

Open the Sheet Metal part.

- o
On the Resource bar, click the HD3D Tools tab.

On the HD3D Tools tab, double-click Check-Mate
|4

In the Check-Mate dialog box, in the Settings group, click Set Up Tests
In the Set Up Tests dialog box, in the Parts tab, select Current Part.
Click the Tests tab and from the Categories list, select the tests you want to run.

For this example, expand the Sheet Metal node, click Check Web Length and then click Add to

) 4

Selected ;
The selected test is added to the Chosen Tests list.

Click Execute Check-Mate ; to execute the test.
Click Close to close the Set Up Tests dialog box.

The validation results are displayed in the Check-Mate dialog box, in the Results group, and in the
graphics window.

The following graphic shows a failed test.

3
>

—
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2.4.3 Patterning in sheet metal
2.4.3.1 Pattern Face

Use the Pattern Face command to create patterns of faces in various pattern layouts and define pattern
boundaries, reference points, orientation, and clocking.

You can create a pattern of faces using a variety of pattern layouts.

1 < - -

Linear Polygon Along Reference
g = o0 [

s <& i =2
Circular Spiral General Helix

a. Create a rectangular pattern of boss faces

This example shows how to create a linear pattern of the faces of a boss
in two directions to create a rectangular pattern of connection bosses.

Choose Home tab— Feature group— Pattern Face ‘f@ L

v I

N

Select the faces as to pattern.
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In the Pattern Definition group, from the Layout list, select or confirm Linear TS' :

Middle-click to advance.

5

In the Direction 1 subgroup, with Specify Vector active, specify an axis for the first direction of the
pattern.

Set the pattern spacing parameters.
For this example they are set as shown:
Spacing = Count and Pitch
Count=3

Pitch Distance =20

Press Enter after specifying a parameter to display the effect of that parameter on the pattern.
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With Specify Vector active, specify an axis for the second direction of the pattern.

Set the pattern spacing parameters.
For this example they are set as shown:
Spacing = Count and Pitch
Count=3

Pitch Distance =20

[ Alerts *®|
| € Thepatter connotbeapghed.
[ The selected Faces might be an
i:_ incomplete set for patterning,

An Alert message displays because the reference point of the center instance is located in hole, or void
area, that specific instance could not be patterned.

The Pattern Face operation can be completed now, but there will be an Alert graphic ?fﬁ?ﬂ on the
respective Part Navigator node.

The instance reference point can also be deleted if it is not needed.

Right-click on the center reference point and select Delete.

Click OK.
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In the Part Navigator, the Pattern Face node graphic is updated M g

b. Create a grip pattern on a knob sleeve

This example shows how to pattern the faces of protrusions and
recesses to create a grip pattern on a cylindrical sleeve for a knob.

@

Choose Home tab— Feature group— Pattern Face |

Select the faces as shown.

Middle-click to advance.

5
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In the Rotation Axis subgroup, with Specify Vector active, specify an axis of rotation for the circular
pattern.

For this example, the Z axis of the Orient Xpress tool is selected.

&
~

With Specify Point active, specify a rotation point.

For this example, the arc center of the bottom edge is selected to specify a rotation point.

g °
In the Angular Direction subgroup, set the pattern spacing parameters.
For this example they are set as shown:

Spacing = Count and Span

Count =10

Span Angle =360

g5 @

Click OK.
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2.4.3.2 Pattern Feature

Use the Pattern Feature command to create a pattern of features in layouts such as linear, circular, or
polygon, with options for pattern boundary, instance orientation, clocking, and variance.

Create a pattern of Sheet Metal features in a linear layout

This example shows how to create a pattern of a Bead feature in two linear directions.

',
Choose Insert— Associative Copy— Pattern Feature @ :
In the Feature to Pattern group, Select Feature E% is active.
Select the feature to pattern.

For this example, select the Bead feature.

.
'3
I

In the Pattern Definition group, from the Layout list, select Linear 10}

XC
In the Direction 1 subgroup, from the Vector list, select XC =
..——/-’(“-\“\‘
’/ O e
/"'—" ” \\ .

Specify the parameters to create the pattern in direction 1.
For this example the following parameters are used.

In the Direction 1 subgroup, set the following:

Spacing = Count and Span

Count=3

Span Distance = 150
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To specify that you want to create the pattern in two directions, in the Direction 2 subgroup, select
the Use Direction 2 check box.

¥C
To specify the second direction in which to create the pattern, from the Vector list, select -YC .

Specify the parameters to create the pattern in direction 2.
For this example the following parameters are used.
Spacing = Count and Pitch

Count=4

Pitch Distance = 70

2.4.4 Mirroring in Sheet Metal
2.4.4 1 Mirror features

a. Mirror selected features of a part

This example shows how to mirror features shown about an existing datum plane.

Choose Home tab— Modeling group— Mirror Feature %

Select the features that you want to mirror.
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In the Mirror Plane group, from the Plane list, select Existing Plane, and then click Select Plane -3

Select the datum plane.

NX displays the mirrored reference point.

If no suitable mirror plane exists, you can select a planar face or set the Plane list to New Plane and
use the Specify Plane options to create the mirror plane.

Click OK.

The selected features are mirrored about the specified plane.

NX creates a single Mirror Feature. In the Part Navigator, the feature is listed as Mirror Feature under
the Model History node

b. Mirror selected instances of a pattern

This example shows how to mirror selected instances of a pattern of Louvre features.

Choose Home tab— Modeling group— Mirror Feature % ,

Select the instances of the pattern you want to mirror.

Tip:

To ensure that you select an instance instead of the entire pattern, use the Quick Pick dialog box, or
select the instance in the Part Navigator.
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In the Mirror Plane group, from the Plane list, select Existing Plane, and then click Select Plane =

Select the datum plane.

You can also select a planar face.

Click OK.

The selected instances are mirrored about the specified plane.

NX creates a single Mirror Feature. In the Part Navigator, the feature is listed as Mirror Feature under
the Model History node.

2.4.4.2 Mirror body

Use the Mirror Body command to model symmetrical parts by mirroring a body across a datum plane.

\§

You can unbend and rebend the mirrored body, and perform other sheet metal operations on it such as
creating a flat solid or flat pattern.

Because NX retains the sheet metal characteristics during a mirroring operation, you can perform sheet
metal operations on the mirrored body without using the Convert to Sheet Metal command.

c. Mirror a body

This example shows how to mirror a sheet metal body about an existing datum plane. If a suitable
datum plane does not exist, you must first create one using the Datum Plane command.

oy

=9

Choose Home tab— Modeling group— Mirror Body % .
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Select the sheet metal body you want to mirror.

\ _— “\\

In the Mirror Plane group, click Select Plane and then select the mirror plane.

In the Settings group, set the following parameters to make the Mirror Body feature associative to the
original body and fix it at a current timestamp.

Associative =

Fix at Current Timestamp =

Click OK to mirror the selected body.

2.4.4.3 Unite
Use the Unite command to unite sheet metal bodies.

As the sheet metal characteristics are retained during the unite operation, you can perform sheet metal
operations on the resulting body without using the Convert to Sheet Metal command.

The example shows a typical workflow of mirroring and uniting the mirrored sheet metal bodies.

Original sheet metal body
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Mirror the sheet metal body

United sheet metal body and the mirrored body

Flatten the united body

2.4.5 Renew Feature
Use the Renew Feature command to recompute features created in earlier versions of NX to the
current feature version.

Unlike Update, which recreates a feature in its original feature version, Renew Feature recreates a
feature using code from the current NX version.

Renew selected features

Open the part file that contains the features you want to renew.

Choose Menu— Edit— Feature— Renew Feature % :

From the Sort list, select Feature Type.

In the Feature List column, expand the Feature Type for the features you want to renew.
In the expanded feature list, select a feature to renew.

Click Apply to change the selected feature to the current feature version.

The feature version of the selected feature is changed to the current feature version and the item drops
off the feature list.

)

If dependent features do not update correctly or as expected, you can Undo the last operation.
Continue this procedure for other features in the Feature List that you want to renew.

When you have finished all renew operations, exit the Renew Feature dialog box by clicking OK.
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2.4.6 Weld preparations on Sheet Metal parts
Weld preparations on Sheet Metal parts are usually created by applying a Chamfer feature along the
edge between the thickness face and the top or bottom face of a part as shown in the following graphic.

In NX 5 and previous versions of NX, when you apply a chamfer on these edges and then unbend the

3
part, the Unbend =5 command would subtract the chamfered area, as shown in the following
graphic.

Since NX 6, these areas are now handled properly, and the result is what you would expect for a sheet
metal part, as shown in the following graphic.

These new weld preparation edges are also reflected properly in the Flat Pattern feature. If the Chamfer
feature is on the same side of the part as the upward reference face you selected for the Flat Pattern
feature, the chamfered edge is displayed as an edge, as shown in the following graphic.

If the chamfered edge is on the side of the part opposite to the reference face, it is displayed as a hidden
edge, as shown in the following graphic.

]
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2.5 Sheet Metal Drawings

Creating drawings of a sheet metal part is same as creating any other drawing. However, there are
some options specific to sheet metal flat pattern. You can access these settings under View > Flat
Pattern section of the Drafting Preferences dialog.

+ Drawing Format A
- View
Workflow
+ Common
+ Base/Drawing
+ Projected
+ Section
+ Detail
- Flat Pattern

Bend-up Centerli

Bend-down Centl
Bend Tangent
Outer Mold
Inner Mold
Exterior
Interior Cutouts
Intenor Features
Lightening Hole
loggle
Added Top
Added Bottom
Tool Marker
Callouts
Callout Configury
Section Line

To create a flat pattern view, activate the Base View command and select the sheet metal part. On the
Base View dialog, under the Model View section, select Model View to Use > FLAT-PATTERN#1

Model View A
Mode| View to Use Top v
Orient View Tool Top
Front
Right
Scale Back b
Bottom
Scale Left
: Isometric |
Settings Timehic A

FLAT-PATTERN#1 h
Settings q |

On the dialog, set the Scale value and click to place the view. You will notice that lines represent the
bends.
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Flat Pattern

To add a bend table, click Home > Tahle > Bend Table on the ribbon, and then click on the flat pattern

view.
Click on the sheet to position the bend table.

10 tore |Rodivs Angle jOirection e

Band Rodius =
Bend Rodive * 3.00

3.00
Band ] 3 =
e S Beng Angle = 90.00
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i L
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Export Flat Pattern

In addition to creating drawings, you can directly export a sheet metal to DWF or Trumpf GEO
formats. All you have to do is click Flat Pattern > Export Flat Pattern. On the Export Flat Pattern
dialog, select Type > DWF and specify the output file location. Under the Flat Pattern Geometry Types
section, check the geometry types to export. Under the Settings section, select the DWF Revision

type.
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Q Expart Hat Pattern

Type
DxF

Cutplt File
Specify File
Gt\sheet_metal_model13.cf

Fat Pattern
o Select Flat Pattem Feature (1)
B-spline Simplification

Deviational Tolerance [

Flat Pattern Gecmetry Types

[/ Bend-up Centerlines

[v] Bend-down Centerlines

[] Bend Tangent Lines

[¢ Interior Cutout Curves

[ Interior Feature Curves

[_] Added Top Curves and Points

[[] Added Bottom Curves and Points

Settings
DXF Revisian

| Aeey

A‘
=

MT‘

Under Part Navigator, click on the Flat Pattern feature to export, and the click OK.

L | Part Navigator m|
Mame = Up to Date Comr
e (5 History Mode
&; -t Model Views
&- + w8 Camerss
®| + (] Drawing

ﬂ DstumCoor.. ¢
1§ 58 Base Cont.. o

WG Sketch (2175 o

@ MG 5B Dimple (31 o

‘ + [l Pattern Festu... o

4
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2.6. Practical exercises
2.6.1 Example

In this example, you will construct the sheet metal part shown below.

17
Bond Seq =2 —_ Gend B T
/—Sands-qu-mal')-ﬁ
Bend Sequenca ID = 3— Bend Sequence ID = 4 //\
45°
1 it
N 66
Bend Sequonce D=8 | 53
2™ ’k":"‘;\j—smmmmﬂ
AR KRR K Y
}
152 i ==
== T €0
i i LQD_I R R15

¥

R
o

|— 78 152

[ L Band Sequenca ID = &

Bend Sequence ID =6~
Bend Sequence D= 10
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10 Bend 10 240 90.00 up 80.00
8 Bend 9 240 45.00 down 135.00
i} Bend B 240 45.00 down 135.00
7 Bend 7 240 45.00 up 135.00
B Bend & 240 90.00 up 90.00
5 Bend 5 240 90.00 up 90.00
4 Bend 4 240 an.00 up 90.00
a Bend 3 2.00 208.05 down -28.05
2 Bend 2 2.00 208.05 dowr -28.05
1 Bend 1 2.00 208.05 down -28.05
D Name Radius Angle Direction Included Angle
1.Start NX 11.

2. On the ribhon, click the New button to open the New dialog.
3. On the New dialog, select Units > Millimeters and click Sheet Metal. Click OK.

4. On the Top Border Bar, click Menu > Preferences > Sheet Met

3 Select Matenial

I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Bare or. Clad |BARE -
Cat | METAL -
Type (150 -
THICKNESS [16 -
BEND_RADIUS |24 -
NEUTRAL FACTOR  |0.33 -
JOGGLE_RADIUS |E4 v
| - Clear 5‘01!(‘!!0"5 -
Available Matenals 1 /7 A
T

o o

5. On the Sheet Metal Preferences dialog, under Part Properties, select Parameter Entry >
Material Selection.

Click Select Material.

6. On the Select Material dialog, select Aluminiun_6061 from the Available Materials section and
click OK.

7. On the Sheet Metal Preferences dialog, type-in 2.4 in the Relief Depth and Relief Width boxes.
Click OK.

8. On the ribbon, click Home > Basic > Tab and click on the XY plane.

9. Create a sketch and click Finish on the ribbon. On the Tab dialog, click OK to create the tab

feature.

]

0

10. On the ribbon, click Home > Bend > Flange and click on the back edge.
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11. On the Flange dialog, under Flange Properties, select Length Reference > Outside. Select
Inset > Material Outside.
12. Type-in 65 in the Length box. Click OK to create the flange.

Hange Properties A
Length [ mm -
Reverse Direction 3
Metch Face Nane

Angle 90 dey v
Length Reference T Outside -

Inset ) Matenai Qutsde ~

14. On the ribbon, click Home > Bend > Contour Flange.
15. On the Contour Flange dialog, select Section > Sketch Section and click on the right edge of the
tab feature.

Tangent Curves : Edge of 58 Tab(Y) |

16. In the %Arc Length box, type-in 0 and click OK.
17. Draw a line of 15 mm length and click Finish on the ribbon.
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18. On the Contour Flange dialog, select Width Option > Chain.

19. Click Select Edge from the Width section and click on the edge of the tab, as shown in figure.
Click OK to

complete the flange.

20. On the ribbon, click Home > Basic > Tab.

21. Click on the outer face of the contour flange and draw the sketch shown below.

22. Click Finish on the ribbon.

23. On the Tab dialog, select Type > Secondary, and then click OK to create a tab feature.

24. Activate the Sketch command, and then select Sketch Type > On Plane. Next, click on the outer
face of the

tab, and then click OK.

25. Draw a horizontal line at 12 mm distance above the top edge of the contour flange. Next, click
Finish Sketch.

26. Activate the Bend command (On the ribbon, click Home > Bend > More > Bend ) and click on
the line.

27. On the Bend dialog, type-in 45 in the Angle box.

28. Use the Reverse Side button to make sure that the output matches that shown below. Next, click
OK to bend the tab feature.

29. Draw another sketch on the outer face of the contour flange.
30. Activate the Tab command and create a tab feature using the sketch.
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31. Draw a line on the outer face of the tab feature. Next, 15mm dimension between the line and the
top edge of

the contour flange feature. Click Finish Sketch to exit the sketch.

32. Activate the Jog command (click Home > Bend > More > Jog on the ribbon) and click on the
sketched line.

33. On the Jog dialog, select Height Reference > Outside and Inset > Material Outside.

34. Make sure that the Extend Section option is selected.

35. Type-in 20 in the Height box and click OK to add jog to the tab feature.

pd4B-15,0

36. On the ribbon, click Home > Form > Resize Bend Angle é‘ :

37. Click on the outer face of the contour flange feature to define the stationary face.
38. Click on the lower bend of the jog feature and type-in 135 in the Angle box. Click Apply.

Stationary face

39. Click on the inclined face of the jog feature to define the stationary face.
40. Click on the upper bend of the jog and type-in 135 in the Angle box. Click OK
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41. On the ribbon, click Home > Form > Unbend .
42. Click on the outer face of the contour flange feature to define the stationary face.
43. Click on the lower bend of the jog feature. Click Apply to unbend the jog

AY

44. Click on the face located between two bends of the jog to define the stationary face.
45. Click on the upper bend and click OK.

— ’

46. On ribbon, click Home > Feature > Normal Cutout .
47. Click on the outer face of the unbent jog feature. Create the sketch and click Finish on the ribbon.

48. On the Normal Cutout dialog, select Limits > Until Next. Click OK to complete the normal cutout
feature.
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49. On the ribbon, click Home > Form > Rebend and click on the lower bend face of the jog feature.
Click
Apply to rebend the feature

50. Click on the upper bend face, and click OK.

L

51. Activate the Closed Corner command (click Home > Corner > Closed Corner on the ribbon)
and click on

the bends of the flange features.

52. On the Closed Corner dialog, select Type > Close and Relief. Under Corner Properties
section, select

Treatment > Circular Cutout.

53. Under the Relief Properties section, set the (D) Diameter value to 8 mm. Click OK to close the
bends.

Type A
Bends to Close A
# Select Adjacent Bends (0) f
Corner Properties A
Treatment [T Circular Cutout = |
Overlap I Closed *|
Gap 0 mm - |

[] Miter Corner
Relief Properties A
Origan Bend Center - ,
(D) Diameter mm |
(0) Offset 0 |
Legend v
Preview v
| Cancel |
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54. Activate the Hem Flange command (On the ribbon, click Home > Bend > More > Hem Flange
8,

55. On the Hem Flange dialog, select Type > Closed Loop.

56. Under Inset Options, select Inset > Material Outside.

57. Set Bend Radius to 2 and Flange length to 8.
58. Click on the outer edge of the left-side flange, and click Apply

A

59. Click on the outer edges of the backside flange and contour flange. Click OK to create the hem
features.

W

60. Activate the Louver command (click Home > Punch > Louver on the ribbon) and click the Reset
icon on

the Louver dialog.

61. Click on the top face of the tab feature.

62. Draw the sketch shown in figure and click Finish on the ribbon.

63. On the Louver dialog, type-in 5 in the Depth box and click the Reverse Direction button next to
it.
64. Type-in 10 in the Width box.
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65. Under the Louver Properties section, select Louver Shape > Formed.
66. Expand the Louver dialog and check the Round Louver Edges option under the Rounding
section. Type-in 1 in the Die Radius box and click OK to create the louver.

Cut Line A
¥ Sedect Section (1) % M
Lotrer Properties A
Depth #| sq mn
Widih %) w0 mm -
Louwer Shape # Farmed -
Rounding A

[ Rosunet Lowwver Edges

Dwe Ratast 1 mm =

Validation Pararneters A

Minimum Tool Clearance | 50000 mm -

o =

67. Activate the Pattern Feature command (On the ribbon, click Home > Feature > Pattern Feature)
and click louver feature.

68. On the Pattern Feature dialog, select Layout > Linear.

69. Under the Direction 1 section, click Specify Vector and click on the X-axis vector.

70. Under the Direction 1 section, select Spacing > Count and Span. Type-in 6 and 100 in the
Count and Span Distance boxes.

71. Click OK to create the linear pattern of the louver.

Pattern Definition

Layout gH Linear

Boundary Definition

Direction 1

 Specly Vector RlLf 17 -
Spacing Count and Span »
Count 6 -
Span Ditance il mm -
[ ] Symmetric

72. On the ribbon, click Home > Flat Pattern > Flat Pattern.

73. Click on the top face of the tab feature. Uncheck the Move to Absolute CSYS option and click
OK on the Flat

Pattern dialog to create the flat pattern. Next, click OK on the Sheet Metal message.

74. On the ribbon, click View > Orientation > More > New Layout.

75. On the New Layout dialog, click FLAT-PATTERN#1 and click OK to view the flat pattern.
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76. On the ribbon, click View > Orientation > More > Replace View. On the Replace View with

dialog, click

Isometric, and then click OK.

77. Save and close the sheet metal part.

2.6.2 Exercises

Exercise 1

b — — — — 4

41

_—3x®6 THRU
v 910 X 82

[«15T15

T15T15a|

[ 1

SHEET METAL THICKNESS = 2.77 mm

-R2

—2 s

/ J

| )
L , i

Exercise 2
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Exercise 3
. 88 ’
L 33 o A .
4- 45
16 -
= - - i I
: O O 0 : 8
R 2 ~N
. ©)
i i"'I: H 9 Q }
i .
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Exercise 4

24
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. v
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21
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2 |

Exercise 5
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N
44 |
< g .
Sequence Feature Radius Angle Oirection Included
Angle
1 Bend 1 358 mm 9000 deg Down 90.00 deq
2 Bend 2 358 mm 90.00 deg Down 9000 deg
3 Bend 3 358 mm 90.00 deg Up 9000 deg

Exercise 6

27,50

27,80

NS )

VNN

SEIIONE A-A
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Exercise 7

Exercise 8
R4.00 |-— 3200~
l -~
Up 80° R 1
95.00
105,00
28.00—,
POWN 50F R | \
72.50
—{ 2400 r~ B \ '____ o0
7= S
ﬁ, 5 1500 _E_B. 20,00
T & z T
1 4
#13.00—] | % ’:l:E:‘_,ﬁﬁ
25500 ! g 1
-t 9725 T 1000
2500 _ =~ p—5m i
l - 3875
7 1000
=
=
o]
o
&
POWN 0" R11, 75—
95.00
UP 90 R 1
Note:
Al Dimenslons are in mm.
Mattesial : bAS 1

DPP — Vocational Training for Smart Manufacturing in Machine Tools 365



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Exercise 9
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v

Folding Angles & Seguence:

2439

Material: Steel (galvanised), t=1 mm | Scale: 1:2

General Edges
Tolerance ISOf .\ "3324c] LiaMA 2 Centre of Excellence for TVET Dong Nai province

2768 m

Date Name
orawn | /2072017 |J. Frey
Checked
‘Standard
L2-Box-001-small_2 enhanced 2
Al
State Changes Date Name |
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v
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\
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UNIT 3: DESIGN OF PLASTIC INJECTION MOLDS WITH NX: FROM CONCEPT TO DETAILING
Durations:80 hours

Objectives: By the end of this training unit, the trainees will be able to:

Understand the overview of mold design and manufacturing technology

Understand the structure and classification of plastic injection molds

Understand the process of designing and manufacturing plastic injection molds

Understand the design standards of plastic injection molds

Calculating the technical parameters of plastic injection molds

Perform automatic mold design steps with NX software

Implement the simulation process to analyze and optimize the mold design process with NX software
Implement the management of mold data after design (BOM)

Export drawings to manufacture mold details.

Contents:

Mold Overview.
1. Hexagonal screw

2. Positioning ring
3. Spray roll silver
4. Mold (female mold)
5.Siver positioning
6.Front clamp plate
7. Female mold cover
8.Return latch
9. Mold punch (male mold)
10.Locating pin

11. Male mold cover

12. Support plate
13. Suppont pliow
14.Retaining plate
15.Push plate

16.Rear clamp plate

17. Sacondary support
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Hexagon screw: Connects mold plates and creates aesthetics.

Positioning ring: centering between the nozzle bush and the nozzle.

Spray stem bush: guides plastic from the plastic injection machine into the plastic channels.
Mold: creates shape for the product.

Positioning silver: ensures relative position between male and female molds.

Front clamp plate: firmly holds the fixed part of the mold to the plastic injection machine.

Female mold shell: usually made of cheaper materials than the female mold, so it helps reduce mold
costs but still ensures technicality.

Return pin: returns the push system to its original position when the mold closes.
Male mold: shapes the product.

Positioning pin: inserted into the positioning bush when the mold is closed, helping the male and female
molds connect accurately.

Male mold shell: usually made of cheaper materials than female molds, so it helps reduce mold costs
but still ensures technicality.

Support plate: increases mold durability during injection molding process.

Support bearing: creates space for the push plate to operate.

Retaining plate: holds the push pins.

Push plate: push the push pins to release the product from the mold.

Back clamp plate: firmly holds the movable part of the mold on the plastic injection machine.
Secondary support: increases the durability of the mold during the injection molding process.

1. Two-plate mold.

The 2-plate mold is an injection mold using a cold guide system, the channel is horizontal to the mold
parting surface, the plastic entrance gate on the side of the product v2 when opening the mold, there is
only a gap to get the product and the plastic channel.

For a 2-plate mold, the plastic entrance gate can be designed so that the product and the plastic channel
automatically separate when the product and the plastic channel (glue bone) are removed from the
mold.

The 2-plate mold method is very common in injection molding systems. The mold consists of 2 parts:
negative mold and positive mold. The mold structure is simple and easy to manufacture, but 2-plate
molds are usually only used for products where the plastic entrance is easy to arrange.
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L J =

The two-plate mold has many
cavities

The two-plate mold has one mold cavity

\\1 rln

=N

i

Two-Plate Mold with assembled Core) The two plate mold has a side-jointed core)
~in the composne core)

2.Three-plate mold.

The 3-plate mold is an injection mold that uses a cold plastic pipeline system. The channel is arranged
on two flat surfaces and when opening the mold, there are two openings, one opening to take out the
product and the other opening to take out the glue bone. Therefore, if the product is taken into the
channel out of the mold using the ejector system, two systems must be arranged, so the mold structure
will be more complex and larger than a 2-plate mold.

For 3-plate molds, the product and plastic channel are always automatically separated when the product
and plastic channel are removed from the mold.

For large products that need many nozzles or multi-cavity molds that need many nozzles, a 3-plate
mold can be used.

The disadvantage of the 3-plate mold system is that the distance between the machine's nozzle and
the mold cavity is long, which can reduce injection pressure when plasticizing the mold cavity. This can
be overcome by using a hot resin pipeline system
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Figure 1.9.2.1. 3-plate mold structure
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Mold Design with NX Software

T 4. Parting process Choose mold
1' 'nma' Stage ("nitahze) ‘ withdrawal direction Define
Select the save folder (Project Folder) | Core and Cavity areas (Validate Core/ Cavity)
Setthe name (Project Name) Patch holes Create
Seresie unhsilioee) parting lines/surfaces Create
Select the material (Material) Core/ Cavity
\_ Vi
{ 5. Add Mold base
2. Definition / ;
- 6. System design
Work piece Injection system
Ejection system Side
core ejection system (Slider and Lifter)
Cooling system Insert
some sub parts (Sub Inserts) y
3. Options (Optional) | " 7. Complete the :
Change the shrinkage ratio (Edit Shrinkage) Pockets
Layout (Layout) J design Bill of Material
and 2D Drawings

3.1. Initial stage. (Innitiallize)
Open the model file that needs to be molded.

Select mold design environment: Select File All Applicatieag ™% Process Specific ®™»Mold wizard.
The Mold Wizzard toolbar displays.

Home  Curve  Surface Mold Wizard = Assemblies  Analysis  Render View  Tools

H &> E ECQONEDLE ~@AQ To8L s
e 58 L ABKESEeTh. $OSR. 2054 -

Part Validation Main b Parting Tools T Cocling Tools ¥

4

4

Select the Initialize Project initialization command. The Initialize Project dialog box appears
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@ |nitialize Project v?X
Product

Select the product model to make the mold

+/ Select Body (2)

Project Settings

A
-
N s Path from product model file
th
=T
A

Name

=g 7

Mold design project name (name of design model)
Material NYLON Salect production matenals

Shrinkage

Shrinkage coefficient for declared maternial

Configuration Mold.V1

Attributes

Name Value

CUSTOMER  Customerl
DESIGNER <HOST_NAME >
PROJECT_N.. <PROJECT_NAM..

Description of client, designer, project
number.

Settings Unit

Project Units Millimeter /
[ rename Components ——e L

Edit Material Data Base = Rename mold components
Edit Project Configuration ;Q
Edit Customized Attributes E

-

Bl

Mold Wizard includes a material library system (nylon, ABS, PPO, PS...) available, allowing users to
choose directly; or create a new material library for your own use in the Edit Material Data Base section.

After the injection molding process, the product shrinks with a certain coefficient corresponding to each
material being injected. The software will automatically update the corresponding shrinkage coefficient
(Shrinkage), this ensures that the mold created has the right shape. suitable, the designed product is
not deformed or missing in size. In addition, the shrinkage coefficient can be changed by the user by
entering the coefficient in the Edit Material Data Base section.
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3.2. Define

3.2.1. Define mold coordinate system.

NX &~ L - o t-un-n-w Window = = - Modeling SEMENS - & X
EDN o cow suba voiwind Amecbie Aok e Vew Tl Application Flinde
Eood BLALENLE - fRa To4ls #6200 4IEEAN BRF EURIS "
—— OQ ‘Gife.m.kﬂﬁﬂn—\b %H\«i% Ll Rk ] v%m.?r‘aﬁﬁ\dib‘tt LS. mEEs .
t ¥idatan * - FParting Jook ¥ Cooing Toom Mckd Toom = loong valde. * Mo Drawerg il
= ey | e Seeden et - Wit Wers Part and L., = - "l'ﬁ\ Rle= @@ AEEecN-&-@-%-
B pen v (T © rifilion Fijec
3l Name - € U Comm | Produc A
+ [ElModel Yimws
gy oo B NSt ®
ExMadel Hetory s W Praject Settings A
Wé Datian Coordine_
& il Bocy (1) I ® ?un
o G | oo i~
3 Maire
- moduts
E o~ Waterial MYLON -,
Sainkage 106
“' Contiguation Moid i -
® Attribirtrs A
3] Name dalue
I CUSTOMER  Cvicmert -
n DESIONER  <HOST NAME:
k PROECT N, <PROECT NAM. -
i Seftings A
& Propect Linis Wdllimetes -
[ R=namie Campeaens
it Materiai Data Sase =]
Edit raject Canfiguraticn [}
it Customized Attribiites m
Farce

« *

Select salid o1 sheet bady

On the Mold Wizard toolbar, select Mold CSYS in the Main tab.

Home Curve Surface Mold Wizard Assembl

©oE HiPONE DT
i 5 & NS E e F .
Part Validation ~ Main v

MOLD

The mold coordinate system determines the workpiece position, mold withdrawal direction and mold
parting surface. Normally, choose the mold withdrawal direction to coincide with the Z axis.
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© Mold CSYS ue X The origin is available in the design environment

Change Product Position A

At the heart of the detail

(O Current WCS

(® Product Body Center / Al the center of the specified surface

O Center of Selected Faces
(O Select CSYS

Lock XYZ Position A

[] Lock X Position
[JLock Y Position |
Lock Z Position

Change the origin but the X, Y, Z coordinates do not change.

w
| o

Current WCS: When selecting Current WCS, users can still change the coordinate system from the
original design coordinates by double-clicking the left mouse button on the coordinate system, control
buttons as below will appear.

@ Mold CSYS 0?7 X

Change Product Position A YC
(@ Current WCS 4
(O Product Body Center \
(O Center of Selected Faces I o
(O Select CSYS

oK NN | Cancel xc

The direction of the arrow shows how to move the mold TK coordinate system according to the arrow.
The yellow sphere at the control planes rotates the plane around the remaining axis, the orange sphere
at the origin is used to control the coordinate system. move to any position, the mold coordinate origin
is usually located at the mold parting surface.

Product Body Center: When selecting Product Body Center, the coordinate system will automatically
jump to the center of the entire object in all three basic directions (X, Y, Z), however the designer can
lock the system movement coordinates according to those basic directions by clicking on the square
icon in the Lock XYZ Position group.
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¥ Mold CSYS
Change Product Position
(O Current WCS
(® Product Body Center

(O Center of Selected Faces
(O select CSYS

Lock XYZ Position
[]Lock X Position
[JLock Y Position
[ Lock Z Position

Center of selected faces: Command allows placing the coordinate system at the center of a selected
face. This selection face is specified with the Select Object command. Similar to the Product Body
Center command, the Center of Selected Faces command allows control to lock one or more basic
axes in the Lock XYZ Position group.

T Mold CSYS
Change Product Position

(O Current WCS

(O Product Body Center

(@) Center of Selected Faces
(O select CSYS

Lock XYZ Position
[ Lock X Position
[JLock Y Position
[ Lock Z Position

b

Apply i

3.2.2. Definition of embryo.
On the Mold Wizard toolbar, select Workpiece in the Main tab.

File Home  Curve  Surface  Mold Wizard ~ Assemb

&©vE BrASNIE DT -

v -

oy 0@ CIBKL®E>E .
Part Validation ¥ Main v
Workpiece
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NX automatically updates the workpiece size or the user can customize the size or create a new
workpiece cross-section

& Workpiece O ? X fout 009.prt

| &9 Product Workpiece - |
Workpiece Method A
Workpiece Method User Defined Block ~ |
Dimensions A
Define Warkpisce A
Definition Type ‘Skeich -]
Section A
/ Select Curve (4) X[e/1e
Specify Origin Curve D
Limits Al
Start b Value - i - lstan]-2s -
Distance -25 mm v : W
End [+ Value -
Distance 60 mm

Reset Sizes ’3‘

Product Maximum Size:

X =179120 ¥ =117.924
Z_down = 0.000 Z up = 35085
Preview Show Result

Select the type of Workpiece, there are 2 types: Product Workpiece and Combined Workpiece.

Choose embryo creation method :

User Defined Block

Cavity-Core
Cavity Only
Core Only

User-defined: use User Defined Block. In this option, users can define the workpiece type according to
their ideas by defining the workpiece cross-section. An existing line can be selected using the Curve

1o %

or create a new section by selecting Sketch

command
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S|P v St 25 'i

. Y

[k v stan]2s |

3.3. Option. (Optional)

3.3.1. Change the shrinkage coefficient.
On the Mold Wizard toolbar, select Skrinkage in the Main tab.

Home Curve Surface Mold Wizard Assembl
ST B ST
Initiali - % - . "
e 5 & . ABKESE e T

Part Validation Main

4|

4

Skrinkage

The shrinkage factor is automatically updated by the software during initialization, however, the software
provides 3 additional methods to change the shrinkage factor.
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=1

& Scale Body SR B & model3_parting_044.prt

&0 Uniform 4 |

Body A

+/ Select Body (1) ‘E‘

Scale Point A

Scale Factor

Uniform

€ Scale Body

| B Axisymmetric

Body

+/ Select Body (1)

Scale Axis

+/ Specify Vector

Scale Factor

Along Axis
Other Directions

& Scale Bod y

£ General

Body

v Select Body (1)

Scale CSYS
/ Specity CsYS.

Scale Factor

X Direction

¥ Direction
Z Direction

General: Shrinkage coefficient along 3 coordinate axes corresponding to different coefficients X, Y, Z
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3.3.2. Arrange the number of cavities and mold cores (Layout).
On the Mold Wizard toolbar, select Cavity Layout in the Main tab

Home Curve Surface Mold Wizard Assemb

©>3 BCaIlEDlE-
e 8@ - ABELMBE - @ b

b
b

4

Part Validation ~ Main v
Cavity Layout
A mold includes 1 or more Core/ Cavity. With Mold Wizard, users can easily

choose how to arrange the Core/Cavity cluster in a mold to facilitate the placement of nozzles and
subsystems, simple operation:

@ Cavity Layout 0?7 X

Object selection (automatic)
Product X /
 SelectBody (1) 9

Choose loose mold layout (rectangular or round)
Layout Type A /

Rectangular
@ 8alanced () Linear Choose cavity settings (symmetrical or linear)
* Specify Vector XLL .I
\ Chooge the direcion 1o place e next mold cawly
Balanced Layout Settings
Cavity Count 2 vl | Numberof mold cavities
Gap Distance 0 o \
. o mold cavt
Generate Layout i Distance between mold cavities
\ Startlaying out the mold loosaly
Edit Layout A
Edit Insent Pocket Q Lo | o o moasunment sngies for e 4 9cks of B Wokpieos
e 5\\‘-\ Cnangs the positon of fhe moid cavily
Remove X
= Remove mold cavity
Auto Center H
A \\ Automatically move the coordinale sysem belwaen the mald uids
Close
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& Cavity Layout Q7 X LpnD
Product
+/ Select Body (1)

Layout Type

Rectangular
@) Balanced
* Specify’

O Linear

Balanced Layout Settings

Cavity Count 2

Gap Distance o

Generate Layout
Start Layout

Edit Layout

Edit Insert Pocket
Transfarm

Remove

Auto Center

& Cavity Layout
Product

A
+ Select Bedy (1) i‘
A

Layout Type
I_Circular ":‘
@ Radial OCﬂnstanl

Circular Layout Settings

Cavity Count 6 =
Start Angle " 0.0000
Rotate Angle m
Radius | 0.0000]

Generate Layout

Start Layout

Edit Layout
Edit Insert Pocket
Transform

Remove

Auto Center

E Ex el , &,

Arrange 6 round molds.
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3.4. Mold separation process (Parting Process)

3.4.1. Choose the mold withdrawal direction
On the Mold Wizard toolbar, select Check Regions in the Parting Tool tab.

Home Curve Surface Mold Wizard Assemblies Analysis R
©od BLRONECLE ~€~a"
e 5 & . HBKESE2Th. 2SR

Part Validation Main Parting Tools »

4

b

‘

Check Regions
To withdraw the mold smoothly, the product must be designed with a
reasonable bevel angle.

In Mold Wizard, there is a function to measure the bevel angle using a color strip with a limited bevel
angle specified by the mold designer.

Areas that do not meet the requirements can be corrected right in the mold design environment itself.

# Check Regions o7 X

-

Calculate | Face | Region | Information

Praduct Body and Direction A ||
/ Select Product Body (1) @ Select Calculate '
+ SpecfyDrawDirection XC[L] [# - to calculate then select

Caleulate A App'y
Option
@ Keep Existing
() Edit Regions Cnly
(I Reset All

Calculate EE|

Switch to Face card

|| Cancer |
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© Check Regions

Calculate, Face  Region Information

Highlight Selected Faces

Face Draft Angle A
Draft Angle Limit | 30000 *|——————] Enterthabevel angle you want to check

Limit  Count Color
All 33 . Notice tha color resolution comaspanding o the limitad
D Positive »= 3,00 4 . chamfier angle valua.
D Positive <300 4 = Pay 1othe of he object angle Verticai=0
D Vertical a.00 14 . o s verSical surdace. it wil be dificut o mibase Sie mad
[INegative <200 4 .
[[] Negative >= 3,00 5 .
Set Color of All Faces - Set color for all product model surfaces
Undercut A
[[] crossover Faces: 0 .
[Jundercut Areas: g |
[[J undercut Edges: 0

=

Translucency

Selected Faces:

H —————1 Rounds the selected surface
Non Selected Faces:

—-_-__"-———-... 1

I ——————1 _ Surface rounding is not selected

Commands A
Face Split Recalibrate the surface
Face Draft Analysis [ —| T

L ¥ T e |
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388

3.4.2. Determine Core and Cavity areas
Switch to the Region tab

& Check Regions

Calculate  Face Region | Information

Define Regions

Cavity Region
Translucency:

A
127 ||}

Core Region

Translucency:

Undefined Region
Crossover Region Faces
Crossover Vertical Faces
Unknown Faces

Set Regions Color

Assign To Region

/" Select Region Faces (0)

@ Cavity Region
(O Core Region

Settings
Parting Lines
Internal Loops

Parting Edges
Incomplete Loops

e

58

Click to select 3 items in the Undefined Region.

Crossaver Region Faces 2
Crossover Vertical Faces 0
Unknown Faces 0
Set Regions Color ‘ 39‘

select Set Regions Color to separate the detailed
color into 2 parts :Core and Cavity

Details after color separation

Orange (Cavity) .
Blue (Core.

Green {Undetermined).

You can change the color of each area by
clicking on the color box you want to
change and choosing a familiar color.

Click Cavity Region or Core Region and then select faces to add or remove desired faces.

3.4.3. Patch holes

There are 2 ways to patch the hole, use Patch Surface or Use the surface creation tools in the Surface

toolbar to create patch surfaces.

Method 1. Use Patch Surface

On the Mold Wizard toolbar, select Patch Surface in the Parting Tool tab.
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Home Curve Surface Mold Wizard Assemblies Analysis F
L% BEAONEDIE  ~€~ 4K
lt- ¥ ABKE®E 5. 2ASA .

Part Validation Main Pdrting Tools >

4

4]

4
4

Patch Surface

It is necessary to seal the openings to create the secondary molding surface

@ Edge Patch g7 X
Loap Selection A
Type IL\ Traverse >
Iraverse Loop A
Lacp A
* Select Edge/Curve (00 [t
Segments A
Srsira]l
Traverse by Face Color
| Endd Edge
Tolerance | 0.0100
Loop List A
* Select Loop (0] E
List A
[
-
1 1F
|| Ap || Cancel

Patch Surface interface

& Edge Patch 07?7 X
Loop Selection AN
Type s X 1 i

Traverse Loop A
Loop A
Sslect Edge/Curve () !ﬁt'i
Segmenis A

Aislied [:'ﬁ

[+] Traverse by Face Color

[[1End Edae

Tolerance | D."JlUIJI

Loop List M

/ Select Loap (4) ]
List n
Loopt x|

W

Traverse: select each hole you want to patch, the product will be patched one by one

DPP — Vacational Training for Smart Manufacturing in Machine Tools 389



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

@ Edge Patch 0?7 x|

Loop Selection A

Troe e o~

+* Select Face ()

I o]
Loop List A
¥* Select Loop (0)
List A

| || 2ony || Concet |

Face: Select the surface containing the hole you want to patch, the holes on that surface will be patched.

£ Edge Patch 07 Xnas

Locp Selection

Type @ Body

# Select Body (71
Loop List

% Select Loop {0

Lis

>E, @,

Cancel

Body: select the detail with holes you want to patch. All holes on this detail will be patched

The product after being patched with holes using the Patch Surface tool
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On the Mold Wizard toolbar, select Patch Surface in the Parting Tool tab.

@ Edge Patch 0?7 X

Loop Selection A o
| Select the Traverse method "
Type s ol
B Unchecked |:| Traverse by Face Color
Traverse Loop A : . .
Click to select the first Curve line of the hole, then
Loop A ‘ED
_ press Accept! ” 'until the end of the open profile
* Select Edge/Curve (0) N Pal

Ry O

and then press Close Loop | —"
Segments A

If the path does not have the correct profile, select

S ]E]o]m >

Cycle CandidateJ t:j‘ to change direction.
[[] Traverse by Face Color

Tolerance _ 0.010 0

Loop List A
* Select Loop (0)
List A

I Cancel

Details after being patched with Patch
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Method 2. Use the surface creation tools in the Surface toolbar to create patch surfaces.

Home  Curve Surface Mold Wizard  Assemblies  Analysis Ri

o @ £ Through Curves & Face Blend ~ < Four Point Surface &
S 4D Swep P Aesthetic Face Blend & Rapid Surfacing -
Shape Surface ~ & Law Extension & Styled Blend ¥ Fil Surface M

Surface b4

Select N-Sided Surface @ N-sided Surface in More.

Click the Dialog Options icon Eselect N-Sided Surface (More).

Select [ Trim to Boundary

in Settings.
: @ N-Sided Surface 9 ? X
Select Curve: Select the edges you want to constrain as
limits for the created face. |® Trimmed v
Outer Loop A
¥ Select Curve (0) ,/
UV Orientation A
UV Orientation | Area v
Define Rectangle A
Specify Point 1
Reset Rectangle
[~]Praview Show Result .-
w
' Cancel

}_

7 4

L y /
/L] [/

It is necessary to adjust the Cavity and Core part faces so that the mold can be separated

392
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On the Mold Wizard toolbar, select Define Regions in the Parting Tool tab.
Home  Curve  Surface Mold Wizard ~ Assemblies  Analysis R

H ©od BLQAONEDLE ~€~Ra"
e O @

v

HBEESE*Eh. 2R -

Ll

Part Validation ~ Main » Parting Tools >
) . . Define Regions
The Define Regions dialog box appears. 9
& Define Regions O ? X
Define Regions A
Region Name Count Layer
4 All Faces 198 There are a total of 196 faces in the detail
v/ Undefined Faces 0
& Cavity region 129 28 Cavily has 129 sides

% Core region 27
' Core has 67 faces

Create New Region
* Select Region Faces (0)

Search Region

=S
Settings / Create defined zones
[ ] Create Regions

[[] create Parting Lines

- " Create parting lines

o[ o | e

|

Click Cavity Regions then click to select the surfaces you want to add to the Cavity region

Click Core Regions then click to select the faces you want to add to the Core region

DPP — Vocational Training for Smart Manufacturing in Machine Tools 393



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Details before correction (Cavity and Core are mixed up)

Details after calibration (Cavity and Core are separate)
Click Create Region and Create Parting line Apply =

Settings A
Create Regions
Create Parting Lines

o | e

3.4.4. Create parting surface.
3.4.4.1 Creating hand parting faces (manually)

On the Home toolbar, select Sketch in the Direct Sketch tab.
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Home  Curve  Surface  Mold Wizard  Assemblies  Analysis Render  View

QjD/, - @ @ @ &g Pattern Feature % @ @ Chamer 8

/’ O + 7 Datum Extrude Hole @ Unite -~ Delete Edge @ i Body Offset More
¥  Planev ~ @ Shell Body Blend~ @ Draft Surface ¥
Direct Sketch * Feature -
Sketch
The Create Sketch dialog box appears.
& Create Sketch ¥ ?7X
Plane selection method
< On Plane v
Sketch CSYS A
Plane Method Inferred v
' ] Original type as standard
Reference Horizontal v .______________,_
Origin Method Specify Point v
* Specify CSYS kg ~
Mathod for selacting the orgin of d
< 0K > Cancel ‘
Specify the object

Select the plane you want to draw the parting face.

€ Create Sketch

|< On Plane -
Sketch CSYS A
Plane Method | Inferred A
Reference | Horizontal g:d
Origin Method | Specity Point v
-/ Specify C5YS [ =
G
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Select Rectangle L , drag a rectangle around the part (must cover the workpiece).

T 5
& Rectangle X
_R_ec'_{aqg_l_(ﬂ/_[ethod In__pumode
E BNl =
XC/F1/5
YC[BS 1M
ul w

Click the arrow to pull out the tools in the Direct Sketch tab.

Home Curve Surface Mold Wizard
2B W8, O+ N\
Sketch Finish /' ~> "/ \.. .

. Sl-lcr:tsch >'\ /X >?§’ 2 @3&* A .I/.e_’il : I i

Direct Sketch

Click here

Select Project Curve %
lie on the selected plane.

, click to select all edges surrounding the product that

Select Apply
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& Project Curve 0P X

a 1
Objects to Project A
" Select Curve or Point (42} I_ 'Q}
Settings A
Associative
Dutput Curve Type Qriginal b |
Tolerance | '.'J.F.‘rlOEEi
Fs
. *
DK | | Cancel
1 o

On the Surface toolbar, select More in the Surface tab.

Home  Curve  Surface  Mold Wizard  Assemblies  Analysis R«

IO] @ £ Through Curves & Face Blend . <> Four Point Surface &
NX Realiza  Stiidio 4 Swept <D Aesthetic Face Blend ~ @ Rapid Surfacing —
Shape Surface v @ Law Extension & Styled Blend = 7 Fill Surface -

Surface =

Click < Bounded Plane Apply to create the plane.
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© Bounded Plane 07 X

Planar Section A
+/ Select Curve (46) te
Preview Show Result[@

b
| < OK > _'Cancel |

3.4.4.2. Create automatic parting surfaces

On the Mold Wizard toolbar, select Design Parting Surface in the Parting Tool tab.

View  Render  Assemblies  Analysis Tools  Application  Mold Wizard
A vd BLeoNE0LE ~er[@Q] Toec~
pissie]| T 1 QN caGh. PERR\Z20 >4 .

Part Validation ~ Main b Parting Teols v Cooling Tools bl

1 4

=
&
H
&
|

4

4l

Design Parting Surface

The Design Parting Surface dialog box appears.

@ Design Parting Surface

Parting Lines

T > Select all parting lines ‘

Parting Segments

Parti menis | Delete P.. Parting Lines

Offers malding segments for customization ‘
| e s i

| Segment 2 X 18

<

Methods of creating parting surfaces ‘
Create Parting Surface

Method

7] -~ =
. First: Direction l—gm Automatically create parting faces after racognition ‘
+/ Second Direction Em

[ ] Resize All Directions
Use Default Keep Side

Auto Create Parting Surfaces

Auto Create Parting Surfaces

Delete All Existing Parting Surfaces | |

Delete all created parting faces
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Edit Parting Lines A
. Select, add and edit parting lines

+/ Select Parting Lines (0) /---/ //

L W)
Traverse Parting Lines | Qid
Edit Parting Segments A
V/ Select Parting or Guide Line (0) ||
 Select Tranisition Cisrves (0) ::\ / Select the guides for the parting surface
Edit Guide Lines \Y
Settings A
Tolerance | 0.0100 |
Parting Surface Length | 600000 |

I:[ Create Extrude or Swept Surface Preview
[+] As Parting Surface

F

Select Select Parting Lines and 5&“ Single Curve in the Curve Rule section.

Edit Parting Lines A
+/ Select Parting Lines (42) 7
Traverse Parting Lines _Szm

Cooling Tools *

Single Curve w

rting_019.prt & *

Select 2 more edges to form a closed line.

399
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Click Apply then Ok to finish the command.

3.4.5. Create Core/Cavity
On the Mold Wizard toolbar, select Define Cavity and Core in the Parting Tool tab

Home  Curve  Surface  Mold Wizard ~ Assemblies  Analysis Render  View  Tools
©od BLQAONEDLE ~@AQ ol
e 5@ . ABKE®EGh. ISP a. 2824

> Parting Tools i Cooling Tools

3

Part Validation ~ Main

Define Cavity and Core

The Define Cavity and Core dialog box appears
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& Define Cavity and Core O ? X
| % Region v
Select Sheets A
Region Name
A e All regions: All aspects within the product as well
@ Cavity region as the mold.
~( Core region Cavity regions: Product division into Cavity
Caore regions: The surface that divides the product into Core
eet (U o.;,’w Select Sheet: choose to add or remove faces
Suppress A
Settings A
No Interaction Queries
Sew Tolerance | 0.1000

b4

| - 0

Click All Regions then click Apply then Ok.

Go to Windows and select the file named "VothTop"

T Window ~ =
£& New Window...
T Window Layout 8

v 1. modeld_Vothparting_044.prt
. modeld_Vothcore_049.prt

. model4_Vothcavity_048.prt
model4_Vothtop_025.prt

. modeld_Vothlayout_034.prt

. modeld.prt

o v I w N

[F Switch Window...
& Change Displayed Part...

&

Exploded
Use Assembly > Exploded View Views ¥ > New Explotion > Exploded View > Edit Explotion to see
the decomposition of the two mold pieces.
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Iel

File Home  Curve Surface  Mold Wizard Assemb

R &vd BeadlE0ts-
e 9@ . IBEL®E -8 b

Part Validation ~ Main v

On the Mold Wizard toolbar, select Cavity Layout in the Main tab

Al
1l

Cavity Layout

How to use is instructed in section 2.3.2. Layout (Layout).
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3.5. Insert mold. (Add Mold Base).
Mold Wizard provides a rich mold library system with indexes from small to large. Users choose and

can change according to design ideas.

On the Mold Wizard toolbar, select Mold Base Library and Core in the Parting Tool tab

Home Curve Surface Mold Wizard Assemb
©v3 BaolEolR
e 5@ . ABELBE -

Part Validation ~ Main -

Mold Base Library

Use the Mold Base Library command to:

mold assembly to the complete Mold Wizard mold project.
Edit mold structure and size.

Edit existing standards.

Create new standards.

Replace mold jackets with different standards.

Standard Mold Base - Structure one of the components available in the library.

Interchangeable Mold Base - Determines how the panels are arranged and does not use standard
dimensions.

Universal Mold Base - Defines a clear panel layout structure in a combination of thousands of
interchangeable parts.

Custom Mold Base — Develop into your company's standard.

Reuse Library =) L—nﬂ @ Mol Base Library O 7 X Information x .!t i
Hame o Select Item (2A) ) N
— E MW Mold Base Library % ot Y Ter—f T e [ coaptipe
= ] »—]] U —
+IDOMs % Select Mold Base (0) i i|
+ EIFUTABA.DE e [l concept Design L I: : 2
+ EFUTABA_DE REFERENCE * N Dt o =
+ EIFUTABAFG %4 0 » 5 E
+ EFUTABA S O i I ;
+ EIHASCO E " e
1 = Details A (A
+ ETHASCD INTERCHANGEABLE gff L—Tm—-l
[ MName Value
+ B HASCO REFERENCE /
+ l‘:.LKM |1p- e ' index 3040 -~ Layout Size
+1 | - A 3 W =230 Zup =60
+ILKM_SG i xtp_: ) g L =230 Z down =25
+ EILKM_TP =) i
+ FTIMEUSBURGER_DRILLED_INTERCH & DOE b 26 L
+ FEIMEUSBURGER_PLAIN_INTERCH = Bl e 2
+ FEIMEUSBURGER_UNVERBOHRT_INT...
+ FEIMEUSBURGER_VEREOHRT_INTERCH Settings A
+ EIRABOURDIN INTERCHANGEABLE Edit Regster =
E
+EISTRACK INTERCHANGEABLE
+EUNIVERSAL Edit Data Base
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On the Rouse Library bar in the left corner: all mold standards of mold shell manufacturers are
integrated into the software. For example: FUTABA, HASACO... Depending on the working needs as
well as which standard the partner chooses, the designer can choose the mold shell company as
desired.

Below the Rouse Library bar displays selection and viewing modes.

Searc h: Search for mold standards by name.

Wesubes Sekat < Member Select : Displays the mold types within the
8 7|7 7| ©lisors selected standard
Mame Standard

2A 2B 3A
. “« . Preview : preview the structure of a selected set of molds
Preview A
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& Mold Base Library .

v/ Select ltem (GC) @
&
@D

-~
X

The selected standard, here is GC

\

Part

Select Mold Base (0)

["]Rename Components

Dimensional parameters when choosing
a mold cover can be changed
to suit the mold cavity

Details A

Name Value

&' ¥ index 3045 A
ﬂ‘v AP_h 120

&' v BP.h 70

g+ CPh 100

&' Uh 45 Opens an Excel document that allows you to edit it

e v ETYPE 0
e ™w 1850
mold_w 300 v
< | > Open the data file with detailed tables of contents
Settings A /

Edit Register I @‘
B

Edit Data Base |

[ Click Apply

Click Apply

In case you want to correct the parameters of an existing mold, do as follows.
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Right click on the assembly name (the assembly for the entire mold is taken from the library). Select

Edit Tooling Component @ to return to the editing window similar to the window when filling in mold
parameters.

Or click on the Mold Base Library icon on the Main tab to edit the parameters of the mold.

Descriptive Part Name & In.. R M Cou.. ReferenceS.. @
=7 Sections

@q'i - V¥ model3_top_000 (Orde... 75 «
| + @ Constraints 1 S
@i + Vit model3_layout_009 29 Entire Part ;.,(_—_—
|+ [#% model3_misc_006 3 Entire Part i
) @ model3 fill 005 Entire Part | X
+ I3 model3_cool_002 =) & 2 Entire Part [
" @9 model3_var_001 PRV BB/ X B
= + 1% model3Vothmove., e b >
: + [i#s model3Vothfixhalf, & Make Work Part t i

@ I @& Open in Window :

If you want to replace another type of mold cover, right-click on the mold assembly file name you want
to replace and fill in the parameters to get the mold cover.

3.6. System design.

3.6.1. Spray system. (Injection)
Mold Wizard provides a standard library, users can customize appropriate parameters. Selecting details
in the spray system (Positioning ring, Spray stem, Channel, Spray nozzle) becomes simple and fast.

Positioning ring

On the Mold Wizard toolbar, select Standard Part Library @ in the Main tab.
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Home Curve Surface Mold Wizard Assemb
&3 EraoNEEkE -
Initiali : 7 '
e 5@ L R KLSE e H .

Part Validation ~ Main -
':j“se ekl = Standard Part Library

“FLocks "

i Easlide
Lo Select the Rouse Library tab > in MW Standard
S g Part Library > Find the mold row > FUTABA _MM >
— IFUTABA MM Select Locating Ring Interchangeable.

: E5Sprue Bushing

~E3Ejector Pin

- BReturn Pins Member Select section : select locating Ring [M-

- FiEjector Sleeve

— LR]: type of locating ring with fixed pins and bolts to
| PSprue Puller locate and clamp tightly on the front clamp plate.

~PGuides
i EiSpacers

Search v
Member Select A

E ':-"'i 1-20f2

Mame Standard
ey
< &5

Locating Locating
Ring Ring [M-LRI]

Preview v
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Standard Part Management dialog box, there is a
Details box that contains the main parameters of
the positioning ring that need to be edited.

© Standard Part Management 0?7 X

+/ Select ltem (Locating Ring [M-LRJ])

Part

Select Standard Part (0) Click OK.

(® Add Instance(_) New Component
[] concept Design
|:] Rename Components

Placement A

Parent model3_misc 006 ¥ |

Position NULL v

Reference Set TRUE i |

Details A
Name Value

&' ¥ DIAMETER 100 A

' v THICKNESS 15
&' ¥ HOLE_THRU_DI... 35
5'E5 BOTTOM_C_BO... 35
S EESCREW_HOLE_.. 65

LFEl AN ~ DARE N 9c Y
< >
Settings A
Edit Register @!
Edit Data Base @!

s

BN appy | cance

Coat the mold after adding the positioning ring.

408 DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

To edit the parameters of details in the selected library or change the location, there are the following
ways.

Click on Standard Part Library @ in the Main tab.

Right-click on the detail, select Edit Tooling Component @
Ga|
Reponsition ~when you want to change position

Flip Direction | é when you want to change the mounting direction

x,
Remove Componcat - when you want to delete details

Silver spray stem .

On the Mold Wizard toolbar, select Standard Part Library @ in the Main tab.

Home Curve Surface Mold Wizard Assemb
&% BLaoNEEPR
e 5@ . HBEISE > T -

Part Validation ~ Main -

(o]

Standard Part Library

e = Select the Rouse Library tab > in MW
Name Standard Part Library > Find the mold row >
SZZZ:;S i FUTABA _MM > Select Sprue Bushing.

HlLocks
B siide Member Select section: select Sprue

+EADMS_MM z
+ I DUME_LIBRARY Bushlng [M-SJA]
+ EFILL_ MM
- FEFUTABA_ MM

Ellocating Ring (nterchangeable

EIEjector Pin

1 Retum Pins

B Ejector Sleave

3 Ejector Blade

= Sprue Puller

Search v

Member Select A
Em T :
| = Y| NEq-2 0f2
Name Standard
Sprue Sprue
Bushing Bushing
Preview v
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© Standard Part Management 0?7 X
Standard Part Management dialog box , there is
a Details box that contains the main parameters
of the nozzle bush that need to be edited.

+/ Select Iitem (Sprue Bushing [M-SJAM-SJBM m
Part A

Select Standard Part (0) - ‘

@ Add Instanceo New Component
[ ] concept Design
D Rename Components

Click OK

Placement A

Parent | model3_misc_006 '_‘

Position INULL -

Reference Set | TRUE - ‘

Details A

Name Value
e§' v CATALOG M-SJA N
o5 ¥ CATALOG DIA 10
="' v MATERIAL S45C
BvO0 2:A
F*R 10.5Y
o TADED 41 e
< >
Settings A
Edit Register @ ‘
Edit Data Base @ ‘

Coat the mold after adding spray stem silver.
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To edit the parameters of details in the selected library or change the location, there are the following
ways.

Click on Standard Part Library @ in the Main tab.

Right-click on the detail, select Edit Tooling Component m

Fa

Reponsition 'when you want to change the position of the nozzle bush

Flip Direction | G.When you want to change the mounting direction

x
Remove Componcat ' " when you want to delete details

Spray Mouth.

On the Mold Wizard toolbar, select Design Fill 5 in the Main tab.

Home Curve Surface Mold Wizard Assemb
Il >3 BLONE0E-
Initiali ' % ¢

ell> B S 1 [7d] < T =T

Part Validation ~ Main bt

Design
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Reuse Library = Member Select section: select the appropriate

type of plastic input port.
Mame
= MW Fill Library
+ESFILL MM R
© Design Fill V7 X
Component A
5 . +/ Select Item (Gate{Fan]) ' m
Search A
— =l Select Component (0) @
2 1= ["] Rename Component
Member Select A @
i T _Ilo Details A
_ B |7 ~|D1as0115
N .E';t dard v Name Value
ame andarn . o e |0ﬂ_ o Parabolic ~
BvYH 3
o§' ¥ Position Runner
vl 0
Runner[2] Runner[4] Runner[8A] Runner[8B] AT 06
PFTE) a = ¥
Flacement A
% Select Dbject (0) RS
Runner[16] Runner|Circl... Runner[5] Runner|[Circle =
3RAP] Specify Orientation &
Settings A
[] Reference Layout
Gate[Side] =~ Gate[Subari.. GatelSub-yal | GatelFan] (] Add Constraint
-
Cancel
Preview b 4
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On the Mold Wizard toolbar, select Pocket E in the Main tab.

& Pocket 5. 2 ¢ Click on the core plate in Select Body > click on the

newly created plastic entrance to create a cavity >

Mode A select Apply.
! B2 Subtract Material v ‘

Target A

% Select Body (0) P

Tool A

Tool Type ‘. Solid v ‘

¥ Select Object (0)

b -

Reference Set No Change

IR

X
T
X
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Plastic channel .

On the Mold Wizard toolbar, select Runner E in the Main tab.
Home Curve Surface Mold Wizard Assemb

©vd BUQONMS DT
Initi?Iize é % - G% > @ 2 a} -

Project

Part Validation ~

Runner
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& Runner 0 ? X
Guide A
* Select Curve (0) . %)
Section A
¥* Specify Vector t ‘ Tﬁ‘ ]
Section Offset |0 rﬁm—_v
Section Type Circular -

Details | A
Name Value
eEED 8
Preview
-
! Cancel

Click Finish

Click Sketch Section .in the Runner dialog box

. The Create Sketch dialog box appears.

Sketch
@ Create Sketch 0?7 X
< On Plane - ‘
Sketch CSYS
Plane Method ' Inferred », |
Reference |Horizontal ». |

Origin Method ISpecify Point - |
Specify CSYS [&]kg =

Click OK

Sketch the path of the channel.
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& Runner Q7 >< ..:
Guide A
/ Select Curve (4] |ﬁj
Section A
+/ Specify Vector E“IT’ x
Section dffse‘l Cl—mrnv
Section Type E;‘C]lcular -

Details A

Name - Value

ST E——
@Preview

v
Apply

In the Details box, you can edit the channel diameter to suit the nozzle.
Click Apply.

On the Mold Wizard toolbar, select Pocket ii in the Main tab.
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© Pocket 0 ?
Mode

Click on the Core sheet in the Select Body section
> click on the newly created plastic channel to
groove in the Select Object section > select Apply.

Subtract Material

Target

* Select Body (0) @

Tool

Tool Type @ Solid

¥ Select Object (0) .

No Change

Tools

Cancel

The spray system has been designed.

3.6.2. Ejection system design
To be able to arrange the propulsion system appropriately, we need to rely on the structure of the

product.

On the Mold Wizard toolbar, select Design Ejection Pin ﬂm in the Main tab.

DPP — Vocational Training for Smart Manufacturing in Machine Tools A7



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Home Curve Surface Mold Wizard Assemb

H &>E ELeSNEoldE
boee O @ GI%E@?@m@DD

Part Validation ~ Main

On the Rouse Library tab > in MW
Reuse Library

Ejector Library > DME_MM > Select
Bame Ejection.
- @ MW Ejector Library
- DME_MM
- FiEjection
+[IDMS_MM
+ S FUTABA MM

Search

Member Select selects Ejector Pin .

Member Select

= —
B T W V|50
Mame Standard

N RN

Ejscior Pin Fjector Pin Ejector
~ [Straight] [Shoulderad] Sleave Assy

{

Ejecior Pin
Flat [FW,FK]

Care Pin

Preview

The Design Ejector Pin dialog box appears.
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& Design Ejector Pin 0 ? X

Component 5

/ Select Item (Ejector Pin [Straight]) D

Details !
Name Value
65 ¥ MATERIAL 12344 A
CATALOG_DIA 1.2
= - Push pin parameters,
e§' v CATALOG_LENGTH 100 subject to change
o§' v HEAD_TYPE i
ef' v FIT_DISTANCE 5
- CITNE i
Definition A
Parent |voth_prod 014 v ‘ Determine the position of the latch
Type | *+ Specify Position  ~ f—— by clicking the mouse.
Search Sleeve Position .g.':-j-\":
Sy FoinE E ‘g~ \ Smart pin hole finding mode,
Specify Orientation e R SR
@ Instance O New Part
w
‘ oK ‘ ‘ Apply || Cancel ]

Click Specify Point > select the
points you want to set the pin >
Click OK .

On the Mold Wizard toolbar, select

| Concept Design ﬂﬁ in the Main
~ tab.
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Home Curve Surface Mold Wizard Assemb

B ©vE BCSNEDLE
e 8@ - ABELRSE « 0]

Part Validation Main "'/

Concept

4

4

The Concept Design dialog box appears.

£ Concept Design 5 -0 .4 Press CTRL then select the lines below > click
A

OK to create the handle.
Concept Components

Part to Search for Symbols ‘voth _prod_014 » ‘

D Include child components for search
+/ Select Symbol or Point (8) e

Original Na.. Part Name

Catalog

o | e |
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The push pins are longer than the
product position > cut off the excess
products of the pin.

On the Mold Wizard toolbar, select

Ejector Pin Post Processing @in the
Main tab to cut the pin.

Home Curve Surface Mold Wizard Assemb

I ©vE B oNE o idE
e 0@ < HBKMBE~§ Ly

Part Validation

b

4

Main b

Ejector Pin Post

The Ejector Pin Post Processing dialog box appears.

& Ejector Pin Post Processing e 1 -« Press CTRL and then select the rows in the Target

Type & table.
| I'd Trim ¥ |
Target A Trim Surface : select CORE_TRIM_SHEET, use the
male mold surface to cut the pin.
Part Name Cou.. Status
voth_ej_pin_086 1 Original N
voth_ej_pin_089 1 Original Click OK .
voth_ej_pin_095 1 Original
voth_ej_pin_092 1 Original
voth_ej_pin_069 1 Original o
* Select Ejectors (0) &
Tool A
Trim Part ‘voth_tlim_022 > |
Trim Surface ‘ CORE_TRIM_SHEET ~
-
DK | Apply [ Cancel ]
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The mold has cut off all excess pins.

|
' On the Mold Wizard toolbar, select
Pocket ii in the Main tab.

Pocket

Home Curve Surface Mold Wizard Assemb

&©>F BLASMNEDIE-
e 5@ . HBKIBE~E L.

Part Validation

b

4

4
=
B
b=
4

_Target: Main mold, main mold cover,

return plate.
Mode A _Tool: are the pins created here.
i@ Subtract Material = i _Click OK.
Target A
% Select Body (0) @
Tool A
Tool Type @ solid _v|

¥ Select Object (0)

4

sference Set MNo Change

>

Tools

Apply |: Cancel
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3. 6.3. Insert some sub details (Sub Insert).
The spring is mounted coaxially with the return pin to push the return plate back to its original position.

On the Mold Wizard toolbar, select Standard Part Library @ in the Main tab.

Home Curve Surface Mold Wizard Assemb
>3 BLaoNE[EPeT -
Initiali 4 % '
e 5@ . ABELSE e .

Part Validation ~ Main hd

Satndard Part Library

Feuse Library O

Name Select the Rouse Library tab > in MW
. -Blcuides A Standard Part Library > Find the mold row
 Fllocks > FUTABA _MM > Select Springs
 BISlide
+EIDMS_MM
:g EfFi;:'BMRY Member Select section : select Springs [M-
— FIFUTABA_MM FSRI: spring type
rfI Loczting Ring Interchangeable
é'r:—ISprue Bushing
é--EIEjecor Pin

-~ Return Pins
e Ejector Sleeve
= Ejector Blade
e Sprue Puller

. [TGuides

= Spacers
= Support

= Stop Buttons
. -Pslide
 Flock Unit

. Biscrews

- FGate Bushings
LB Strap
 E3PullPin

~ F-1Springs

- - HlInsulator Sheets
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The Standard Part Management dialog box appears.

© Standard Part Management v 7? X
« Select tem (Spring [M-FSB]) i)
Part A

Select Standard Part (0)

@ Add Instance(_) New Component
I:| Concept Design

D Rename Components

0

Placement
Parent voth_top_000 v, Select Voth_top
Position PLANE i
* Select Face or Plane (0) R
Reference Set TRUE

——— | Select the starting plane of
the spring (top of the return plate)

Details

Name Value

o'+ TYPE M-FSB =
'~ WIRE_TYPE RECTANGLE |

' v DIAMETER s

' CATALOG_LEN., |

Spring parameters

5~ DISPLAY TUBE

HEH COMPRESSION O -
Settings
Associative Position
Edit Register
Edit Data Base
Cancel
Click Apply
The Standard Part Position dialog box appears.
& Standard Part Position Q7?7 X
Reference Point A
/' Specify Point |-
Face Center E*E”
Offset A
/" Specify Point ~Jz<:\ Adjust the spring coaxially
X Offset 0 — -! with the return pin
Y Offset 0 mm ‘
-

3.7. Complete design.

3.7.1. Create holes (Pockets).

The hole making stage is the final stage of the mold design process. Intersection locations between
pipes and support plates or screw holes... need to be created. The Pocket tool helps create holes
quickly with a few taps.
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On the Mold Wizard toolbar, select Standard Part Library ﬁ in the Main tab.

Home Curve Surface Mold Wizard Assemb
o3 BLAONE VLT
Initiali P z
oedll- R S E

Part Validation *

b

© Pocket O 7?7 X Pocket

MOde A

& Subtract Material -

Sedect the object that needs

Target A/ to creale a hole
* Select Body (0) P

Tool

Tool Type @ Solid

A
! Tool selection
* Select Object (0) .—/
A

No Change
] Automatically find cut-
% through details

Ramove thae hole created

Tools ‘

% y Cancel

3.7.2. Create a bill of material (Bill of Material).

Molds are created with many details, systems, and sub-details. Each detail or system consists of
different materials and sizes. Bill of Material allows creating a list of materials, dimensions, etc. so that
users can optimally manage materials.

On the Mold Wizard toolbar, select Bill of Material @in the Main tab.
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File Home  Curve  Surface Mold Wizard =~ Assemb

I &> Dol EDR-

e 5@ - ABKESEe T k-
Part Validation ~ Main : 4

Bill of Material

@& Bill of Material

Select Compaonents A
Select Components () . 4
List A
O, 1 L PART NAM QTY CATALOG/SEE MATERIAL SUPPLIER DESCRIETION |
- w
5 v
% %
TBP-10-05 BRASS - DME FLOW DIVER... ™
1.2344 * DME EIECTOR PN *
1.2344 - DME CIECTORFIN =
EIP-EHN 1.2 X ... 1.2344 - DME EIECTOR PN -
s BIP-EHN 1.2 X ... 12344 - DME EIECTORFIN -~
EIP-EHN 4.2 % 1.7344 - DME EIECTOR PN ~
EIF-EHN 4.2 X ... 1.2344 - DME EIECTORFIN ~
EIF-EHN 4.2 % . : 17344 - DME EIECTOR FIN -~
BIF-EHN 4.2 ... L 1.2344 * DME EIECTOR FIN ~
24 -m- BEP-1415 BRASS - DME 1/4 EXTENSL.. =
- £ mabn - 5 = =
. @) BEEON &7
=

| OK |i Appoly || (Smﬂ|

Materials table
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UNIT 4: DESIGN OF PRESS DIES WITH NX PROGRESSIVE DIE WIZARD:
STREAMLINING WORKFLOW
Detailed Content:
Objective: By the end of this training unit, the trainees will be able to
- Present the concept of sheet presswork technology and classify the types of this technology
- Analyze the functions of the components that make up a common stamping die
- Explain the use of support commands of the PDW tool
- Use the commands of the PDW tool to design a complete set of progressive die
- Solve application assignments with the help of the PDW tool.
Content:

4.1. Overview of press dies

4.1.1. Sheet stamping technology

Sheet forming technology is a part of pressure metal processing technology to deform sheet
metal to obtain details of the desired shape and size. This is a type of technology that is being widely
applied in many different industries, especially in the fields of electrical engineering, electronics,
automobile manufacturing industry, aviation industry, and manufacturing industry, consumer goods
manufacturing industry, defense industry, food, chemicals, healthcare...

a. Concept of sheet stamping technology: Sheet stamping is a part of a technological process that
includes many different technological operations to deform metal (tape or strip blanks) to obtain details
of the required shape and size, with negligible change in the thickness S of the material and no scrap
in the form of chips.

Sheet stamping is often done with the workpiece in a cold state, so it is also called cold stamping when
the thickness S of the workpiece is small (usually S £ 4mm) or may require stamping in a hot state when
the thickness of the material is large. Products of die technology may have to go through many different
operations, which can be performed on the same machine or multiple machines. For example: cutting
shapes, punching holes, stamping, bending...

b. Classification of sheet stamping technology: According to the deformation characteristics of the
sheet stamping process, people are divided into 2 main groups:

- Material cutting operations group: when shaping details, operations in this group often have to deform
and destroy the material.

- Material plastic deformation operations group: detailed shaping is based on the plastic deformation of
the material and in most cases there is metal redistribution. In most cases, the workpiece material
thickness barely changes or changes slightly but unintentionally.




I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Sheet Stamping

¢ v

‘ A — Cutting materials ‘ ‘ B — Plastic deformation ‘

v

v ' ! !

y

‘ I - Cutting ‘ ‘ II - Bending ‘ ‘I]I — Draw Stamping

IV — Forming ‘ ‘ V —Forging

A\ Y Y

-

:

= E . =1)]

| &8 o | = =

u|l 2| S| m (=) = | = B

=4 s — i 172 1 =l | = 5 = A

gl 2|52l & e h == o0 n
Moo | | s S =38 o o= s =l "

Z|F| = 2|5 |B|E| oo | = | o 55 o .5 ., =0 2 8

=a| =0 E| ol sof =n| 2| an = e|.g %5 . B e | 02 B e AR £

= I S O~ o - B~ = | B g > |5 elal=a |- B9 |5 5]

E|E|2|E|E|E|g|E Z| 5|2 5 |-5°8 EE|E| & B|B 3

R BISIBIEIBIEIA 39| F L= E S|E|z|E 2|5 g

ORNORN-TR RERRON RGN NN RS 0| Ol 5 e || i

— ||l | F | n | d | |4 —~ | i | en — |l B — il ||| & —

. Mark stamping

-

3. Elastic extrusion

(=

4. Parts assembling

Figure 4.1: Classification of sheet stamping operations

In the die process, people can stamp each operation separately or combine two or more operations on
the same die. When stamping each operation separately, the productivity is generally low, the
manufacturing time is long, it will have to be disassembled many times, and many workers are used.

b1. Advantages of die technology:
- Can perform complex tasks with simple movements of equipment and dies

- Can produce complex parts that are impossible or very difficult with other mechanical processing
methods.

- The precision of the die parts is relatively high, ensuring good fit, no need for mechanical processing

- The structure of the die part is sturdy, durable and lightweight, the level of material wastage is not
large, saving materials

- Saves raw materials, facilitates mechanical processes and automation, thus high labor productivity
and lower product prices.

- The operation process is simple, so there is no need for high-level workers, reducing salary training
costs

- Production form suitable for large batch and mass production
- Take advantage of raw materials, high material utilization coefficient

- Stamping dies can only process metal materials but can also process non-metallic materials and
flexible materials.

b2. Disadvantages of die technology:

- Relatively large initial investment (dies and equipment) so only suitable for large batch and mass
production

- Requires a team of highly qualified and skilled engineers
- Complicated technological calculations.
c. Stamping sheet metal on a progressive die

c1. Concepts, characteristics and applications of continuous stamping dies
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Continuous stamping is a unique technology in which a progressive die integrates multiple die
operations on the same press machine journey. Designing and manufacturing continuous stamping
dies is a complex and meticulous process, requiring the designer to master all technological processes
in die. At the same time, master current advanced manufacturing technology.

The application of modern simulation design and machining technologies has increasingly
increased the accuracy, speed, and efficiency of continuous stamping dies to meet the needs of
producing large series of parts with high interchangeability, low cost for industries.

Progressive stamping die (referred to as progressive die) is a die consisting of many pairs of
punches and dies arranged on the same die base to perform different sheet stamping operations
(stamping, bending, embossing, cutting. ..) after one journey of the press. Each working position (a pair
of punch and die) performs one or more separate technological steps, with support of the automatic bar
feeding structure, the workpiece is continuously and sequentially moved through positions to complete
the part to be manufactured. The product is formed after the final stamping in the cavity of the die. Each
stamping will produce a product. Each journey of the sliding head will perform many different
technological operations. The sequential execution of operations makes continuous dies highly
automated.

Always accompanying the progressive die is the automatic bar feeding system. It plays a
decisive role in the automation ability of each factory. Progressive stamping requires absolute precision
in moving the workpiece to produce high quality products.

Progressive die s can be classified as follows:

- The die continuously performs stamping operations
- The die continuously performs bending operations
- The die continuously presses and cuts

- Progressive stamping includes many different operations (bending, drawing, punching, cutting...)

Figure 4.2: The progressive die performs the bending operation
1. Stopper 2. Cutting punch 3. Bending punch

Progressive die application selection criteria:
- Manufacturing parts need to go through many different sheet stamping operations
- High required production capacity (mass and large batch production)

- Products require high uniformity and accuracy

achine Tools
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- Machinery and equipment capable of meeting high requirements: high-precision stamping machines,
unrolling equipment, billet straightening and precise automatic bar feeding system.

Around the world, stamping dies are continuously applied in many manufacturing industries:
electricity, electronics, aircraft, cars, mechanical parts, household appliances... In Vietnam, this
technology is initially being applied to production in the field of processing details in motorbikes, electric
motors...

The reason why continuous stamping dies are so widely used is because this type of die has
many outstanding advantages compared to other types of technology:

- Smooth metal organization, high product mechanical properties

- The gloss and precision are higher than parts made by other stamping methods because the stamping
process occurs continuously

- Save time and minimize errors by not wasting time setting and setting errors
- Easy to mechanize and automate, so productivity is high and costs are low
- Process complex parts efficiently and effectively

In the future, the application of continuous sheet stamping technology will continue to grow
strongly because of the great efficiency and benefits it brings to industrial manufacturing industries not
only in Vietnam but around the world.

c2. Basis of technological processes on progressive die
Stamping operations in continuous stamping technology can be divided into 2 groups:

- Separation operations: based on the principle of material destruction to separate one part from another
(division cutting, punching cutting, injection cutting...)

- Shaping operations: based on the plastic deformation process of metal (bending, stamping, drawing,
chipping...)
c3. Cutting operations

Cutting is a chipless machining operation that separates part or all of a metal from a sheet of

material. The cutting method is arranged according to the shape of the blade. The material is cut by two
cutting edges that join together at an angle of the B knife.

When the punch contacts the workpiece, the cutting edge presses against the material until the
stress exceeds the allowable shear stress value. At the cutting edge of the die, cracks form in the
material, the cracks grow into the plate and separate the material. In the cutting die, the punch plays
the role of the moving upper blade while the die plays the role of the non-moving lower blade of the
sheet cutting machine.

The die cutting process is carried out on a crankshaft press or a hydraulic press.

Sectioning is the operation of completely separating material along a curve whose two ends do not
meet.

Extraction cutting is the operation of cutting a part of material along a curve whose two ends
do not meet.

Shape cutting is the operation of separating a part of metal along a closed contour, the
separated metal part is the detail.

Hole punching is the process of cutting material along a closed contour to form a smooth hole
in the part or plate. The cut material is scrap.

Edge cutting is the operation of cutting the edge rim when stamping block parts on an open die.
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Figure 4.3: Stamping and cutting process

c4. Shaping operations

Draw stamping is an operation to transform flat or hollow blanks to create hollow parts of the required
shape and size. There are two methods of stamping as follows:

Draw stamping without thinning: unintentional stamping reduces the thickness of the material

Draw stamping with thinning. stroke stamping intentionally reduces the thickness of the
workpiece (mainly the thickness of the part wall). Most cases of debossing with thinning are performed
with workpieces that have been first deformed without thinning from flat workpieces.

During the non-thin stamping process, the rim edge of the workpiece may not be pulled all the way into
the die, causing wrinkles at the rim. To prevent wrinkles, people often use a material blocking plate to
press the rim of the workpiece to the die surface.
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Figure 4.4: Draw stamping steps

a) Draw stamping for the first time b) Draw stamping for the next times

Bending is a method of turning a straight workpiece into a curved or folded workpiece at a certain
angle.
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Figure 4.5: Stages of the bending process in the die

4.1.2. Structure of a progressive stamping die
a. Structure of a progressive stamping die
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Figure 4.6: Overall structure of a progressive stamping die

1. Bolt

2. Locator pin

3. Screw

4. Upper die base

5. Suspension bolt

6. Punch

7. Local wiper

8. Shoulder punch

9. Centering punch

10. Upper pusher

11.

Spring

12. Bending die

13. Auxiliary guide pin

14.

Auxiliary guide bush

15. Workpiece clamp (Pad)

16. Bending punch

17.

Workpiece push pin

18. Punching die

19. Workpiece lifting gauge 20. Balancer 21. Lower die base

22, 23. Bedding plate 24. Die bedding plate 25. Die shell

26. Guide pillar, guide bush 27. Stripper plate 28. Workpiece stripper plate
29. Punch shell 30. Punch pad
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b. Uses of main components of progressive stamping dies

A set of progressive stamping die includes many parts and components depending on the
complexity of the product to be stamped as well as the cost of making the die. In addition, in the
stamping dies we will get acquainted with standard parts from famous brands such as Misumi, Daton...

Important and indispensable parts in the design of sheet metal stamping dies are: Punch and die
assembly, guide assembly, springs, billet ejection pins, basic metal plates of the die... These assemblies
are also same as single stamping die.

The difference between a progressive die and a single die is the automatic blank feeding system into
the die, the blank lifting system during the blank moving process, balancer, the centering punches and
the blank step, stop block, height adjustment assembly for storage.

b1. Centering punches and guide pins to position the workpiece

Pilot pins
”-""' \\"""‘*--.._._‘_
— S
e & 0 o) oI I
AN C Y4 hY 4 Y4 Y4 hY 4 )

/
\

Pilot pins

Figure 4.7: Layout diagram and the workpiece positioning pins

The purpose of the workpiece pin is to keep the exact position of the workpiece with the punch

and die during the workpiece transportation process. Each workpiece step is arranged with one or two

workpiece pins depending on the technological layout. The distance and position between the punches

and dies participating in the machining process need to be arranged appropriately. Therefore, we need

to add waiting steps of the workpiece to increase the distance between the punch and the working die
live the step adjacent near.
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Figire 4.8: Types of workpiece positioning pin structures
To create holes and slots for the centering punch to position the workpiece, step-slot punches
are needed. The structural types of centering punches can be round punches or step-shaped punches.

Step 3 Step 2 Step |

7

B I/ 7 Workpiece

Figure 4.9: Use a shaping punch to continuously set the steps in the die
b2. Balancer

Balancer ensures that the material thickness is within the elastic limit and does not
overcompress and turn into plastic deformation. After deformation, the thickness of the workpiece will
be reduced.

Strip Layout

i

Balancer Balancer g P

Figure 4.10: Balancer in a progressive die
b3. Progressive die height alignment block when installed on the machine (Stop block)

Unlike single dies, when putting the die on the machine, the height must be adjusted to ensure
product retrieval. The progressive die has a base to ensure the tight height of the die. This part is made
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last after aligning the die on the machine for the first time. The next time the die is put on the machine,
just make sure the stop block touches each other.
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i
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Secton A-A
Very Good Good

Figure 4.11: Stop block in a progressive die
b4. Stock block

When storing progressive dies in warehouse, to ensure that the punch and die do not collide
during transportation and storage, stock block is used. Structures are plastic blocks inserted into the
corners of the die to support the two halves of the die to ensure that the punch and die do not collide.
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pe
(Very good) (good) (gooc)

Figure 4.12: Stock block in a progressive die

Figure 4.13: Stop block and stock block in a progressive die
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b5. Coordinate pin/hole

Determining the pressure center of the die is to bring the die pressure center to coincide with
the pressure center of the machine. These pins also have the effect of taking the center to serve the
assembly and repair of the die.

Die center line
©)

Coordinate hole } '
|

e
Figure 4.14: Coordinate holes/ pins in a progressive die
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4.2. Overview of NX PDW (Progressive Die Wizard)

4.2.1. Introduction

NX progressive die design is a comprehensive solution for both edge and free surface part
design processes. You can design a complete structure with relationships between components and
stamping operations.

Product analysis: Appraise the design with analysis of the stamping process (product thickness
distribution, stress concentration, wrinkles) and flattening the workpiece. Apply Unform and Formability
analysis tools for stamping operations and create models for stamping operations with complex profiles.

.t B 8 2 A — L B 3 S B = Rk | = -
Blank nesting to maximize material utilization Optimization based on formability Mesoscopic scale composite forming simulation

Design of stamping operations: Tool to design layout of stamping operations and design punching

and cutting areas. Definition of stamping operations, reasonable arrangement of stamping operations.

Simulation of the stamping process to ensure that the design operations are reasonable.

Structural design: Automatically insert all standard die components, design models of punches, dies,
punching and cutting tools, design additional mold components. Easily change the design with ease.
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Detailed design: Tool to automatically export 2D technical drawings, create hole lists, record 3D
dimensions, record hole tolerances, 3D dimension recording tool allows easier production connection.

b

Design appraisal: Appraise the entire design in the assembly environment of the completed die
system, including tolerances and exit grooves. Analyze materials and force balance, simulate the entire
stamping process, calculate and create reports on stamping force and force application points.

e
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Result of Force Calculation

SCRAF _LSCRAP JSCRAP 4

C Name Vilee
Procen Force 5204,8000{N]
Holding Force 410.2900[N]
Total_Foecs 218 0900(N]
Pormews ol Cuming 4470534 mus|
Comter_of Foree  (842.415],.24.3330,0.0000)
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Integrated solution: Integrated solution with CAM for CNC machining and CAE for analytical
simulation helps reduce time and costs.

|
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4.2.2. The relevant commands

Command

-
=

|

Initialize
Project
== —!_ta

Blank
Generator

i

Blank Layout

BED

=
Scrap Design

firir.~1

Strip Layout

=
=

Force
Calculation

=

Die Base

i

Die
Setting

2

Piercing Insert

Design

A

Bending Insert

Design

g

Design

Description

Lets you select a part, specify project name and path, select material, and create
a Progressive Die project.

Lets you create blanks in your project once you have completed project initialization.

Lets you set the flat pattern orientation, the pitch, and the strip width.

Lets you determine scrap profiles, split the strip layout, create scrap features, and

define overlap and over-cut.

Lets you generate the strip layout boundary, retrieve design information to generate
process features, and do Process Planning for Progressive Die design.

Lets you calculate force for each process feature, calculate total force, and display
the force center.

Lets you load a die base from a catalog, then split the die plate.

Lets you specify the values of progressive die parameters.

Provides you with functions for creating and modifying piercing punches and dies.

Lets you create a bending punch and die.

Lets you create a forming punch and die.
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Forming Insert
Design

IiIﬂ Lets you create a burring punch and die.

Burring Insert
Design

.ﬁi Lets you add shanks to strength punch or die inserts, create and edit punch mounts,

4 or copy or delete inserts.

Insert Auxiliary

Design

aj] Lets you add to the die base from a library of standard or custom parts and group
= sets.

Standard Parts

Lets you select the forming feature and relief type to create user-defined and

g
%7 automatic relief pockets.
Relief Design
%,j y Lets you select one of five methods to create pockets.
Pocket Design
% Lets you create and export a bill of material to a spreadsheet (.xIs) file.
Bill of Material
A Lets you change the color and visibility of components, and show tools in 3 positions.
View Manager
E Provides tools to check interferences, run motion simulations, and get advice on the
effects of design changes.
Tooling
Validation
%E; Gives you access to the following functions:
Workflow Changeover Lets you create one or more changeovers in
Management T'gs_; your project, which lets you store similar sheet
Management | ™= metal products in the same die design.
Concurrent Design Lets multiple designers work on the same project
‘FE;_) concurrently.
Management 3
e Lets you calculate a quick cost estimation of your progressive die based on your
= conceptual design.
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Quick
Quotation
“_~ Lets you access the NX Generic Tools gallery. The NX Generic Tools gallery is
NXC populated with a collection of often-used NX tools, such as Extrude, Edge
. Blend, Sew, and synchronous modeling commands.
NX Generic
Tools

a. Initialize Project
al. Function and command call

Use the Initialize Project command to either open a project or create a new project for a sheet metal
part.

To design a die using Progressive Die Wizard, you must create a project. A project is uniquely defined
by a project name (or number) and path, which you define. A project contains all design information
related to your tool: sheet metal parts, part material, and all subsequent parameters and components
(such as strip, die bases, punches, dies, or screws) that you add to your tool design.

You can use the Initialize Project dialog box options to:
Insert or remove sheet metal parts or a strip layout.
Specify a project path and name.

Specify the part material.

Edit the material data base.

Stamp multiple parts in a die.

The units, thickness, and material of the inserted part or strip layout are automatically evaluated and
displayed in the Initialize Project dialog box.

Where do | find it?

Application Progressive Die Wizard

L

Command Finder|Initialize Project B

a2. Initialize Project dialog box
Project
Lists the sheet metal parts open in your session.

+
Add ¥ lets you browse for additional parts to add to the Sheet Metal

Sheet Metal Parts Parts it

Remove X deletes the selected part from the list.

Project Path and Name Shows the nhame and path of your current project.
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B
ot

Lets you browse for an existing project.
Browse Project Path

Part Unit Shows whether your part's units are Metric or English.

Part Thickness Shows the thickness of your sheet metal part.

Part Material Showg the part's material, and lets you change it from a list of eligible
materials.

Project Template Lets you select a template to use with your project.

Settings

=

Edit Material Data Base

% Lets you edit the project template configuration spreadsheet. This is
Edit Project Template Useful when you want to add customized project templates.

Configuration

Lets you edit the material parameters spreadsheet.

Rename Components Lets you rename each component of the design assembly template.

Lets you insert an existing strip layout into your project. You must select

the top face as the stationary face in the strip.
Insert Strip
Keeps the design association related to the inserted strip by directly

adding it to the project. The strip part may be a subassembly.

b. Blank Generator
b1. Function and command call

Use the Blank Generator command to create blanks in your project once you complete project
initialization. You can:

Insert a blank from a file.
Select a blank body from the sheet metal part.
Update a blank.

Remove a blank.
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Where do | find it?

Application Progressive Die Wizard

Command Finder|Blank Generator ;

b2. Blank Generator dialog box

list Specifies whether to create or edit a blank.

Appears when Type is set to Create.

Sheet Metal Part  Lets you select a sheet metal part from a list of available sheet metal parts.

192

Import Blank Part

Imports a sheet metal part as a blank.

& \
Lets you select a sheet metal part to create the blank.
Select Blank Body

W

Planar Face

Lets you select a planar stationary face to define the blank.

Appears when Type is set to Edit.

Blank Part Lets you specify the blank to edit.

%

Update Blank

Updates the blank after you make changes.

X
< Deletes the blank.

Delete Blank
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c. Blank Layout

c1. Function and command call

Use the Blank Layout ‘ﬁ command to orient parts in a flat pattern relative to each other, to decide
what strip width to use, and to determine the distance between process stations. The sheet metal blank
must be complete before you can layout the strip and design the scrap.

You can use the Blank Layout command to:

Insert blanks and put new instances of a blank under *_nest part.

Design the orientation of the blank.

Copy blanks.

Remove blanks.

Set a base point for rotation origin.

Modify burr direction by flipping the blank.

Set the pitch, strip width, rotation angle, and number of rows.

View the percent of material utilization and the minimum space between blanks.

Where do | find it?

Application Progressive Die Wizard

I
Command Finder|Blank Layout ‘g

c2. Blank Layout dialog box

Type menu Lists the operations you can perform.
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Create Layout

Creates the initial blank layout. (This ia a required initial step.)
Add Blank

Adds the blank from the list.

Copy Blank

Copies the selected blank to a second row.

Remove Blank

Deletes the selected blank.

Set Base Point

Sets the base point for reference to move, copy, and rotate blanks. The software uses
this point as the “0” station’s start point in Strip Layout. It is better to set this point to a
pilot hole or another meaningful point.

Flip Blank

Turns the blank over, reversing the action direction of punch and die tools in the die
assembly.

+

Select a
Blank

Lets you select a blank for the layout.

f' Appears when Type is set to Set Base Point

Select the Lets you select a base point to place the blank.
Base Point

Appears when Type is set to Add Blank

List Lists the blanks you added.

The following options appear only when Type is set to Create Layout.

Moves the selected blank along the X axis. Type a new value, or use the slider to
move the blank in shap-size increments.

Shift X

Moves the selected blank along the Y axis. Type a new value, or use the slider to

ShiL Y move the blank in shap-size increments.
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Turns the selected blank around the base point. Type a new value, or use the

Rotate slider to move the blank in snap-size increments

- Specifies the distance between parts in the strip layout. The software automatically
Pitch g : - .
computes the minimum pitch as a starting point.

Specifies the width of the strip. The software automatically computes a minimum
strip width on the blank layout.

Assigns side webs to the layout. You can specify one of the following:

Width

Average
Available when you select the Average radio button.
Assigns equal webs to each side of the layout.

Bottom

side webs

; Available when you select the Bottom radio button.
options

Specifies the bottom distance for the side web. You can either type values in the
boxes, or move the sliders to specify the distance.

Top
Available when you select the Top radio button.

Specifies the top distance for the side web. You can either type values in the
boxes, or move the sliders to specify the distance.

Material : !

Utilization Displays the percent of material the current layout uses.

Minimum Displays the minimum area necessary for the specified layout, excluding side
Space Size webs.

Snap Size Specifies the increments of the Placement, Pitch-Width, and Side Webs sliders.

Show Three ApPpears only in the Engineering Die Wizard application.

Blanks Lets you specify whether a single blank or three blanks are displayed.
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d. Scrap Design

d1. Function and command call

A scrap is a sheet body created from any of the following:
A blank's boundary plus additional curves

A hole boundary

A closed loop of curves

An existing sheet body

Use the Scrap Design command to specify how to punch out scrap piercings and, if needed, create
pilot holes to aid in transporting the metal strip through the die. Pilot holes can be any shape, but are
often circles.

i

All scraps are sheet bodies and put into a "*_nest"” part.

After you finish using Blank Layout, use Scrap Design to pierce the strip and form the profile shape
of the sheet metal part. Scrap Design determines scrap profiles based on the blank layout result.

| |

in

)
1
)
|
e
|
I
]
1
]
|
1
]

You can use Scrap Design to:

Design all scraps and assign station numbers.

Design individual scrap you profiled by using, for example, sketching, existing sheet bodies, or holes.
Extract internal holes as scraps automatically.

Specify multi-hit, precision-punched scrap trims.

Split scrap areas into smaller pieces. The scrap can be regular/piercing scrap or pilot scrap.

Merge scraps.

Design and edit overlaps and overcuts, which you can add to any scrap, including pilot scrap. You can
also add overcuts to overlaps.

Apply a minimum radius to all sharp corners of a scrap.
Create pilot holes for metal strip transport.

Set the display color for scraps, holes, overlaps and over-cuts.
Create a group of scraps that are the same shape and size.

Change regular (piercing) scrap to pilot scrap, and vice versa.
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Where do | find it?

Application

Progressive Die Wizard

Command Finder|Scrap Design <—

T

=

d2. Scrap Design — Create options

Note See Common dialog box options for common options not discussed here.

The options in the Scrap Design dialog box vary, depending on the specified operation in
the Type group. The following options appear when Type is set to Create.

Method

Method icons

s

Select Curve

&

Specifies the method to use in creating the scrap:

o
W Biank Boundary + Sketch

Creates scrap based on curves that remains associative to the blank.

* Hole Boundary

Extracts holes you select in the blank and defines them as hole scrap automatically.

[.l._“J_l

¥ Closed Curves

Creates scrap based on a closed loop of edges and curves you select as the
boundary.

If an edge or curve is adjacent to another edge or curve, they must be joined together.
If an edge is adjacent to a curve that is not an edge, they must intersect.

v
W | Existing Sheet Body

Creates scrap based on an existing sheet or group of sheets you select.

w-
Change Type

Lets you change piloting scrap to piercing scrap, or vice versa.

Appears only when the method icon is Blank Boundary + Sketch or Closed Curves.
Lets you select a closed loop of curves in the graphics window, or you can

click Sketch Section @’ to create curves that, by themselves or along with a blank
boundary, complete a closed loop.

Appears only when the method icon is Existing Sheet Body.

Lets you select one or more sheet bodies to define the scrap or a group of scraps.
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450

Select Sheet

Body

Station - .

Niimber Lets you assign a station number to the scrap.

Setting
Lets you specify whether the scrap is piercing or piloting.

Scrap Type
Note The Piloting setting is ignored unless the method is Closed Curves.
Lets you specify the position of the scrap in a strip layout:

Position Project to Strip

Keep Origin
Tolerance Lets you specify the tolerance for cutting off scrap.

Scrap Color Lets you define colors to distinguish different types of scrap.

d3. Scrap Design — Edit options
Note See Common dialog box options for common options not discussed here.

The options in the Scrap Design dialog box vary, depending on the specified operation in
the Type group. The following options appear when Type is set to Edit.

Edit

You can choose any of the following six icons to define the edit operation.

W Divides large scrap into two smaller pieces. The pieces are split along curves you
Son select or create with the Sketch task environment.
plit
s} R
. Joins adjacent pieces of scrap together.
Merge

Apply Lets you specify a minimum radius to round sharp corners in the scrap.
Minimum

Radius

a5 Lets you change the scrap station number.
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Change
Station

Delete

Y=

Update

Select Scrap

M

Select Split
Curve

Minimum
Radius

Station
Number

Filter

Deletes scrap pieces you select from the blank. You can use the Filter options to
help you select the scrap.

Updates all defined scraps after you change the blank profile.

Appears for all edit operations except Update.

Lets you select a scrap for an operation.

Appears only for the Split edit operation.

Lets you select existing curves for a split operation.

If the curves you want do not exist, you can click Sketch Section @@ to open the
sketch environment, where you can create the curves. See the Sketching Help for
more information.

Appears only for the Apply Minimum Radius edit operation.

Lets you specify a minimum radius that is used to round sharp corners.

Appears only for the Change Station edit operation.

Shows the current station number of the scrap, which you can modify.

Appears only for the Delete edit operation.

Lets you specify the scrap type, which helps you select it in the graphics window.

d4. Scrap Design — Add-on options

Note See Common dialog box options for common options not discussed here.

The options in the Scrap Design dialog box vary, depending on the specified operation in
the Type group. The following options appear when Type is set to Add-on.

Add-on

You can choose any of the following four icons to define the add-on operation.

Overlap

Lets you define the overlap between two adjacent scraps.
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Overcut

Trimming

| J

User Defined

Lets you add an overcut on to a scrap overlap corner.

Lets you define the scrap precision trimming processes.

Lets you create a custom add-on for scrap.

. Appears for every add-on operation except Overcut.

Select Scrap Lets you select a scrap.

' Appears only when Overlap is selected.

Select Edge of Lets you select a scrap edge for the overlap.
Scrap

Appears only when Overlap is selected.
Overlap Width
Lets you specifies the overlap width.

Appears only when Overcut is selected.

Overcut Type
Lets you specify the type of overcut.

i Appears only when Overcut is selected.

Select Side Lets you select a side edge of the overlap to place the overcut.
Edge
A

B Appears only when Overcut is selected.

H Lets you define the parameters of the overcut.

R

Number of Appears only when Trimming is selected.

Trimming Lets you specify the number of trimming processes.

Appears only when Trimming is selected.
Process
Lets you specify the size for each trimming process.
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Appears only when User Defined is selected.

'[ag.ﬁ Lets you select existing curves to define your custom add-on.

Select Curve [T the curves you want do not exist, Sketch Section E" opens the sketch
environment, where you can create curves. See the Sketching Help for more
information.

d5. Scrap Design — Grouping options
Note See Common dialog box options for common options not discussed here.

The options in the Scrap Design dialog box vary, depending on the specified operation in
the Type group. The following options appear when Type is set to Grouping.

Assign Color to Same Scrap

Select Scrap

Lets you select scrap in the graphics window.

Select Color Lets you select a color to apply to the selected scrap.

Apply Color to Scraps of Controls whether the selected color is also applied to all scraps of
Same Size the same size.

e. Strip Layout
e1. Function and command call
A die strip layout is required for every progressive die.

Use the Strip Layout command to create that layout by setting the number of stations, assigning scrap
and processes to specific stations, then simulating the forming of the sheet metal part.
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Strip Layout enables the relationships between associative intermediate stages to be maintained with
the original sheet metal part, so you can make changes to a die design by modifying its associated
parts. Even clearing a simulation will not remove associative intermediate stage associations.

When you lay out all the processes in Strip Layout:
Each scrap process in the strip layout is represented by a sheet body.
Each intermediate stage is represented by a solid body.

Your strip layout view can have either one or three views, depending on your Views in Strip
Layout customer default setting.

To add a description of the process performed at each station, right-click a station name in the Strip
Layout Navigator and choose Add Process Description. You can set the font, scale, and color of the
description text if desired.

NX also displays the station number inside the circle of each station.

Tip To find a customer default, choose File—Utilities—Customer Defaults, and click Find

Default q
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Where do | find it?

Application Progressive Die Wizard

e
Command Finder|Strip Layout| |

e2. Create a strip layout

Choose Progressive Die Wizard gallery—Strip Layout =

The Strip Layout Navigator appears. Its Strip Layout Definition node has the following child nodes:
Pitch

Width

Feeding Direction

Station Number

In the Strip Layout Navigator, double-click the Station Number node and enter the number of stations
you want.

Right-click the Strip Layout Definition node and choose Create.

Scraps that were not assigned to stations during scrap design appear in the Strip Layout
Navigator under the Unprocessed node.

The strip layout appears, as shown in the following figure.

Yo
‘li 1

Strip showing scrap with preassigned stations

O
O
o
G—

The Strip Layout Navigator now shows a node for each station. Other nodes appear if appropriate,
such as an Unprocessed node, and nodes for any existing scrap, intermediate bodies, or intermediate
parts.

If you specified station numbers during scrap design, those scraps appear in the graphics window at
their strip layout station nodes, and also under their corresponding station nodes in the Strip Layout
Navigator.

If you want to move a scrap to a station, drag it in the Strip Layout Navigator.
You can drag multiple scraps to a station.

An alternate way to move a scrap is to right-click the scrap, choose Move Up or Move Down, and
choose the station number you want.

If you want to change the strip feed direction, do the following:

Double-click the Feeding Direction node.
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Specify 0 to feed the strip from left to right, or 1 to feed the strip from right to left.
Right-click the Strip Layout Definition node.

Choose Update to update the strip.

If you want to edit the strip pitch or width, do the following:

Double-click the Pitch or Width node.

Specify the new pitch or width.

Right-click the Strip Layout Definition node.

Choose Update to update the strip.

You can insert an intermediate stage as either a body or a part, depending on the procedure used to
design it:

Intermediate Body — Use this option when the intermediate stage was defined as a separate body
within the original sheet metal part added to the project.

To insert an intermediate body, drag it from the Unprocessed node to the station where you want to
place it.

Intermediate Part — Use this option when the intermediate stage was defined within an intermediate
staged assembly by the Direct Unfolding command, or another method.

To insert an intermediate part, do the following:

Right-click the Intermediate Part node.

Choose Open.

In the Select Part dialog box, specify the appropriate parent part of the intermediate staged assembly.
Click OK.

If the intermediate part has a preassigned station number, it automatically appears at that station.
Otherwise, you can drag the intermediate part to the station where you want it.

To insert an idle station and create intermediate stages in the Strip Layout Navigator:
Right-click the station before the desired location of the idle station.

Choose Insert Idle Station to insert an empty station.

Right-click the intermediate stage body or part before the empty station, and choose Copy.
Right-click the empty station, and choose Paste.

The station is now an idle station.

Optional - You can choose Insert Process Station in step 2 to create a new station after the current
station. This will also copy the intermediate stages from the current station into the new station.

To delete a station, in the Strip Layout Navigator, right-click it and choose Delete.
When you finish defining the stations, you can simulate the piercing process.

In the Strip Layout Navigator, right-click the Strip Layout Definition node.
Choose Simulate Piercing.

The software generates a solid body representation of the strip based on the scraps, intermediate
stages, and station definition, as shown in the following figures.
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A simulated piercing

The simulation's resemblance to the actual physical strip is improved if you remove the blank material
from stations with intermediate stages. To do this, right-click the Strip Layout Definition node,
choose Remove Blank Material, and define the range of stations in the Strip Layout Design dialog
box.

To delete the simulation, right-click the Strip Layout Definition node again, and choose Clear
Simulation.

Optional - You can create a description at each station.
Right-click a station name in the Strip Layout Navigator and choose Add Product Description.

Specify a description for the station. You can also specify the font, scale, and color of the tex

e3. Strip Layout Navigator options

Node Description

Strip Layout Design Provides the top-level node for all the other nodes in the Strip Layout
Center Navigator.

Strip Layout Specifies the parameters of the strip. Its child nodes are:

Definition

Pitch — Specifies the distance between strip stations.
Width — Specifies the width of the strip.

Feeding Direction — Sets the direction in which your strip feeds through the
die.

Station Number — Specifies the number of stations in the die.
Unprocessed Appears after you create a strip layout.

Shows any existing scrap or intermediate stages (bodies or parts) that are
available to be inserted in a strip station.

Station nodes Appears after you create a strip layout.

Shows the scrap and intermediate stages at each station. You can right-click
a scrap node to move it to another station.

A station node appears for each station.

Strip Layout Definition node shortcut menu
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The following table lists the shortcut menu commands that appear when you right-click the Strip Layout
Definition node.

Command Description

Create Creates the initial strip layout. Scrap with preassigned stations appear at the
assigned stations.

Update Updates the strip layout after a blank change, scrap change, pitch change, or
width change.

Simulate Piercing Simulates the piercing operation, so you can preview the physical appearance
of a strip.

Clear Simulation  Deletes the piercing simulation.

Update Simulation Updates the piercing simulation.

Remove Blank Removes blank material from stations with intermediate stages, to make a
Material piercing simulation more accurately resemble the physical strip.

Update Blank Updates the orientation of the blank.

Orientation

Drag/Drop Lets you lock or unlock the ability to drag intermediate stages.

Intermediate

Station node shortcut menu

The following table lists the shortcut menu commands that appear when you right-click
the Station node.

Command Description
Insert Process Adds a new process station after the selected station. The software clones the
Station After intermediate stage from the selected station to the new station.

Insert Idle Station Adds an idle station after the selected station. The idle station is empty, so you

After can copy the intermediate stage you want to this station.

Delete Station Deletes the current station.

Add Process Lets you add a description of the process that is performed in the station. You
Description can set the font, scale and color for the description text.

Note You can set the default process in the Customer Defaults.
You can display the Station Number in the station circle permanently.
Paste Lets you paste an intermediate stage you copied to the selected station.

Process node shortcut menus

The following table lists the shortcut menu commands that appear when you right-click
the Process node for a scrap.

Command Description

Move Up Lets you move the scrap up to the station you select from this list.
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Move Down  Lets you move the scrap down to the station you select from this list.

The following table lists the shortcut menu commands that appear when you right-click
the Process node for an intermediate stage.

Command Description

Close Closes the current intermediate stage.

Copy Copies the current intermediate stage.

Move Up Lets you move the intermediate stage up to the station you select from this list.

Move Down Lets you move the intermediate stage down to the station you select from this list

f. Force Calculation
f1. Function and command call

Use the Force Calculation command to calculate the forces for processes. Scraps created in the
previous Scrap Design step are automatically included in the process list.

To calculate the force of a process, you can do any of the following:

Select a process from the list and quickly calculate its forces. The software chooses the formula for the
calculation.

Edit the formulas used for calculation, then select a process and calculate the forces.

Create a user defined process. You specify the type of process (such as piercing or bending) and select
faces for the process. You can then calculate the force.

Calculate the total force for all processes with current force calculations.

Note An uncalculated process has an asterisk * before its name in the process list. To include it
in the total force calculation, you first need to select the process and calculate its forces.

The results appear in the Force Calculation dialog box, or you can create an .xml report that can be

displayed in your browser.
° o

el

L., DR
5 &6 6 4

Select the piercing for a force calculation
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Where do | find it?

Application

Progressive Die Wizard

Command Finder

i
Force Calculation F&

f2. Force Calculation dialog box

Note See Common dialog box options for common options not discussed here.

Process List

list

Define
Process options

Calculation

&

Select Process

parameters

%

]

Calculate

S

Create Report

New

Lists the currently defined processes for selected faces in your model.

Scraps from the previous Scrap Design step are automatically listed. You can
select additional faces and specify processes for them.

When you calculate the force for a process, the * character at its beginning is
removed.
Lets you select a face and define a new process, which you can then add to

the process list.

NX displays a graphical representation labeled with the listed values for the
selected process.

Lets you select the process that you want to calculate.

Shows the results of a force calculation for the following parameters:
Process Force

Holding Force

Perimeter of Cutting

Center of Gravity

Calculates the selected process in the process list.

Generates an .xml report that can be displayed in a browser.
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=
==

Calculates the total force for all processes in the Process List.
Calculate Total

Force
Settings

Lets you specify the type of calculation:
Overlapped Cutting

The software calculates the force after removing from consideration the
common edges of adjacent scrap and the length of scrap edges that extend
Calculation Type beyond the strip boundary.

No Overlapped Cutting

The software calculates the force according to the full boundary of each scrap.
This method is faster than the Overlapped Cutting method, and is commonly
used when calculating the force for holes.

Decimal Places Specifies the number of decimal places for the calculation.

Edit Formulas Lets you customize formulas used to interactively calculate force

f3. Calculate forces in the Progressive Die Wizard

—
Choose Progressive  Die  Wizard tab—Main gallery—Force  Calculation 5= or

choose Menu—Tools—Process Specific—Progressive Die Wizard—Force Calculation.
The Force Calculation dialog box appears, with the scraps listed in the Process List.

In the Process List, arrange the scrap processes as desired.

You can select a scrap process and remove it, or move it up or down in the list.

(Optional) To define a new process, do the following:

In the Define New Process subgroup, from the Process Type list, select the type of process.

In the graphics window, select one or more faces from the strip layout, simulation part, or intermediate
part.

In the Define New Process subgroup, in the Process Name box, specify a name for the process.

+
Click Add ¥,

The new process is added to the list. The asterisk * at the front of its name shows that the force of the
process is not calculated yet.

(Optional) In the Settings group, click Edit Formulas to open a spreadsheet where you can edit the
formula used for the calculation.

In the Process List group, from the list, select one or more processes.

>

A,

In the Calculation group, click Calculate
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The results appear in the Calculation group in the boxes for the following parameters:
Process Force

Holding Force

Perimeter of Cutting

Center of Gravity

(Optional) Click Create Report L

The results appear in the browser, where you can save them for further analysis.

=
(Optional) After you calculate all the processes you want, click Calculate Total Force = to calculate
the total force for all currently calculated processes.

The results appear in the Calculation group and in your browser.

Click OK or Apply.

The results are automatically written onto the features' sheet bodies as the following attributes:
FORCE_CENTER_X

FORCE_CENTER_Y

FORCE_CENTER_Z

CUTTING_LENGTH

PRO_FORCE

HOLD_FORCE

g. Die Base
g1. Function and command call

Use the Die Base command to lay out a die base in your progressive die design. A die base consists
of an assembly of standard parts, including plates, guide pins, guide bushings, and screws.

You can:

Add a die base from standard catalogs to your die design.
Edit an existing die base.

Split, merge, or delete die plates.

Modify the length of a die plate.

Add a die base with part family components. A sample template, <DB_UNIVERSAL_PartFamily>, is
provided to create a die base with part family components.

462

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

UNIVERSAL_SIMPLE die bases

When you add a die base, the die base NX provides for your strip layout is based on your inputs in
the Manage Die Base dialog box. NX may switch to a different default die base when you modify any
of the following inputs:

The Catalog
The Plate Numbers
The Value of a parameter in the Details table

Where do | find it?

Application Progressive Die Wizard

Command Finder|Die Base %

g2. Manage Die Base dialog box
Create Die Base

Appears when Type is set to Design Die Base.

You can also use these options to select and edit an existing die base.

Lets you select an existing die base for editing.
Select Die Base to

Edit
Lets you specify the parent subassembly node where the die base will be
installed.
Parent
Tip You can review the assembly structure of your die design in
the Assembly Navigator.
Lets you specify a catalog from which you can select a standard die base.
Catalog

The catalog list is dependent on the project units and the die base register file.
You can edit this file to customize your installation. For example, when the
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project units are in inches, only die base catalog names that are defined in the
English units sheet of the register file appear in the Catalog list.

Plate Numbers Lets you specify the number of die base plates for the installation.

Lets you specify the work area that includes defined processes by selecting
two points on the strip.

Note Because die base choices are limited to those offered in the catalog
you specified, only die bases from the catalog that meet both the length
Pick Work Area and width values of the work area are available. For example, the
available die bases may all be longer than the length of your defined
work area.

Appears only in the Progressive Die Wizard application.

Specify Reference Lets you select a reference point in the strip layout to position the die base.
Point

Opens a spreadsheet that lists all the registered die bases.

Opens a spreadsheet that contains all parameter data for the selected die

base.
Edit Data Base

Lets you define the distance from the selected reference point to the die base
edge.
Distance to Die If the feeding direction for the strip layout is from left to right, the Distance to
Base Edge Die Base Edge value is measured from the reference point you select to the
left edge of the die base. Otherwise, it is measured from the reference point
to the right edge of the die base.

Details
Appears when Type is set to Design Die Base.

Lets you review the parameters of the current default die base. The default
die base is available in the specified catalog.

you need a different die base, you can click the Value column to modify a

Table If d a different die b lick the Val lumn to modif
parameter. You can select an alternate value, if available, from a list or, for
some parameters, you can enter a new value.

Design Tools

Appears when Type is set to Design Tools.
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g

Split Die Plates

O

Merge Die Plates

oo

=m
Align Die Plates

=

Adjust Length of
Die Plates

A
Save as Template

X

Delete Die Base

Standard or User
Defined

Whole Sub-Diebase
or Plates

Direction

Select Curve

s

Lets you split one or more selected die plates or the whole sub-diebase.

Lets you merge either selected die plates or a whole sub-diebase into a single
plate.

Lets you align selected die plates or adjust the gap between two plates.

It is useful to align the die plates or adjust the gap between plates after you
change the length of the die plates.

Lets you change the length of selected die plates by dragging an edge or
entering a new value.

Lets you save the current die base as a template for a new catalog.

Deletes the selected die base.

Lets you choose a split method.

@ Standard

Lets you split die plates from a point. You can specify the direction in
the Direction subgroup.

User Defined

Lets you split die plates with a curve you create.

Lets you specify whether the operation occurs for the whole sub-diebase or a
selected plate.

For a split operation, you can select more than one plate with the Single
Plate option, but the selected plates must be the same length.

Lets you specify the direction for the operation.

Appears when you select User Defined.

Lets you select existing curves or edges.
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Sketch Section

[%.

Pick Split Location

Plate Length/Width

Gap

X

4

Reverse gap
Direction

Pick Location

Settings

Tip To filter curve selection, use the Curve Rule options on the Top Border
bar.

Appears when you select User Defined.

Opens Sketch task environment to enable you to create a new sketch.

The Cue line states that you can also select a planar face to create a sketch.

Tip To select all the edges of a face to define the section, set the Curve
Rule option on the Top Border bar to Face Edges before selecting the
face.

Appears when you select Split Die Plates.

Lets you select a location on one or more die plates for a split operation.

An alternate method is to specify the gap and the plate lengths or widths.

Appears when you select Split Die Plates or Adjust Length of Die Plates.
Lets you specify the length or width of the selected plates.

Appears when you select Split Die Plates or Align Die Plates.

Lets you specify the gap value between plates.

Appears when Align Die Plates or User Defined is selected.

Lets you reverse the direction of the gap between plates.

Appears when you select Adjust Length of Die Plates.

Lets you select one or more die plates.

Appears when Type is set to Design Die Base.

Load Die Base Only
(Don't Update
Parameters)

Rename
Components

Loads the die base without updating any parameters. You can use this option
to reuse a die base by saving it as a die base template.

Opens the Part Name Management dialog box where you can rename
components before you complete a Split Die Plates operation.

Lets you rename a component before loading the die base. You can also use
this option to specify the components referenced within Teamcenter.
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h. Die Design Setting
h1. Function and command call

Use the Die Design Setting command to specify the values of die parameters, which may be used
later in downstream design.

Examples of die design parameters include the following:
STRIP_LIFT_HEIGHT Specifies the metal-strip-lifted height when the die set is open.

PUNCH_PENETRATION Specifies the depth of the piercing punch that goes into the piercing
die.

The Read Default Value From customer default specifies whether the default values for die

parameters come from their customer default values or from the PDW_VAR part.

Tip To find a customer default, choose File—Utilities—Customer Defaults, and click Find

i

Default :

Downstream design gets the default values from the PDW_VAR part.
Where do | find it?

Application Progressive Die Wizard

=

Command Finder|Die Design Setting

h2. Modify the value of a die design setting

Choose Progressive Die Wizard tab—Main gallery—Die Design Setting g :

In the Die Design Setting dialog box, in the parameters table, double-click the parameter that you want
to modify.

The image in the dialog box provides an illustration of the selected parameter.
In the Value column, enter the new value.

Click OK or Apply.

i. Special Piercing Insert
i1. Function and command call

Use the Special Piercing command to create and edit a special punch for angular and side piercing
within your die design.
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Where do | find it?

Application Progressive Die Wizard

Command Finder|Special Piercing %

i2. Special Piercing Insert dialog box

Lets you specify the type of operation you want to perform.

@ Create

Lets you to create a new insert in the current assembily.

Type list ‘ﬁ’ Edit

Lets you edit an existing insert in the current assembly.

@ Delete

Lets you delete an insert from the current assembly.

The following options depend on the Type selected.

@ Lets you to select one or more edges to be used to create the
insert.

Select Edge

@ Lets you to select a face in the hole of the selected edges to be

used to create the insert.

Select Hole Face
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Lets you to select the insert to edit, when Type is set to Edit.

Lets you to select the insert to delete, when Typeis set
Select Insert to Delete.
J£ 7 . -
b Lets you specify the vector of the piercing insert.

Specify Vector

]

o Lets you specify the orientation of the piercing insert.

Specify Orientation

Lets you select a parent part for the insert.

Parent
Lets you select the type of insert to create.
Insert Type m Punch
ﬂ Die
? Lets you select a standard blank for your insert.
Select Standard Blank

? Lets you select a standard blank for editing.

Edit Standard Blank

Start Lets you specify the start distance of the insert travel.

End Lets you specify the end distance of the insert travel.

Punch Plate (PP)
Lets you specify individual poioming Plate (BP)

clearance for each plate.
Stripper Plate (SP)
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Cavity and Slug Hole
Appears when the Insert Type is set to Die.

Lets you specify the type of cavity hole in a die base.

/%

o
Cl
AL | H - Depth of hole
Taper Anale A - Diameter of the die clearance
P g (Step, Round Step 1)
- Creates a Taper .
Cavity Type Angle cavity. Angle of the die clearance (Taper
Angle)
C1 - Diameter of the slug hole in the
top backing plate
- C2 - Diameter of the slug hole in the
Step bottom backing plate
Creates a Step cavity.
Clearance

Appears when the Insert Type is set to Die.

Die Plate (DP) Lets you specify a clearance value for the die in the die plate.
Setting
Appears when Insert Type is set to Die.
Clearance
Lets you specify a clearance value.
Offset Side Lets you specify whether the offset side is the die side or the

punch side.

j.- Bending inserts
j1. Function and command call

Use the Bending Insert Design command to add a bending insert group that forms one of the sheet
metal folds in your product. As the progressive die moves each blank to the station where the insert is
located, the bending punch folds the sheet metal of the blank against the bending die. If your product
requires more sheet metal folds, you can add bending inserts at other stations.

You can design your own bending punch and die. In the Progressive Die Wizard application, you can
also select a standard part from a catalog.
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Where do | find it?

Application Progressive Die Wizard

Command Finder(Bending Insert Design ﬂ

j2. Bending Insert Design dialog box

Standard Lets you select a bending punch or die from a catalog and
Insert add it to a station in your die design.
Tvoe list User Lets you design a customized bending punch or die for a
yp Defined station in your die design.
Delete Lets you select one or more bending insert groups and
delete them from the die design.
Standard Insert

Appears when Type is set to Standard Insert.
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Lets you select one or more faces to be bent by the insert.

=

Select Bend |,

Start Face
Lets you specify the bending shape by clicking one of the following icons. The
icons differ depending on whether the bending direction is up or down.
90 Degree Bending
Up J . Down -:i
Angle Bending
Up ", Down
Bending Type
Z Bending .r 1
Up , Down
V Bending
Up , , Down %
Universal Z Bending
Up r ., Down m
Insert Type Lets you specify whether you are adding a bending punch or a bending die.
E'l;l Lets you select a standard bending punch or bending die to add to your design.

You are offered default choices that can be used with your start face selection and
Standard Insert  your specifications for the Bending Type and Insert Type options.

User Defined

Appears when Type is set to User Defined.

Lets you select one or more faces to be bent by the insert.
Select Bend

Region Faces
Insert Type Specifies whether the insert is a bending punch or a bending die.

& Lets you specify a parent node for the bending insert.
arent
You can review the assembly structure in the Assembly Navigator.
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In the Engineering Die Wizard application, the parent is the station where the
insert is located.

Lets you control the bending insert height by specifying which plate is associated

Position to the insert height.

Lets you do one of the following:
Select an existing loop of curves to define the shape and size of the insert.

Sketch options Use the sketch options to create a loop of curves (usually a rectangle). You can
create a datum plane on which you can sketch the curves.

If you want to create a composite insert, you should select or create two or more
loops.

Lets you control the trimming of the bending insert by specifying how far NX

Extanc Distaiicn extends the bend region faces to create the trim.

Lets you edit an existing bending punch or die.
Select Insert to

Edit
Clearance
Appears when Type is set to User Defined.

Lets you define the clearance between the insert and the pocket that is created
for the insert in each plate.

Plates
Settings
Appears when Type is set to User Defined.

Rename Lets you name the insert.

Specifies that NX should design the bending insert without creating any solid

Concept Design bodies.

Without FALSE Specifies that NX should install the insert without creating a pocket in the die

Body plates.
Composite Specifies that the bending insert consists of multiple inserts. When you sketch the
Insert insert, you should draw two or more loops to define it

j3. Create a user defined bending insert

This example shows how to create a user defined bending insert, which consists of a bending punch
and a bending die.

Together, the punch and die will produce the first bend in your strip layout.
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Create a user defined bending punch

Choose Progressive Die Wizard tab—Main gallery—Bending Insert Design ﬂ :
In the Bending Insert Design dialog box, from the Type list, choose User Defined.
In the graphics window, select the bend region face.

NX displays the angle measurement beside the selected face. This example uses a 90 degree angle
for the bend.

In the Bending Insert Design dialog box, in the User Defined group, define the following options.
Insert Type = Punch
Parent = prj_db_008

Position = Punch Plate

Click Create Datum Plane D

The datum plane is created at the center of the selected bend region face. You will use this datum plane
to sketch the bending punch.

Sketch the curves to define the bending punch.

Click Sketch Section T |
The Create Sketch dialog box is displayed, and NX prompts you to select the sketch plane.
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In the graphics window, select the datum plane.

In the Create Sketch dialog box, click OK.

NX enters the sketch task environment.

Y

Sketch a rectangle to define the size and shape of the bending punch.
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L/

(= — =

Click Finish Sketch ‘E

NX exits the sketch task environment and displays a preview of the bending punch.

pee

(Optional) Define other parameters for the bending punch.

In the Bending Insert Design dialog box, in the User Defined group, set Extend Distance to 1 mm.
In the Clearance group, set the following clearances.

Punch Plate = 0.2

Bottoming Plate = 0.2
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Stripper Plate = 0.2
Click Apply.

The bending punch is created.

/

Now you want to create the corresponding bending die.

Add a standard bending insert

This example shows how to add a standard bending punch and bending die to a die design. A standard
bending insert is an existing punch or die that you can order from a catalog.

Together, the standard punch and die will produce the first bend in your strip layout.
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j4. Create a bending punch

Choose Progressive Die Wizard tab—Main gallery—Bending Insert Design ﬂ , or
choose Menu—Tools—Process Specific—Progressive Die Wizard—Bending Insert Design.

In the Bending Insert Design dialog box, from the Type list, choose Standard Insert.

In the graphics window, select the bend start face.

NX displays the angle measurement beside the selected face. This example uses a 90 degree angle
for the bend.

In the Bending Insert Design dialog box, in the Standard Insert group, under Bending Type, click 90

Degree Bending -"i )

Under Insert Type, select Punch.

Click Standard Insert ag :
The Standard Part Management dialog box is displayed.

In the Folder View group, the PDW Bending Insert Library—Straight_Down—punch directory is
highlighted.

In the Member View group, a table lists the types of 90-degree bending punches that are available.

In the Member View group, in the table, select the Bend Down Punch[Without Screw, With
Springback Radius] row.

The Information window shows a drawing of the selected punch type.

ot =t —u]

Based on your inputs, NX selects a default punch from the directory of the punch type you selected.
The parameters of the default punch appear in the Standard Part Management dialog box, in
the Details group. You can select a different standard punch by clicking the Value column of the
parameter that you want to change.
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For this example, you want to accept the default punch.

Click OK.

NX adds the bending punch to your progressive die design.

You have created the bending punch. Now you need to create the corresponding bending die.
Create a bending die

In the graphics window, select the bend start face for the die.

In the Bending Insert Design dialog box, in the Standard Insert group, under Insert Type, select Die.

Click Standard Insert ﬂ;' ;
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In the Standard Part Management dialog box, in the Folder View group, the PDW Bending Insert
Library—Straight_Down—die directory is highlighted.

In the Member View group, in the table, select the BDDIA[Bend down insert, Without Screw, With
Springback Angle] row.

The Information window shows the following drawing, and the parameters for the default die appear
in the Details group.

Click OK.

NX adds the bending die to your progressive die design.

’

C

\\

The following picture shows the complete bending insert.
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Create a user defined bending die

In the graphics window, select the bend region face.

In the Bending Insert Design dialog box, in the User Defined group, under Insert Type, select Die.

Click Create Datum Plane D .
The datum plane is created.

Sketch the curves to define the bending die.

Click Sketch Section & |

The Create Sketch dialog box appears, and NX prompts you to select the sketch plane.

In the graphics window, select the datum plane.
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In the Create Sketch dialog box, click OK.
NX enters the sketch task environment.

Y

Sketch a rectangle to define the size and shape of the bending die.

| —— —— ———— —

482 DPP — Vocational Training for Smart Manufacturing in Machine Tools



Module: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Click Finish Sketch.

NX exits the sketch task environment and displays a preview of the bending die.

In the Bending Insert Design dialog box, click OK.

The bending insert die is created.
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k. Forming Insert Design

k1. Function and command call

Use the Forming Insert Design command to create a forming punch and die. You can:

Specify any forming region or free-form region for purposes such as bending or embossing.

Load a sketch to define any shape for a forming blank.

Specify a clearance for the punch plate, bottoming plate, stripper plate, or die plate.
Automatically create the forming head area and unit with the forming blank when you click Apply.

Where do | find it?

Application Progressive Die Wizard

Command Finder|Forming Insert Design g

k2. Forming Insert Design dialog box

Note See Common dialog box options for common options not discussed here.
Select Forming Region

You can select the forming region by two methods: selecting the faces directly, or defining the region
by selecting seed faces and boundary faces.

Appears when you select the Use Seed Face and Boundary
Faces check box.

Lets you select forming faces by selecting only the faces necessary to
define the region. NX determines the other faces based on your
selections and Region Options settings.

Use Seed Face and Boundary faces specify the ends of the forming region, and seed faces
Boundary Faces options  define the location of the region (that is, which side of the boundary face
the region is on).

Tip This method is useful when you have to select small faces or a
large number of faces.

Preview Region highlights the faces in the forming region as currently
defined.

J Appears when you clear the Use Seed Face and Boundary
m— Faces check box.

Select Forming Faces Lets you select forming faces in the graphics window.
Create Forming Blank

Design Forming Punch Specifies the type of blank.

m DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Design Forming Die

Parent

Blank Type

=

Select Blank

Position

Trim by Forming Region
Directly

Lets you specify the parent part. You can accept the default or select a
new parent from the list.

In the Engineering Die Wizard application, the parent is the station
where the insert is located.

Lets you select the type of blank to create.

Appears when the Standard blank type is selected.

Opens the Standard Part Management dialog box allowing you to
select forming inserts for your die design.

Note To make insert selection easier, only forming insert options from
the PDW Forming Insert Library are displayed.

Specifies where the punch or die is located:

A forming punch can be in the punch plate or the stripper plate.

A forming die must be in the die plate.

Specifies whether the forming blank is trimmed directly by the forming
region.

The forming region must be large enough to trim the extrude body, and
the extrude body must be long enough to trim.

If the Trim by Forming Region Directly check box is not selected,
project the forming region to the datum plane if there is no extrude body.

LN

If there is an extrude body, project the forming region to the extrude solid
body.
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Lets you sketch or select curves to define the punch or die profile.

D Create Datum Plane creates a datum plane where you can
sketch curves.
profile options -
E‘ Sketch Section enters the sketch environment, where you can
sketch the profile on the datum plane.

m Curve lets you select existing curves for the profile.
Height Specifies the height of the punch or die.

Lets you specify clearances for the following plates:

Punch plate (PP), bottoming plate (BP), and stripper plate (SP) when

Cisamsite gpion you select Design Forming Punch.

Die plate (DP) when you select Design Forming Die.

Lets you edit an existing punch or die.
Select Punch or Die to

Edit

Deletes the selected punch or die.
Delete Punch or Die

Component

486 DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

k3. Create a forming punch

This example shows how to create a forming insert in a die project.

Choose Progressive Die Wizard tab—Main gallery—Forming Insert Design g .

In the Forming Insert Design dialog box, in the Select Forming Region group, select the Use Seed
Face and Boundary Faces check box.

In the graphics window, select a seed face.

r

—

Select a boundary face.

__—

\ x

In the Region Options group, select the Traverse Interior Edges and Use Tangent Edge
Angle check boxes.

Click the Preview Region button.

The highlighted faces are the ones you want in the forming region.

Click the Finished Preview button.

In the Create Forming Blank group, select the Design Forming Punch option.
From the Position list, select Stripper Plate.

Sketch a profile for the forming punch by doing the following:
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Click Create Datum Plane D , and create a datum plane where you can sketch the profile for the
forming punch.

Click Sketch Section | B |

In the sketch task environment, on the datum plane, sketch a rectangle around the selected faces.

Click Finish Sketch.

The initial forming punch appears.

\\ A-
(Optional) Modify the initial forming punch as needed. For example, you can do any of the following:
In the Height box, specify the height of the forming punch.

In the Clearance group, in the Stripper Plate box, specify the clearance between the forming punch
and the stripper plate.

For a progressive die, you can use the Replace Face command to reshape the sides of the forming
punch to match the shape of the forming region.

In the Forming Insert Design dialog box, click OK.
The forming punch is created.

You can now create a forming die to shape the following faces on the bottom of the part. Create the
forming die in the same way as the forming punch, except in step 8, select the Design Forming
Die option

488
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|. Burring Insert Design

I1. Function and command call

You can now design:

A punch and die to create non-circular burring holes in the product.

A punch for burring holes without defining a blank.

Non-circular burring holes are very common in electronic parts. Use this enhancement to generate such
burring holes.

Where do | find it?

Application Progressive Die Wizard and Engineering Die Wizard

IE 4
Command Finder Burring Insert Design '@

Burring Insert Design dialog box—Burring Insert group—Circular or
Non-circular

Location in dialog|Burring Insert Design dialog box—Burring Insert group— Create without
box blank

I12. Burring Insert Design dialog box
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Burring Insert

S Lets you select a cylindrical face for the burring insert.
s
For a burring punch, you should select an internal face.
Select Burring

Face For a burring die, you should select an external face.

Burring : : S

Direction Lets you specify whether the burring direction is up or down.
Lets you specify whether to add a burring punch or a burring die.

Insert Type

The options in the dialog box vary, depending on which Insert Type you choose.

Circular or Non- : - L .
SiiGUlar Lets you specify whether the burring hole is circular or non-circular.

Lets you specify the parent assembly for the burring insert.
Parent
You can review the assembly structure in the Assembly Navigator.

The following options appear when you set Insert Type to Punch.

Eg Opens the Standard Part Management dialog box, where you can select a
Select Standard Standard burring punch to add to your design.

Blank

Lets you specify the shape and size of the punch head.

The Punch Head Type list lets you choose a shape for the punch head. A drawing

e e of the punch head type is displayed below this option in the dialog box.

options
Depending on which type you choose, you can define other parameters such as
the Punch Head Arc Radius.

The following options appear when Insert Type is set to Die.
Lets you do one of the following:

m Select an existing loop of curves to define the shape and
" curve size of the insert.
Select Curves

Use the sketch options to create a loop of curves. You
can create a datum plane on which you can sketch the
curves (usually a rectangle).

Ef Sketch
Section

The following options appear for both Insert Type settings.

Parameters Lets you specify other parameters for the burring punch or die.
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The start and end height of the insert

The clearance between the insert and the plate that contains the pocket where the
insert is installed.

(Optional) If you are creating a burring die, you can specify that you want to provide
a name by selecting the Rename Component check box in the Settings group

13. Add a burring insert to a die design

This example shows how to add a burring insert in the up direction to a die design.

Because the burring is in the up direction, the punch will be below the strip, and the die will be above
the strip.

Create a burring punch

Choose Progressive Die Wizard tab—Main gallery—Burring Insert Design ﬁ'

In the graphics window, select the internal cylindrical face of the burr.

_,-r"‘
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In the Burring Insert Design dialog box, under Burring Direction, select Up.
Under Insert Type, select Punch.

Add a standard burring punch.

Click Select Standard Blank ? :
The Standard Part Management dialog box is displayed.

The parameters of the default burring punch that NX selects appear in the Details group, and
the Information window displays a diagram of the punch and its parameters.

Note If the current standard punch does not meet your needs, change the value for a
parameter by clicking its Value column. Select a new value from the list if values are

provided, or enter a new value.

Click OK.
A preview of the burring punch is displayed in your die design.

p

L 4

In the Burring Insert Design dialog box, from the Punch Head Type list, choose Type 1.
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|

R

In the Punch Head Arc Radius box, enter 0.4.
Click Apply.

The burring punch is created.

i

Create a burring die

In the graphics window, select the external cylindrical face of the burr.

S~
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In the Burring Insert Design dialog box, under Insert Type, select Die.

Create sketch curves to define the boundaries of the burring die insert.

Click Create Datum Plane ‘g‘
A datum plane that defines the sketch plane is created in the top plane of the strip layout.

N

*

Click Sketch Section B |

The Create Sketch dialog box is displayed.

In the graphics window, select the datum plane.

In the Create Sketch dialog box, click OK.

You are now in the sketch task environment.
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¥

Sketch a rectangle to define the burring die.

Click Finish Sketch ‘E‘

A preview of the die is created.

In the Burring Insert Design dialog box, click OK.

The burring die is created.
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m. Insert Auxiliary Design

m1. Function and command call

Use the Insert Auxiliary Design command to:

Add a shank to strengthen any punch or die insert. The shank can have a heel, ramp, or flange shape.
Specify a clearance for the punch plate, bottoming plate, or stripper plate.

Create or edit a punch mount.

Copy or delete inserts.

Where do | find it?

Application Progressive Die Wizard

o
B
Command Finder|Insert Auxiliary Design

m2. Insert Auxiliary Design dialog box
Type
Type list Lets you specify the type of operation.

Insert Shank

Appears when Type is set to Insert Shank.

Lets you specify whether the shank shape is a flange, ramp, or heel. You can create

Shapsioptidas shanks as needed to strengthen punch and die inserts.

The following options appear when Shape is set to Flange.

Lets you create and edit a flange shank.

The picture shows the parameters of the flange shank, which you can edit.

Tip If you do not see all the parameters in the picture, drag the right edge of the
dialog box to expand it.

Flange shank

Bolioes The Clearance check boxes let you define the clearance for the punch plate,

bottoming plate, and stripper plate.
@ Select Punch Edge lets you select a punch edge to place the shank.

[lj Select Punch Shank Face lets you select a shank face, to edit it, for example.

The following options appear when Shape is set to Ramp.
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Lets you create or edit a ramp shank.
@ Select Punch lets you select a punch where the ramp shank will be created.

m Select Shank Profile lets you select curves to define the shank profile. If the

curves do not exist, ET@ lets you enter the sketch task environment to sketch the
curves.

The parameter boxes let you edit the dimensions of the shank. See the picture for
ramp  shank definitions of each parameter.
options
Tip If you do not see all the parameters in the picture, drag the right edge of the
dialog box to expand it.

m Select Face for Ramp lets you select a face to place the ramp shank. The
other ramp options let you select additional geometry or enter values to finish the
ramp definition.

m Select Punch Shank Face lets you select a face of a ramp shank, fro
example, to edit it.

The following options appear when Shape is set to Heel.

Let you create or edit a heel shank.

The picture shows the parameters of the flange shank, which you can edit.

Tip If you do not see all the parameters in the picture, drag the right edge of the

heel shank dialog box to expand it.
options
paramelers @ Select Insert Edge lets you select an insert edge to place the shank.

m Select Insert Shank Face lets you select a heel shank face, for example, to
edit it.

Punch Mount

Appears when Type is set to Punch Mount.

Lets you select an edge to specify the location of the punch mount.
Select Punch

Edge

ﬁ Opens the Standard Part Management dialog box, where you can select a punch

Design Mount mount.
Head
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ma3. Insert a flange shank

Choose Progressive Die Wizard tab—Main gallery—Insert Auxiliary Design | L)
In the Insert Auxiliary Design dialog box, set Type to Insert Shank.
In the Insert Shank group, from the list, select Flange.

In the graphics window, select a punch edge.

Click Apply.

The flange shank is created.

m4. Insert a ramp shank

Choose Progressive Die Wizard tab—Main gallery—Insert Auxiliary Design @ ‘
In the Insert Auxiliary Design dialog box, set Type to Insert Shank.
In the Insert Shank group, from the list, select Ramp.

In the graphics window, select a punch.
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Sketch the profile of the shank.

Click Sketch Section & |
Select the top of the punch as the sketch plane.

In the Create Sketch dialog box, click OK.

In the sketch environment, sketch the following profile.

Click Finish Sketch.
In the Insert Auxiliary Design dialog box, in the Insert Shank group, in the H box, enter -30.
In the F_H box, enter -32.

Click Apply.

The initial ramp shank is created.
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Create the ramp for the shank.
Click Select Face for Ramp.

Select the following face.

.

Click Specify Vector for Ramp.

Select the following vector.

=

Click Specify Point for Ramp.
Select the following point.

=

| S|

In the Radius for Ramp box, enter 1.
Click OK.

The ramp is added to the ramp shank.
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mb. Insert a heel shank

Choose Progressive Die Wizard tab—Main gallery—Insert Auxiliary Design =V .
In the Insert Auxiliary Design dialog box, set Type to Insert Shank.
In the Insert Shank group, from the list, select Heel.

In the graphics window, select a punch edge.

Click Apply.

The heel shank is created.

m6. Create a punch mount

Choose Progressive Die Wizard tab—Main gallery—Insert Auxiliary Design ‘g_
In the Insert Auxiliary Design dialog box, set Type to Punch Mount.

In the graphics window, select a punch edge.

DPP — Vocational Training for Smart Manufacturing in Machine Tools 501



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Click Design Mount Head |ﬁ|

In the Standard Part Management dialog box, from the parts list, select Screwholder (Bottom).
Click OK.
In the Insert Auxiliary Design dialog box, click OK.

The punch mount is added to the punch.
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n. Standard parts
n1. Function and command call

Mold Wizard, Progressive Die Wizard, Engineering Die Wizard, and Die Design provide several libraries
of standard parts that you can use to create your design.

The standard part libraries available provide a wide selection of commonly used components that you
can install and adjust, such as bushings, ejector pins, and inserts.

You can customize your libraries to match your company's design standards and expand the library to
include any component or assembly.

You can add standard parts to your mold or die assembly in one of two ways:
Using the Reuse Library W on the Resource bar. This is the preferred method.

;'l-
Using the Standard Part Library '1J command.

n2. Standard Part Management system

The Standard Part Management system consists of libraries of parts and supporting database
spreadsheets.

You can use the Standard Part Management system to:

Register components in a new or existing catalog.

Install new components or instances of existing components.

Position standard parts in the mold or die assembly.

Edit database spreadsheets to control optional parameter choices and attributes for parts lists.
Use database spreadsheets to define interpart expressions to link components and mold bases.

Remove components.

Application Die Design, Mold Wizard, Progressive Die Wizard, Engineering Die Wizard

Prerequisite |To work with Die Design commands, you must be in the Modeling application.

Resource Bar ﬁ
Reuse Library —MW Standard Part Library or PDW Standard Part
Library, or EDW Standard Part Library, or Stamping Die Standard Part
Library.

Command ;]‘]
Finder Standard Parts &~
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n3. Install a standard part

Prepare a library for use

Before you attempt to install a standard part, you should ensure that the library is set up:
Install the engineering library. It is supplied separately from NX.

In the Assemblies customer defaults, under General, on the Interpart Modeling page, under Allow
Associative Interpart Modeling, select Yes.

On the same page, ensure that the Delay interpart Update check box is deselected.

(Optional) In the Mold Wizard, Progressive Die Wizard, or Engineering Die Wizard customer defaults,
under Standard Parts, review the options and customize them. For Die Design, the Standard
Parts customer defaults are in the Standard Tools section.

(Optional) Use the Partially Shaded rendering style. Typically, standard parts are shaded in this mode,
and other objects are not shaded.

From Reuse Library, select Reuse Library Management w , and click OK in the dialog box.

This step insures that the Reuse Library configuration file is properly loaded.

n4. Select and install a standard part

On the Resource Bar, click Reuse Library w ;

In the Name panel, select the library that contains the catalog you want, and expand it.
Navigate to the manufacturer’s catalog or a custom catalog you created and expand it.
Select the folder for the type of reusable object you want to add.

Bitmaps of the parts in the folder are displayed in the Member Select panel.

If you do not see the parts displayed, select the Thumbnails from the view style list, and View All from
the view filter list.

In the Member Select panel, select a part, right-click and choose Insert.

You can also select the part, hold down the left mouse button and drag the part into the graphics
window. For this to work, you must have the Assemblies application open.

The Standard Part Management dialog box displays. An Information window that includes a bitmap
of the selected part with dimensions and catalog information also displays. You can toggle the display

of this window by clicking Iil in the Part group.

In the Standard Part Management dialog box, in the Part group, specify whether you want to add
another instance or add a new component based on the selected instance.

In the Placement group, you can specify:
The parent for the standard part

A positioning method

A reference set

In the Details group, specify parameters for the part, such as length, diameter, radius, and taper.
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Select the row for the parameter you want to modify.

In the Value column, click i and select a value from the list.

Use options in the Settings group to open the register or database file for editing.

Click OK or Apply.

If the part requires positioning, specify the position information as required for the method you are using.

When you place a part as a child of a part that has two or more instances, you must specify a the
placement point in the instance that is the work part

n5. Install a standard part using Point Pattern

To use Point Pattern with standard parts, you must first select the Point Pattern and modify it to fit
your requirements. Then you select a standard part (such as a screw), and use the point pattern you
created as your positioning method.

This example uses a simple part to illustrate the Point Pattern method.

On the Resource Bar, click Reuse Library ﬁ :
In the Name panel, select and expand the MW Standard Part Library.

Expand the POINT PATTERN (MM or INCH) catalog. Select a Point Pattern, right-click and
select Insert.

The Standard Part Management dialog box opens, and the Information window displays the default
pattern (2A). Note the location of the red Pattern Point in the middle of the pattern.

[i A1 I

© o+ ©
Change the pattern and modify some of its parameters.
This example uses the following settings:

Position = NULL
Pattern 4A

s,

5]

o o

X1=75
Y1=75
Click OK.
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506

The Point Pattern is now listed in the Assembly Navigator. It should also be visible in the graphics
window. If you do not see it, make Layer 99 visible. It is the default layer for Point Pattern features.

The red arrow in the following graphic indicates the Pattern Point that you will need to select in a later
step.

Repeat steps 1-2 and select the standard part you want to position with the pattern you just created.
This example uses a PUNCH angle pin bolt.
Select the bolt and click Insert.

In the Standard Part Management dialog box in the Placement group, from the Position list,
select POINT PATTERN.

Select the Pattern Point shown in step 5, then click OK.

The pattern of bolts is created.
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o. Relief Design
o1. Function and command call

Use the Relief Design command to create a solid body to cut out the pockets and holes on die plates.
This prevents interference between the strip and the die plates.

You can also edit, copy, or delete a relief solid body.

Relief solid body — bounding-box type
Where do | find it?

Application Progressive Die Wizard

Command Finder|Relief Design

02. Relief Design dialog box

Note See Commeon dialog box options for common options not discussed here.

Lets you select the operation to perform:
Create
Type menu Edit

Copy
Delete

The Create group appears when you set Type to Create.

Bounding Box  gpecifies whether the relief body shape is determined by a bounding box or by
User Defined user defined inputs.
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W

Select Face

Lets you select the extreme faces of the area where the relief is required.

Lets you specify the following when you select the Bounding Box option:

Clearance

2ounding hox The distance between the bounding box and the selected faces

options
Radius
The radius of the bounding box corners
Lets you specify the user defined shape for the relief solid body.
user defined
options You can select curves to define the shape, and specify the start distance and

height of the body.

The Edit group appears when you set Type to Edit.

Lets you select a relief solid body to edit.
Select Relief

Solid

Lets you edit the bounding box that defines the relief solid body.

bounding box [_“
options You can change the radius, or you can use | e i Bounding Box to edit
other parameters.

user defined

Crlions Lets you edit the start distance or height of a user defined relief solid body.

The Copy group appears when you set Type to Copy.

Lets you select a relief solid body to copy.
Select Relief

Solid

Number Specifies the number of copies.

The Delete group appears when you set Type to Delete.
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Lets you select a relief solid body to delete.
Select Relief

Solid

Delete Selected

Instance
Specifies how many relief bodies to delete.
Delete All

Instances
Setting
Creates the solid in the original station.

Create in Original
Location Note Relief bodies are put in a "™ _relief" part. If you want to generate a relief

pocket, use the Pocket Design command in the "Solid+Solid " mode.

Hide Relief Solid

Body Hides the relief solid body

03. Create a relief design using a bounding box

This example shows how to add a bounding-box type of relief solid body to a strip station.

-
Choose Progressive Die Wizard tab—Main gallery—Relief Design %
In the Relief Design dialog box, in the Create group, select the Bounding Box option.

In the graphics window, select faces to define the boundaries of the relief area.
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(Optional) Do any of the following:

In the graphics window, drag the handles of the bounding box to modify its size.

DPP — Vocational Training for Smart Manufacturing in Machine Tools 511



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

512

In the Relief Design dialog box, modify the values in the Clearance or Radius boxes.

Select or clear the Create in Original Location check box to specify the location of the bounding box.
Select or clear the Hide Relief Solid Body check hox to specify the visibility of the relief solid body.
Click OK.
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p. Pocket
p1. Function and command call

After you have finished adding standard parts and other components, you can use
the Pocket command to model pockets in die or mold plates, inserts, and other solid bodies.

Pockets are associative to the tool body by default. You can choose to make them non-associative to
improve performance.

When you create pockets, a tool body is geometry linked in the part containing the target body, and the
linked body is subtracted from or united with the target body.

You can create pockets using part family members as tool components. Part family pocket bodies are
defined in the PDW Pocket Tool Body Library.

You can specify a default reference set name for the pocket in Customer Defaults—Progressive Die
Wizard—Pocketing—Custom Reference Set of Tool Bodies.

You can also:

Select a component pattern to be used as a tool component.
Edit the pocket tool body.

Preview part family tool bodies.

When to Create Pockets

To minimize the number of features that update as you design your tooling assembly, create pockets
at the last stage of design:

After you cut pockets, the number of features in the assembly dramatically increases, which can affect
system performance.

Some updates may fail if insert groups/standard parts are moved outside of their target body.

Where do | find it?

Application Progressive Die Wizard

)

Command Finder|Pocket
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p2. Pocket dialog box

List Subtract Material — In body selection mode, subtract a copy of each tool body
from the target(s). In part selection mode, subtract a copy of the FALSE
reference set of each part from the target(s).

Add Material — In body selection mode, unite a copy of each tool body with
the target(s). In part selection mode, unite a copy of the ADD_MATERIAL
reference set of each part with the target(s).

lé[ Select one or more target bodies.

Select Object

@ Select one or more tool parts, components, or bodies.

If the selected compoenent's parent part has UM_STANDARD_PART_ROOT =
Select Object 1 attribute, the parent part will be automatically selected.
Tool'Type @| Solid — Filters the Select Object command in the Tool group to select

only solids.

@ Component — Filters the Select Object command in the Tool group to
select only components.

@ Show  Shortcuts — Replaces  the Select Typeslist  with
the Solid and Part buttons.

E Hide Shortcuts — Replaces the Select Types Solid and Part buttons
with the list.

Reference Set With Part or Component selected as the Tool Type, you can specify one of
the following reference sets:
False
True
Entire Part

No Change

@ Find all target bodies that intersect with selected tool bodies, or find all tool
bodies that intersect with selected target bodies.
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Find Intersecting
Components

Check Pocket
Status

[¥]

Remove Pocket

'II'Hr?:

Edit Tool Body
Settings
Associative

Show Target and
Tool bodies Only

Create Interfering
Solid

Always Save
Results in Part

Show Check
Results in HD3D

Preview Tool
Body

Highlight and show a total count of all standard parts that have no
corresponding pockets in the Status line, or give a message that there are no
unpocketed bodies.

Remove all pockets from the selected target body.

Opens the Edit Reusable Object dialog to edit the pocket tool body.

Makes the pocket associative to the tool body.

Hides all bodies other than those currently selected as targets and tools.

In cases where the pocket subtraction fails, creates a solid to highlight the
problem area.

Automatically saves the results of failed pocket checks in the part file.

- - o
Displays the check results in the HD3D tab on the resource bar.

Displays a preview of the generated pocket tool body for the family standard
tool part.

DPP — Vocational Training for Smart Manufacturing in Machine Tools 515



I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

p3. Pocket design procedures

Creating new pockets

Tip Before you create pockets, you can use the View Manager dialog box to hide components other
than target and tool bodies. This simplifies selection and checking.

You must be in the Mold Wizard application. If you are in the Progressive Die Wizard, or Engineering
Die Wizard application, use Command Finder to locate the command.

. +
ey 4 ool

Choose Mold Wizard tab—Main gallery—Pocket /= '
In the Mode group, select Add Material or Subtract Material.

(Optional) In the Target group, click Select Object and select one or more target objects.
Caution If you skip this step, you must select tools and then click Find Intersecting Components.

(Optional) In the Tool group, from the Select Types list or shortcut buttons, specify whether to select
parts or solid bodies.

Note You can select only parts that have the UM_STANDARD_PART attribute.

(Optional) In the Tool group, when a part family part is selected as the tool object, the entire component
pattern containing the part is selected and added to the tool object list.

(Optional) If you are selecting parts, in the Tool group, from the Reference Sets list, select one of the
available filters to make selection easier.

(Optional) In the Tool group, click Select Object and select one or more tool objects.

Caution If you skip this step, you must select targets and then click Find Intersecting
Components.

(Optional) After you select one or more of either targets or tools, in the Tools group, click Find

onn
Intersecting Components IEI.

Note If you selected one or more targets, all potential intersecting standard parts are selected.

If you selected one or more tools, all intersecting plates and other parts that can be pocketed
are selected.

Standard parts can be targets, tools, or both, depending on the value of
the UM_STANDARD_PART file attribute.

(Optional) In the Tools group, when selected part family parts are all the same size, the Edit Tool

ik
Body ?‘ command can open the Edit Reusable Object dialog to edit the pocket tool body.

(Optional) In the Tools group, select the Show Target and Tool Bodies Only check box to temporarily
hide all bodies except the current selection of targets and tools.

(Optional) In the Settings group, select the Preview Tool Body option and a preview of the pocket tool
bodies for selected family parts is displayed.

Click OK or Apply.

Deleting pockets
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=

Choose Mold Wizard tab—Main gallery—Pocket 227 :

Select one or more target bodies or tool bodies that are associated with pockets.

In the Tools group, click Remove Pocket @

Checking pocket status

1-11?,_
Choose Mold Wizard tab—Main gallery—Pocket = .

In the Tools group, click Check Pocket Status okt |

Note If there are no standard parts with no corresponding pocket, you will see an information dialog
box advising you that no standard part is unpocketed.

If there are parts without corresponding pockets, they are highlighted. You can see a count of
parts without pockets in the Status line
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q. Bill of Material

q1. Function and command call

Use the Bill of Material % command to manage part attributes. The Bill of Material command
name is commonly referred to by the acronym BOM.

e 1 i 1 1 1 1 |
Sie Industry Scfty {Shanghal) Co., Lid
B O M Table
CUITONER | -ConTTRE R, PRCACT WU FECECT WAEER- VERLAOH
. +
PUELEABE DATE DE BSHER BY <DL S APPERIVID BY

Pdisam oy 1 L L
iy Gy - L O SO TN CATALOG T i | sewoas SROCK S AN T
s B [0 o [ AR D T T T AR SO e - B LR AR
=1 7] L i v 5 o 2 I w
Frre] 7] T v - 0 o
= 7 T 73 o o A b
=

Using templates

You can use templates to define the related part information and the following parameters.

Display Specifies the display names of the BOM list items, which are displayed as column
Name titles in the Bill of Material dialog box.

Attribute  Specifies the attribute name of the BOM list items. Only the attribute values that
Name you specify in the template are displayed in the BOM list. If you do not specify a
value for an attribute, the attribute is not shown in the BOM list.

Key Field Lets you specify whether the corresponding attribute is to be used as a key field
attribute or not. The components which have the same key field are grouped
together and shown in one row in the BOM list.

Locked Specifies whether you can modify the value of an attribute in the BOM list.

Filter Specifies if you want to use the value of an attribute as a filter string.

For example, if the Display Name attribute has a string value set to SUPPLIER,
then the attribute is shown in the BOM list and you can also use the attribute
value to filter the BOM data.

If you do not define the Display Name for the filter attributes, for example the
MW_COMPONENT_NAME in the template, the attribute is not shown in the BOM
ul.

Note The cells shown in gray cannot be used as they will be deleted when you export the BOM. You
can enter user information at the top of the template.

Changing values

You can change the value from the predefined alteration list in the specified column by defining a
common data template. There are four types of lists in the common data template, and you can define
them by setting LIST_TYPE to values as shown in the following table.

LIST_TYPE ‘Option List [Mark if not in list Mark if in list (ban list) \User Change

0 ‘Yes No No No
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1 Yes No No Yes
2 Yes Yes No No
3 No No Yes Yes

You can also do the following:

Generate different BOM lists by switching templates in the Bill of Material dialog box.
Quickly recognize modified information in the BOM list.

If you modify a row in the BOM list, the particular row is highlighted in blue.

A7 CameraCore.. 8 6x22 BRASS SHCS

Filter BOM data based on specific attributes which are defined in the BOM template.
A check box will flag the rows that you have exported.

These features will generate a BOM with a formatted template in Excel. You can specify different part
attributes in different columns of the template, specify one or more part attributes to be a key field, a
lock status, or to filter the column.

Editing

You can edit the BOM table similar to how you would edit a spreadsheet. You can:
Select individual cells.

Edit multiple cells simultaneously.

Use better filtering options to filter data.

Use visual cues such as cell color to identify certain types of data. For example, a locked cell appears
in gray, and an invalid entry appears in pink.

You can either accept your manually entered BOM data by clicking Apply or exit by clicking Cancel.
Footer information

You can add footer information to the Bill of Material template including general text, or assembly
attributes such as date and designer.

LY

Foorer Dafine | e ——— !
B § coter | RELEASEDATE _ [-DWTE- | DESIGNERBY |[-DESIGNER> | APPROVED BY| ]

Information added to the footer section of the template appears at the bottom of your generated bill of
material spreadsheet.

“RELEASEOATE (o | DESIGNER BY_[Desguer fiave | APPROVED BY| : |
T T T ! ) : :

DPP — Vacational Training for Smart Manufacturing in Machine Tools 519



I MVodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Where do | find it?

Mold Wizard, Progressive Die Wizard, Engineering Die Design, Electrode

Application Design
Command g
Finder Bill of Material

g2. Bill of Material dialog box

Setting

_ﬁj Lets you select a component in the graphics window. NX then highlights the
selection in the BOM list.

Select

Components

List

Rows represent standard parts in the assembly. Columns represent calculated value for item number
and quantity, and part attribute value. You can edit cells in a selected row by clicking them.

Note You cannot edit the NO. and QTY columns. You cannot edit system-assigned attributes such
as part names if they appear in your parts list note.

You can choose one of the following commands at the bottom of the BOM dialog or right-click rows in
the list to get the corresponding commands:

N Shows the components that appear in the BOM list.
A
BOM List
NF Shows the components that are currently hidden from the BOM list, so that you
§ can use a shortcut command to show them.
Hide List
% Lets you create a new parts list.

Create Parts List

E Adds the current displayed part to the BOM list.
Add Displayed

Part

Lets you open the Stock Size dialog box.

For multiple row selections, calculates the stock sizes according to the parameters
Edit Stock Size  set in the Settings group.

li] Opens the Component Information dialog box, which has a list showing the
name of the component part file.
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Information
ﬁ Creates a spreadsheet file containing the contents of the list.

Transfers the BOM list data from NX to a temporary spreadsheet. You can use
Export to your default spreadsheet viewer commands to save the temporary file.
Spreadsheet
3 Moves the selected component to the Hide List display and removes it from the

BOM List. Appears only when BOM List option is selected.
Hide Components

e 4 Opens the Filter dialog box and lets you filter the BOM data by the given filter
strings.
BOM Filter
Setting
Name Generates different BOM lists by switching templates
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r. View Manager

r1. Function and command call

Use the View Manager command to do the following to progressive die or engineering die components:
Control visibility and selection through check boxes.

Right-click a component node to open or close it, freeze or unfreeze it, isolate it, or set its color.

Note You can use the View Manager Browser with other commands in the Progressive Die Wizard
and Engineering Die Wizard applications. Start the View Manager Browser first, then open the
other commands.

The View Manager Browser is similar in style to the Assembly Navigator, displaying holders like

assembly files. Holders® look like assembly files, and represent a group of component types. Holders
may contain other holders and can be used to organize other holders and nodes in the View Manager

Browser. Nodes (3 look like component files and represent a group of components of a single type.

View Manager Browser

Customized Name Isolate Freeze Status Open Status Attribute Count
= MH Top & & = 0
O &% Other e 3 i 0
fu Diebase & D = 0
= M hide ‘@ & = 0
0 & hole ‘@ 3] i 0
i) die / punch & & > 1
M3 bend ) 3 = 1
w M& strip B ) = 0

The View Manager Browser tree structure

As shown in the previous figure, holders and nodes may have custom names in the View Manager
Browser that are independent of the component name.

If a node is displayed "Dowel Pins" and all components in the die that contain the part
attribute PDW_COMPONENT_NAME or EDW_COMPONENT_NAME with the value "DOWEL" will be
managed by the "Dowel Pin" node.

XML code:

<PDW_COMPONENT_NAME Description="Dowel
Pin">DOWEL</PDW_COMPONENT_NAME> or <EDW_COMPONENT_NAME Description="Dowel
Pin">DOWEL</EDW_COMPONENT_NAME>

Where do | find it?

Application Progressive Die Wizard

Command Finder|View Manager
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s. Static Interference Check
s1. Function and command call

Use the Static Interference Check command to analyze selected solid bodies for overlap and to report
the type of interferences found.

A static interference check helps you improve your design by showing you where interferences or
missed pockets occur.

Where do | find it?

Application Progressive Die Wizard

Command Finder|Static Interference Check @j

s2. Static Interference Check dialog box

User Defined Sets

w

Select Object

You are prompted to select a target component or body.

P

Select Object

You are prompted to select a tool component or body.

Note The following options become unavailable after you select the first object.

For any single analysis you can select either bodies (exclusively) or components (exclusively).

Component Selects components.

Solid Body Selects individual bodies in component parts.

Standard Sets

List Displays the components from
the static_interference_check_standard_sets.xls spreadsheet.

+=

5 Adds the selected set to the user defined sets that appear in the list in

the Sets Name List group.
Add to User Defined Sets

‘Sets Name List

List Shows the assemblies clearance sets defined in the displayed part.
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524

Clearance Set Name

Clearance Zone
Remove

Settings

Analysis Mode

Reference Set

M

Include Subassemblies

%

Include Blanked Bodies

M

Defines the current selection as a user defined clearance analysis set,
and displays the name in the list in the Sets Name List group.

Note You can select a saved set for future rechecking without having
to select the targets and tools again.

Sets the clearance tolerance for soft interference.

Deletes the selected clearance zone.

Select one of the following:
Exact

Checks solid bodies for interference.

Note This is the more accurate mode, but it can be slow if
several components are analyzed.

Lightweight
Compares faceted bodies for interference.

Note This mode is less accurate, but it is comparatively very
fast.
Select one of the following:
True Body

Selects the actual assembled component model of standard parts for
the analysis.

False Body
Selects the pocket cutting body in standard parts for the analysis.

Entire Part

Selects all solid bodies in standard parts for the analysis.

Includes child components of every assembly part you select for
analysis.

Adds hidden bodies in selected components to the analysis.

Includes parts that contain a symbolic thread feature in the analysis.
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Include Fasteners

2
Selcet  Standaid:  Séts Lets you select the standard sets spreadsheet file.
Spreadsheet
Lets you edit the standard sets spreadsheet file.
Edit Standard Sets
Spreadsheet
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t. Motion Simulation
t1. Preprocess Motion

Use the Preprocess Motion command to set and load the kinematic model, and mount the sheet metal
or plastic parts of the die or the mold on the kinematic model to prepare your motion simulation data.

You can:
Clone a predefined kinematic model for tooling into your current assembly or to a directory you specify.
Change the kinematic model.

NX displays a message window asking you to confirm whether you want to remove the current kinematic
model and add another one. You need to clickYes, and then mount the components again and redefine
the cams.

Generate control data and import it to a kinematic model according to the die settings. You can also
change to different control data and re-read the control data.

Mount components immediately to the kinematic model by using the Mount g command.

You can also specify different motion types for the mounted components.

Update the current simulation by using the Re-read Configuration Data File ﬁ command.

The check box for this option is removed.

Example of an injection molding cycle.

A complete mold assembly or progressive die can have thousands of components. When you simulate
the motion of your tooling assembly, you can locate and resolve potential interference problems before
the assembly is built.

Where do | find it?

Application Mold Wizard and Progressive Die Wizard

Command Finder|Preprocess Motion E
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t2. Preprocess Motion dialog box

Type
; Add Kinematic Model
Clones a new set of kinematic parts and adds them to the current tooling
assembly as a subassembly.
Type list

g Mount Component

Lets you identify components as belonging to a specific kinematic category, such
as fixed or moving components.

The following options and groups appear based on what you select from the Type list.
Kinematic Model
Appears when Type is set to Add Kinematic Model.
_ Lets you select a kinematic model template.
£ Two templates are provided as examples.

Sets the folder to which the kinematic components are cloned.

Target Directory Typically, you should place the kinematic model in a location that is included in

your search paths, or with the tooling assembly.
Kinematic Parameters
Appears when Type is set to Add Kinematic Model.
The following options appear only in Mold Wizard.

Specifies whether the mold assembly has two or three plates.
Lets you define the following kinematic parameters for a mold assembly:
Machine Stroke (A)

Two-plate Style  Sets the injection mold open distance.

Three-plate Style Ejection Distance (D)

Sets the distance over which the plastic model is ejected when the mold opens.

Example of a two-plate style mold
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The following parameters appear when Three-plate Style is selected.
Pull Runner Distance (B)

Sets the distance over which runners are pulled.
Injection Relief Distance (E)

Sets the distance between the runner plate and the cavity plate.

Example of a three-plate style mold

Eject Lets you specify when the ejector plate advances to eject
Product the part from the mold.
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After Mold Advances the ejector plate to
Fully Opened release the part, only after the mold

is fully open.

While Mold Advances the ejector plate to
Opening release the part as the mold opens.

Mold Open Available only when Eject Productis set to After Mold
Angle Fully Opened.

The mold open angle defines when to open the mold. A
mold simulation cycle has a range from 0 to 360, 0 being
the start of the simulation and 360 being the end of the
simulation.

Note The Mold Open Angle value must be between 0 and
90 only.

Ejection Lets you specify the point in the 0-360 simulation range in
Start which to activate additional hydraulic motions.
Angle

The following options appear only in Progressive Die Wizard:

Lets you define the following kinematic parameters for a progressive die assembly
or an engineering die assembly:

Machine Stroke (D)
Stripper Travel (A)

Strip Lift Height (C)

Strip Lift Height (Feeder2)
Pitch (Feeder)

Pitch (Feeder2)

Transfer Start Angle
Transfer End Angle
Strokes per Minute

Example of a progressive die
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ﬁ

Ay | |

Bf-*_ |

Settings
Appears when Type is set to Add Kinematic Model.
. M | Rename Components
Rename Sets a suffix that is added to cloned kinematic part names.
Kinematic T & -
Model options .— | Hide CSYS in Kinematic Model
Hides the CSYS in the kinematic model.
When this check box is cleared, the CSYS is displayed at the center of the mold
base in the plane where the A-plates and B-plates meet.
E Creates the kinematic model in all bodies.
Include Hidden When this check box is cleared, NX does not include the kinematic model in
Bodies bodies that are hidden.
Import Control Sets a control file to import. The default file
Data is [pdiewizard_dir]\proj_temp\tooling_validation.xls.
Export Control Creates a standard .csv (Comma Separated Values) file with the current control
Data data.
- (jﬁ Appears when Mount Component is selected in the Type group.

Reruns the mounting calculation. Click on the icon after you modify the
Re-read Configure configuration file tooling_validation.xls.

Data File The file path is$PDIEWIZARD_DIR\configuration\tooling_validation\.
r ﬁ Appears when Mount Component is selected in the Type group.

Opens the tooling_validation.xls file.
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Edit

Data File

Component Mounting

Appears when Type is set to Mount Component.

Motion

Lets you select one of the motion nodes in the kinematic model.
For Mold Wizard, you can choose the following:

Move

This node of the kinematic model is the motion driver.

Add plates such as BP, UP, CP, and so on, and other plates and hardware
attached to these plates.

Fix

This is the fixed node of the kinematic model. If you reposition it, everything else
moves with it.

Add fixed parts such as the A-plates.

Ejection

This node of the kinematic model is used to push the product out of the mold.
Add parts such as ejectors, lifters, and the ejector plates.

Injection

This node of the kinematic model moves along the Z-axis.

Stripper

Product

A lifter type used to define motion. This node of the kinematic model first moves
along Z-axis and then along the X or Y-axis.

Add product components to this node.

For Progressive Die Wizard, if you are using the Tooling Kinematic Model
template, you can choose from the following:

TOP

BOTTOM

LIFTER

STRIPPER

FEEDER

For Progressive Die Wizard, if you are using the Tooling Kinematic Model 2
template, you can also choose:
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FEEDER2
LIFTER2

STRIPPER2

Mounted Specifies the number of components mounted.

Lets you select components when you highlight a node in the list. Selected
.Q. components are added to the node, and included in the simulation.

Note Components are added to the node only when you

SEECteRE click Apply when Type is set to Mount Component.

=

Mount

Mounts the selected object into a Motion item.

; _| ’ | Appears when you select FEEDER/FEEDER2 motion type in Progressive Die
’ ho!.. ,"f “ Wi
o | izard.

Specify Vector Lets you specify a vector for the FEEDER/FEEDER2 move direction

t3. User Defined Motion

Use this command to add user defined motion data to your kinematic model.
You can define:

Linear movement along a specific vector.

Angular movement about a specific axis.

The motion curve is a set of 360 values, one for each angular increment of 0-359 degrees, that
determines how far to move along or about the axis at each point of the simulation. You can use the
simple motion curves created by NX, or supply your own values using a comma separated values (CSV)
file.

Where do | find it?

Application Mold Wizard and Progressive Die Wizard

Command Finder|User Defined Motion

t4. User Defined Motion dialog box

Bodies in Motion

v

Select Bodies

Lets you select the bodies for the motion you are defining.
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Motion
Specifies the type of motion that you want to use.
Linear A motion that is in a straight line.

Rotary A motion that reveolves around an axis.

<[] B2 -

! Specifies the direction of motion for the selected bodies.

Specify Vector
g‘; ;/7: - Appears when the motion is set to Rotary.
Spet;i iy Poiﬁt Lets you specify a stationary point around which the selected bodies will rotate..

Motion Curve

Sets a linear motion.

You define the motion using the timing options.

Linear
The motion curve is a set of 360 values, one for each angular increment of 0-359
degrees, that determines how far to move along or about the axis at each point of
the simulation.
Sets a rotary motion.
You define the motion using the timing options.
Rotary : : .
The motion curve is a set of 360 values, one for each angular increment of 0-359
degrees, that determines how much angle to rotate about the axis at each point of
the simulation.
Press Timing )
Start  Lets you specify the start angle.
Stop Lets you specify the stop angle.
Return Timing )
Start  Lets you specify the start angle.
Stop Lets you specify the stop angle.
Move Distance Sets the linear move distance.
This only applies to linear motion.
Rotation Angle Sets the rotation angle.
This only applies to rotary motion.
From File Lets you define the motion from an external CSV file.
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Appears when the Motion Curve is set to From File.

Ve
Import Curve Data L Import Curve File

Lets you import an external curve file to be used for motion.
Name

Sets the name for the motion you are defining.

User Defined Motions
%
Lets you define a new set of motions to be added to the list.

Add New Set

Name Sets the name for the motion that you are defining.
List

Active  Indicates whether or not the defined slide is active.
S

Previews the motion you have defined.
Preview Motion

Lets you export the motion curve to an external file for later use.
Export Motion

Curve
Settings

Use Control Data

Uses the kinematic control data for the user defined motion.

Add a kinematic model to a die assembly

Choose Menu—Tools—Process Specific—Progressive Die Wizard—Validation
Tools—Preprocess Motion.

In the Preprocess Motion dialog box, in the Type group, select Add Kinematic Model & 4 :

In the Kinematic Model group, from the list, select a kinematic model template.

Two default templates are provided. You can also create other templates. (A Machine Tool
Builder license is required.)

Tooling Kinematic Single Strip Model: This template is for a regular progressive die with one strip layout.

Tooling Kinematic Two Strips Model: This template can simulate a progressive die with two strips
moving perpendicularly.
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(Optional) In the Target Directory box, specify a file location for the kinematic subassembly.

Click OK or Apply.

t5. Run Simulation

Use this command to view a simulation that shows the kinematics of all the automatic and user-identified
components in the model.

You can:

View the components and parts within the model and check for collisions and interference.
Detect and analyze the collision at each angle of the simulation.

Choose one of three accuracy methods for collision checking:

If you want a quick rough check, use the Facet Body Distance option. The check time is relatively fast
but the precision is rough.

If you want average precision, use the Mesh Triangle Intersection option. The check time is average.

If you want the greatest precision, use the Solid Body Intersection option. The check time is longer
than the other two options.

Where do | find it?

Application Mold Wizard and Progressive Die Wizard

L

Command Finder|Run Simulation B JJ.

Run Simulation dialog box
Position in Cycle

Lets you move directly to any angle of the simulation, or enter a specific angle.

Angle Drag the slider or enter an angle value (between 0-360) to go to a specific position in

the simulation.
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Refresh

Interval

Controls

Control buttons

Collision

Collision
Check Method

Check
Collision

Stop

Simulation at

Collision

Highlight
Collision

The cycle of the simulation is a set of 360 values, one for each angular increment of
0-359 degrees, that determines how far to move along or about the axis at each point
of the simulation.

Lets you control the speed of the simulation.

Drag the slider or enter a value between 0-10 degrees to set the refresh rate. This
controls the speed of the simulation.

The refresh rate is the number of degrees between each step of the animation.

Let you control the simulation.

When you click Play ’ , NX runs the simulation within 0-360 degrees and repeats

this until you click Stop

Alows you to specify the type of collision check to be used when analyzing data for
collisions.

Facet Body Provides a quick check for collisions. The check time is

Distance relatively fast but the precision is rough. This method
makes it difficult to distinguish between touching and a
hard collision.

Mesh Triangle This method is more accurate than the Facet Body

Intersection Distance method, and it has greater accuracy for
determining a touch from a hard collision. Identifies the
colliding facet bodies rather than just a mounted
component.

Solid Body This is the most accurate method in identifying collisions.

Intersection It uses a boolean analysis between the solid bodies to
determine the collision. Larger assemblies will take a
considerable amount of additional time to complete using
this method.

Checks the collision and displays the collision in a list.

Available when Check Collision is on.

Stops the simulation when the collision list changes.

Highlights the colliding bodies during the collision.
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Ignore
Touching

Shortcut
commands

Collision list

SF

Collision
Configuration

¥y

Collision
Information

o

Reset
Collision

Disregards any touching information that occurs in the simulation.

Available in the shortcut menu when you right-click a collision in the list.
Analyze

Opens the Analyze Collision dialog box where you can see more detailed
information about the collisions.

Ignore This collision

Ignores the selected collision including interference.

Note Applies only to one collision between the two parts. If the parts collide again at
a different point in the cycle, NX detects the collision.

Ignore Between Parts

Ignores the collision for the selected pair of parts.

Displays all currently colliding or interfering pair of parts in a list. The list changes as
the simulation progresses. New collisions are added at the top and removed when
they no longer collide.

You can right-click an entry in the list and choose Ignore to turn off the collision.

Tip You can choose to ignore just the collision in the current range or all collisions
between the two parts. You can turn off collisions that you are not interested in,
for example, a collision between the sheet metal and a die at the closed position
of the press, which is an expected collision.

Opens the Collision Configuration dialog box where you can specify more detailed

parameters regarding collisions..

Opens an Information window which includes the detailed collision data.

Restores any ignored collisions to their original state. The restored collisions will
Ignored apPpear in the simulation.

t6. Run and analyze a simulation

Choose Menu—Tools—Process Specific—Progressive Die Wizard—Tooling Validation—Tooling

Motion Simulation.

In the Tooling Motion Simulation dialog box, in the Type group, select Run Simulation

=
o

In the Run Simulation group, click Run Simulation B
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In the Run Simulation dialog box, click Play ’ | to observe the current motion.
Only components that are assigned to a node in the kinematic assembly are shown.
To perform a dynamic collision check, select the Check check box.

The analysis takes a while to perform.

With a really large assembly, it is useful to add only a few components at a time.

You can also click Modify Checks to reduce the number of checks that are done for each step of
motion.

When Check is selected, you can also select the following:
Stop — Stops motion when a collision occurs.

Highlight — Highlights pairs that touch or interfere within the tolerance specified in the Clearance box.

M

You can play the motion cycle one step at a time by clicking Step Forward , or with

4
the Stop option, click Play and allow the motion to proceed until a change is detected.
You can control the number of degrees of the 360 degree cycle that occurs when you click

When you find a motion step, click List Changes for a detailed description of the changes during the
most recent motion.

For example, the Information window might contain the following:

Collision changes from 30.0 to 32.0 degrees

TOOLING_ATTACH_FIX_MNT and TOOLING_ATTACH_PRODUCT_MNT are no longer colliding
TOOLING_ATTACH_EJECTION_MNT and TOOLING_ATTACH_PRODUCT_MNT are colliding

Click Close when you are done.
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u. Component Drawing
u1. Function and command call

Use the Component Drawing command to automate the creation and management of drawings for
components in a mold or die assembly. You can:

Select components in the Modeling application to create a drawing directly.
Assign the same or different templates to multiple parts.

Edit drawings; for example, add a new sheet, delete a sheet, delete a self-contained drawing, or change
the drawing template.

Use a user-defined drawing template, which dynamically changes the drawing frame size according to
the part size.

Where do | find it?

Application Mold Wizard, Progressive Die Wizard

Command Finder|Component Drawing j

u2. Component Drawing dialog box

Drawing
Lets you create drawings for all the components that you select in the Components
Create table. You can filter the components that are listed, using the Component Type list.
Drawing Note Only components that do not have associated drawings are listed in the
Components table.
Update Lists in the Components table the drawings for the selected components in the
Drawing current assembly.

Specifies the components to display.
All displays all the components in the assembly for which drawings do not exist.

Component A selected component type, such as PLATE or SCREW filters the list to display only
Type the components of that type.

The component type attribute (PDW_COMPONENT_NAME) values are defined
in $PDIEWIZARD_DIR\templates\pdw_attribute.xls::Attribute_list. You can
customize these values.

Lets you select one or more components for which you want to create drawings. You

_$_ can select components:

From the Components table in the Component Drawing dialog box.
Select . : : : ; : :
Component In the graphics window. The view must be either a drawing view or a model view.

From the Assembly Navigator.
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Note In the Assembly Navigator, make sure that you select the objects that
you want. For example, if you open the Assembly Navigator, right-click
the top-level node, and choose Select Assembly, only one object, your
top-level assembly, is selected.

Lists the components eligible for drawing creation when you click Create Drawing.
Lists components that have drawings, when you click Update Drawing.

Name column Displays the name of the component.

Drawing Displays the default name for the potential Master Model
File column drawing of the component. You can specify a name for a
Self Contained drawing.

When Update Drawingis selected, you can select a
drawing in the table and press the right mouse button to
display the following menus:

Add Sheet: You can specify a new sheet name.

Edit Sheet. Appears If you have changed the template
for the drawing. Select it to apply the new template.

Components
table Delete Sheet: Lets you delete the sheet currently listed
in the Sheet column.
Open Drawing: Opens the selected drawing.
Delete Drawing: Deletes the selected drawing, unless it
is the displayed part or the work part.
Sheet column Displays the name of the sheet on which the potential
drawing will be created.
Template Displays the name of the template currently assigned to
the component.
Type column Lists the component type that is selected from
the Component Type list.
Toggle column Whether to copy this title and value as an attribute to the
drawing part.
Attributes : . . .
Copicd | To Title column Displays the attribute titles.
Drawing Part
Value column  Displays the attribute values.
Note You can double-click the title or value column to edit it.
+

-y Appears when a component type is selected.
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Add
Component
to List

=
Create
Drawing

Templates

Template

Settings
Projection

Keep
Drawing
Open

Lets you add to the Components table a component that you select in the graphics
window and assign to it the current Component Type part attribute. You select the
component first and then click this button.

Appears when Create Drawing is selected at the top of the dialog box.

Creates drawings of the currently selected components.

Lists the templates available for the current assembly, which vary depending on the
whether the assembly units are English or metric.

Metric templates are available for drawing sizes: A0, A1, A2, and A3.

English (inch) templates are available for drawing sizes: B, C, D, and E.

Lets you specify the angle of a projected view in your drawing.

See the Drafting Help for more information about projected views, drawings, and
drawing types.

Keeps all the drawings that you created open after you close the Component
Drawing dialog box. You can access the drawings from the Window menu

u3. Create drawings for selected components in a die assembly

This example shows how to create drawings for one or more components of a specified type in a die

assembly.

Die assemblies can have hundreds or even thousands of components. Sometimes, you want to create
drawings only for specified types of components, such as the die plates.

Open the Component Drawing dialog box in one of these ways:
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Choose Progressive Die Wizard tab— Drawing Automation gallery—Component Drawing |

Choose Menu—Tools—Process Specific—Progressive Die Wizard—Drawing
Automation—Component Drawing.

In the Drawing group, click Create Drawing.

From the Component Type list, select PLATE.

All the plate components are listed in the Components table.
Select the top plate.

The component is highlighted in the graphics window.

In the row of the selected component, click in the Drawing File cell and from the drop-down list,
select Self Contained.

Click Create Drawing | [ I

NX creates a drawing of the top plate.

e

= o a LR T s o ——

In the Drawing group, click Update Drawing.
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Click Return to the Root Part ‘7 .

The drawing closes and the assembly is displayed in the graphics window.
Click Close to close the Component Drawing dialog box.

Start the Drafting application.

In Drafting, you can modify views, change view style, add annotations, notes, and balloons, and change
text style, according to the requirements of the drawing and the standards of your company.

u4. Create drawings for all components in a die assembly

This example shows how to create component drawings for all the components in a progressive die
assembly.

Open the Component Drawing dialog box in one of these ways:

Choose Progressive Die Wizard tab—Drawing Automation gallery—Component Drawing |

Choose Menu—Tools—Process Specific—Progressive Die Wizard—Drawing
Automation—Component Drawing.

In the Drawing group, click Create Drawing.

All the components in the current assembly are listed, with their default drawing file names, sheet
number, template, and type, if applicable.

From the Component Type list, select All.

Select all components in your assembly.

In the Components table, select the top row.

Scroll to the bottom of the table, press and hold Shift, and select the bottom row.

Although there are other ways to select all the components in an assembly, you must be careful that
your method selects the objects that you want. For example, if you open the Assembly Navigator,
right-click the top-level node, and choose Select Assembly, only one object, your top-level assembly,
is selected.
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In the Templates group, from the Template list, select the template file you want to use for all the
drawings.

For this example, template_a0_comp_mm.prt was selected.

Click Create Drawing @

NX creates a drawing for each component in your assembly.

In the Drawing group, select Update Drawing to confirm that the drawings were created.
All the drawings for the die assembly are listed.

Select a drawing from the list, right click, and choose Open Drawing.

The component drawing opens with the default template settings.

For this example, a set of lifter components was selected.
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|

The drawing closes and the assembly is displayed in the graphics window.

To close the drawing, click Return to the Root Part|

Click Close to close the Component Drawing dialog box.
Start the Drafting application.

In Drafting, you can modify views, change view style, add annotations, notes, and balloons, and change
text style, according to the requirements of the drawing and the standards of your company
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4.3. Designing the Progressive Die using NX

4.3.1. Create intermediate stages
a. Detailed workflow 1: Create intermediate stages

This workflow shows you how to:
Prepare the bracket part shown.
Create intermediate stages.

Select a start stage.

;I. ﬂ -& ﬁ g g Start the Progressive Die application.

Most of the commands that you will use

‘ 2 _g a : are in theProgressive Die
: Wizard tab—Intermediate Stage
Tools group.
2. Open the part.
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3.
Choose Direct Unfolding -@
Set Type to Convert to Sheet
Metal and select the top face as the
base face.

4, Choose Define Intermediate
Stage ﬂ
Set the following:
@ From Part to Blank
Number of Intermediate Stages
Start Station
Pitch
Orientation of Pitch

5 ~ Create the intermediate stages.

. This workflow uses 5 intermediate

stages.
In the Assembly Navigator, the stages
appear as Final, Final-1, Final-
2, Final-3, and Final-4.

6. Make Final-1 the work part.
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Choose Universal Unform @
Set Bend Type to Straight

Bend E 'and unbend the deformed
bend regions.

Make Final-2 the work part.

izl

Straighten the two remaining bends.

Choose Bend Operation
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10. Make Final-3 the work part.

11.

Choose Universal Unform g

Set Bend Type to Burring E and

flatten the burring.
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12. Make Final-4 the work part.

13. Choose Analyze Formability-One

i
Step 2

Select the faces to be unformed.

Set the following:

Type = Intermediate Unform
Object Type = Face

Select the target region face.

Set the overall element size.

Click Mesh @
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14. In the Calculation group,

click Calculation r

The results display a section that
represents a flattened version of the
deformed region.

Use Modeling commands such as Trim
Body and Extrudeto remove the
deformed region and replace it with a
flat face that conforms to the shape
defined by the Analyze Formability -
One-Step command.

15.
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To clearly distinguish this final stage
from the other intermediate stages,
select a face and change its color.

16.

17. Display the parent assembly.

b. Define Intermediate Stage
b1. Function and command call

Use the Define Intermediate Stage command to create a specified number of associative intermediate
unfolding stages in your assembly. You can then use the Bend Operation command to unbend,
rebend, or flatten the straight-brake bends in each of these intermediate stages. You can also use
the Universal Unform or Analyze Formability — One-step commands to unform freeform geometry,
or use other modeling commands to generate the intermediate geometry.
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The command supports a default item type in Teamcenter for newly-created intermediate parts. You
can establish the naming rule using the Custom Part Naming Rules customer default.

TipTo find a customer default, choose File—Utilities—Customer Defaults and click Find

Ov

Default i

Where do | find it?

Application Progressive Die Wizard, Engineering Die Wizard

»
Command Finder|Define Intermediate Stage E]‘

b2. Define Intermediate Stage dialog box

Define Intermediate Stage

Stage Sequence Specifies the order in which the intermediate stages are created.
From Part to Blank
Assigns station numbers of intermediate stages in decreasing order.
From Blank to Part

Assigns station numbers of intermediate stages in increasing order.

Number of Stages Sets the number of intermediate stages for your assembly.

Start Station Sets the stage at which the unfolding begins.

Pitch Sets the distance between the intermediate stages in the graphics
window.

Orientation of Pitch Sets the axis on which the intermediate stages will be aligned: X, Y, or Z.

Preview Displays the stages using the selected pitch orientation.

Edit Intermediate Stage

.ﬁj Lets you select an intermediate stage for inserting a new stage, or for
deleting one.

Select Intermediate

Stage

Settings

Naming Rule for

Intermediate Stages Defines how to nhame the intermediate stages.
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Top Part Name Lets you specify the name of the top part when creating an intermediate

stage.
Creates a copy of the sheet metal part within the intermediate stages.
Create Copy of Sheet Note The copied part has the suffix copy following the part name, and
Metal Part is not assigned any attributes associated with the original part.
Opens the Part Name Management dialog box, allowing you to rename

Rename Components the component.

Lets you link intermediate stages to a sheet body instead of, or in addition
Link Sheet Body for to, a solid body
Intermediate Stages
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c. Direct Unfolding
c1. Function and command call
Use the Direct Unfolding command to:

Automatically recognize straight-brake sheet metal bends, including bends with a 0 bend radius, or
bends without a planar base.

Define prebend parameters for each bend. The Prebend command combines Divide
Face and Extrude features into a single Prebend feature in the Part Navigator.

Merge bends of equal radius that share a common bend axis.

Change the K Factor and developed length parameters for individual or multiple bends in a sheet metal
part.

Specify additional geometry to be used to flatten a sheet metal part by using Select Additional Bend

Faces "  within your operation.

Where do | find it?

Application Progressive Die Wizard, Engineering Die Wizard

-
)

Command Finder|Direct Unfolding ==

c2. Direct Unfolding dialog box

Type
Lets you specify the direct unfolding operation to perform:
f@.‘l Convert to Sheetmetal converts an imported part or a part created in the
Modeling application to an NX Sheet Metal part.
Type list el Merge Bends merges bend regions that have been split into multiple bend

segments, or that have the same axis, radius, and reference face or edge.

~
== Define Prebends divides bend regions into multiple bend segments.

* Delete Bends deletes bend regions.
Recognize Bends

Appears when Type is set to Convert to Sheetmetal.

@ Lets you select a planar face to serve as the base face for the part you are

converting to an NX Sheet Metal part.
Select Base Face

f‘z Lets you specify additional bend faces when converting to sheet metal.
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Select Additional

Bend Faces
Bend List
Available when more than one body is available in the current part.
Bodies in Part
Lets you designate a body to use when selecting bends for unfolding operations.
@ Lets you select a bend from the list or in the graphics window for direct unfolding
operations.
Select Bend

Available when Type is set to Define Prebends.

.,
Lets you select the start edge that is used to calculate the angle for multiple
Select Start Edge prebends.

Lists the recognized bends with their radii, angles, K Factors, and developed

Bend list lengths.

Define Neutral Factor
Lets you specify the material, neutral factor, and developed length.

Selects the source for material and bend parameters in
the process_data.xls spreadsheet.

Neutral Factor Table

Developed Length Designate the Neutral Factor page as the source for bend parameters.

Calculation BAF Table

Designate the BAF (Bend Allowance Formula) page as the source for bend
parameters.

NX uses the user defined BAF to calculate the developed length of bend faces.

Lets you select a material that is defined on the Material page of

Material the process_data.xls spreadsheet.

Opens the process_data.xls spreadsheet.
Load Material

Database

Available when Developed Length Calculation is set to Neutral Factor Table.

Neutral Factor Shows the neutral factor that is interpolated from the table. You can override it

by selecting a different value.

Shows the calculated unfolded length of material. You can override it by typing

Developed Length s e valie.
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Appears when Type is set to Define Prebends.
Number of Bends Specifies the number of prebends to create in the selected bend.

Specifies the angle of a prebend.

Angle
If Number of Bends is set to more than 2, multiple Angle boxes appear.

Appears when Type is set to Merge Bends.

Lets you select the following bend types and merge them into one bend:
Select Bend A parent of the prebends in the Bends List
Bends with the same axis, the same radius, and the same reference face or
edge

Appears when Type is set to Delete Bends.

Select Bend Lets you select a bend in the Bends List and delete it.
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d. Bend Operation
d1. Function and command call
Use the Bend Operation command to:

Unbend, rebend, prebend, and overbend sheet metal parts without entering the NX Sheet Metal
application. Prebends also appear in the Direct Unfolding dialog box.

Define prebend parameters for each bend. The Prebend command combines Divide
Face and Extrude features into a single Prebend feature in the Part Navigator.

Note You can use the Bend Operation command only on parts that you converted to sheet metal in
the Direct Unfolding operation, or on sheet metal parts you created in the NX Sheet Metal
application.

Where do | find it?

Application Progressive Die Wizard, Engineering Die Wizard

Command Finder|Bend Operation

d2. Bend Operation dialog box

Type
Specifies the type of bend operation.
Unbend 2

Type menu or Rebend /4

buttons
Prebend
Overbend £

Inputs

'd} Lets you select an intermediate stage in the graphics window with bends that

you want to modify.

Select You can create intermediate stages with the Define Intermediate

Intermediate Stage Stage command.

&

Select Bend

Lets you select one or more bends for the bend operation.

Show Alternate APpears when Type is set to Unbend, Rebend, or Overbend.

Result Displays alternate results for your inputs.
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Alternate overbend radii

Alternate overbend angle positions.

. Prebend Parameters
Appears when Type is set to Prebend.

Designates a tabbed page in the process_data.xls spreadsheet from which
the material and bend parameters are taken to develop the length of bend
material.

Developed Length Neutral Factor Table

Galcuiaion Use the Neutral Factor page
BAF Table
Use the BAF page
Material list Lists you specify a material that is defined on the Material page of

the process_data.xls spreadsheet.
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Load Material

Database %

Neutral Factor

Developed Length

picture

Number of Bends

Angle(n)

Prebend Parameters

Opens the process_data.xls spreadsheet.

Available when Developed Length Calculation is set to Neutral Factor
Table.

Shows the neutral factor that is interpolated from the table.

You can override it by selecting a different value.

Shows the calculated unfolded length of material.

You can override it by typing a new value.

Varies with the total number of bends that you specify, from 2 to 6.

1 1
—  ——

- - 4

The number of bends shown is always one less than the total number of bends.
The first bend is the one defined by the geometry; the rest are prebends.

Sets the number of prebends, from 2 to 6.

Lets you specify intermediate angles. The number of input boxes (n) ranges
from 1 to 5.

Appears when Type is set to Overbend.

Overbend Type

Target Angle

Specifies the type of overbend operation.

Resize Bend Angle ,@

Resize Bend Radius @

Appears when Overbend Type is set to Resize Bend Angle.

Sets the angle to which the feature is bent in the overbend stage.

Keep Radius Fixed Appears when Overbend Type is set to Resize Bend Angle.
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» When not selected, the overbend can change the
~ radius.

~ When selected, the bend radius remains constant,
and only the angle can change.

Appears when Overbend Type is set to Resize Bend Radius.
Target Radius

Sets the radius to which the feature is bent in the overbend stage.

Appears when Overbend Type is set to Resize Bend Radius.

When not selected, the overbend can change the
position of the tab or flange.

Fixed Tab/Flange

Position
When selected, the feature position is constant, and
only the radius can change.
Available when a result moves the fixed face of the part.
Restore Part
Position Restores the fixed face and adjacent features to their position before the

overbend.

d3. Perform a bend operation on a sheet metal part

Choose Progressive Die Wizard tab—Intermediate Stage Tools gallery—Bend Operation, or

choose Menu—Tools—Process Specific—Progressive Die Wizard—Intermediate Stage
Tools—Bend Operation.

In the Bend Operation dialog box, set Type to the operation you want: Unbend, Rebend, Prebend,
or Overbend.

In Settings, select the Preview check box if you want to see a dynamic preview in the graphics window
as you define the operation’s parameters.
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562

In the graphics window, select a bend.

You can select more than one bend, or the software may select multiple bends for you if the bends have
the same reference plane or edge.

Select the Show Alternate Result check box if you want to see alternate results for your inputs.
If Type is Overbend, in the Inputs group, do one of the following:

Specify the Target Angle.

If you want the bend radius to be fixed, select the Keep Radius Fixed check box.

Select the Resize Bend Radius check box and, in the Target Radius box, enter the radius you want.
Click Show Result. > to preview the appearance of your part.

Click Undo Result "7 to return your part to its pre-operation appearance.

To apply the bend operation to your part, click OK or Apply
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e. Universal Unform
e1. Function and command call

Use the Universal Unform command to flatten complicated regions such as:

Bend regions that include deformation features, such as embosses.

i 2

Bend regions on parts with non-uniform thickness.

Contour flange bend regions.

Where do | find it?
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Application Progressive Die Wizard, Engineering Die Wizard

Command Finder|Universal Unform )

e2. Universal Unform dialog box

Define Bend

Bend Type
@r Straight Bend

Flattens straight bends with deformations such as embosses or ribs.

La Contour Flange

Flattens a contour flange-type bend. The contour flange must lie on the same
plane and maintain a consistent angle in relation to the reference face.

'

7./ Burring

Flattens deformations that have blends at the base of the feature.

Select Reference Lets you select a face or plane to indicate the position of the bend region when

Face or Edge it is unbent.
Select Blend
Faces

Lets you select a blend area or a bend face as the area to unform.
Select Bend Faces
Selects the source for material and bend parameters in
the process_data.xls spreadsheet.
Neutral Factor Table
Developed Length Designate the Neutral Factor page as the source for bend parameters.
Calculation BAF Table

Designate the BAF (Bend Allowance Formula) page as the source for bend
parameters.

NX uses the user defined BAF to calculate the developed length of bend faces.

Lets you select a material that is defined on the Material page of

Material
the process_data.xls spreadsheet.

ﬁ Load Opens the process_data.xls spreadsheet.
Material Database
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Available when Developed Length Calculationis set to Neutral Factor

Table.
Neutral Factor

Shows the neutral factor that is interpolated from the table. You can override it
by selecting a different value.

Shows the calculated unfolded length of material. You can override it by typing

Developed Length a new value.

e3. Flatten complex areas with Universal Unform

This example shows how to unform a contour bend and a burred feature on a sheet metal part.

Open the Universal Unform dialog box in one of the following ways:

!
ChooseProgressive Die Wizard tab—Intermediate Stage Tools gallery—Universal Unform %

Choose Menu—Tools—Process Specific—Progressive Die Wizard—Intermediate Stage
Tools—Universal Unform.

In the Define Bend group, under Bend Type, click Contour Flange‘g!.

For the reference face, select a planar face, as shown.
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With the Face Rule set to Connected Blend Face, select one of the bend segments and then
click Apply.

The contour flange is flattened.
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r ﬂl'
Under Bend Type, click Burring @‘

For the reference face, select a planar face as shown.

With the Face Rule still set to Connected Blend Face, select one of the blend segments and then
click OK.
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f. Analyze Formability — One-step
f1. Function and command call

Use the Analyze Formability — One-step command to flatten all or some faces of a sheet metal part
using FEM analysis and calculate the thinning, stress, strain, and springback to predict the risk of
forming.

You can:
Perform complete or intermediate unforming, or flatten a Sheet Metal part.

Output the flattened profile or springback faceted bodies for complete part unforming. You can also
specify the target region and the unform region from a different sheet body.

Define different constraint types, both geometry and process, to control unforming.

Create trim line feature curves on the addendum surfaces when your part has a flange and addendum
sheet bodies with a common boundary.

The flattened profiles are produced as spline curves and the analysis results are post-processed and
displayed in a color-coded plot mode. The analysis report is generated based on the subsequent results.

Thickness results Stress results

Strain results Flattened shape

The Onestep Unform feature which saves your inputs and settings, is listed in the Part Navigator, and
can be edited if required. The data is retrieved when you reopen the part file and run the Analyze
Formability — One-step command.
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Where do | find it?

Gateway, Modeling, Progressive Die Wizard, Engineering Die Wizard, Sheet
Application Metal, Die Engineering, Die Design, Press Die Checker

Simcenter Pre/Post installation (License not required)

Prerequisite  |Towork with Die Engineering commands, you must be in the Modeling application.

Command =
Finder Analyze Formability — One-step ® |

f2. Analyze Formability — One-step dialog box

Specifies the type of unform feature you want to create.
&7
=4 | Entire Unform
Performs complete unforming of the part.
Type list

Entire Unform — Thickness analysis results

P Intermediate Unform

Performs intermediate unforming of the part.

Intermediate Unform results
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"'i* Advanced Unform

Performs advanced unforming. Additional advanced constraints and options are
available to specify springback match points, or draw bead constraints with or without
addendum, and create the springback faceted body.

Advanced Unform — Thickness analysis results with Draw Bead constraints

<

L_*/Trim Line

Creates trim line feature curves on the addendum surfaces when your part contains
a flange and addendum sheet bodies with a common boundary.

1Addendum face

2Product face
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3Flange face

4Trim line profile

Not available when Type is set to Trim Line.

Lets you specify if you want to perform the formability analysis on a solid body or on
a face.

Object @ Solid
Type list

Lets you select solid bodies to perform the formability analysis.

ﬁFat::el

Lets you select faces to perform the formability analysis.

Not available when Type is set to Trim Line.
= | Lets you define the surfaces to be unformed and calculated.

Select Faces If you select the entire surface of a body, a complete unform is performed. If you
select a partial surface, an intermediate unform is performed.

I Notavailable when Type s set to Trim Line.

Lets you select curves or points on the selected faces to perform the formability
analysis.

Select Curve
or Point

: Available when Type is set to Intermediate Unform.
Selict Eanes Lets you define the target surfaces to which the unform region is mapped.
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If the target region and unform region faces are from the same body, they must have
common edge which is defined as the Curve to Curve boundary condition constraint
type for intermediate unform.

Boundary Conditions

Not available when Type is set to Trim Line.
Specifies the boundary constraints depending on the region selected to unform, and
the unform type.
Curve to Curve

Lets you specify the curves that define the boundary for the unform region.

For an intermediate unform, select common edges between the unform region and
the target region.

For an entire unform, select curves from the boundary of the unform region.

.?:S:Tir;mt The Select Curve from Unform Region m option is available.

Point to Point

Lets you specify the points on the surface of the unform region to lock the position.

4
L]

+
The Specify Point from Unform Region ‘- options are available.

Curve along Curve

Lets you specify the curves that define the region for an entire unform. The Select

Curve from Unform Region m option is available.

Constraint List

+
Lists the constraints you applied. Click Add New Set {1} to specify additional constraints.
Springback Match Points

Available when Type is set to Advanced Unform.

o) 2
'g:?h Rkt Lets you specify three points to define the springback constraints.
. For example, the following graphic shows how the three springback match points are
oF )’5, fully constrained within six degrees of freedom.
Match Point
Two
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DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

o7 |

Match Point
Three

o First springback match point with zero displacement in the X, Y, and Z direction
° Second springback match point with zero displacement in the X and Y direction
° Third springback match point with zero displacement in the X direction

o Constraint curves
Advanced Constraints
Available when Type is set to Advanced Unform.

Specifies the part type:
With Addendum

Part Type list For a part with addendum, you can specify the binder region and the draw beads.
Without Addendum

For a part without addendum, you can specify the equivalent binder region.
Blank Holder
These options are available when Part Type is set to With Addendum.

=

Binder
Region

Lets you specify the binder region.

Sets the blank holding force.

During stamping of sheet metal parts, appropriate control of the blank holding force

Force (kN) minimizes the wrinkling tendency, material discontinuity, and non homogeneous
stress or strain distribution. Generally, a lower blank holding force must be applied
on the thicker blank side to allow more metal to flow in for obtaining a more uniform
strain distribution.
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These options are available when Part Type is set to Without Addendum.

s

Equivalent
Binder

Lets you specify the equivalent binder region.

Tension : : : ;
(kN/mm) Sets the value for the tension applied to the binder region.
Force

Strength

Available when Part Type is set to With Addendum.

M

Lets you specify the location of the draw bead.
Specify Draw
Bead

Sets the value for the force applied to the binder region.

Tangential
Tension Sets the value for the tension applied in a direction that is tangent to the draw bead.
(kN/mm)

Normal
Tension Sets the value for the tension applied in a direction normal to the draw bead.
(kN/mm)

Force

Strength Sets the value for the force applied to the draw bead.

List Lists the specified draw beads.

Appears when Type is set to Trim Line.
Lets you select product and flange faces that define the unform region.

Appears when Type is set to Trim Line.

Lets you select addendum faces that are tangential to the product and flange faces.

Material list Lists the materials available in the standard Default Material Library.
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If you customize the properties in the standard Default Material Library, the changes
are reflected in the Material list and the analysis results.

Local
Material

Specifies that a local material is used.

Default
Material Specifies that materials from the standard Default Material Library are used.
Library

Site MatML

Library Lets you specify the location of an alternate materials from the MATML Library.

User Mat ML
Library

Lets you specify a user defined material library.

List Displays the list of materials available from the specified material library.

Q}L Available when you select a material from the list.

Inspect Opens the Isotropic Material dialog box in which you can inspect the material
Shatoral properties.

[i] Available when you select a material from the list.

Information Displays the material properties in the Information window.

Not available when Type is set to Intermediate Unform.

Appears when Type is set to Entire Unform, Advanced Unform, or Trim Line.

El 2 Lets you define the normal of the unform plane.

Specify The unform region is flattened normal to the plane in the specified draw direction.

Specifies the surface from which the unforming region is extracted. The solver

Surface Type automatically offsets the surface in the right direction.

@ Inner Surface
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Infer
Thickness

Calculation

V]

Infer Element
Size

Overall
Element Size

Tolerance to
Find Contact
Size

&

Mesh

L 2

Mesh Quality
Check

=

Calculation

Creates an unform region with an offset, where the result is an unform profile larger
than the original.

D Middle Surface

Creates an unform region with no offset.

@ Outer Surface

Creates an unform region with the specified offset, where the result is an unform
profile smaller than the original.

Available only for solid bodies.

Infers the thickness automatically if the unform region surfaces are from a solid body.

Appears when Type is set to Trim Line.

Infers the size of the mesh element.

Appears when Type is set to Trim Line and available when you clear the Infer
Element Size D check box.

Sets the size of the mesh element.

Specifies the default tolerance that NX uses when, after creating mesh elements, NX
searches for contact points between the product or flange faces and the addendum
faces. NX uses the mesh elements to find the constraints, and defines the boundary
of the trim line profile.

You can specify the default tolerance using the Tolerance to Find Contact
Size customer default.

Tip To find a customer default, choose File tab—Utilities—Customer Defaults,

and click Find Default ov !

Creates the mesh in an interim FEM part and gets mesh elements data back to
modeling for the Onestep solver to calculate.

Examines the mesh quality in term of mesh shape, mesh element node overlapping.

Launches the solver to start calculating the unforming results.
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Results Display

A

Display
Thickness

R

Display
Stress

Displays the thinning simulation results in a color-coded plot.

Displays the stress simulation results in a color-coded plot.

M

—y

. Displays the strain simulation results in a color-coded plot.
Display
Strain

U

Display
Springback

&
Outputs the springback facet body and creates a .spb file which includes node

Output coordinate and element information.
Springback
Facet Body

=

Display Displays the results for the flattened model with mesh elements.

Flatten
Shape

Displays the springback simulation results with before and after images of the model.

L

Create
Profile

Creates an unform profile of the flattened sheet body.

Captures static images of the analysis results and represents them in an analysis

R report in the XML format. The XML file is generated using an XSL template.
eport

Show Model

Boundary Hides or displays boundary edges of the model while displaying the results.

Settings
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Lets you modify the material, mesh, solver, and report parameters.
Material

Lets you modify the following material properties:
E (Elastic Modulus)
Density

Poisson’s Ratio

Yield Stress

n (Hardening Coefficient)
Initial Strain

K (Strength Coefficient)

r0 (Anisotropy Coefficient)
r45 (Anisotropy Coefficient)
r90(Anisotropy Coefficient)

Note n (Hardening Coefficient) is a material constant that is used while performing stress-strain
analysis. It is calculated using the following formula:

oc=Ke"

where,

o = The applied stress on the material
K = Strength coefficient

£= Strain

n= Hardening coefficient

The value of n lies between 0 and 1. A value of 0 denotes that the material is a perfectly plastic,
and a value of 1 represents material that is perfectly elastic. The usual range of n for most
metal is between 0.10 and 0.50.

Mesh
Specifies the element type to be used for performing the surface meshing.
Triangle

.IIE_I;)r:ent Specifies the triangle element type for surface meshing.

Quad4
Specifies the quadrilateral element type for surface meshing.
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Infer Element
Size

Split Quad

Attempt Free
Mapped
Meshing

Mesh  Size
Variation (%)

Small
Feature (% of
Element
Size)

Solver

Triangle mesh Quad4 mesh

Appears when Type is set to Entire Unform, Intermediate Unform, or Advanced
Unform.

Infers the overall element size automatically.

Available when Element Type is set to Quad4.
Sets the surface meshing method to split quad.

Performs the mapping.

Sets the value (as a percentage) for the tolerable variation between the largest and
smallest elements of the mesh.

Sets the percentage of the element size for surface meshing of small features.

Lets you modify the solver settings.

Convergenc
y Level

Maximum
lteration
Steps

Friction
Coefficient

Specifies the level of convergence (low, medium, or high) of the iterative process.

An iterative solution is considered to be sufficiently converged (or attained a particular
level of accuracy) when any additional iterations produce negligible changes in the
variable values.

Specifies the maximum number of steps to be performed by the solver to reach the
specified convergency level.

Specifies the coefficient of friction.
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During sheet metal forming processes, the coefficient of friction, if controlled properly,
can generate the required stresses to deform the metal to the required shape and
predict the fretting fatigue damage.

Save
Analysis
Results into
Feature

Saves the specified formability analysis results into the One-Step feature.

Join Output

Biinves Joins the resulting output curves.

Calculate Calculates springback, which predicts the springback results. Select this check box
Springback to create spring back faceted bodies.

Display Springback mode

Available when Type is set to Advanced Unform.

Lets you specify the springback display options.
Displacement

Displays the springback in 3D displacement.

Along X

Displays the springback displacement in the X direction.
Along Y

Displays the springback displacement in the Y direction.
Along Z

Displays the springback displacement in the Z direction.
Report

Display
Thickness

Display
Stress

Display
Strain Lets you specify the analysis result images you want to include in the XML report.

Display
Springback

Display
Flatten
Shape

580

DPP - Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Allow View

Change Lets you change the view orientation before you export the analysis results.

f3. Analyze sheet metal forming

i
Choose Analysis tab—More gallery—Part gallery—Analyze Formability — One-step S .
In the Analyze Formability — One-step dialog box, from the Type list, select Entire Unform.
In the Object Type group, from the Object Type list, select Face.

In the graphics window, select the faces to unform.

\,{"ﬂ

In the Boundary Conditions group, from the Constraint Type list, select the boundary condition.
For this example, select Point to Point.

In the Constraint List sub group, click Specify Unform Point and select the constraint point as shown
in the following figure.

ZC /

In the Material group, do the following:

Set the Material List to specify the location of the material library from which you want to use a specific
material.

For this example, select Library Materials.
In the Libraries subgroup, make sure that the Default Material Library check box is selected
In the Materials (Filtered) sub group, select the required material from the list.

For this example, select Steel.
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Note All the available materials in the standard Default Material Library are listed in
the Materials list. Click Display material properties for selected material(s) EI

or Inspect Material A to view information about the selected material. You can also
modify the material properties in the Settings group.

Specify the draw direction.

For this example, the draw direction is specified along the +ZC axis.

In the Thickness group, from the Surface Type list, select Outer Surface.

In the Calculation group, do the following:

Click Mesh @ to perform the surface meshing.

Click Mesh Quality Check w to examine the mesh quality.

In the message box that appears indicating the status of the mesh quality check, click OK if the mesh
passed the quality check.

If the mesh quality is poor, you can change the surface meshing options in the Settings group,
under Mesh, and then re-calculate the surface meshing results.

Click Calculation | 5’ to calculate the unforming results using the solver.
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a

The thickness and flattened shape unforming results are displayed in a color-coded plot.

In the Results Display group, click Display Thickness | and Display Flatten shape ‘ E

Display Thickness results Display Flatten Shape results

Click Report |

An external XML file with the XSL template is generated. The analysis results are automatically saved
in the XML file.

In the Settings group, under Solver, select the Save Analysis Results into Feature check box.
This ensures that the formability analysis results are saved with the Onestep Unform feature.

Click OK or Apply to finish the analysis and save the analysis results with the Onestep Unform feature.

4.3.2. Create a strip layout
Detailed workflow 2: Create a strip layout
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This workflow shows you how to:

Create the strip layout shown.

Specify the number of stations in the
layout.

Position scrap at appropriate stations.

Position intermediate stages at
appropriate stations.

Run a simulation of the layout process.

You must have previously prepared your
part, created intermediate stages, and
designed scrap.

e B, & 77 75 ==

2.
3. 'Strip Layout _ Choose Progressive Die
(= £== 'Strip Layout Design Center Wizard tab—Main group—Strip
= 2 'Strip Layout Definition T
8 'Pitch = 150.000000 Ky
- & 'Width = 190.000000 NX displays the Strip Layout
%% 'Feeding Direction = 0 Navigator. All the steps in this
ﬁ 'Station Number = 18 workflow are done in this navigator.
4. Set the number of stations.
Right-click Strip Layout

Definition and choose Create.

This workflow uses 10 stations.

6 & 6 & o & & &
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5. Position the scrap at appropriate
stations.

|
: Drag scrap from Station 1 to the other
6&&&&56! stations.
For this workflow, the following are
used.

B Station ﬁ Scrap

Number

Station 1 SCRAP_10
SCRAP_11

Station 2 SCRAP_6 through
SCRAP_9

Station 3 SCRAP_1
SCRAP_3

Station 4 SCRAP_O
SCRAP_2

Station 10 SCRAP_5
SCRAP_4

6. Open and display the intermediate
| stages in the strip layout.

Right-click Intermediate Part and
select the  previously created
intermediate part from the folder on
your system.

7. Drag the Final stages nodes under the
appropriate Station nodes so that they

< - . E @@@@ represent the progress of the part
2 R ﬂ through the die.

é J’ For example, in this

workflow Final appears under both
the Station 9 and Station
10 nodes. Final-1 appears under
the Station 8 node, Final-2 under

the Station 7node and so on in
descending order.
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Pl et

Simulate the strip.

Right-click Strip Layout
Definition and choose Simulate
Piercing.

Enter the numbers for your From and
To stations.

Run the simulation.

T

Remove the blank material to make the
simulation resemble more closely the
actual physical strip.

Right-click Strip Layout
Definition and choose Remove
Blank Material.

Enter the numbers for your From and
To stations.

Run the simulation.

Close the Strip Layout Design
Center
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4.3.3. Create piercing inserts
Detailed workflow 3: Create piercing inserts

This workflow shows how to create:
User defined punch and die blocks
Standard punch and die inserts

Die cavity and slug holes

You must have previously created
intermediate stages, designed scrap,
created a strip layout, and added a die
base.

1. at 2 @ E E % E E E‘ ﬂ Start the Progressive Die application.

The commands that you will use are in

' ﬁ ' ﬂm E Ee 3 r the Progressive Die
: Wizard tab—Main group.

2. Open the top level assembly.

> -~
Choose View Manager I
In the View Manager Browser hide
the die base so that you see only the
strip layout.

4. Create inserts for user defined scrap.

Choose Piercing Insert Design %
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In the Piercing Insert Design dialog
box, do the following:

Set Type = Die Insert

Click Select Scrap
Select the scrap.

For  this  workflow, SCRAP_3 is
selected.

In the User Defined Insert group,

click Create Datum Plane D

Select the highlighted scrap to accept
the default datum plane and open the
Sketch task environment.

Sketch a rectangle that contains the
selected scrap.

Click Finish Sketch ﬂ
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8. In the User Defined Insert sub-group,
click Create Insert G

9. Create additional die inserts for all the
user-defined scrap, using the same
design method.

10. Create standard die inserts for
individual hole scraps.
Select the scrap.
In the Die Insert group,
click Standard Insert ﬂ
Use the Standard Part
Management dialog box to add an
instance of a standard die insert.
Add standard inserts for the remaining
individual scraps in the layout.

11. Create punch inserts to correspond to

the user defined die inserts you
created.

From the Typelist, choose Punch
Insert.

One by one select all the user defined
inserts you created.

Click Select Scrap

In the Punch Insert group,
click Create User Defined

Punch m
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12. Create a standard punch insert to
correspond to the standard die insert
you created for the remaining scrap.
From the Typelist, select Punch
Insert.

Click Select Scrap —

Select the scrap.

In the Punch Insert group,
click Standard Punch.

Use the Standard Part
Management dialog box to add an
instance of a standard punch insert.

13. Create standard punch inserts for the
remaining scrap.

14. In the View Manager, expand
the Insert Group, and hide
the Piercing sub-assembly.

590

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

15.  Create die cavity and slug holes.

The die cavity slug holes cut through
the die block, backing plate, and die
shoe to let the scraps drop from the
strip.

From the Type list, select Die Cavity

'}
and Slug Hole E

Click Select Scrap | — .

Select all the scrap on the strip layout.

Click Create Die Cavity and Slug

Hole ‘E‘

16. ' In the View Manager, show
i the Piercing sub-assembly.

4.3.4. Create bending inserts
Detailed workflow 4: Create bending inserts

This workflow shows how to create die and punch
bending inserts for regular straight brake sheet metal
bends.

You must have previously created intermediate
stages, designed scrap, created a strip layout, and
added a die base.
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1. " T r —a—— Start the Progressive Die application.
HRExETEE=EELEEE LA

=
G@lipo e
2. Open the top level assembly.
Hide the die base.
3. . Zoom in on the stage that contains the
standard straight-brake sheet metal
bends.

For this workflow, the stage is Final-
2 at Station 8.

Choose Progressive Die
Wizard tab—Main group—Bending

it -/

Insert Design ﬂ .

11

~~=H

Set the following:

Type = User Defined Insert

Bending Type = J 90 Degree
Bending

Insert Type = @ pie
Position = Stripper Plate
Select the bend.
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5. m
Click Create Datum Plane
Select the highlighted face to accept
the default datum plane and open the
Sketch task environment.

6. Draw a rectangle as shown.

Make sure that the bottom of the
rectangle is collinear with the lower
bend line.
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Finish the sketch and click Apply to
create the insert.

8. y. A Create the corresponding punch
insert.

Rotate the strip so that you are looking
( at the back face of the part.

Change the Insert Type to Punch.

Select the back face of the same bend
you selected for the die insert.

Create a datum plane and sketch a
rectangle. Make the sides of the
rectangle collinear with the edges of
the die insert, as shown.

Finish the sketch and click Apply to
create the punch insert, as shown.
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10. Create die and punch bending inserts
for the remaining bend on Final-2, as

shown.

4.3.5. Design Worlflow of a Progressive Die Set
NX Progressive Die Wizard (PDW) provides a streamlined workflow for creating high volume sheet
metal parts efficiently and cost-effectively.

1. Prepare your sheet metal part.

Design a solid-based sheet metal partin
NX or import one from another 3D CAD
system. PDW creates a progressive die
based on a solid model. Repair the part
if there are any apparent flaws or quality
issues.
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Prepare intermediate stages.

Use the Define Intermediate

Stage ﬂ command to specify the
estimated number of stages you need to
form the part and the initial stage
number.

Use the Direct

Unfolding -@ command to convert

parts with standard straight-brake
bends.

Use the Bend

Operation Tﬁ command to flatten
standard sheet metal bends.

Use the Universal

Unform g command to flatten
straight-brake bends with deformation
features such as beads, ribs, gussets,
contour flanges, and burring.

Use the Analyze Formability-One
£
Step ® command for more complex
freeform deformation areas.

3 _-,h.-'_'l-——’
. B et b e

Create a PDW project.

Use the Initialize
B
Project % command to create a
project for this part, name parts, and
assign materials.

Create the blank layout.
Use the Blank

[
Generator% command to import a
blank from the fully flattened part.

Use the Blank Layout A command
to create a layout for blanks. The layout
must allow for efficient use of material
and adequate spacing between blanks
to form the scrap.
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5. Design scraps.
g
Use the Scrap Design ==— command
to design scrap to remove.
6. e Create a strip layout.
s
| S .
e Use the Strip Layout command
*i.._'.._ to define the number of stations and
. assign scrap to be removed at each
E i station. You can drag scrap to assign it
..E =4 to a station.
.E-‘ You can also add intermediate stages
_— - into the strip layout and drag stages to
.'E:‘ v the appropriate stations.
=
E . 1%
el * | e
7. Add a die base.
Use the Die Base % command to
design and add a die base to hold the
strip layout.
8. Design cut punch and die inserts.

Use the Piercing Insert

Design % command to create
standard and custom shaped punches
and dies to remove scrap from the strip
layout.
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9. Design punch and die blocks for
bending, forming, and burring.
Use the following commands to create
bends, burring, and other deformed
shapes:
t Bending Insert Design
'. Forming Insert Design
ﬁ Burring Insert Design

10. Add auxiliary features to punches and
dies.
Use the Insert Auxiliary
Design . command to create
strengthening features such as shanks
for various inserts.

11. Add standard parts.

From PDW libraries of standard parts

in Standard Parts aa or the Reuse

Library ﬁ , select standard parts
such as lifters and springs.
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12. Design relief pockets.
Use the Relief Design * command
to create solid bodies to cut out pockets
and holes in the die plate or strip plate.

13. Cut pockets.
Use the Pocket
Design & command to create
pockets in the die plates to
accommodate the standard parts and
other components. The pockets are
associative to the tool bodies.

14. Do detailing.

Use the following commands to
document your die assembly with
drawings:

Assembly Drawing

/| Component Drawing

° | Auto Dimension

4 ' Hole Table

Hole Manufacturing Note
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Perform static interference checks and
dynamic interference checks.

- - Use the Tooling Motion
ﬁ‘ifo TN [ E:
e =] Simulation | ' command to simulate
the progress of the strip through the die
e stations.
=

4.4. Application Assignments
4.4.1. Application Assignment 1

76
S5
< !
o) B \% | o]
(o] i (o] 5
o | ! o
h r _____
™
g o~
-
ﬂ‘} : |
| 10 y"’“ 3
24 8x @28
o
-
—

I_ 120 _I 15
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4.4.2. Application Assignment 2

935—\

poe— 275~ G~

e T e L R BA-l K-

A ——r——1
8

25
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602

UNIT 5 : INTEGRATED NX EASY FILL: PLASTIC INJECTION MOLD DESIGN
THROUGH SIMULATION

Objective: By the end of this training unit, the trainees will be able to

Read and understand simulation and analysis results

Analyze the causes and find ways to fix design errors

Understand the process of simulating plastic flow with NX software

Export the report of simulation results of plastic injection mold with NX software.
Contents:

5.1 Overview of nx easyfill advanced technology.

Moldex3D

MOLDING INNOVATION
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5.2 Product analysis process with NX Easy Fill.
5.2.1 Set Working Folder

This section demonstrates how to set working folder.

Attribute of molding components and analysis result will be saved to the working folder.

This is optional, and the system will set current work part folder as working folder if user does not
specify one.

ﬁ . ? a % . g Click Set Working Folder in the ribbon.

Set Working  Set Set SetMelt SetParting Start Show

Folder  Cavity Runner Entrance Direction Analysis Result

Setting v
{3} Working Folder O X Click Browse... to select working folder.
' Click OK to confirm your settings.
Specify Working Folder
. CA\Users\moldex3d\Desktop\NXModel\ I‘ = i
oKk | cancel |

Easy Fill If there already exists data in the selected
| working folder, the massage will show up.

@ Reload analysis setting from working folder?

The attribute of molding components is saved as a .XEDS file, including the path of analysis result
folder, with the same name as model file.

5.2.2 Set Cavity

This section demonstrates how to set up a part and corresponding parameter.

ﬁ ? 8 % g SCe!i;t:::‘g-Set Cavity in the ribbon to start

Set Working | Set Set SetMelt SetParting Start Show
Folder  Cawity Runner Entrance Direction Analysis Result

Setting -
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£} Select Cavity O X Click Select Body and then click on your
- model to make selection
Cavity Setting A
 Select Body (1) N7
Material Setting "

{3} Select Cavity Click Select Material to activate Moldex3D
- - Material Wizard.
Cavity Setting v
Material Setting
Material
_ |
Select Material &

® Moldex3D Material Wizard . Select a material from the pull-down list and

click OK.
If the complete Moldex3D Material Bank is
Material- |ABS needed, click on Advanced....
Producer: |A. Schulman
Grade Name: |POLYMAN M/MI-A
Advanced. .. |
L3} Select Cavity Click OK to apply the settings.
Cavity Setting A
 Select Body (1) 5" |
Material Setting A
Material

ABS_POLYMANMMI-A_ASchulman

Select Material &

| ok | cancel |
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 belder3D Mot Vi - neeon € s molder S Debontodelsamseteral et l#&% How to manipulate Moldex3D Material

Hhmﬁdlmmﬂmm_ o
WM-EE|TT O S ESEEAE A T Bank

A Poject e e e e e e By clicking on Advanced... of material
wizard, users can access Moldex3D Material
Tt R, e Bank.

10*

LI F—D »
€ Liser Hank
T Mol daxdld Bank

ABS / POLYRAN MAAI-4 (A Schulman ) NUM

. Click Moldex3D Bank on the left panel to
M Project load Moldex3D material bank. Find the
l £ User Bank I material for the plastic melt.

. & Moldex3D Bank ]

-l ABS E
-8 A. Schulman F

=-J§ ASAHI

@ STYLAC 120

----- @ STYLAC 120B

----- @ STYLAC 121

----- @ STYLAC 121B

@ STYLAC 180

----- @ STYLAC 181

----- @ STYLAC 182

----- @ STYLAC 183

----- @ STYLAC 184

@ STYLAC 190

----- @ STYLAC 191

@ STYLAC 191F

R ASTYLAC R2404

----- @ STYLAC VA29

@ STYLAC V4507

+-JB BASF
48 CAE

:
;

)-8 CHEIL
EE---E CHI-MEI
;

:

:

m

#- 18§ DAICEL

+- 8 DENKA
+-l8 EVER E

h R Do Chavnianla Tkl
[11] b

=
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8 aideyiD Materal Wzard - Injestio - [ st i [ |
Fle View £ Cuve Metenal el

a0 BB % e Right-click the target material and click Add
. Project Vimosity | PPT | Bt Capasity | Thecosl Conductinty | Favaeleotiaty | bsckussal Bruyesties | Cuntect | 014 | ¥

e to Project in the context menu. Click OK in
[ mokie,cD Bunk | the pop-up confirmation. In the next pop-up

Erd A 3 AEG ETYLAC RI40A ASAHI M 15 pilnls. 4 s .
Bl e : T dialog, click Yes to add the material to User
& STVLAC 1 FR. )

W ONVLACIHNE = fk-“\\ | lams Bank.
Eoie, oy o

E s \\ :

E 1n\u

~8 STYLAC 130
@ STULAC 181
& STVLAC 152
@ ETVLAC 133

~ STVLAC 15d

-4 SINLAC 150

-8 ETVLACIEL t

- ETVLACIDIF =L

Vimeaty [gferm me) |

& 5TV Addro Prgjert
L BE s Praject A
-1 CAT At User Bank

at 10 n? ot m®
[ CHEIL Add to Comganson Lis
= I I st e [Liee ]|

{AES / ETYLAL FIADA [ ASAHL) T [MOM

5.2.3 Set Runner

5.2.3.1 Set Runner - Create Runner System from Solid Bodies

— Click Set Runner in the ribbon to
o
N . i set up runner.
Set Working  Set Set  SetMelt SetParting Start Show

Folder Cavity Runner Entrance Direction Analysis Result
Settir'lg -

& Select Ruriner Click Specify Runner to set object
with the runner attribute. It is
Runner List A supported to specify either solid
- = runner or line runner.
kd
)
w
oK H Cancel |
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{3} Select Runner X
. Objects A
Select Objects (0) ‘j:
Select All .
Invert Selection | @.:

_ =

| OK | Cancel

£ Settings
Attribute A
Type | Cold Runner |
-
| oK ] ~ Cancel ‘
£} Select Runner O X
Runner List A

Runner-1 <Cold> (Solid)

| OK | Cancel |

Click on the target solid object and
click OK to confirm the selection.

Specify runner type and click OK to
confirm.

To modify runner design such as
shape and sizes, use CAD
functions.

An entity representing the solid
runner will appear in the tree menu,
double click to edit runner type or
click delete button on the right side
of the list to delete.
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S -p o
e ©T & & E
Set Working  Set Set  SetMelt SetParting Start

Folder  Cavity Runner Entrance

setting

Show

Direction Analysis Result

Click Set Runner in the ribbon to
set up runner.

£ Select Runner

Runner List

{3} Select Runner X

Objects A
« Select Objects (4) {]}
Select All

Invert Selection ‘

Other Selection Methods v

Filters v

Click Specify Runner to set object
with the runner attribute. It is
supported to specify either solid
runner or line runner.

Click on the target line objects to
select and click OK to confirm the
selection.

{3} Settings
Attribute A |
Type Cold Runner oy ‘
Cross-Section Parameters A
Type Circular vi

. m
D |2.00001 % /2.00001 5|

|| cones

Specify runner attribute, type and
diameter and then click OK to apply.

608

DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

To modify an existing runner
segment, double click its entity in
Runner List, or otherwise click
delete button on the right side of the
list to delete.

£ Select Runner
Runner List A

Runner-1 <Cold=>
Runner-2 <Cold>
Runner-3 «<Cold=>
Runner-4 <Cold=

w
£} Settings O X After change runner attribute, shape and
size, click OK to confirm the settings.
Attribute A
Type | Cold Runner - ‘
Cross-Section Parameters A
Type | Circular - ‘

] ]
D 2.00000 5 [ 2.00001 5|
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5.2.3.3 Set Runner - Valve Gate Control

This section demonstrates how to set up valve gate control in hot runner attribute.

¥ Settings Select Hot Runner for runner attribute.
Click Valve Gate Setting to access valve

Attribute A | gate control settings.
Type Hot Runner v
Valve Gate Setting W
-
Ok | Concel

O Valve Gate Setting Specify whether trigger by Melt Front (melt
. front position) or Time (filling time).
Valve Gate Control
() By Melt Front @ By Time

Parameter Setting A

l « | 1

Time (Sec.)

Action @ Open () Close

v

| Ok | Cencel |
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¥ Valve Gate Setting

Valve Gate Control
) By MeltFront @ By Time

Parameter Setting

ID Time Action \i‘
1 0.0008ec. Open X
2 0.200%ec. Close =
3 0400Sec. Open &
< | . J
Time (Sec) 0.00001 % |
Action @ Open O Close
v

£} ‘Valve GateSetting

Yalve Gate Control
@ By MeltFront () By Time

Parameter Setting A
[ |
hd

X
r"l‘
Time (Sec) 1000001 2 |
Action @ Open () Close
Reference Point A

x[-13.24: 2 |¥[22.167 |2 [19.8231 2| [t

o

H Cancel |

Triggered by Time
Specify the gate action to open or
close, and set the delay time.

Click Add to add a new control point.
Click Modify to modify a new control
point.

Click Delete to delete an existing
control point.

Triggered by Melt front

_ ) ‘@9
Enter coordinates or click | ™ to
select a specify point for trigger point.
Select the gate action, open or close,

and set the delay time.

Click Add to add a new control point.
Click Modify to modify an existing
control point.
Click Delete to delete an existing
control point.
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5.2.3.4 Set Melt Entrance

Melt entrance is essential to the simulation. This section demonstrates how to set up the melt
entrance in the model.

S ; 5= Click Set Melt Entrance in the ribbon
ﬁ i ‘ % ﬂ menu to define a melt entrance.
Set Working  Set Set | SetMelt SetParting Start Show
Folder  Cavity Runner Entrance Direction Analysis Result

Setting[} -
Melt Entrance Settin
o 2 O X Click Specify Melt Entrance
Melt Entrance List A Position to create melt entrance and
click OK to proceed.
e
&
X
| OK | Cencel |
{3} Point O X Click on the surface of runner or part
to create melt entrance and click OK
Type A to proceed.
(& Point on Face -
Face A
 Select Object (1) J
Location on Face A%

QOutput Coordinates
Offset A

Offset Option ‘ None -
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{3 Melt Entrance Setting O X

Meit Entrance List

A

[Melt Entrance-1 (D = 9.000) e

=

oK Cancel

{3 Melt Entrance Setting O X

Melt Entrance Diameter

Diameter

A

9. 0000

Coce

An entity will appear in the list upon

completion of set-up.

Click &

or click the
to delete.

X

to modify any previous settings,

on the right side of the list

Note: if the melt entrance is directly set on
the part, the diameter of the melt entrance

is adjustable.

There are some differences among building melt entrance on the runner with solid bodies, on the
runner with line element, by runner wizard, and directly on the part surface. Building melt entrance
on the runner with line element is the same as using runner wizard to create melt entrance, which its
diameter is defined by that of runner end point. The melt entrance on solid body is defined by the
surface area of runner end. In addition, a complete runner system, including gates and runner, is
prerequisite for creating melt entrance on solid body. Users also can add melt entrance directly on
the part surface, and the diameter is defined by that of a hypothetical gate on the cavity surface. The
comparison table is shown below.

Building melt entrance
on the runner with line
element

Building melt entrance
by runner wizard

Building melt entrance
on the runner with solid
bodies

Building melt entrance
on the part surface

Its diameter is defined by
that of runner end point

Its diameter is defined by
that of runner end point

Its diameter is defined by
the surface area of runner
end

Its diameter is defined by
the diameter of a
hypothetical gate
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5.2.4 Set Parting Direction

A customize mold open direction function.

Click Set Parting Direction on the ribbon to

ﬁ | Ch g open the setting dialogue.
N\ o

SetWorking Set  Set |SetParting Start Show
Folder ~ Cavity Gate | Direction Analysis Result

Setting I} -

Vector Type

Type A selection.
Vector Orientation

? /. \(4" XC YC ZCs "' U_se Reverse Direction to flip the parting
? " u T direction.
' Click OK to apply the setting.

Vector Orientation A

T
Reverse Direction | x
L

The specified parting direction will be shown
in orange arrow.
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5.2.5 Start Analysis

This section will demonstrate the analysis setup in default settings. Before starting an analysis, please make
sure all the model components of injection molding are properly set.

W a % o g After setting up all the model components, click Start
= o— Analysis on the ribbon
SetWorking Set  Set SetParting = Start  Show
Folder ~ Cavity Gate Direction Analysis Result

Setting b v

. Analysis Setup
£ Analysis Setup O X There are four sections in the analysis setup dialog:
Analysis Set A Analysis Set, Process Condition, Mesh, and
Computing Setting.
Remark | Runl |
Analysis | Filling - F - ‘
Process Condition A
Max. Injection Pressure (MPa) 1.55 .00001]
Filling time (sec) _ 0 .?SOUII
Melt Temperature (°C) 230. Um|
Mold Temperature (°C) _SO_GOO_UI|
Mesh A
Meshing Size 3.48 18_."
Computing Setting A
No. task | 8 pd |

Start Analysis Immediately

B el |

Analysis Set
Add a remark for this Analysis.
Analysis Set A Choose the molding process you would like to
simulate from the pull-down menu.
Remark Runl _.
; S | Filling - F
Analysis mMalyﬂs “FPA - : Filling & Packing - FP

Full Analysis - FP/CW
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rvmace (CarnAiH ae
S Lonamon

Maximum injection pressure(MPa)

Filling time (sec.)
Melt Temperature (oC)

Mald Temperature (oC)

Mesh

Meshing Size

Computing Setting

No. task 8
[¥] Start Analysis Immediately

A

155.0000

0.60001

240.00001

60. 00001

3.4818

Process Condition:

The default process condition is set based on the
cavity dimension and the material selection.

In this example, Filling Analysis is chosen; Only
Maximum injection pressure, Filling time, Melt
temperature and Mold temperature can be modified.
Packing time is adjustable if the Analysis Sequence is
selected as Filling & Packing

Mesh
Generate mesh with customized mesh size so that tiny
feature would be remained.

Computing Setting

User can set the number of working core to run
analysis; the number of working core can't exceed max
core number of CPU.

If Start Analysis Immediately is unchecked, current
analysis would be exported to project monitor list.
Multiple run data can be added for simultaneous
simulation.

After setting above-mentioned process conditions, click OK to start or click Cancel to cancel it.

5.2.6 Start Analysis - Analysis Monitor

Easy Fill Advarced Project Moritar

=N =N <

| Run | Bnalysis | Progress | Remaining T... | Status
| Run1 Filling 92 % o 07: 22 RLINNING
Information (S
i) 1.869e-83 8. 83 1.13 B.57Y4 21 -
7 2.424e-03 a.e2 1.13 B.841 24
8 3.A93e-A3 a.e1 1.13 1.142 27
9 3.898e-82 8.61 1.13 1.540 20
18 4.873e-83 a.e1 1.13 2.817 32
Ho Time(sec) Pres{MPa) Q{cc/sec) Fill{%) CPU{sec)
11 6.834e-83 a.e1 1.13 2.575 i
12 7 .366e-03 a_ea 1.13 3._21%5 a7
13 B.89%e-82 a.68 1.13 3.952 9
14 1.859e-82 a.82 1.13 4.766 42
Remoie Glatt | | Stop | | Close

The analysis monitor shows the run ID, analysis
sequence, estimate time, calculation percentage, and
status.

Analysis log shows the calculation data of the current
run.

To control the calculation process, use the button on
the bottom of the monitor:

Use the Remove to remove a selected analysis which
is pending.

Use Run to start the pending run.

Use Stop to abort the calculation.

Use Close to Abort the calculation and close the
monitor.
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5.2.7 Show Result

=] I After analysis finished, click Show
ﬁ i a % g Result in the ribbon to open the

SetWorking Set  Set SetMelt SetParting Start Show 9ialogue.
Folder Cavity Runner Entrance Direction Analysis ResulT

Setting
£} Show Result O X
Analysis Result A
Runl ‘ ) 4
Run2 ‘
Description
I Close |
{3} Show Result O X Analysis Result
- Select a run to view by clicking on it, or
Analysis Result A click Delete on the right side of the list to
T | | delete.
- There are eight sections in the Show
Result Dialog: Analysis Result, Display
Result, Display Setting, Animation
Desarintion Setting, Views Tool, Save Animation as
y ; Files, Generate Report and Export
! New run for virtual moldin_g trial Result to Moldex3D Viewer.
Display Result A
Criteria Mot use - ‘ E
Display Mode Classic Mode -
Analysis . Filling -
Result Type | Melt Front Time v |
XY Plot

Result Adviser

Display Setting

Animation Setting

Save Animation as Files

v
v
Views Tool v
'
Generate Report %

v

Export Resuit to Moldex3D Viewer
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Display Result A Criteria
3 Check if the results are out of user
Criteria | None v B defined limit range.
) ' - —— Display Mode
Display Mode Customized 1 ¥ User can change it to customized mode
Result Type Moldability_Filling ~ for only showing the result added to
@ preference setting, or show all results by
Classic mode.
XY Curve Type Cavity Weight 1 Fi ~ Analysis
) =N By using the Filling/Packing option, users
Result Adviser can view the result of filling or packing
— stage.
Result Type

Select the result to view from the pull
down menu. There around 30 result
types, including Melt Front Time, Air
Trap, and Weld Line...ect.

If the result is out of the criterion used,
there is a warning sign “I!” shown before

result name.
Display Result A
Criteria _. My Set '”: :-;!.“:11
Display Mods Classic Mode v|
Anzlysis Filing - |
Result Type UMkt Front Time |
|| X¥ Plot =
. Air Trap
Result Adviser \Weld Lins
‘Weld Linz Meeting Anglz
Display Setting Weld Lins Temperature
Animation Sefting ate Co.r‘.t”bmmn =
Moldability
Views Tcol Pressure
el
Save Animation as Files ','T“mpemt“re
Shear Rate
Generate Report H-Velocity
Export Result to Moldex3D View Y_Vemc!ty
Z-Velocity
Volumetric Shrinkage
Density

XY Plot

Check to activate XY Plot and select the
result in the pull down menu of XY Curve
Type.
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Display Result A
Criteria Not use - é},
Display Mode Classic Mode E
Analysis : Filling =
Result Type :-Melt Front Time v:

[] X¥ Plot

Result Adviser ‘

Criteria

User can specify each result with limit
range.

Expand the pull down menu to select the
criterion you want to use.

Click Jb‘ to call result criterion setting
dialog and modify each result limit.

{3} Result Criterion Setting O X

Import from file A
| |u|

Import | D|

Result limit setting A

Criteria | My Set

Criteria Setting A

Analysis Filling - |

[Melt Front Time 8
iWeld Line Meeting Angle (@
\Weld Line Temperature ‘:‘
|Pressure

Temperature

Shear Rate

X-Velocity

iY-Veiocity

iZ-VeIocity -

Limit Value A
0.09001 % |
.

Upper Limit Value

Export to file A
l El
File Name

| _i
Export ||3.|

Result Criterion Setting

The Result Criterion Setting dialog box
shows as the following:

Import from file—Import the criteria setting
file *.xmre.

Result limit setting—After clicking the
result in list, the limit value group would be
shown below. In limit value group, user can
input upper/lower limit to be the constrain of
the result.

User also can remove setting by clicking 4
button.

Export to file—Export the criteria setting
file *.xmrc for other PC.

DPP — Vacational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

5.2.9 Display Result - Result Advisor

Display Result A ReSt._llt _Advisor guickly coordinates
possible issues for this run.
Filling Packing
Result Type Melt Front Time  ~ |
[C]xY Plot
Result Adviser
{3 Result Adviser 50 ¢| ResultAdvisor
Click Result Advisor to view the issues
Found Issues A detected during the analysis, shown as the
= following:
Air Trap

Found Issues—Lists the issues detected
in the simulation. Click an issue to view its
description and solution.

Problem Description—Displays the
description for the selected issue with a
Problem Description A conceptual animation.

Possible Solution—Displays the
recommended solutions for the selected
issues.

Update the analysis as recommended in
the solution and rerun the analysis.

Unbalanced flow

Air traps found inside the cavity. This may cause voids or :

Possible Solution A

-Increase the filling time.

-Change the gate location.

-Reduce the injection speed.

-Modify the size or location of the vents.

rs

 Close
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Display Setting A
""; D 1.3004,
il 0..00001
Reset Range E!

isibility Setting A

[¥] Cavity [¥] Runner
Animation Setting A
Percentage Step 5.00001 ¢
Percentage |:| 100, UOUU'
Play 4
Animation Speed D
Slow Fast

Display Setting

This function allows users to adjust the
upper and lower limits with a specific range
for analysis results such as the part

temperature and shear stress.
-t
[ |

Lower limits of display range C o

Use the slider to adjust the upper or lower
limits of color legend.

Click Reset Range to reset the upper and
lower limits as your preference.

Click Cavity to hide/show part.

Click Runner to hide/show runner.

Upper limits of display range

Animation Setting

Animation tools controls the play speed
and display step. It helps to inspect results
during the filling process or at specific
filling percentage both on post and XY
Curve.

Animation tools support only some results
and XY Plot:

Percentage Step

Click the arrow to increase or reduce the
step percentage of each frame. The
animation displays smoothly with low
value of percentage step.

Percentage

Pull the control bar changes the melt front
display during filling process. The post and
the color legend will be synchronized when
pulling control bar.

View Tool

Click a result item and check View Tools to
enable view tools function.

There are three options, Clipping Function,
Slicing Function, and Iso-surface Display.

Clipping Function

Referring to the plane equation: aX + bY +
cZ =d, user can specify each parameter to
define the clipping plane.

~ Slicing Function

PP —
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Views Tool A

[¥] Clipping Function
[7] slicing Function

|7l Isosurface Display

Referring to the plane equation: axX + bY +
cZ =d, user can specify each parameter to
define the slicing plane.

Iso-surface Display

User can use this feature to view a specific
value of result by adjusting the color

Equation-aX + bY + cZ=d A
legend.

a 1.00001

b 0.0000

c | 0.0000i

d 4 0.0000
o TR Animation type
Y Animation as Fil A

S TN AR 1ES Select the format of the animation, AVI or
Animation type AVI » GIF.

N Time

Time (Sec) 5.00000 ¢

% : = Specify the total length of the animation.
Frames / sec S - Frames / sec
Range (%) 0.00001/~ | 100.00001] Define frames per second. The larger

Export animation file path

C\Users\moldex3d\Desktop\NXEZfill\weld line\Cover_ -'_ ""‘ .

File Name

Cover_CL_weldline02

Save Animation B:J

number makes the smoother animation
but longer processing time.

Range

Users can make a partial animation by
adjusting the range.

Export animation file path

Enter file name and specify the file path.
Save Animation

Click Make Animation to start recording.

DPP - Vocational Training for Smart Manufacturing in Machine Tools
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5.2.10 Generate Report

After analyzing, analysis results such as melt front time animation, temperature distribution, pressure
distribution can be coordinated as a Powerpoint file.

Generate Report A Click Generate PowerPoint Report .
Generate Powerpoint Report @
Create Report — Report Information.
Fill the information to provide in the report,
Report Information A and click OK. The report will then be
generated automatically.
Title CAE flow results The information items to be filled are:
| Title
Author The title of the report.
Company Moldex3D CoreTech Author
The author of the report.
Company Logo Company
C:\logo.bmp | The company name that generates the
o — report.
Recipient Company Logo

The company logo can be insert into the
report, supporting the *.bmp file format.
Report Path A Recipient

. The recipient of the report.
Location Recipient Company
CA\ The recipient company of the report.
= - Report Path
Flie Name CAE_I‘ESUH Spec|fy the reporl path

Location

- The location of the report.

File Name
OK ‘ Cancel The filename of the report..

The report will be done automatically in
several minutes.

Recipient Company

("

5.2.11 Export Result to Moldx3D Viewer
After analyzing, user can export *.rsv file which can be opened by Modex3D Viewer.

Export Result to Moldex3D Viewer

Click Export RSV button B to output *.rsv file

Export RSV File Folder to indicated folder.
ChUsersymoldex3d\DesktopiMNX11Y o |

File Name

RSV

Export RSW B
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5.2.12 Gate Wizard
Click on Gate Wizard in the ribbon. A dialog will pop up for users to set the gate types and other

€ «

Gate Runner Melt Entrance
Wizard Wizard Wizard

corresponding parameters. Wizard v
£} Create Gate O X NX EasyFill Advanced supports many
gate types: Pin Gate, Sprue Gate,
Position of Gate A Edge Gate, Fan Gate, Lapped Edge
_ Gate, Tunnel Gate, Cashew Gate,
« Select Point (1) \Q -+ Tunnel Gate With Ejector Pin, and
Cashew Gate With Ejector Pin.

s Each gate can be set to Cold Runner
Axtribte ~ Gate or Hot Runner Gate. Following
Type of gate ‘pin Gate = are the step-by-step procedures for

. : setting each gate:
Attribute
Sprue Gate

Cross-Section Parameter Edge Gate
Fan Gate

[ Lapped Edge Gate

Tunnel Gate

Cashew Gate

Tunnel Gate With Ejector Pin
L Cashew Gate With Ejector Pin

i

D1
oL [2.00001 3 D2 [6.00001 3
Gate length(L) ‘6.0000' - .
| ok | Apply | Cancel |
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o1 [2.000013) D2:
Gate length(L)

16.00001 %
16.00001 % |

3;f:=§;1

——f

E'f _‘_
DL [8.00001 3 D2 [4.00001%
Gate length(L) 40.0001% |

Pin Gate
Step 1: Select Pin Gate.

Step 2: Click Select Point @
and select the point on model
surface as the gating location.
Step 3: A gate parameter setting
panel will pop up as left. Set
related parameters, such as
diameter of cross-section and
gate length. After setting, click OK
to confirm and exit the setting or
click Apply to set next gate.

Sprue Gate
Step 1: Select Sprue Gate.

Step 2: Click Select Point

and select the face or point on
model surface as the gating
location.

Step 3: A gate parameter setting
panel will pop up as shown. Set
related parameters, such as
diameter of cross-section and
gate length. After setting, click OK
to confirm and exit the setting or
click Apply to set next gate.

Edge Gate
Step 1: Select Edge Gate.

DPP — Vacational Training for Smart Manufacturing in Machine Tools
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b i

2.00001 3 |

0.00001

4.00001 5

al: 2. 00%;_ a2:
b: 3.00001 %
Angle I_

Gate length(L)
To Nearest Edge

< )}

il

.

\\

Step 2: Click Select Point @ and
select the face or point on model
surface as the gating location.

Step 3. A gate parameter setting
panel will pop up as shown. Set
related parameters, such as the
width and length of cross-section,
orientation vector and gate length.
After setting, click OK to confirm and
exit the setting or click Apply to set
next gate.

al:  [2.00001 3 a2:
bi: 6.00001 5 b2: 6.00001 5
Angle I_ 0.0000

Gate length(L)
To Nearest Edge

Fan Gate
Step 1: Select Fan Gate.

Step 2: Click Select Point @
and select the face or point on
model surface as the gating
location.

Step 3: A gate parameter setting
panel will pop up as shown. Set
corresponding parameters, such
as the width and length of cross-
section, orientation vector and
gate length. After setting, click
OK to confirm and exit the setting
or click Apply to set next gate.
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Note: While selecting Fan Gate, there is an additional option, To Nearest Edge, shown at the

bottom of setting panel.
Check To Nearest Edge, and the gate will automatically move to the nearest edge from the

location you selected.

Lapped Edge Gate
Step 1: Select Lapped Edge Gate.

Step 2: Click Select Point @ and
select the face or point on model
surface as the gating location.

Step 3. A gate parameter setting
panel will pop up as shown. Set
related parameters, such as the

b

:,1,‘ I% :2 {%ﬂ::l width and length of cross-section,

' — ) et T orientation vector and gate length.
Angle !— 0.00001] After setting, click OK to confirm and
Gate length(L) 3.00001 5 | exit the setting or click Apply to set

next gate.

/ ;
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— ‘ Tunnel Gate
Type . Circular > Step 1: Select Tunnel Gate.

Step 2: Click Select Point @ and
select the face or point on model
surface as the gating location.
Step 3: A gate parameter setting panel
will pop up as shown. Set related
parameters, such as diameter of
cross-section, orientation vector and
‘— gate length. After setting, click OK to

confirm and exit the setting or click

D1

DL [2.00005] Dz [6.00001 %] Peply losst nextgate:
T- [45.0000% ]

Angle [—— | 0.00001

Gate length(L) 116.0001 % |

628 DPP — Vocational Training for Smart Manufacturing in Machine Tools



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

Note: The cross-section can be
designed as circular or rectangular
by selecting from Type drop down
: menu in the setting panel. Set
-—-*':) corresponding parameters, such as

1 dimensions of cross-section,
orientation vector and gate length as
in circular type.

Type | Recta ng_uiar v ‘

: . _ a2 |3.00001 3]
b1 b2
T: 45.0001 5 |

Angle .—

Gate length(L) m‘

0.00001
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Cashew Gate

Type | Circular ¥ ‘ Step 1: Select Cashew Gate.
w PR Step 2: Click Select Point @ and
- select the face or point on model

surface as the gating location.

Step 3: A gate parameter setting
panel will pop up as shown. Set
related parameters, such as the
diameter of cross-section, orientation
vector and gate length. After setting,
click OK to confirm and exit the

1
. )

D1: ‘2.0000| :‘ D2 ‘5.0000| :‘ sett'ting or click Apply to set next
—_— | — alte.

d: [4.00002]  w: [16.0001% °

h: |6.00001 % |

Angle l—‘ UUUOU'i
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Note: The cross-section can be
designed as circular or rectangular
by selecting from Type drop down
menu in the setting panel. Set
corresponding parameters, such as
dimensions of cross-section,
orientation vector and gate length
as in circular type.

Type ] Rectangular -

al: 1.00001 5| al: 3.00000 3
bl: 1.50000 5 b2: 4.50001 5
d: 4.00001 2 w: 16.0001 5

h: 6.00001 3
Angle

l—— [ 0.0000]

- &
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Tunnel Gate With Ejector Pin
- Step 1: Select Tunnel Gate With
Type Circular i \ Ejector Pin.

g i

Step 2: Click Select Point @ and
select the face or point on model
surface as the gating location.

Step 3. A gate parameter setting
panel will pop up as shown. There
will be two parts of setting
parameters. The top part is for

- Tunnel Gate setting; the bottom is for

Ejector Pin setting. After setting

D1: [ = D2- |~ corresponding parameters, click OK
‘%‘ ‘m‘ to confirm and exit the setting or click
T: 45.0001 5 | Apply to set another gate.

Angle

Gate length(L) @

Ejector Pin Cross-section Parameters A

Type | Rectangular - ‘
» & [2.0000%]
a b 13,0000 5 |
l|-— b —

Ejector Pin length 16,0001 3 |

Extension _ 5.00001 3

Note: There are three types of
ejector for users to select: pin,
Rectangular, Semicircular and U-

Semicircular

U-shape

shaped,
l— b =
Ejector Pin length [ 16.000 :_|
Extension : 5.0000 :|
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Type

‘ Circular v

T

e

DL |2.000013 |
d: 4.00000 3
e 16.000003
Angle

Type

I
da
i

—p —

Ejector Pin length

Extension

D2 |6.00001 3

w: 16,0000 7

I | 0.00001

Ejector Pin Cross-section Parameters

A

‘Rectangular VI
a: 12,0000 5 |
b 3.00001 3 |

16.0001 %
5.00001 3 |

Cashew Gate with Ejector Pin
Step 1: Select Cashew Gate With Ejector Pin.

Step 2: Click Select Point @ and select the face
or point on model surface as the gating location.
Step 3: A gate parameter setting panel will pop up as
shown. There will be two parts of setting parameters.
The top part is for Cashew Gate Setting; the bottom
is for Ejector Pin. After setting related parameters,
click OK to confirm and exit the setting or click Apply
to set next gate.

DPP — Vocational Training for Smart Manufacturing in Machine Tools
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Note: There are three types of gjector pin for users

| 1
Type Rectangular ¥ | to select: Rectangular, Semicircular and U-shaped,.
T Rectangular .
a Semicircular ‘
Il U-shape
b—p —
Ejector Pin length | 16.0001 5 |
Extension |5 L0000 3 |
5.2.13 Runner Wizard

Runner Wizard automates the runner system design process by generating a knowledge built-in
runner system. When designing the runner system, users have to set only gate location and
dimension on the model, and the wizard will calculate for proper runner sizes, shapes and layout. It
also supports to generate a complete runner system by specifying runners, sprue, and drops
sequentially. With Runner Wizard, users can design runner systems more efficiently.

tR &

Gate Runner Melt Entrance
Wizard Wizard Wizard

Wizard -

Click on Runner Wizard in the ribbon to launch Runner Wizard.
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Note: it requires defining gates before running the wizard, or the following warning would be shown.

Runner Wizard

)

I]i Specify Gate first.

Click the Mold Setting tab. The explanatidn of each parameter is described below:

£ RunnerWizard Parting direction: _ ) o
Parting direction is available in positive

Mold Seing |ICRSERHS IS E I o neg=tve X. Y. and  directons.

Select the mold plate type; there are 2-

Parting Direction ‘ Z-huis " Plate mold and 3-Plate mold available.
Mold Plate Type ‘ 3-Plste rnold v ‘ Using: ) )
- The wizard offers four options to specify
Runner Attribute ‘ Cold Runner ¥ ‘ the position of main parting plane: Top of
Parting Plane Position A gaur;,tog‘oﬁom o part; (Gate: [plaric ek
, = ' PL1:
Using ITOp of part | Define the main parting plane position.
L2oua =] (Modify only in Custom using type)
, 1@ 11.0001 i
i - - .
lpL2@ 44,8009 Define the secondary parting plane
Part | FLI|p _33300! 3 gils:tlon
Distance between main parting plane
and secondary parting plane
Default ‘ E‘)
-

Cancel ‘
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The Sprue Settings tab of the wizard is for specifying the sprue position, sprue length and sprue
diameter. The explanation of each parameter is described below:

Select the sprue position from the drop-

- s down list. There are two options
sprue: Position ~ available: Center of gates and Custom.
Using | Center of Gates v Center of gates: Position the sprue at the
| R? center of gates.
Coordinate Center of Gates " A Custom: Specify a custom sprue
p— Custom P location. Please enter values for sprue
50. 105+ Y | 49,757 =] Z]-35. 0015} location in the X, Y and Z text box, or left-

click in the graphic window to specify
desired sprue location.
Sprue Geometry Parameters

Runner Wizard D1:
24 O X Specify the diameter of sprue start.
Mold Setting !:-pru;:Settmg Runner sefting Specify the diameter of sprue end.
i DA A A SH:
3prue Position i Specify the length of sprue.
: CL1:
u Center of Gat A
g srer of ates Specify the length of cold slug well.
Coordinate A CLD:
. _ Specify the diameter of cold slug well.
57.6990 1Y 31.6041<Z 44 8001 Use cold slug well:
B . If users want to use the cold slug well for
) - sprue, make sure this option is checked
Sprue Geometry Parameters A
02 D1 17.20001 ¢ |
o |, o2 4.3200 %
SH (35.8401 2|
CLl |
Use cold slug well
er 7.20001 2|
CLD |7.20001
Default E')
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£} RunnerWizard 5> ¢| Runner Setting

Type:
. . Define the cross section type of runners.
Mo'd et | Semaieng Pumer{emng There are Circular, Trapezoidal,

i

Runner Geometry Parameters A Semicircular, and U-shaped available.
. : D:
T Circul -
¥Re il , — Specify the diameter of runner.
D 7.20000 2 Use cold slug well:
If having the cold slug well for runner,
Use cold slug well make sure this option is selected.
CL2 ] CL2:
Sross o & 200 Specify the length of cold slug well.
pecity d g
D .- D -t D3
rop Liameter N Specify the diameter of drop start.
= - ral D4:
D3 [6.00001 - D4 [7.20000 . Specify the diameter of drop end.
Other parameters A

|1 Extend the gate
0.00001 =]
0.00001-

Extended Gate Parameters

Other parameters S :
In some specific locations, the runner

L | Extend the gate L setting has option to use extended gate,
0 UUUUI'”; and _s.pecify the values of L (length) and
- : S § RATE D (Diameter) of the extended gate. Users
0.0000(= PART can use extended gate function to avoid

unreasonable runner creation.
An example is shown below:

5.2.14 Melt Entrance Wizard
You can start auto melt entrance command in the ribbon.

R A

Gate Runner Melt Entrance
Wizard Wizard Wizard

Click Melt Wizard to start Melt Entrance Wizard. Wizard ki

After clicking it, melt entrances will be added to the runner system automatically and the melt entrance
can also be set directly on the gate as below.
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After

Before

Before After

5.2.15 Cooling Time Indicator
@O
8% -

Indicator Tool ~
This tool can estimate the cooling time of cavity.
After the part attribute setting process, you can find the Cooling Time Indicator icon enabled in the

Tools menu. Within one click, the result of estimated cooling time will show up in the display window.
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Estimoted cooling time

G0 .93
54, 84
48.75%
42 66
36.57
30.48
24,39
18,29
12,20
6. 11
0.025
SEecC
£} Cooling Time Indicator At the same time, Material Information and
Parameter Setting will be displayed on left.
Legend Range Setting A The calculation of estimated cooling time
— is based on the associated information.
-’i m | 60. 9255:_5 Besides, users can use the slider to adjust
- upper and lower limits of color legend
e I |M manually.
Material Information A
Density (g/cm*3) 1.0406!
Melt Temperature (oC) 240, 0000
Mold Temperature (oC) a0 . 0000
Eject Temperature (oC) 10585001
Heat Capacity (erg/g.K) 24000000

Thermal Conductivity (erg/sec.cm.K) 15000 00
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5.2.16 Flow Length to Thickness Ratio Indicator

After gate or melt entrance setting is done, click L/t Indicator in the Indicator Tool.
Pull the Upper/Lower Limit Slider to specify the range of the Flow Length/Thickness.

®O
5% -

Indicator Tool ~

Flow Length/Thickness
41.68

37.51
33.34

29.17
¥} Ltindicator O X

Legend Range Setting A

N | | 41.6783 |

25.01

|
A 0.00001

5.2.17 Gate Location Adviser

£} GatelocationIndicator

) . After part setting is done, click Gate
Gate Location Adviser A Location Advisor in the category of

Gating Mode Autariatie - indicator toal.

Automatic Mode A Q o A
Parting Direction z - 2 & -

Gate Counts 1 -

Indicator Tool

Automatic Mode

Select gate number (up to 6 gates).
Set parting direction of the mold base.

=

Calculate

Auto add gates

- Click ' = | to calculate the suggested
L/t Indicator A gate location(s).
["] Show target L/t band I
. 0..0000! After calculation, click “/| to add pin
= gates on the suggested gate location(s).
Note: User can click Show target L/t band
b to show L/t immediately.
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Suggested

Not Suggested

{3 GatelocationIndicator Manual Mode
Click Add button to call gate wizard for
Gate Locafion Adviser A adding gates.
Note: User can click Show target L/t band
Gating Mode Manusl | to show L/t immediately.
Manual Mode A
4y
X
L/t Indicator A

[] Show target L/t band
¥ 0..00001

DPP — Vocational Training for Smart Manufacturing in Machine Tools 641



I Vodule: Advanced Mold and Die Design with Integrated CAD/CAM/CAE Solutions

5.2.18 Sink Mark Indicator

This tool is to estimate the location of sink mark.

To use this function, users must finish part attribute setting and make sure that both runner and melt
entrance attribute exists (at least one attribute each).

©O
8% -

Indicator Tool ~

After the attribute setting, click on sink
mark Indicator. Within one click, the result
of Sink Mark will show up on the display
window.

Sink Mark usually occurs at rib or corners
of cavity.

Legend Range Setting will be displayed on
left. Users can use the slider to adjust upper
and lower limits of color legend manually.

.m. SinkMarkIndicator

Legend Range Setting A
" il [ Loool
-1 B | 0.00101

I- Close ]
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5.2.19 Upload to Teamcenter/Download from Teamcenter
If NXis opened via Teamcenter, it is available to upload the analysis result to Teamcenter or download
the analysis result from Teamcenter.

On the other hand, the analysis result opened directly from local disk and can only be saved to the
local disk.

Note: The following functions will respond only if NX is opened via Teamcenter.

Q All result files will be placed in the local folder %Temp%!\<item> after the analysis
finished.
Gotoad o Click Upload to Teamcenter to collect the files into a XEDZ file and upload into
O Teamcenter as a dataset.
Teamcenter
Click Download from Teamcenter to download the XEDZ file from Teamcenter
@ back to the local folder % Temp%!\<item>.

Download from
Teamcenter

5.2.20 Set Preference

After click Preference in the ribbon, there will pop up a dialog to help filtering the result for users’
need. It also provides that user can import *.xmrg file, or export setting file to other projects.

=

Set
Preference
Preference ~
£} Freisrence O X
Famtomizec Hesult Cheplay Customized Result Display
EREOED = Users can set result list what they need to
— check ; after click OK button, result shown
fmeen ) in Show Result dialog would be changed.
e Reslt DISHlay S5t “ Import
Analysis A - |

User can import *.xmrg file in the group.
Customized Result Display Setting

Weld Line
Weld Line Temperature
Gate Contribution

Moldabiliy User may change analysis type, select the

Yt ) e

Shear Stress result and click button, then the

el selected result would be added to

Z-velocity . as customized list.

Custormize | Custormized_1 || || P ™ o
Customized List A User also can set priority by A4
el [ eesi AnghFilling button, and delete the result in customized
Melt Fromt Time._Filling 3 list
Pressure_Packing = - TR 3 3 .

R e i e S I = In addition, customization can modify by

add button 1*, rename button 0&’ and

delete button X :
Export A Export
= After setting, user can export *.xmrg for
other project.

File Name

Export |3

| OK Canc=l
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APPENDIX

1. PROJECT REGIONS AND

PARTNERING TVET INSTITUTES

Project regions

Ninh Thuan Province

Ninh Thuan Vocational College m
Supported Occupations:
Industrial Electronics, Mechatronics

Long An Province

Long An College m
Supported Occupation:
Mechatronics

An Giang Province ---*
An Giang
Vocational College
Supported Occupation:
Mechatronics

,~------- Bac Ninh Province
B Bac Ninh College of Industry
Supported Occupation: Metal Cutting

Hanoi City

B Directorate of Vocational Education and Training (DVET)
B Construction Technical College No.1

Supported Occupation: Sewage Engineering

Ha Tinh Province
B Vietnamese-German Technical College of Ha Tinh
Supported Occupation: Automotive Mechatronics

,~----Thua Thien Hue Province
B Hue Industrial College
Supported Occupations:
Sewage Engineering, Mechatronics

v

,~---Khanh Hoa Province
B Nha Trang College of Technology
Supported Occupation: Automotive Mechatronics

o
.

----=-=Dong Nai Province
B LILAMA 2 International Technology College
Supported Occupations: Mechatronics,
Construction Mechanics, Metal Cutting CNC,
Industrial Electronics

B College of Machinery and Irrigation
Supported Occupations: Mechanics for Sanitary,
Heating and Climate Technology, Electronics for
Energy and Building Technology

“----- Ho Chi Minh City
m College of Technology Il
Supported Occupation:
Sewage Engineering

644
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